Note
Before using this information and the product it supports, read the information in "Notices" on page 361.

Product Information
This document applies to Cognos Incentive Compensation Management Version 9.0.0 and may also apply to subsequent releases.

Licensed Materials - Property of IBM

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Introduction ........................................................................................................... xv

Chapter 1. What’s new ....................................................................................... 1

Chapter 2. Overview of the IBM Cognos Incentive Compensation Management client ... 3

Chapter 3. Getting started ................................................................................ 5

Models .................................................................................................................. 5
  Adding a model ................................................................................................. 5
  Adding a model with multilingual support ....................................................... 6
  Changing the model name ................................................................................. 6
  Viewing and publishing the model summary .................................................. 6
Login window ......................................................................................................... 7
  Options menu ..................................................................................................... 7
  Selecting the model environment ..................................................................... 8
  Setting language and date formats .................................................................. 8
Tabs ...................................................................................................................... 8
  Opening, closing, and moving tabs ................................................................. 8
  Rearranging open tabs ..................................................................................... 9
Defining the export tagline .................................................................................. 9
Testing the connection between the IBM Cognos Incentive Compensation Management client and the server .................................................................................................................. 9
Accessing help ....................................................................................................... 9

Chapter 4. Home page ...................................................................................... 11

Welcome message .............................................................................................. 11
Online pane and Client Success portal .............................................................. 11
Text in toolbars ................................................................................................... 11
Navigator tab ........................................................................................................ 12
Recently Opened Items and Most Commonly Opened Items panes ...................... 12
  Finding a recently opened item ..................................................................... 12
  Finding a most commonly opened item ......................................................... 12
The Quick Navigation pane ................................................................................ 13
  Finding components, tables, reports, and web forms ................................... 13

Chapter 5. Process lists .................................................................................. 15

Adding a process list .......................................................................................... 15
Resizing a process list pane ................................................................................ 15
Adding tasks to a process list ............................................................................ 15
Viewing and filtering process lists .................................................................... 16
Editing a process list .......................................................................................... 16
Marking tasks as complete ................................................................................. 17
Rearranging the order of tabs on the Home page .............................................. 17

Chapter 6. Composer ...................................................................................... 19

Models .................................................................................................................. 19
Composer toolbar ................................................................................................ 19
  Multi-Edit icon ............................................................................................... 20
  Link icon ......................................................................................................... 20
  Arrange icon ................................................................................................... 21
  Visibility icon ................................................................................................. 21
  All icon ............................................................................................................ 21
  Uses and Used By icons ............................................................................. 21
  Go To icon ..................................................................................................... 22
  View Connection icon .................................................................................. 22

© Copyright IBM Corp. 2005, 2015
Chapter 7. Table configuration ................................................. 41
Table data connections between components .................................. 41
Table columns between components ............................................. 41
Tables .................................................................................. 41
System tables ........................................................................ 42
Hierarchy tables ..................................................................... 42
Data table .............................................................................. 44
Structural tables ..................................................................... 44
Custom tables ........................................................................ 44
View tables ........................................................................... 44
Table additions ....................................................................... 45
Table column types .................................................................. 45
Primary keys .......................................................................... 46
Adding a table ........................................................................ 46
Adding a Data table ................................................................. 47
Adding a View table ................................................................ 48
Viewing the Payees and Accounts tables as a hierarchy .... 48
Viewing the Time table as a hierarchy .................................... 48
Table data edits ...................................................................... 49
Viewing and editing table structure ......................................... 50
Deleting a table ...................................................................... 51
Adding and editing table descriptions .................................... 51
Deleting multiple rows in a table ............................................. 51
Copying a table ...................................................................... 52
Publishing a table ................................................................... 52
Viewing table dependencies .................................................... 55
Adding a global table ............................................................... 55
Globalizing and replacing connections....................................... 55
Navigating between tables ....................................................... 56
<table>
<thead>
<tr>
<th>Chapter 8. Data imports</th>
<th>65</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1. Selecting the table and import type</td>
<td>65</td>
</tr>
<tr>
<td>Step 2. Selecting a data source</td>
<td>65</td>
</tr>
<tr>
<td>Step 3. Checking required columns</td>
<td>66</td>
</tr>
<tr>
<td>Step 4. File selection</td>
<td>66</td>
</tr>
<tr>
<td>Selecting a text file as a data source</td>
<td>66</td>
</tr>
<tr>
<td>Selecting a Microsoft Excel file as a data source</td>
<td>67</td>
</tr>
<tr>
<td>Selecting ODBC Compliant Database file option 1 as a data source</td>
<td>67</td>
</tr>
<tr>
<td>Selecting ODBC Compliant Database file option 2 as a data source</td>
<td>67</td>
</tr>
<tr>
<td>Selecting Salesforce.com as a data source</td>
<td>68</td>
</tr>
<tr>
<td>Selecting a Microsoft Dynamics CRM file as a data source</td>
<td>68</td>
</tr>
<tr>
<td>Selecting an EBCDIC file as a data source</td>
<td>68</td>
</tr>
<tr>
<td>Selecting a Microsoft Excel file from TerrAlign as a data source</td>
<td>69</td>
</tr>
<tr>
<td>Selecting an XML file as a data source</td>
<td>69</td>
</tr>
<tr>
<td>Step 5. Mapping columns</td>
<td>70</td>
</tr>
<tr>
<td>Effective date columns</td>
<td>70</td>
</tr>
<tr>
<td>Adding sub-items</td>
<td>70</td>
</tr>
<tr>
<td>Merging fields</td>
<td>71</td>
</tr>
<tr>
<td>Step 6. Selecting save and run options</td>
<td>71</td>
</tr>
<tr>
<td>Step 7. Tracking import progress in the Activity module</td>
<td>72</td>
</tr>
<tr>
<td>Viewing import exceptions reports</td>
<td>72</td>
</tr>
<tr>
<td>Changing the import escape character</td>
<td>72</td>
</tr>
<tr>
<td>Managing saved imports</td>
<td>73</td>
</tr>
<tr>
<td>Using a remote directory for saved imports</td>
<td>73</td>
</tr>
<tr>
<td>Data from IBM Cognos Territory and Quota Management</td>
<td>74</td>
</tr>
<tr>
<td>Adding an IBM Cognos Territory and Quota Management object in Composer</td>
<td>74</td>
</tr>
<tr>
<td>IBM Cognos Territory and Quota Management data synchronization</td>
<td>75</td>
</tr>
<tr>
<td>Data from IBM Cognos Producer Lifecycle and Credential Management</td>
<td>76</td>
</tr>
<tr>
<td>Adding an IBM Cognos Producer Lifecycle and Credential Management object</td>
<td>76</td>
</tr>
<tr>
<td>IBM Cognos Producer Lifecycle and Credential Management data synchronization</td>
<td>76</td>
</tr>
<tr>
<td>Chapter 9. Activity tab</td>
<td>79</td>
</tr>
<tr>
<td>Viewing the Activity tab</td>
<td>79</td>
</tr>
<tr>
<td>Viewing error details on the Activity tab</td>
<td>79</td>
</tr>
<tr>
<td>Chapter 10. Input forms</td>
<td>81</td>
</tr>
<tr>
<td>Adding an input form</td>
<td>81</td>
</tr>
<tr>
<td>Assigning security to input forms</td>
<td>82</td>
</tr>
<tr>
<td>Assigning users to the input form role</td>
<td>82</td>
</tr>
<tr>
<td>Adding input form validation rules</td>
<td>83</td>
</tr>
</tbody>
</table>
Viewing an input form .................................................. 83
Change submission through an input form .......................... 84
Adding a new row to an input form .................................. 84
Editing a row in an input form ....................................... 84

**Chapter 11. Calculation creation .................................. 85**
Calculation types ..................................................... 85
Data sources for calculations ........................................ 86
   Changing the size of Calculation wizard icons ................. 86
   Calculation wizard column icons ................................ 86
   Calculation wizard keyboard shortcuts ......................... 87
Multiple sources .................................................... 87
   Columns ................................................................... 87
   Adding additional sources by columns ......................... 87
   Rows ...................................................................... 89
   Adding additional data sources by rows ....................... 92
   Data preview ......................................................... 93
Formulas ..................................................................... 94
   Formula operators .................................................. 94
   Formatting formulas ............................................... 98
Partitions .................................................................. 99
   Empty partitions .................................................... 100
   Accumulated partitioning ......................................... 100
   Defining partitions in a calculation ........................... 101
Restrictions .............................................................. 101
   Defining a restriction for a calculation ....................... 102
   Multiple restrictions that use AND or OR groups ......... 103
   Adding an AND or OR group .................................... 103
Adding a user-defined calculation .................................. 103
Adding a sort calculation ............................................ 104
Adding a time shift calculation .................................... 105
Adding a category calculation ..................................... 106
   Copying and pasting categories in a category calculation.

**Chapter 12. Working with calculations ......................... 109**
Previewing a calculation ............................................. 109
Running individual calculations .................................... 109
Viewing current calculation values ................................. 110
Filtering calculation data ............................................ 110
Viewing calculation history ......................................... 110
Viewing sources that use the calculation ....................... 111
Viewing sources that the calculation uses ..................... 111
Viewing a calculation description ................................ 111
Editing a calculation .................................................. 112
Locked calculations ................................................... 112
Copying a calculation ............................................... 112
Publishing a calculation ............................................. 113
   Publishing a calculation to a Microsoft Excel file .......... 113
   Publishing a calculation to a Microsoft Dynamics CRM database 113
   Publishing a calculation to a PDF file ....................... 114
   Publishing a calculation to Salesforce.com ................ 114
   Publishing a calculation to a text file ...................... 114

**Chapter 13. Draws ..................................................... 117**
Adding a draw .......................................................... 117
   Adding a draw in Composer .................................... 118
   Adding a draw template ......................................... 119
   Editing the draw name and earnings period ................. 120
   Copying and pasting a draw .................................... 121
   Deleting a draw connection .................................... 121
Editing draw templates .......................................... 121
Draw web tab settings ........................................ 122
Adding web tabs for draw assignment and draw reports . 123
Defining web access for draw report and assignment tabs 124
Assigning payees to draws in the web client .............. 124
Assigning payees to draw templates ....................... 124
Viewing and editing draw assignments for payees on fixed term draws 124
Viewing and editing draw assignments for payees on ongoing draws 125
Unassigning payees and hiding inactive payees .......... 125
Viewing draw reports in the web client ................... 125
Overview report .................................................. 126
Draw Assignments report .................................... 126
YTD Payouts report ............................................. 126
By Period Payout report ....................................... 127
Exporting report results to Microsoft Excel .............. 127

Chapter 14. Data stores ........................................... 129
Data store creation .............................................. 129
Adding a data store object .................................. 129
Selecting sources for the data store ...................... 130
Selecting columns for a data store ....................... 131
Selecting restrictions for a data store ................. 131
Naming columns in a data store ........................... 132
Data store security .............................................. 132
Setting permission for a role to view a data store .... 132
Setting permission for a role to view and edit a data store 133
Exporting data from a data store to Microsoft Excel ... 133
Refreshing data store data in Microsoft Excel .......... 134
Exporting data from data stores to Watson Analytics 134

Chapter 15. Plans and tailored reports .................... 135
Compensation plans ............................................ 135
Plans and payee groups ...................................... 135
Compensation plan creation ................................. 136
Step 1. Naming the plan and defining the calendar .... 136
Step 2. Adding calculations .................................. 136
Step 3. Selecting a payee group and defining holds, caps, and guarantees 138
Locked compensation plans ................................ 138
Copying a compensation plan ............................... 139
Managing documents ........................................ 139
Tailored reports .................................................. 140
Step 1. Naming the report, adding calculations, and selecting reporting settings 140
Step 2. Selecting a payee group ............................ 140
Step 3. Enabling alert generation through Task Manager 141
Editing a locked tailored report ......................... 141
Copying a tailored report .................................... 141
Report results in Payee Ledger ............................... 142

Chapter 16. Adjustments ........................................... 143
When to use an adjustment .................................. 143
Adding adjustment categories .............................. 143
Adjustments and calculation speed ....................... 143
Manual adjustments ......................................... 144
Adding a manual adjustment ............................... 144
When not to use an adjustment ......................... 145
Start and end dates in adjustments ...................... 145
Payee Ledger reports ......................................... 145
Viewing adjustment details on the web .............. 146
Contents

Chapter 21. Working with completed Presenter reports ................................................. 205

Chart, report, and web page links .................................................................................. 205
  Linking a Presenter report to another Presenter report ........................................... 206
  Linking a Presenter report to a web form .................................................................. 206
  Linking to web pages ................................................................................................. 206
  Presenter report link with parameters example ....................................................... 207

Presenter report edits ................................................................................................. 207
  Editing the font in Presenter reports .......................................................................... 207
  Editing the padding in a layout table .......................................................................... 208
  Editing the border in a layout table ............................................................................ 208
  Editing alignment in a layout table ............................................................................. 208
  Undoing and redoing actions in a Presenter report .................................................. 208

Previewing a Presenter report ...................................................................................... 209
  Printing a Presenter report chart .............................................................................. 209
Chapter 22. Workflow Manager ........................................... 213

Workflows ........................................................................ 213
  Adding a workflow .......................................................... 214
  Editing a workflow .......................................................... 215
  Deleting a workflow .......................................................... 215
  Copying a workflow .......................................................... 215
  Setting default parameters for a workflow ......................... 215
  Starting a workflow .......................................................... 216
  Adding payees after a workflow has started ........................ 216
  Organizing workflows ....................................................... 216
  Searching for a workflow .................................................... 216
Swim lanes ......................................................................... 217
  Editing the Form Initiator swim lane .................................. 217
  Adding a swim lane ............................................................ 218
  Deleting a swim lane .......................................................... 218
  Adding and removing columns in a swim lane ................... 218
Nodes ............................................................................... 218
  Editing the Start node ....................................................... 219
  Adding an Alert node ........................................................ 219
  Adding an Action node ...................................................... 220
  Adding a process node ...................................................... 221
  Creating conditional nodes ................................................. 221
  Editing or deleting a node .................................................. 222
  Cutting, copying, and pasting a node ................................. 222
  Connecting nodes .............................................................. 222
  Editing or deleting a connection ........................................ 223
Workflow value submission in pending state ....................... 223
Workflow errors and reports ............................................. 223
  Viewing workflow errors .................................................. 224
  Resolving action node errors ............................................. 224
  Viewing workflow events in the Audit module .................... 224
  Viewing workflow events in Workflow Manager .................. 224
  Viewing pending actions .................................................... 225
  Filtering workflow errors, pending actions, or history .......... 225
  Exporting errors, pending actions, or history to Microsoft Excel 225
  Clearing the pending actions or history ............................... 226
Workflow Manager in the web client ................................ 226
  Initiating a workflow ........................................................ 226
  Performing an action in a workflow .................................... 227
  Viewing a completed workflow ......................................... 227

Chapter 23. Portal Access ...................................................... 229

Web tabs ........................................................................... 229
  Adding a web tab ............................................................ 230
  Adding a web tab group .................................................... 231
  Setting access to web tabs ................................................ 231
Portal Access hierarchy ...................................................... 231
  Adding Portal Access groups ............................................. 232
  Finding a payee on the Groups tab ..................................... 234
Portal Access trees ............................................................ 234
  Access trees .................................................................. 234
  Signoff trees .................................................................. 235
  Inquiry trees .................................................................. 235
  Adding web adjustments .................................................. 236

X IBM Cognos Incentive Compensation Management Version 9.0.0: User Guide
Using the Portal Access Tree Builder ................................................................................. 237
Assignments .................................................................................................................. 238
  Validating tree assignments ...................................................................................... 238
  Setting compensation plan visibility ........................................................................ 238
  Tree assignment .......................................................................................................... 238
Sign off .......................................................................................................................... 239
  Sign off colors ............................................................................................................ 240
  Starting a sign off ....................................................................................................... 240
  Signing off in the web client ....................................................................................... 240
  Ending the sign off process ......................................................................................... 240
  Sending email notification about the sign off process to pending payees ................. 241
  Forcing sign off approval .......................................................................................... 241
  Viewing sign off status for group members ............................................................... 241
Inquiry process .............................................................................................................. 242
  Disabling inquiries ..................................................................................................... 242
  Enabling inquiries ..................................................................................................... 242
  Sending email notifications about inquiries to pending payees .............................. 242
  Submitting an inquiry from the web client ............................................................... 243
  Handling inquiries ..................................................................................................... 243
  Viewing inquiry details ............................................................................................. 244
  Adding and editing inquiry categories ..................................................................... 245
  Enabling inquiry resubmission .................................................................................. 245

Chapter 24. Scheduler ...................................................................................................... 247
Setting Scheduler properties ......................................................................................... 247
Adding processes .......................................................................................................... 248
  Adding subfolders ..................................................................................................... 248
Tasks ............................................................................................................................. 249
  Adding a task ............................................................................................................. 249
  Adding a calculation ................................................................................................. 249
  Adding plan calculations ......................................................................................... 249
  Adding a tailored report calculation ....................................................................... 249
  Adding a Presenter report calculation .................................................................... 250
External tools .................................................................................................................. 250
Adding imports .............................................................................................................. 251
Adding IBM Cognos Territory and Quota Management table synchronization ........ 251
Publications ..................................................................................................................... 251
Adding a task generation ............................................................................................. 253
Adding a task run ......................................................................................................... 253
Populating star schemas .............................................................................................. 254
Adding data transformations ....................................................................................... 254
Scheduling the deletion of table contents at a specified time ..................................... 254
Scheduling model optimization during off-peak hours .............................................. 255
Add period locking ....................................................................................................... 255
Temporarily enabling and disabling the web client ..................................................... 255
Scheduling the addition of workflow payees ............................................................... 256
Unassigning idle inquiries ............................................................................................ 256
Clearing history from selected tables ......................................................................... 256
Viewing a scheduled history purge ............................................................................. 256
Disabled tasks and processes ....................................................................................... 257
Searching for an item .................................................................................................... 257
Scheduling an item ....................................................................................................... 257
  Unscheduling an item ............................................................................................... 258
  Running an item ........................................................................................................ 258
Scheduler timing ........................................................................................................... 258
Scheduler time conflicts ............................................................................................... 258
Scheduler error notification ......................................................................................... 259
  Accessing the Scheduler log .................................................................................... 259
### Chapter 25. Task Manager

- Task creation .......................................................... 261
  - Step 1. Adding a group .............................................. 261
  - Step 2. Adding a rule ................................................ 262
  - Step 3. Generating a task list ..................................... 263
  - Step 4. Administering tasks ....................................... 264
  - Step 5. Adding email notifications ............................... 264
  - Step 6. Alert options ................................................ 265

### Chapter 26. Audit

- Audit log ................................................................. 267
  - Audit log functionality ............................................ 267
  - Filtering Audit log results ...................................... 269
  - Viewing details of table edits .................................. 269
  - Cleaning up the Audit log ....................................... 269
  - Exporting Audit logs .............................................. 269
- Computation log .......................................................... 270
  - Clearing a log ........................................................ 270
  - Computation log generation ..................................... 270
  - Copying a log ......................................................... 270
- Error log ................................................................. 270
  - Setting date filters in a log ....................................... 271
- Service Error log ....................................................... 271
- Import log ................................................................. 271
- Export log ................................................................. 272
- Scheduler log ............................................................. 272
- Task log ................................................................. 272
- Signature log ............................................................ 272
- Performance log ......................................................... 273

### Chapter 27. Payee Ledger

- Detail Ledger ............................................................. 275
  - Filtered plans by selected payee ................................. 275
  - Generating a Detail Ledger report ............................... 275
  - Filtering out payees with no earnings ......................... 276
  - Exporting Payee Ledger results .................................. 276
  - Publishing Payee Ledger results .................................. 277
- Summary Ledger .......................................................... 277
  - Generating a Summary Ledger report .............................. 277
- Adjustment Details ....................................................... 278
  - Generating an Adjustment Details report ....................... 278
  - Adding an adjustment category ................................... 278
  - Viewing adjustments ................................................ 278
  - Adding manual adjustments ....................................... 278

### Chapter 28. Calculate module

- Calculation types .......................................................... 281
  - Calculating results .................................................. 282
  - The Summary pane .................................................... 282
  - Computation log ..................................................... 283
  - Incremental calculations .......................................... 283
  - Adjustments and calculation speed .............................. 283
  - Enforcing single row formulas .................................... 284
  - Participating in the statistics monitoring program .......... 284

### Chapter 29. IBM Cognos Incentive Compensation Management Client security

- Roles ................................................................. 287
  - Adding a role ......................................................... 288
  - Deleting a role ....................................................... 288
  - Copying a role ....................................................... 288
Renaming a role .......................................................... 288
Role permissions ......................................................... 288
  Access permissions .................................................. 288
  Process list security ................................................ 298
  Composer security ................................................... 300
  Component security .................................................. 301
  Table security ......................................................... 302
  Import data security .................................................. 304
  Input form security ................................................... 305
  Data store security ................................................... 307
  Compensation plan security ........................................ 309
Scenarios security ....................................................... 309
Web form security ....................................................... 310
Presenter report security ............................................. 311
Portal Access security ................................................ 312
Scheduler security ....................................................... 313
Setting Task Manager security ...................................... 314
Audit module security .................................................. 314
Setting Payee Ledger security ........................................ 315
Workflow Manager security .......................................... 315
Setting Calculate module security ................................ 316
Administration security .............................................. 317
Tools security ............................................................ 319
User security ............................................................ 322
Role segregation example ............................................. 329
  Environment roles creation ........................................ 329
  User role assignment ............................................... 330

Chapter 30. Administration ............................................. 331

Chapter 31. Tools menu .................................................. 333
  Optimizing a model ................................................... 333
  Calendars and period locking ...................................... 333
    Calendar creation .................................................. 334
    Period locking ................................................... 335
  Payee groups ........................................................ 339
    Adding a payee to a group ....................................... 340
    Deleting a payee from a payee group ......................... 340
  Star schemas .......................................................... 341
    Adding a star schema ............................................. 341
  Star schemas imports from Microsoft Excel ..................... 341
    Connecting to a model .......................................... 342
    Importing a star schema ...................................... 342
    Refreshing data ................................................ 342
  Changing the web client theme .................................... 343
  Turning off the warning message when deleting rows in tables that are pick listed by other tables ...... 343

Chapter 32. Migration .................................................... 345
  General practice and rules for migration ......................... 345
  Rules for migrating Composer .................................... 346
    Rules for migrating components ................................ 346
    Rules for migrating tables with pick lists .................... 346
    Rules for migrating global tables .............................. 347
    Rules for migrating web forms and Presenter reports ....... 347
    Rules for migrating web form filters .......................... 347
    Rules for migrating web tabs .................................... 348
    Rules for migrating process lists ............................... 348
    Rules for migrating Workflow Manager workflows ............. 349
  Objects that cannot be migrated ................................ 350
  Performing a migration ............................................ 350

Contents xiii
Introduction

The IBM Cognos Incentive Compensation Management User Guide describes how to use IBM® Cognos® Incentive Compensation Management to calculate and create compensation plans.

Cognos Incentive Compensation Management enables organizations to automate the process of administering, calculating, reporting, and analyzing variable-based pay programs. The solution simplifies incentive compensation management for organizations by increasing accuracy, reducing costs, and improving visibility into sales performance and compensation plans.

Audience

The IBM Cognos Incentive Compensation Management User Guide is intended for administrators who work in the Cognos Incentive Compensation Management client.

Finding information

To find documentation on the web, including all translated documentation, access IBM® Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Publication date

This document was published on May 17, 2016.

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. IBM Cognos® HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features. For information about these features, see “Accessibility features,” on page 359.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.
Chapter 1. What's new

The What's new section contains a list of new, changed, and deprecated installation and configuration features for this release. It also contains a cumulative list of similar information for previous releases. You can use this section to plan your upgrade and application deployment strategies and the training requirements for your users.

For information about upgrading, see the installation and configuration guide for your product. To review an up-to-date list of environments that are supported by IBM Cognos products, including information on operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, go to IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter).

New features in version 9.0.0

The following features are new in Cognos Incentive Compensation Management version 9.0.0.
Chapter 2. Overview of the IBM Cognos Incentive Compensation Management client

In the IBM® Cognos® Incentive Compensation Management, you can manage payment for individuals who receive variable compensation, including the sales force, management, or distribution channels.

Cognos Incentive Compensation Management enables organizations to design, manage, and automate the calculation of variable payment for dozens of plans and thousands of employees simultaneously. From the client, administrators can add models, customize tables, import data, add calculations, and report on results.
Chapter 3. Getting started

When you start to use the IBM® Cognos® Incentive Compensation Management client, you must understand how to work with the login window, the Options menu, models, and tabs.

Models

In IBM® Cognos® Incentive Compensation Management, your first step is to select a model. The information associated with a model determines the fiscal year, payroll periods, and currencies.

Related concepts:
“Access permissions” on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Adding a model

When you add a model in IBM® Cognos® Incentive Compensation Management, you must set up the calendar and the currencies.

Procedure

1. Open the client.
2. Click Options to change the language of the client and set the date format.
   • If you set the language to EnglishUS, the date format is set to month/day/year.
   • If you set the language to EnglishGB, the date format is set to day/month/year.
3. In the login window, click New Model. Use the New Model wizard to add and customize a new model.
4. Name the model. Cognos Incentive Compensation Management removes all spaces and punctuation from your model name and uses it as the database name on your database server. The model name can be changed at any time from within the Cognos Incentive Compensation Management client, but the database name that is set initially remains for the life of the database.
5. Select the beginning fiscal year. Cognos Incentive Compensation Management uses this date and the number of payroll periods to construct a default calendar for the new model. The default calendar can be edited and refined from within the client, or replaced entirely if necessary.
6. Select the number of payroll periods. Select whether your organization pays employees weekly (52), biweekly (26), semimonthly (24), or monthly (12). The number of pay periods is used to create the default calendar, which is used to set payment schedules for calculated earnings. The default calendar can be edited or replaced entirely later.
7. Click Next.
8. Select the currency. A currency is used for either collection or payment. You can select more than one currency from the list, if necessary.
9. Optional: You can add another currency, if necessary.
   a. To add another currency, select the Other Currencies check box.
b. Click Add.
c. Type the currency ID and the currency name.
d. Click OK.

Tip: You can add currencies without using the New Model wizard, so the list can be expanded later.

10. Click Finish.

Adding a model with multilingual support

In IBM® Cognos® Incentive Compensation Management, you can add Unicode models in structured query language (SQL) to support double-byte characters. Unicode models are useful because Unicode supports all of the major languages in East Asia.

Procedure
1. In the IBM Cognos ICM Windows Service.exe.config file, add Unicode to the DBType value. For example, type the following information in the value field:
   <add key="DBType" value="SQLServer2005Unicode"/>
2. In the jdbc.properties file, type the following information as the jdbc.productName value:
   jdbc.productName=sqlserverunicode

Important: To prevent any possible damage to models, Cognos Incentive Compensation Management prevents users from opening Unicode models in non-Unicode mode and vice versa.

Changing the model name

You can change the model name that appears in the header of the IBM® Cognos® Incentive Compensation Management client and in the menu of the login screen. The name of the database does not change if the model name is changed.

Procedure
1. Click Admin > Administrative Options.
2. On the General tab, type a new Model Name.
3. Click OK.

Viewing and publishing the model summary

The IBM Cognos Incentive Compensation Management model summary provides basic model statistics.

In the title, the model name appears next to Model Summary. The information can be published to Microsoft Excel.

Procedure
1. Go to Admin > Model Summary.
2. To publish the information to Microsoft Excel, click the To Microsoft Excel button.
   A new Microsoft Excel spreadsheet with the model information will be displayed.
Login window

You can access the IBM® Cognos® Incentive Compensation Management client and select a specific environment and language for the client from the login window.

To log in to the Cognos Incentive Compensation Management client, you must know the model name, your user ID, and your password. You can browse for models on different servers in the Model Name menu.

Users can access multiple database servers with a single service. You can configure access to multiple databases in the Cognos Incentive Compensation Management Windows Service configuration file. Each model on each database server is accessible from the login window. Users are able to access both Unicode and non-Unicode SQL models with a single service.

All models on each database server set in the service configuration file are accessible from the login window. For more information on configuration files, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Forgot Your Password? and Forgot Your User ID? links are visible in the login window. After you click either link, you receive a recovery email with instructions. This setting is configured in the Administrative Options window in the client. The email address where the notification is sent is the email address that is associated with the user ID in Cognos Incentive Compensation Management.

Related tasks:
“Setting user login security options” on page 323
From the User tab in the Administrative Options window, you can define security options for the IBM® Cognos® Incentive Compensation Management client. If you do not set options in this window, users have unlimited login attempts, passwords never expire, and users are not required to create strong passwords.

Options menu

Use the Options menu on the login window to choose the environment and language that is used in the IBM® Cognos® Incentive Compensation Management client.

Environments that you define during the installation and configuration process are visible in the Environment menu. After you select an environment, you can access any models that are contained in that environment. If you have models on different servers, you can set up multiple environments in the configuration file for the Cognos Incentive Compensation Management client. You must give the environments a name and provide the address and security mode.

Important: The security mode in the configuration file must be identical to the security mode in the Cognos Incentive Compensation Management Windows Service configuration file. It is case-sensitive.

You can select multiple languages from the Language menu. If you select English with a regional setting (that is, United States or United Kingdom), you set the language as well as the date format. English (United States) sets the language to English and the date format to mm/dd/yyyy. English (United Kingdom) sets the language to English and the date format to dd/mm/yyyy.
Selecting the model environment

If you have multiple environments set up in IBM® Cognos® Incentive Compensation Management, you can select the environment that you want to use.

Procedure
1. In the login window, click Options.
2. In the Environment menu, select the environment that you want to use.
3. Click OK.

Setting language and date formats

You can specify the language that is used in the IBM® Cognos® Incentive Compensation Management client.

Procedure
1. In the login window, click Options.
2. In the Language menu, select the language that you want to use in the Cognos Incentive Compensation Management client.
   - To set the language to English and the date format to mm/dd/yyyy in the client, select English (United States).
   - To set the language to English and the date format to dd/mm/yyyy in the client, select English (United Kingdom).

Tabs

The IBM® Cognos® Incentive Compensation Management client is divided into multiple tabs for ease of navigation.

The following tabs are available:
- Home
- Composer
- Workflow Manager
- Portal Access
- Scheduler
- Task Manager
- Audit
- Activity
- Payee Ledger
- Calculate
- Scenarios

Opening, closing, and moving tabs

You can access functions for the IBM® Cognos® Incentive Compensation Management client by opening tabs. You can also move and close tabs as you work.

Procedure
1. Multiple tabs can be open at the same time. To open a tab, complete one of the following steps:
   - Click the View menu, and then click the tab that you want to open.
• Click the + tab, and then click the tab that you want to open.
• Right-click the tab bar, and then click the tab that you want to open.

2. To close a tab, complete one of the following steps:
• Right-click the tab and click Close.
• Click the tab and click the middle mouse button.
• Click the tab and press Ctrl +w.

When you close a tab, the previously selected tab opens. If the previously selected tab is removed, the tab beside the closed tab opens.

3. To change the order of opened tabs, drag one or more tabs to a different location.

**Rearranging open tabs**

You can rearrange open tabs in IBM Cognos Incentive Compensation Management.

**Procedure**

1. Click and hold the tab that you want to move.
2. Drag it to a different location.

**Defining the export tagline**

You can define the tag line text that is displayed on a Microsoft Excel spreadsheet when the **Send to Microsoft Excel** option is used in the IBM Cognos Incentive Compensation Management client.

**Procedure**

1. Click **Admin > Administrative Options**.
2. On the **General** tab, type the **Export Tagline**.
3. Click **OK**.

**Testing the connection between the IBM Cognos Incentive Compensation Management client and the server**

You can test the connection of the IBM Cognos Incentive Compensation Management client with the server. When you test, you can view how long it takes to ping the server, upload 10 Mbits to the server, and download 10 Mbits from the server.

**Procedure**

1. Click **Admin > Administrative Options**.
2. Select the **Connection** tab.
3. Click **Connection Test**.

**Accessing help**

You can access information that is related to the module that you are viewing in IBM Cognos Incentive Compensation Management.

**About this task**

You can access the IBM Knowledge Center from within the product.
Procedure

- Press F1.

- Click the help icon.

- Click Help, and then click Help Contents, Request Support, Assist Portal, or About.
Chapter 4. Home page

The Home page is your entry point for working with models in IBM® Cognos® Incentive Compensation Management. It provides a dashboard that you can use to manage your models.

The Home page is designed to help users complete the following actions:

- Navigate directly to tables and reports without having to drill through components.
- Access process lists.
- Identify whether a global action was started by another user.
- Manage the model maintenance process with the help of process lists.
- Access help with links to documentation and external resources.

Related concepts:

“Access permissions” on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Welcome message

When you log in to your IBM® Cognos® Incentive Compensation Management model, you can see a welcome message and helpful information.

When you log in to your Cognos Incentive Compensation Management model, you see your user ID and the name of the environment and model that you are logged in to.

If a global action icon is displayed with your user name, a global action is being run by another user. When you hover your cursor over the global action icon, you can see the user name of the person who is running the global action and the amount of time that the action has been running.

Online pane and Client Success portal

You can access the IBM Client Success portal from the Online pane on the Home page of IBM® Cognos® Incentive Compensation Management.

You can click the heading on the Online pane on the Home page to access the IBM Client Success portal. On the Client Success portal, you can log tickets, access the knowledge base, and download documents. A user name and password are required for this portal.

Text in toolbars

On the Home page and other modules in IBM® Cognos® Incentive Compensation Management, you can display or hide the text that is normally displayed under toolbar icons.
You can find the show or hide text icon, which looks like an up arrow, in the menu bar. This icon is visible in each module.

By default, the show or hide text icon is enabled, and the text in the toolbar is displayed. Your selection is remembered as you move between different modules during your session. However, if you log out of the client, and then you log back in, the toolbar returns to the default setting.

**Navigator tab**

The Navigator tab in IBM Cognos Incentive Compensation Management lists links to various modules, objects, and help resources. You can use the Navigator tab to quickly open an item or to search for a link to an item.

**Recently Opened Items and Most Commonly Opened Items panes**

In the Recently Opened Items and Most Commonly Opened Items panes on the Home page of IBM Cognos Incentive Compensation Management, you can see links to the top ten most commonly used and recently used items.

The lists are specific to each individual login ID and are populated with tables, input forms, Presenter reports, and web forms that were accessed by the user.

- The items in the Recently Opened Items pane include the last ten items that were opened by the current user.
- The items in the Most Commonly Used Items pane include the items that are opened most often by the current user.

**Finding a recently opened item**

You can easily find items that you recently opened in IBM Cognos Incentive Compensation Management.

**Procedure**

1. On the Home page, open the Navigator tab.
2. Under Recently Opened Items, click a link.

**Results**

A new tab opens and displays the selected item.

**Finding a most commonly opened item**

You can easily find items that you use frequently in IBM Cognos Incentive Compensation Management.

**Procedure**

1. On the Home page, open the Navigator tab.
2. Under Most Commonly Opened Items, click a link.

**Results**

A new tab opens and displays the selected item.
The Quick Navigation pane

On the Home page of IBM® Cognos® Incentive Compensation Management, use the Quick Navigation pane to quickly find any component, table, Presenter report, or web form.

All items in the Quick Navigation pane are grouped by type and listed alphabetically. To open an item that you want to find, click its link.

Finding components, tables, reports, and web forms

You can use a filter on the Home page of IBM® Cognos® Incentive Compensation Management to find components, tables, and reports in large models.

Procedure

1. On the Home page, open the Navigator tab.
2. In the Filter field, type the name or partial name of the item that you are looking for.
   The filtered list consists of any component, table, Presenter report, or web form that contains the text that you typed.
Chapter 5. Process lists

You can create process lists in IBM® Cognos® Incentive Compensation Management to help users complete maintenance tasks for models.

A process list is useful when a user must remember what tasks must be completed and the order in which those tasks must be completed.

Related concepts:
"Access permissions” on page 288
When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.
"Process list security” on page 298
By default, all administrators can see the IBM Cognos Incentive Compensation Management Home page module. To give roles permission to create, view, edit, duplicate, or delete process lists from the Home page, additional access must be granted.

Adding a process list

You can add process lists that identify the tasks that users must complete for a particular process in IBM® Cognos® Incentive Compensation Management.

Procedure
1. To add a process list, click Add Process List.
2. In the new New Process List tab, click Edit.
3. Type a name for your list and then select the type of process from the Process Type list:
   - Ordered
     A process whose items must be completed in a particular order.
   - Perpetual
     A process whose items can be completed in any order.
4. Optional: To select an icon to represent the entire list, click Icon and select an icon.

Resizing a process list pane

You can change the size of the panes on a process list tab in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Open a process list.
2. To change the size of panes on the process list tab, drag the empty space between any two panes.

Adding tasks to a process list

A process list in IBM® Cognos® Incentive Compensation Management can contain any number of tasks and subtasks.
About this task

Each task can have a description to provide users with information about the task. Tasks can be linked to an appropriate item in the model and all right-click functions for the item can be selected. For example, you can link a process list item to a table, and then import data on the table.

Procedure

1. Click Edit.
2. To add an item to a process list, click the Add Task icon in the Tasks pane.
3. Select the new task.
4. In the Process Overview pane, type a description of the task to help users understand its purpose.
5. In the Tasks pane, click the Add Link icon to link the selected task to a component, table, input form, web form, Presenter report, Scheduler process, or module. Process list users can navigate to the item by clicking the task.

   Important: When you link to a Presenter report in the View Presenter Report section, the Presenter report opens in a new tab and displays the report as it appears on the web client when the task is selected.
6. From the Select menu, select the action that you want to complete on the linked item.
7. To show the row count of an input form beside the task name, select the input form and then select the Show Details check box.

   Important: If the input form contains more than 1000 rows, the row count displays as (1000+).
8. Type a task name and description and select a task icon from the Task Icon list.
9. Click Save.

Viewing and filtering process lists

In IBM® Cognos® Incentive Compensation Management, you can open a pane on the Home page that lists all saved process lists. You can then search for a specific list by using the Filter field.

Procedure

1. To view and access saved process lists, click the Sidebar button in the toolbar. You can see only the lists that you have access to in the Manage Roles window.
2. Select a process list to open it.
3. To search for a process list, type the name (or partial name) of the process list in the Filter field.

Results

The filter returns all process lists that contain the text that you entered.

Editing a process list

You can edit and add tasks to existing process lists in IBM® Cognos® Incentive Compensation Management.
**Procedure**

1. Select the process list that you want to edit and click **Edit**.
2. To delete a task, select the task and click **Delete Task**.
3. To edit the order of any tasks in the list, click the blue arrows in the **Task** pane.
4. To delete a link, select the task and click the **Delete Link** icon.
5. Click **Save**.

---

**Marking tasks as complete**

Completed tasks can be tracked and flagged as complete in process lists in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. On the Home page, open the process list.
2. To mark a task as complete, select the check box next to the task.

**Results**

The user name of the administrator who selected the check box and the date and time that the task was completed is populated automatically.

**Important:** The date and time of task completion are recorded as the time on the database server, regardless of the local time on the user’s computer. This approach ensures that the completed time is consistent and accurate for all users in all locations.

---

**Rearranging the order of tabs on the Home page**

In IBM® Cognos® Incentive Compensation Management, the order of the process list tabs displayed on the Home page can be changed.

**Procedure**

1. On the Home page, select the tab that you want to move.
2. Drag the tab to the new location.
Chapter 6. Composer

Use Composer in IBM® Cognos® Incentive Compensation Management to view, manage, and build a model.

From this interface, you can build and edit calculations, tables, compensation plans, tailored and Presenter reports, and web forms. Composer is also used to manage hierarchies, such as the payee structure, and import data into the model.

Composer provides a visualization of the entire model, which is helpful for design, troubleshooting, and refinement. This visual representation is configurable and can show either a high-level representation of the model or a detailed picture of table and calculation streams.

Related concepts:
“Access permissions” on page 288
When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.
“Composer security” on page 300
You can grant a role permission to view and edit the Composer module in IBM® Cognos® Incentive Compensation Management.

Models

In IBM® Cognos® Incentive Compensation Management, Composer provides the interface for building a model.

At a high level, the following steps describe how to build a model:
1. Add components to organize model elements.
2. Set security for each component.
3. Add any necessary or relevant documents to a component. These documents might include a description of the contents of the component.
4. Build tables to contain data.
5. Import data into the tables from external source systems.
6. Manipulate the data by using calculations.
7. Present calculation results in a compensation plan, tailored report, Presenter report, or web form.

Important: If any of your calculations require a data source that is contained in another component, you must add an inbound connection from that data source to use it in your calculation. If any of your table data or calculation results must be used as sources for a calculation that is contained in another component, you must add an outbound connection so that your data can be used outside the component.

Composer toolbar

In IBM® Cognos® Incentive Compensation Management, the toolbar in Composer contains many icons that you can use to work on your model quickly and easily.
**Multi-Edit icon**

When you work in Composer in IBM® Cognos® Incentive Compensation Management, you can use single-edit mode or multi-edit mode. To select a mode, click the **Multi-Edit** icon.

If you want to use multi-edit mode, click the **Multi-Edit** icon and make sure that it is highlighted. If you want to use single-edit mode, make sure that the **Multi-Edit** icon is not clicked and the icon is not highlighted.

In single-edit mode, every change is immediately saved. In multi-edit mode, validation is suspended and changes are not saved until you leave multi-edit mode or save your model. You can make many temporary changes in multi-edit mode.

For example, imagine that you want to change the source of a calculation that is used by another calculation. You must edit each calculation in the chain, but until you change all calculations, some calculations might be invalid. These temporary changes can occur only in multi-edit mode because only valid calculations can be saved in single-edit mode. If you try to make an invalid change or connection in single-edit mode, an error message opens.

In single-edit mode, you can complete the following tasks:
- Open components and elements
- Auto arrange
- Add or delete components
- Add or delete tables, calculations, compensation plans, tailored reports, Presenter reports, and web forms
- Import data into tables
- Add inbound or outbound connections
- Set component color
- Export Composer diagram
- Select visibility icons
- Cut, copy, and paste
- Preview calculations

In multi-edit mode, you can complete the following tasks:
- Open components and elements
- Add, edit, or delete calculations
- Edit the partitions of a calculation and the port that is connected to the partition, so that it matches the new calculation
- Add inbound or outbound connections
- View and edit data in tables
- Select visibility icons
- Export Composer diagram

**Link icon**

To link components together in Composer in IBM® Cognos® Incentive Compensation Management, you can click the **Link** icon.

When you click the **Link** icon, a black box opens inside a component and on the edge of an element. You can then link one component to another.
To disable Link mode, click the Link icon again.

**Arrange icon**
In Composer in IBM® Cognos® Incentive Compensation Management, you can click the Arrange icon to automatically arrange the components and elements into a logical pattern.

The Arrange icon also smooths out connection lines. You can undo the auto arrange by clicking the Refresh icon if you do not like the layout.

**Visibility icon**
In Composer in IBM® Cognos® Incentive Compensation Management, you can choose to show or hide components and objects.

If you clear Table from the Visibility menu, tables are longer visible.

**All icon**
In Composer in IBM® Cognos® Incentive Compensation Management, you can choose to see all elements or just some elements.

While you are working in Composer, you might see only some elements, for example, if you are in Uses mode. You can click All to view all elements in the window.

**Uses and Used By icons**
In Composer in IBM® Cognos® Incentive Compensation Management, you can see which objects the selected object uses as data sources. You can also see which objects use the selected object as a data source.

When you select an object in Composer and click the Uses icon, only the objects and elements that are used by the object that is selected and exist in the same component as the object selected are displayed.

When you select an object and click the Used By icon, only the object and the elements that use the object and exist in the same component as the object are displayed.

**Viewing dependencies**
In Composer in IBM® Cognos® Incentive Compensation Management, you can view the objects that use a selected object in the Navigation pane.

**About this task**
The dependencies list includes objects in Composer as well as Presenter data sources, row form sources, and stored values. When you view the Used By report for a data store, the Presenter reports and star schemas that use the data store are displayed. Web forms, tailored reports, and compensation plans are not supported by the Used By report.

By default, the Pin Dependency List button is selected, and the Navigation tab cannot refresh when a new object is selected in Composer. To view the dependencies of a new Composer object, you must clear the Pin Dependency List button.
Procedure
1. In Composer, click the Navigation tab.
2. Click Dependencies.
3. In Composer, select an object.
   The objects that are dependent on the selected object are displayed on the Navigation tab.
4. Click Export to Microsoft Excel to send the list of dependencies to a Microsoft Excel file.

Go To icon
In Composer in IBM® Cognos® Incentive Compensation Management, you can view objects in Uses or Used By mode. You can click the Go To icon to view the top level of Composer or the last component that you viewed.

View Connection icon
In Composer in IBM® Cognos® Incentive Compensation Management, you can see where a selected connection was added and where the connection is being used.

Use the information in the View Connection window to analyze the flow of data through your model.

Purging table history
In Composer in IBM® Cognos® Incentive Compensation Management, you can clear the history for specified tables, including data from any locked periods.

Procedure
1. In Composer, from the toolbar, click Purge History.
2. Select the table or tables whose history you want to remove.
3. Select a date range for the history that you want to purge.
4. Click OK.

Purging table and calculation data
In Composer in IBM® Cognos® Incentive Compensation Management, you can clear the data from calculations and data type tables that are associated with a period in a specific calendar. Data in data tables and calculations is removed up to and including the selected period.

About this task
You can purge periods on both data tables and calculations or on calculations only. In data tables, rows with dates in the Locked by date field that are at or before the last date in the selected period are removed. In calculations, rows that have a partition at or before the selected period are removed. The periods must be locked before you purge calculation data or the purged records will be added the next time that the model is calculated. This action includes any locked data but does not include data in history tables.

Attention: Purging periods is a global action that cannot be undone. You must have the appropriate permission to complete this action. This action is irreversible.
**Procedure**

1. In Composer, from the toolbar, click **Purge Periods**.
2. Select the calendar.
3. Select the level of the calendar.
4. Select the period. Data that is associated with all periods up to and including the selected period will be cleared.
5. From the **Mode** menu, select **Tables and Calculations** or **Calculations Only**.
6. Click **Purge Periods**.

**Converting tables to effective dated tables**

In Composer in IBM® Cognos® Incentive Compensation Management, you can convert any hierarchy, custom, or structural table to a table with effective dates.

**About this task**

Two effective date columns, **Effective_Start** and **Effective_End**, are added to a table when it is converted. You can convert a table by using existing date columns as the effective start and effective end dates. The values in the start date column must be earlier than the values in the end date column. The process of converting a table to an effective dated table cannot be reversed. If a table pick lists a parent table, the table must be converted before the parent table can be converted.

Tables cannot be converted if they are used in the following ways:

- Row form source in Presenter reports
- Data source for data grids with editable columns in Presenter
- Row forms or admin forms in web forms
- Web form sources with editable columns
- Editable through the web client
- Saved imports
- Saved transformations
- Main sources in unions in data stores and calculations
- Connections

**Procedure**

1. In Composer, click **Make Effective Dated**.
2. Select the available tables where you want to add effective dates.
3. Click **Add**.
4. Click **Next**.
5. Select the **Remove mapped non-key columns** check box to clear any date columns that are not primary key columns.
6. Select the date column that you want to use as the effective start date.
7. Select the date column that you want to use as the effective end date.
8. Click **Finish**.

**Results**

The Audit log displays an event record that indicates that the table was successfully converted to a table with effective dates. If a column is removed during the conversion, an event is displayed in the Audit log.
Sidebar

In Composer in IBM® Cognos® Incentive Compensation Management, the sidebar contains the Palette tab, the Navigation tab, and the Overview pane.

You can opt to show or hide the sidebar by toggling the Sidebar icon on or off.

Palette tab

In Composer in IBM® Cognos® Incentive Compensation Management, the Palette tab in the sidebar stores empty components and elements.

You can select objects in the Palette tab and drag them to the main Composer window.

Navigation tab

In Composer in IBM® Cognos® Incentive Compensation Management, the Navigation tab contains a Favorites section and a Search section.

Any object in Composer (except connections) can be added to the Favorites section. When objects are added to the Favorites section, links to those objects in Composer are added. When a user clicks the link in the Favorites section, the object is highlighted and centered in the Composer window. You can arrange the object links into folders and subfolders. You can also use the Filter field to search for objects in the Favorites section.

The Search section lists all the objects in Composer and groups them by element such as components, tables, calculations, plans, tailored reports, Presenter reports, and web forms. You can type the name of the object that you want to find in the Filter field. When you stop typing, Cognos Incentive Compensation Management searches for any objects that contain the text string that you typed. The results return the top 50 matches for all objects; however, the search results do not limit the number of components shown. To view all the results, click the Show All link. To search all the components for an object, make sure that the Search All Components icon is selected. If you want to search for an object within the current component, make sure that the Search All Components icon is not selected.

To expand or collapse any folder in the Search section or Favorites section, click the Expand All or Collapse All icon.

To view a menu that is associated with the object, you can right-click any component, calculation, table, plan, report, or form in the Favorites or Search section.

Adding an object to the Favorites list

In Composer in IBM® Cognos® Incentive Compensation Management, you can add a link to any frequently used object (except ports) to the Favorites section.

Procedure

1. Right-click the object in Composer and click Add to Favorites.
2. On the sidebar, open the Navigation tab and click the yellow star to view the Favorites list.
Tip: You can add folders and subfolders to the Favorites section to organize your Favorites list.

**Overview pane**

In Composer in IBM® Cognos® Incentive Compensation Management, the Overview pane shows a scaled-down version of the Composer diagram.

The whole Composer diagram is displayed in the window. Dependency view selection and component visibility selection in Composer is reflected in the Overview pane.

The section of the Composer diagram that you are currently viewing is outlined in gray. You can resize and move the gray box around the Overview pane to navigate to different areas. You can also use the middle mouse wheel to zoom in and out around the location of your cursor.

To resize the Overview pane, click and drag the window. To open and close the Overview pane, click the Overview header.

**Viewer icon**

When you click the Viewer icon, a window opens below the Composer window in IBM® Cognos® Incentive Compensation Management. When you select a table or a calculation, you can see the data and results in the Viewer window.

**Font icon**

You can choose font style, type, size of text, effect, and script types in Composer in IBM® Cognos® Incentive Compensation Management. When you change the font, the text of every component changes accordingly.

**Pasting formats from one component to another**

In Composer in IBM® Cognos® Incentive Compensation Management, you can copy the format options of a component and apply them to another component.

**About this task**

You can use Format Painter to apply the formats in one component to one or more other components. All components must be on the same level in Composer.

**Procedure**

1. Select the component that contains the format options that you want to copy, and click the Format Painter icon.
2. Click the component where you want to paste the format options.

   **Tip:** To paste the format options to multiple components, press Ctrl and click the components.

**Connection lines**

In Composer in IBM® Cognos® Incentive Compensation Management, you can choose to show or hide all connection lines. The Collapse Links icon hides connection lines in the Composer window.

Click the Expand Links icon to show connection lines. Click the Collapse Links icon to hide connection lines.
A formula is used to decide whether connection lines should be hidden. The formula is based on the length of the line, the number of bends in the line, and the number of sibling connections each connection in the model has. Connection lines are hidden only if they receive a high enough value based on the formula.

**Exporting the Composer diagram**

In IBM Cognos Incentive Compensation Management, you can export the Composer diagram to an image file.

**Procedure**

1. Click the Export icon.
2. Select the server location for the image file to be saved and select the image file type.
3. Select the scaling options. You can scale the saved image down or up in size by increasing or decreasing the height and width of the pixels or the zoom percentage.
4. Click Finish.

**Composer navigation**

You can easily work and locate objects in Composer in IBM Cognos Incentive Compensation Management.

**Selecting objects and zooming in Composer**

In Composer in IBM Cognos Incentive Compensation Management, you can select multiple items and zoom in and out of the Composer window.

**Procedure**

Complete one or more of the following steps:

- To select multiple items, drag a selection box around the items or press Ctrl + click.
- To select a different group of items, hold down Ctrl and drag a selection box around the items.
- To zoom in and out, scroll up and down with the mouse wheel. The Composer window centers on your cursor.

**Finding elements in Composer**

In Composer in IBM Cognos Incentive Compensation Management, you can use the Select feature to search for objects.

**About this task**

You cannot use this procedure to select connections.

**Procedure**

1. Right-click a blank area and click Select.
2. Type a name in the Select dialog box. The feature is not case-sensitive. Any object whose name matches the name that you typed is selected.

**Tip:** To select multiple objects, type a semicolon between names. For example, to select the Account, Title, and Payee tables, type account;title;payee.
3. Click OK.

**Results**

The matching element or elements are selected and centered in the Composer window.

**Titles and descriptions of Composer objects**

In Composer in IBM® Cognos® Incentive Compensation Management, you can see the name of the object when you hover your cursor over the object.

For objects that contain descriptions such as, tables, calculations, and compensation plans, you can see both the description and the title.

**Components**

A component is a container that is used to organize your model in IBM® Cognos® Incentive Compensation Management.

Before you add a model, add components to give your model a framework and to ensure that your model is easy to use. After you add components, you can build model elements such as tables, calculations, and plans.

An element is an item that is used to build a model, such as table, calculation, compensation plan, tailored report, Presenter report, or web form.

**Related concepts:**

- **“Access permissions” on page 288**
- **“Component security” on page 301**

You can grant or restrict access to each component in the Composer module in IBM® Cognos® Incentive Compensation Management.

**Component organization**

In IBM® Cognos® Incentive Compensation Management, you can organize your model in many ways.

You can build your model wide by placing components side-by-side (sibling model), or you can build your model deep by placing components inside other components (parent-child model).

For example, a typical model might have all of its compensation plans represented by high-level components and all of the plan elements (tables, calculations, and reports) contained in child components. Complex plans might have multiple levels of components that are used to separate and organize different calculation pieces.

When you are planning how to organize your model, you must also consider security and data accessibility.

**Security**

While granular access permissions can be defined, typically security is defined at a component level. If you grant access to particular compensation pieces, but deny access to other pieces, you can put the
compensation pieces in separate components. Then, by turning access on or off for a particular component, you can deny or allow access to everything in the entire component.

**Data accessibility between components**
While data can flow between components through connections, certain restrictions do exist. For example, any calculations that must be added to a reporting element (compensation plan and tailored reports) must be contained in the same component as the reporting element.

**Navigation between components**
In Composer in IBM® Cognos® Incentive Compensation Management, you can move in, out and between components easily by using breadcrumbs and the drill-through feature.

**Drill-through feature**
In Composer in IBM® Cognos® Incentive Compensation Management, after you build the model structure, you can double-click components to drill into their contents.

There is no limit to the depth of the model. The number of levels is determined by model size, complexity, and security requirements.

**Breadcrumbs**
In Composer in IBM® Cognos® Incentive Compensation Management, you can see breadcrumbs at the top of the page to help you understand the location of components.

Breadcrumbs are displayed horizontally across the top of the window and provide links back to each parent component that you drill into to arrive at the current component. The Top breadcrumb represents the top level, or main window, in Composer.

**Data flow between components**
When you work with components in Composer in IBM® Cognos® Incentive Compensation Management, you might want to connect data in one component to another component.

To share data between components, you must create a connection between the two components. Connections can flow from parent to child components or from one sibling component to another.

**Data accessibility in components**
To make data inside one component available to another component in Composer in IBM® Cognos® Incentive Compensation Management, you must add outbound and inbound connections.

You can add inbound and outbound connections to complete the following tasks:
- Use table data as a source for a calculation in another component.
- Use calculation results as sources for a calculation or report in another component.
Data accessibility between sibling components
To use data from tables or calculation results that are in a sibling component in Composer in IBM® Cognos® Incentive Compensation Management, you must create connections. Sibling components are components that are on the same level in Composer.

Data accessibility from parent to child components
To use data from tables or calculation results that are in a parent component (one level up in Composer in IBM® Cognos® Incentive Compensation Management), you must create connections.

An outbound connection from the object that contains the data in the parent component must be linked to the child component. In this way, you create an inbound connection in the child component so that the data stored in the parent component can be available in the child component.

Component details
In Composer in IBM® Cognos® Incentive Compensation Management, you can add components to contain tables, calculations, compensation plans, web forms, and reports.

You can rename and change the color of components to make specific components easily identifiable. You can attach documents to components to show users the data that is available inside the component. You can also move components around the Composer diagram and organize them by cutting, pasting, and wrapping them into parent components.

Adding a component
In Composer in IBM® Cognos® Incentive Compensation Management, you can add empty components to contain and organize objects.

Procedure
1. To add an empty component, complete one of the following steps:
   • Right-click in Composer and click Add Component.
   • Drag the Component element from the sidebar to the Composer window.
2. Type a Name for the component.
3. Click OK.

Setting the color of a component
In Composer in IBM® Cognos® Incentive Compensation Management, you can change the color of any component, and you can define custom colors.

Procedure
1. Select a component.

   Tip: To select multiple components, press Ctrl and select.
2. Click the arrow next to the Color icon and select a color.
3. Custom colors that are defined in Composer are unique to each login. To define a custom color, complete the following steps:
   a. Click the Define Custom Color button.
   b. Select a basic color or click the Define Custom Colors button.
   c. Add the color that you want, and then click Add to Custom Colors to save it.
Renaming a component
You can change the name of a component after the component is added to Composer in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Right-click the component and click Edit.
2. Type the new name and click OK.

Adding a document to a component
In Composer in IBM® Cognos® Incentive Compensation Management, you can attach files that contain data or information about the component to the component.

Procedure
1. In Composer, right-click a component and click Manage Documents.
2. In the Document Manager window, click Add.
3. Select the document that you want to attach.
4. Click Open.
   The document is added to the Document Manager window.
5. Click Close.

Results
After the document is attached, you can see a document icon on the component.

Opening a component
In Composer in IBM® Cognos® Incentive Compensation Management, you can open a component to view and manage the elements that are inside it.

Procedure
1. To open a component, complete one of the following steps:
   • Double-click the component.
   • Right-click the component and click View Component.
2. From inside a component, you can right-click to complete one of the following actions:
   • View its parent component.
   • Add a component, table, calculation, plan, tailored and Presenter report, draw, data store, and web form.
   • Add an inbound and outbound connection.

Copying a component
In Composer in IBM® Cognos® Incentive Compensation Management, you can copy a selected component along with the calculations and tables that it uses or depends upon.

Procedure
1. To copy a component, complete one of the following steps:
   • Right-click the component that you want to copy and click Copy.
   • Select the component that you want to copy and click the Copy icon.
2. To paste the component, complete one of the following steps:
• Right-click the place where you want to copy the component and click **Paste**.
• Move to the place where you want to copy the component and click the **Paste** icon.

3. In the Paste Form window, specify the **Paste suffix**. The suffix ensures that you do not have two components with the same name, and ensures that you can distinguish the copied component from the original.

4. If the copied component contained any ports, specify the new sources for the ports by clicking **Automatch** or by dragging the sources. You must map the old sources to the new sources.

5. Click **OK**.

**Results**

The component is pasted as required. All connections (if any) stay intact.

**Deleting a component**

In Composer in IBM® Cognos® Incentive Compensation Management, you can delete components if they do not contain any objects that are used as sources for objects in other components.

**Procedure**

1. To delete a component, complete one of the following steps:
   - Right-click the component and click **Delete**.
   - Select the component and click the **Delete** icon.

   **Tip**: Delete all of the component's dependencies before you delete the component. If you try to delete a component that has other components that are still connected to it, the Dependency Viewer opens showing the component's dependencies.

2. In the confirmation window, click **Yes**.

**Wrap and unwrap component feature**

In Composer in IBM® Cognos® Incentive Compensation Management, you can add a component out of selected elements (wrap) and remove a component by moving its contents into its parent's component (unwrap).

The wrap feature takes the selected elements and puts a component around them, adding connections and linking them as needed. The unwrap feature takes the selected components and moves their contents into the current component; removing connections and relinking parent elements as needed.

The following list describes restrictions for wrapping:

• If the set of selected elements would create a cycle, they cannot be wrapped, for example, if A > B > C and you try to wrap A and C.

• Web forms that contain sources with editable fields, row forms, multi-select, or admin forms that reference non-global tables must exist in the same component as the referenced table.

• Compensation plans and tailored reports must exist in the same component as their calculations.

• Calculations that are used as sources in detail ledgers must exist in the same component as their compensation plan or tailored report.
• Tables with a single key column cannot be made into connections that are used by calculations.

The following list describes restrictions for unwrapping:
• If the parent component has an inbound connection with the same name as something in the target component, it cannot be unwrapped. This restriction prevents the possibility of two items with the same name in the same component.
• If any connections are not linked, the component cannot be unwrapped.
• Components that are empty cannot be unwrapped. A message instructs you to delete the component instead.

Wrapping an element or component
In Composer in IBM® Cognos® Incentive Compensation Management, you can wrap any number of elements into a component, if they comply with the restrictions for wrapping.

Procedure
1. In Composer, select an object.
   Tip: To select multiple objects to wrap, press Ctrl and select.
2. Right-click the selection and click Wrap.

Unwrapping an element or component
In Composer in IBM® Cognos® Incentive Compensation Management, you can delete a component and the elements inside the component that were placed in its parent component by unwrapping the component. You can do so only if you comply with the restrictions for unwrapping.

Procedure
In Composer, right-click the component and click Unwrap.

Connections
In Composer in IBM® Cognos® Incentive Compensation Management, connections link components together. Connections can be inbound and outbound.

In Link mode, ports are represented by small black square boxes. When Link mode is disabled, connections from one element to another are represented by arrows.

From inside the components, the connections are represented by blue boxes, which are called ports. Inbound connections are at the bottom of the component, and outbound connections are at the top.

Use connections to send data from tables, calculations, and other sources to related components that require the information. For example, if a component contains a data table with transactional data, it can be connected to another component that contains a calculation that must calculate results by using the transactional data.

Outbound and inbound connections
In Composer in IBM® Cognos® Incentive Compensation Management, an outbound connection is a resource that is used to export calculation results or table data from
a component. An inbound connection is a resource that is used to import data from selected outbound connections into a component.

Outbound connections can be created from tables, calculations, and other outbound connections. When you add an outbound connection, you are specifying that the data in the selected table or calculation is available for use in child or sibling components. If you want to use the outbound connection in a second component, you must make a corresponding inbound connection to the second component. Inbound connections specify which component the selected outbound connection must connect to.

**Adding connections**

In Composer in IBM® Cognos® Incentive Compensation Management, you can use inbound and outbound connections in components to send data from one component to another. Inbound connections can be used as sources in components.

**Procedure**

1. Click the **Link** icon in the toolbar.
2. Drill into the component with the object that is your outbound connection source.
3. From inside the component, select the object that is your outbound connection source and drag an arrow from that object to the top of the window. An outbound connection is added.
4. From outside the component, drag the arrow from the port on the component that contains the outbound source to the component that will use that source.
5. In the Link From wizard, to add the inbound connection from the object, drag the connection from the **Source Connections** column to the **Map to** column.

**Related concepts:**

“**When to use the Connection wizard**” on page 37

In Composer in IBM® Cognos® Incentive Compensation Management, the simplest way to add connections is by dragging the connection.

**Viewing current values in a connection**

In Composer in IBM® Cognos® Incentive Compensation Management, you can view the data from the table or calculation that is the original source of a connection.

**Procedure**

1. In Composer, double-click the component that contains the connection.
2. Right-click a blue connection port and click **View Current Values**.

**Using an inbound connection as a calculation source**

In Composer in IBM® Cognos® Incentive Compensation Management, when a component has an inbound connection, you can use that inbound connection as a data source for a calculation inside the component.

**Procedure**

1. In Composer, double-click the component that contains the inbound connection.
2. Inside the component, right-click and click **Add Calculation**.
3. Type a name for the calculation and select the calculation **Type**.
4. Select the inbound connection as a source.
5. Finish the Calculation wizard.
Connection changes

In Composer in IBM® Cognos® Incentive Compensation Management, you can edit or delete inbound and outbound connections in components. You can also remove connections and replace them with global tables.

Editing a connection

In Composer in IBM® Cognos® Incentive Compensation Management, you can rename and edit connections.

Procedure

1. Right-click a component and click Edit Connections.
2. Select the connection that you want to view or change and click Edit.
3. You can rename the connection and change the source of the connection, and then click Finish.
4. If you are editing a user-defined connection, you can add columns, remove columns, or change the name of columns, and then click Next.
5. You can remap the source columns to the connections columns, and then click Finish.

Editing connection mapping

In Composer in IBM® Cognos® Incentive Compensation Management, you can change the source columns that the connection columns are matched to.

Procedure

1. Right-click the connection and click Edit Connection Mapping.
2. Drag source columns to match them to connection columns, or use the Automatch button.
3. Click Finish.

Deleting a connection

In Composer in IBM® Cognos® Incentive Compensation Management, you can remove inbound and outbound connections from components.

About this task

You cannot delete a connection if it is in use by another object.

Procedure

1. In Composer, right-click the component and click Edit Connections.
2. Select the connection and click Delete.
3. Click Close.

Replacing a connection with a global table

In Composer in IBM® Cognos® Incentive Compensation Management, you can replace connections with global tables.

About this task

If the global table has more columns than the connection, it can replace the connection if identical column connections exist in the table and connection.

Procedure

1. In Composer, right-click the component and click Edit Connections.
2. Right-click the connection that you want to replace and click **Replace Connection**.
3. Select the **Global** table from the list and click **OK**.

**Editing a connection from inside a component**
In Composer in IBM® Cognos® Incentive Compensation Management, you can edit connections while you are working inside a component.

**Procedure**
1. Inside the component, right-click the port and click **Edit** or double-click the port.
2. Edit the details of the connection in the Connection wizard.

**Related concepts:**

“Connection wizard”
In the Connection wizard, users can define or edit the schema of connections in Composer in IBM® Cognos® Incentive Compensation Management.

**Connection names**
When you add an outbound connection, IBM® Cognos® Incentive Compensation Management automatically gives the outbound connection the same name as the source.

For example, if you add an outbound connection from a table that is named ERP, the connection is named ERP.

You can rename the connection in the Connection wizard. When you rename connections, make sure that you have a method of distinguishing connections from other model elements such as tables and calculations. For example, you can use a suffix such as 0ut, or you can choose another suffix, such as Feed. You can also change inbound connection names and the 0ut suffix to a prefix, or add a prefix such as IN prefix.

The following list gives you a few examples of naming options:
- Out ERP
- ERP Feed
- In ERP
- Connect ERP

**Connection wizard**
In the Connection wizard, users can define or edit the schema of connections in Composer in IBM® Cognos® Incentive Compensation Management.

When you use the Connection wizard, connection columns must have the same data types as the columns that they are connected to, but the order and names of the connection columns does not matter. The connection can have fewer columns or an equal number of columns as the source. After the schema of the connection is added, you can link the table or calculation to another component.

**Related tasks:**

“Editing a connection from inside a component”
In Composer in IBM® Cognos® Incentive Compensation Management, you can edit connections while you are working inside a component.
Connection definitions

In Composer in IBM® Cognos® Incentive Compensation Management, you can add or edit an outbound or inbound connection with any structure.

To define the schema of a connection, you can select columns from the References, Columns, Tables, and Structural tabs.

References tab

In Composer in IBM® Cognos® Incentive Compensation Management, the References tab provides a list of available references that you can use to define a connection.

References include the calendar and the tables that were added when the model was added.

For example, if you are adding a connection that contains columns from any of your hierarchies, such as payee ID or product ID, you can easily locate those columns in the References tab.

Columns tab

In Composer in IBM® Cognos® Incentive Compensation Management, the Columns tab provides options that you can use to add generic calculation and table columns.

For example, if you must make a placeholder connection but you do not know the names of the required columns, you can select the column types.

You can choose from the following column types:
- Text
- Numeric
- Date
- Int (placeholder for a rank column from a Sort calculation)
- Comment or URL

Tables tab

In Composer in IBM® Cognos® Incentive Compensation Management, the Tables tab lists all tables, calculations, and connections available to the connection that you are defining.

When you select a table, calculation, or connection from the menu, you can see the columns of that table, calculation, or connection on the Tables tab. You can then drag specific columns to the Connections Columns window. For example, if you are adding a connection and you know the names and structure of the columns in the connection, you can select the required columns from a table, calculation, or connection on the Tables tab.

Structural tab

In Composer in IBM® Cognos® Incentive Compensation Management, the Structural tab lists all the hierarchy tables.

When you select a table from the menu, all the columns from that table are listed in the Connection Columns window.
For example, if you are adding a connection and you want all the names and structure of columns from a specific hierarchy table, you can select the table from the **Structural** tab.

**When to use the Connection wizard**

In Composer in IBM® Cognos® Incentive Compensation Management, the simplest way to add connections is by dragging the connection.

Typically, the Connection wizard is used only in the following situations:

• Viewing and editing existing connections
• Adding a placeholder connection for a source that is not added yet

**Related tasks:**

“Adding connections” on page 33

In Composer in IBM® Cognos® Incentive Compensation Management, you can use inbound and outbound connections in components to send data from one component to another. Inbound connections can be used as sources in components.

**Existing connections**

After a connection is added in Composer in IBM® Cognos® Incentive Compensation Management, you can use the Connection wizard to view and edit the details of those connections.

If a connection was initially made by using generic column types, you can use the Connection wizard to edit the connection columns to use the correct table or calculation. You can also use the Connection wizard to reduce the number of columns that are included in the connection.

**Placeholder connections**

In Composer in IBM® Cognos® Incentive Compensation Management, you can use the Connection wizard to add an outbound connection from a source that is not yet added. You can then add a corresponding inbound connection, and the two components can be linked.

For example, imagine that you want to work on a compensation component that requires the *Quota* table as a source. If the *Quota* table is not yet created, you can use the Connection wizard to create a placeholder connection. After the *Quota* table is created, you can edit the connection in the Connection wizard to reference the appropriate columns.

**Adding a placeholder connection**

In Composer in IBM® Cognos® Incentive Compensation Management, you can add connections for sources that are not yet created.

**Procedure**

1. In Composer, right-click the component that you want to add the outbound connection from, click **Add Outbound Connection**, and name the connection.
2. Select **User-Defined** from the **Source** menu and click **Next**.
3. Using the **References, Columns, Tables**, or **Structural** tabs, define the schema of the source as accurately as possible by selecting columns and dragging them to the right pane.
4. To edit the connection column name or to make it a key column, right-click the column and click **Edit**.
5. Rename the column and select the **Key Column** check box.
6. Click **OK**.
7. Click **Finish**.
8. In **Link** mode, drag the outbound connection to a second component that requires it as a source. In this way, you create an inbound connection in that component, and you can use the placeholder outbound connection as a source in the second component.

**Adding outbound and inbound connections with the Connection wizard**

In Composer in IBM® Cognos® Incentive Compensation Management, you can use the Connection wizard to view, edit, and add inbound and outbound connections.

**About this task**

When you add connections, it is easier to add the outbound connection first. However, you can also create placeholder inbound connections, and then connect them to the corresponding outbound connection later.

When you select tables or calculations from the **Tables** or **References** tabs, all columns that are listed in bold are required for the connection. Other columns can be omitted from the connection. For tables, all primary key columns must be included in the connection. For calculations, all partitions and the value column must be included in the connection.

**Procedure**

1. Right-click a component and click **Add Outbound** or **Add Inbound Connection**.
2. Type a **Name** for the connection.
3. From the **Source** list, select the table or calculation that is the source of the connection and click **Finish**.

**Linking tables and calculations to outbound connections**

To finalize the connected columns in Composer in IBM® Cognos® Incentive Compensation Management, you must link the table or calculation to the connection.

**About this task**

To link a table or calculation to a connection, you must use **Link** mode in Composer and draw a line from the table or calculation to the port that you are linking to.

**Procedure**

1. In Composer, double-click the component that contains an outbound placeholder connection.
2. Click the **Link** icon.
3. Click the black box in the table or calculation and drag to the outbound placeholder connection.

   **Tip:** Tables and calculations can link to more than one outbound or inbound connection.
Mapping incompatible connections
If you have incompatible connections in Composer in IBM® Cognos® Incentive Compensation Management, you can map connection columns to source columns in the Connection wizard.

Procedure
1. In the Connection wizard, drag the Source columns on the right to the Matched cells of their matching connections on the left.
2. Click Finish.
Chapter 7. Table configuration

In IBM® Cognos® Incentive Compensation Management, you can edit the database structure to store the metrics that are needed for compensation calculations. To edit database structure, you can add fields or entire tables.

For example, you might need to include commission rates or quotas by customer, product, or payee. Use Composer to add that information to an existing table, such as the Payee table, or you can choose to add an entirely new table for lookup purposes. The rate and quota information can be retrieved later for calculations.

When you add a model, the Hierarchy tables (Payee, Accounts, Time, Product, and Customer), are displayed in the top level of Composer. The hierarchy tables and any other tables that you add can be moved by cutting and pasting, if the table is not used by a calculation.

Table data connections between components

In IBM® Cognos® Incentive Compensation Management, you can use the data in tables as a source for calculations in other components by adding inbound and outbound connections.

Data in tables can be connected from a parent component to a child component or between sibling components.

Table columns between components

The table schema for all tables is globally available throughout a model in IBM® Cognos® Incentive Compensation Management, regardless of the component that contains the table.

You can add a table in a component that requires a column from another component.

For example, your Payee table is in one component and you add a custom table in another component. Your custom table contains a payee ID column that pick lists from the Payee table. Because the table schema is universally accessible, tables can pick from other tables that are in different components.

Tables

In every model, IBM® Cognos® Incentive Compensation Management adds system tables and tables for each of the hierarchies that were defined when the model was initially created.

Users can also add Data, Structural, Custom, and View tables.

After a table is added, new fields can be added and existing fields can be deleted. However, the primary key structure of the table cannot change and adding or deleting primary key fields is not permitted after the table is added.
System tables

System tables are automatically added in IBM® Cognos® Incentive Compensation Management. System tables include Title, Salutation, Currency, and Group Member tables.

System tables are added to contain common attributes for fields in the Payee table. The Title, Salutation, and Payee Currency fields in the Payee table are populated with information from their respective System tables. Therefore, all possible titles, salutations, and currencies that are needed by the Payee table must be listed in the System tables. More fields can be added to System tables as needed.

Title table

The Title table in IBM® Cognos® Incentive Compensation Management contains a TitleID field and a Title field.

The Title column in the Payee table picks from the TitleID field in the Title System table, so all job titles attributed to any payee in the Payee table is loaded into the Title table. More fields can be added to this table if needed.

Salutation table

The Salutation table in IBM® Cognos® Incentive Compensation Management contains a Salutation column and is pre-populated with common salutations.

The Salutation field in the Payee table picks from the Salutation table, so any salutations attributed to any payee in the Payee table must be loaded into the Salutation table. More fields can be added to this table if needed.

Currency table

The Currency table in IBM® Cognos® Incentive Compensation Management is populated with currencies selected in the New Model wizard. More currencies can be added if necessary.

The Currency table contains a CurrencyID field and a Name field. The Payee Currency field in the Payee table picks from the Currency table, so any currencies needed to pay any payee must be contained in the Currency table. More fields can be added to this table if needed.

Group Member table

The Group Member table in IBM® Cognos® Incentive Compensation Management contains the PayeeID, Name, Start Date, and End Date for each payee that has been added to a payee group through the Payee Groups window.

The Group Member table is created automatically and its structure cannot be edited. The primary key field for this table is the GroupID, which is automatically generated. To view or edit group members, open the Payee Groups window from the Tools menu. This table can be used as a calculation source, but you cannot view its structure or contents in Composer.

Hierarchy tables

Hierarchy tables contain relationships that are necessary to analyze and manage organizational data in IBM® Cognos® Incentive Compensation Management.

After a model is created, the Account, Payee, and Time hierarchy tables are created automatically.
More hierarchy tables can be added after the model is created. Common hierarchy examples include product, customer, and territory hierarchies.

Hierarchies use parent-child relationships to organize structural information. In a parent-child hierarchy, two table columns define the hierarchical relationships among the dimension members. The primary key column uniquely identifies each dimension member and a parent column identifies the parent of each dimension member. Each parent can have many children, but each child can have only one parent. The parent column in hierarchies has a self-referencing relationship, or self-join, within the table.

For example, if the Parent column in the Payee table contains each payee's manager, your table might look like the following table. The Parent column contains the ID for each payee's manager and references the PayeeID column.

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>Parent</th>
</tr>
</thead>
<tbody>
<tr>
<td>E010 HUDDLE</td>
<td>Dan Huddle</td>
<td>E030 CLARKSON</td>
</tr>
<tr>
<td>E020 HUMPHREY</td>
<td>Darnell Humphrey</td>
<td>E030 CLARKSON</td>
</tr>
<tr>
<td>E030 CLARKSON</td>
<td>Debbie Clarkson</td>
<td>E040 YOUNG</td>
</tr>
<tr>
<td>E040 YOUNG</td>
<td>Diana Young</td>
<td>E210 KAREY</td>
</tr>
<tr>
<td>E210 KAREY</td>
<td>Doug Kary</td>
<td></td>
</tr>
</tbody>
</table>

**Payee table**

The Payee table is used to store data about individuals who are being compensated by, or who are approving variable compensation payments in IBM® Cognos® Incentive Compensation Management.

The Payee table contains many of the fields that are typically needed to organize payee information. You do not need to use columns that do not suit your organization, and you can add more columns to the table as required.

In the Payee table, the primary key column is the Payee ID column. The Parent column identifies the groups that your payees are organized into. For example, because payees are often grouped into territories, the Parent column is often used to store payee territories.

**Accounts table**

The Accounts table is used to store loaded values from your source system and output values in IBM® Cognos® Incentive Compensation Management.

The accounts in the Accounts table are typically a subset of the general ledger chart of accounts and are associated with commissions and other variable compensation payments. By default, the Accounts table contains AccountID, Name, Parent, and DrCr fields. You do not need to use columns that do not suit your organization, and you can add more columns to the table as required.

In the Accounts table, the account ID column is the primary key field. The Parent column is used to organize your account IDs into groups. For example, GL accounts are typically grouped by account type, so the account type is stored in the Parent column.
**Time table**
The Time table is used to store the payroll periods calendar as defined during model creation in IBM® Cognos® Incentive Compensation Management.

The Time table is the only hierarchy that is not displayed as a table in Composer.

**Data table**
A Data table contains a date field, but you can add other fields as needed. Key columns are defined at the time that the model is created in IBM® Cognos® Incentive Compensation Management.

A Data table is best suited for transactional data, such as lists of sales or orders.

When periods are locked, all Data tables that are associated with the locked calendar are locked by the Date field in the table (other table types are not locked). If more than one Date field exists in the data table, you must select a **Lock by Date** when the table is created to specify which field to use to lock the table.

**Structural tables**
Structural tables help to define the structure of your model in IBM® Cognos® Incentive Compensation Management. Structural tables are customizable.

Because you can add only one primary key column in a structural table, pick lists can pick from structural tables.

**Custom tables**
Custom tables are used to help define the structure of your model in IBM® Cognos® Incentive Compensation Management. Custom tables are customizable.

Because you can add multiple primary key columns to a custom table, pick lists cannot pick from custom tables.

Custom tables can be created for multiple purposes. One common use of a custom table is to contain data for reference values that vary by one or more key members, or that exist in the form of a lookup. As a reference for compensation calculations, you can add a custom table to hold compensation rates that vary by product and by quarter, or multipliers that define benefits based on a percent of quota attainment. For example, a custom table might contain the following data format.

<table>
<thead>
<tr>
<th>Product</th>
<th>Quarter</th>
<th>Compensation Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Quarter 1</td>
<td>8.00%</td>
</tr>
<tr>
<td>100</td>
<td>Quarter 2</td>
<td>7.95%</td>
</tr>
<tr>
<td>100</td>
<td>Quarter 3</td>
<td>7.75%</td>
</tr>
</tbody>
</table>

**View tables**
You can use a View table to display results that are contained in two different sources In Composer in IBM® Cognos® Incentive Compensation Management.

Views do not contain their own unique data sets. Use a view to join tables together to add a view of two tables.
With views, joins can contain tables and the results of calculations. When you add calculations, you cannot use views as data sources. Instead, add columns to the original data source during the calculation creation process. Because views cannot be used as data sources, they also cannot be made into global tables. Views are not accessible from the web client.

When you add a view, you join two or more tables based on a point of commonality. For example, consider a situation where you join a Product table to a Payee table to display the products that were sold by each payee. If you restrict (link) your results based on the payee ID, you receive the following results:

Table 3. Payee table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
</tr>
</tbody>
</table>

Table 4. Product table

<table>
<thead>
<tr>
<th>ProductID</th>
<th>ProductName</th>
<th>PayeeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Printer</td>
<td>001</td>
</tr>
<tr>
<td>234</td>
<td>Cable</td>
<td>001</td>
</tr>
<tr>
<td>345</td>
<td>Monitor</td>
<td>003</td>
</tr>
</tbody>
</table>

Table 5. Payee table and Product table joined in a view table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>ProductID</th>
<th>ProductName</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>345</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

Important: In the preceding example, no data is displayed for Sue Jacob or Mary Scott because there are no corresponding product sales for those payees.

Table additions

You can add Data, Structural, Custom, and View tables in Composer in IBM® Cognos® Incentive Compensation Management. When you add a table, you must add columns in the table for the data.

Table column types

Tables in IBM® Cognos® Incentive Compensation Management use several different column types.

Table 6. Table column types

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Can contain any numeric, alpha, or symbol, but cannot be used in a formula. Text fields have a limit of 100 characters.</td>
</tr>
<tr>
<td>Date</td>
<td>Can contain any data in a date format (mm/dd/yyyy, dd/mm/yyyy, Jan. 1, 2011).</td>
</tr>
</tbody>
</table>
Table 6. Table column types (continued)

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric</td>
<td>Can contain only figures and can be used in formulas. A numeric column can contain up to 28 integers and 14 decimal places.</td>
</tr>
<tr>
<td>Pick List</td>
<td>A link to another table. Values that are loaded into this field must be contained in the linked table or they will be rejected during an import. Pick lists are ideal for situations where the data that you need exists. For example, you can add a pick list for the payee ID. If you want to add a Data table that contains accounts, dates, payees, values, and customers, you can define pick lists for accounts and payees. <strong>Important</strong>: Pick lists can pick only from Hierarchy and Structural tables.</td>
</tr>
<tr>
<td>Email</td>
<td>A column similar to Text but with extra validation to restrict the input to email addresses.</td>
</tr>
<tr>
<td>Comment</td>
<td>A column that is designed for longer text input. Comment fields have a limit of 1000 characters.</td>
</tr>
<tr>
<td>URL</td>
<td>Restricts input to valid URLs.</td>
</tr>
</tbody>
</table>

Primary keys

A primary key uniquely identifies each row in a table in IBM® Cognos® Incentive Compensation Management.

If your primary key is the payee ID, no two rows of data in your table can contain the same payee ID. You can identify more than one primary key in some tables. If you add a custom table that identifies both the payee ID column and the date column as primary keys, no two rows of data can contain the same combination of date and payee ID.

Adding a table

You can add tables in Composer in IBM® Cognos® Incentive Compensation Management to contain data that is required for your model.

Procedure

1. Open the component that you want to add the new table to.
2. To add a table, complete one of the following steps:
   • Right-click a blank area in Composer and click Add Table.
   • Drag the Table element onto the main window.
3. Select the appropriate Table Type from the menu and click OK.
4. Type a name for the table. The table name cannot contain spaces.
5. Type a name for the primary key field and select the column type from the Type list. Each field in the table must have a unique name. Field names can contain spaces. Field names cannot be changed after the table is added.
6. To add columns to the table, click the Add a Field link.
7. If the field is a primary key field, select the ID check box.
8. Type a name for the new field and select the type of data for the field.
9. When you are finished, click Save.
Defining pick list field types
If you selected pick list as a field type in a table in IBM® Cognos® Incentive Compensation Management, you must define the source to populate the pick list.

Procedure
1. In the Add Table wizard, click the gray question mark to open the Define Pick List window.
2. Select the table to populate the pick list.
3. You can select the Description check box and a column from the menu.
   For example, if you link to the Payee table, you might want the description to be the Name column.
4. To restrict the rows available for the pick list, select the Filter check box and click Add Filter.
   a. Add any data sources to filter your data.
   b. Click Next.
   c. Define any restrictions and then click OK.
      For example, you can add a table with a Payee column that contains transaction information for Regional Sales Managers. After you add this filter, only payees with the job title Regional Sales Manager can be added to the new table.
   d. Click Finish.
5. Click OK.
6. To review the links that exist in default tables, click the gray L next to a pick list column.
7. All linked fields are attached to a source table. Review the structure of all source tables before you exit.

Adding a Data table
In IBM® Cognos® Incentive Compensation Management, you can add a data table that can be used to hold transactional data.

Procedure
1. Open the component that you want to add the new table to.
2. To add a table, complete one of the following steps:
   • Right-click a blank area in Composer and click Add Table.
   • Drag the Table element onto the main window.
3. Select Data from the Table Type menu and click OK.
4. Type a name for the Data table.
5. To define the primary key, select the ID check box next to the field.
   Important: Although data tables can contain multiple primary key columns, to simplify the partitioning process during calculation creation, use only one column, such as a transaction ID column.
6. To add more fields, click the Add a Field link.
7. Type a name for the field and select a field type from the Type list.
8. Define any pick list columns.
9. If your data table contains more than one date field, select the Lock by Date link to indicate which date field to lock by when a period is locked.
10. Click Save.
Adding a View table

You can add a View table to display results from two different sources in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Open the component that you want to add the new table to.
2. To add a table, complete one of the following steps:
   - Right-click a blank area in Composer and click Add Table.
   - Drag the Table element onto the main window.
3. Select View from the Table Type menu and click OK.
4. Type a name for the View table and click Next. The name cannot be edited after it is created.
5. Click the Source menu to add a table.
6. Click Add to join another table.
   a. Select the second Source from the menu and click Next.
   b. Define any restrictions for the join, and click OK.
   c. Click Finish.
7. Click Next.
8. Drag columns on the left to the right to select the Detail Columns. Each column must be unique.
9. Click Next.
10. Define any restrictions and click Next.
11. Double-click a column to rename it. Each name cannot contain more than 100 characters, must be unique, must start with a letter, and can contain only letters, numbers, spaces, periods, and underscores.
12. Click Finish.

Viewing the Payees and Accounts tables as a hierarchy

You can view the Hierarchy tables in a tree-based interface in Composer in IBM® Cognos® Incentive Compensation Management.

Procedure
1. In Composer, right-click the Hierarchy table and click View As Hierarchy. The table opens in a new tab in a tree-based structure.
2. To add a row to the table, click the Add Item icon, type the appropriate information in the fields, and click OK.
3. To search for an item in the table, click the Find icon.
4. To edit an item in the table, select the item and click the Edit Item icon.
5. To delete an item in the table, select the item and click the Delete icon.

Viewing the Time table as a hierarchy

You can view and edit the Time table in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Tools > Calendars.
2. Select the calendar and click Edit.
Table data edits

In IBM® Cognos® Incentive Compensation Management, you can use Composer to edit an existing table.

For example, if an organization wants to add a commission rate for each payee, the model administrator can add a commission rate field to the Payee table. Then, each payee in the system has a commission rate attribute that can be imported (or manually entered) and then used in calculations.

When you open a table for viewing or editing, any columns that contain a key icon in the header are the primary key columns. If you do not have access to edit certain columns, those columns are not available.

The options in the following table are available when you open a table for editing.

Table 7. Table editing options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Row</td>
<td>Add a row of data to the table in an unlocked period.</td>
</tr>
<tr>
<td>Edit Row</td>
<td>Make changes to the row data if the row is in an unlocked period. Primary key fields cannot be changed.</td>
</tr>
<tr>
<td>History</td>
<td>View details of every change that is made to that row. History includes edits that are made in both locked and unlocked periods.</td>
</tr>
<tr>
<td>Delete Row</td>
<td>Delete a row in an unlocked period.</td>
</tr>
<tr>
<td>To Excel</td>
<td>Send the contents of the selected rows to a Microsoft Excel spreadsheet.</td>
</tr>
<tr>
<td>Publish</td>
<td>Send the contents of the selected rows to Microsoft Excel, Microsoft Dynamics CRM, PDF, Salesforce.com, or text file.</td>
</tr>
</tbody>
</table>

Adding table data

In Composer in IBM® Cognos® Incentive Compensation Management, you can add data to a table manually.

Procedure

1. To open a table, complete one of the following steps:
   - Double-click the table.
   - Right-click the table and click View/Edit Data.
2. Click the Show Row Editor icon.

   Tip: By default, the Show Row Editor is not displayed. However, if you choose to display the Show Row Editor, it remains displayed even if the tab is closed and then reopened. To hide the Show Row Editor, click the Row Editor icon again.
3. Click the Add Row icon or the Add button.
4. In the top pane, enter the data in the appropriate fields and click Submit. If you click Add, you also submit the row of data.

   Alternatively, you can open the table, enter the data in the columns of the first empty row, and press Enter when you finish entering all the data into the row.
**Editing table data**
In Composer in IBM® Cognos® Incentive Compensation Management, you can edit existing data in a table.

**Procedure**
1. To open a table, complete one of the following steps:
   - Double-click the table.
   - Right-click the table and click View/Edit Data.
2. In the table, select the row that contains the data that you want to edit.
3. Click the Show Row Editor icon.
4. In the Row Editor pane, enter the new data in the appropriate fields and click Submit. If you click Add, you also submit the row of data.
5. To edit the row before the selected row, click the Previous Row icon or click the Edit Prev button.
6. To edit the row after the selected row, click the Next Row icon or click the Edit Next button.

**Displaying a description field in tables**
In IBM® Cognos® Incentive Compensation Management, you can view the description for a pick list field while you are viewing table data.

**About this task**
This option is available only if the Description column is set for the pick list column. If the Show Description feature is enabled when you publish the table, the published results display the description. After you enable the Show Description feature, it remains enabled until the table is closed.

**Procedure**
1. View the data in a table that has a pick list column to another table.
2. Right-click the pick list column and click Show Description.
   The ID and description are displayed for each row in the column.

**Filtering table data**
When you are viewing table data in IBM® Cognos® Incentive Compensation Management, you can filter the results.

**Procedure**
1. While you are viewing table data, click the filter icon in the column header.
2. Set filter parameters. You can filter results based on a range of values or by a specific value.
3. Click Filter. You can choose multiple columns to filter data by.

**Viewing and editing table structure**
You can view, add, and remove columns in a table in the Composer window in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. In Composer, right-click a table and click Edit.
2. To delete a column, click the Remove link next to the column you want to delete.
3. To add a column, click the **Add a Field** link.
4. Type a field name and select a field type from the **Type** menu.
5. Click **Save**.

**Important:** The Edit Table window for **Account** tables and tables that are used by inbound or outbound connections is displayed in read-only mode and cannot be edited.

**Editing a View table**

If you have view and edit permission for the structure of a **View** table, you can edit the sources, detail columns, restrictions, and column names in the Composer window in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. In Composer, right-click the **View** table that you want to edit and click **Edit Table**.
2. Edit the source, joins, columns, restrictions, or column names. You cannot edit the name of the **View** table.

**Important:** If you change the **View** table, an entry is made to the Audit Log indicating that the **View** table was edited.

**Deleting a table**

You can delete a table from the Composer window in IBM® Cognos® Incentive Compensation Management if it does not have any dependencies.

**Procedure**

Right-click a table element and click **Delete**.

**Adding and editing table descriptions**

You can add a description to a table in the Composer window in IBM® Cognos® Incentive Compensation Management. The description is then visible in Composer as a tooltip.

**Procedure**

1. Right-click the table and click **Edit Table Description**.
2. Type a description for the table.
3. Click **OK**.
4. Hover your cursor over the table to see the description tooltip.

**Deleting multiple rows in a table**

In IBM® Cognos® Incentive Compensation Management, you can filter and delete multiple rows from a table at one time if the rows are not locked, and if the table is not a **View**.

**About this task**

When you delete rows from a table or clear an entire table, all child table records that have pick listed columns that are linked to the table are also deleted.
When you try to delete rows that are pick listed by other tables, a warning message is displayed that identifies the tables whose records are deleted. You can click the Details button to view the dependent tables that are affected by table clearing.

The Audit log records the start and finish time of the row deletion operation. Although many factors determine the exact amount of time that it takes to delete multiple rows, testing indicates that 500,000 rows can be deleted in approximately 1 minute.

This operation deletes the selected rows in the table as well as all referencing rows from other tables. This action cannot be undone.

**Procedure**
1. Right-click the table and click Data > Delete Rows.
2. Define the restrictions to filter the rows that you want to delete. Drag the column that you want to filter on into the pane on the right, then select an operator, and filter based on a selected field or a specific value.
   
   For example, to delete all rows before January 1, 2011, drag over the date field and select < 01/01/2011.
   
   • Most columns can use these operators: =, < >, is not empty, is empty.
   
   • Date and value columns can use these operators: <, <=, =, >, >=, < >, is not empty, is empty.
   
   • If no restrictions are defined, the entire table is cleared.
3. Click OK.

**Copying a table**
In Composer in IBM® Cognos® Incentive Compensation Management, you can duplicate tables and rename them by adding a suffix.

**Procedure**
1. To copy a table, complete one of the following steps:
   • Select the table and click the Copy icon.
   • Right-click a table element and click Copy.

   **Important:** You cannot copy System or Hierarchy tables.
2. In the component where you want to paste the table, complete one of the following steps:
   • Click the Paste icon.
   • Right-click and click Paste.
3. Type a suffix for the new table name.
4. Click OK.

**Publishing a table**
You can publish data from an IBM® Cognos® Incentive Compensation Management model directly to a Microsoft Excel file, a Microsoft Dynamics CRM database, a PDF file, Salesforce.com table, or a text file.

**Procedure**
1. Right-click a table and click Data > Publish.
2. Select Publish to my computer or Publish to the server.
3. If you select **Publish to the server** and you want to save the publication to run later by using the **Scheduler** module, type a name for the publication in the **Save this publication as** field.

4. Click Next.

5. Select the output format for the published table or calculation.

**Publishing a table to Microsoft Excel**

You can publish data from your IBM® Cognos® Incentive Compensation Management model directly to a Microsoft Excel file.

**Procedure**

1. Right-click a table and click **Data > Publish**.

2. Select **Publish to my computer** or **Publish to the server**. If you select **Publish to the server** and you want to save the publication to run later by using the **Scheduler** module, type a name for the publication in the **Save this publication as** field.

3. Click Next.

4. Select **Microsoft Excel** as the destination for the published table or calculation.

5. Format the headers and cells and then click Next.

6. Click **Browse** to select where you want to save the file.

7. Click Finish.

**Publishing a table to Microsoft Dynamics CRM**

You can publish data from your IBM® Cognos® Incentive Compensation Management model directly to a Microsoft Dynamics CRM database.

**Procedure**

1. Right-click a table and click **Data > Publish**.

2. Select **Publish to my computer** or **Publish to the server**. If you select **Publish to the server** and you want to save the publication to run later by using the **Scheduler** module, type a name for the publication in the **Save this publication as** field.

3. Click Next.

4. Select **Microsoft Dynamics CRM** as the destination for the published table or calculation.

5. Type your login credentials.

**Publishing a table to a PDF file**

You can publish data from your IBM® Cognos® Incentive Compensation Management model directly to a PDF file.

**Procedure**

1. Right-click a table and click **Data > Publish**.

2. Select **Publish to my computer** or **Publish to the server**. If you select **Publish to the server** and you want to save the publication to run later by using the **Scheduler** module, type a name for the publication in the **Save this publication as** field.

3. Click Next.

4. Select **Portable Document Format** as the destination for the published table or calculation.

5. Select the **Orientation** and **Scaling**.
6. Select the **Use header image** check box if you want to display an image as the header on each PDF file.
7. You can select the **Include page numbers** check box to show page numbers in the footer.
8. You can select the **Show total page number** check box to show the total number of pages in the document along with the current page number.
9. You can type a **Footer** to be included on each page.
10. Click **Next**.
11. Format the headers and cells then click **Next**.
12. Click **Browse** to select where you want to save the PDF file.
13. Click **Finish**.

**Publishing a table to Salesforce.com**

You can publish data from your IBM® Cognos® Incentive Compensation Management model directly to a Salesforce.com table.

**Procedure**
1. Right-click a table and click **Data > Publish**.
2. Select **Publish to my computer** or **Publish to the server**. If you select **Publish to the server** and you want to save the publication to run later by using the Scheduler module, type a name for the publication in the **Save this publication as** field.
3. Click **Next**.
4. Select **Salesforce.com** as the destination for the published table or calculation.
5. Log in to Salesforce.com with a user ID that has administrative rights.
6. Select the **Setup** link.
7. From the left pane, select **Create > Objects** from the **App Setup** section.
8. Select **New Custom Object**, and add the object according to your specifications.
9. In the IBM Cognos Incentive Compensation Management Client, right-click the table and click **Publish Table**.
10. In step 2 of the Publisher wizard, select **Salesforce.com** and click **Next**.
11. Type your user name, password, and security token, then click **Next**.
12. Select the table to export data to from the menu and click **Next**.
13. Continue with the Publisher wizard and click **Finish**.

**Publishing a table to a text file**

You can publish data from your IBM® Cognos® Incentive Compensation Management model directly to a text file.

**Procedure**
1. Right-click a table and click **Data > Publish**.
2. Select **Publish to my computer** or **Publish to the server**. If you select **Publish to the server** and you want to save the publication to run later by using the Scheduler module, type a name for the publication in the **Save this publication as** field.
3. Click **Next**.
4. Select **Text File** as the destination for the published table or calculation.
5. Select a delimiter and click **Next**.
6. Click **Browse** to select where you want to save the file.
7. Click **Finish**.

**Viewing table dependencies**
You can use the Dependency Viewer to view a list of all calculations, web forms, input forms, or other tables that use the selected table as a source in the IBM® Cognos® Incentive Compensation Management model.

**Procedure**

To open the Dependency Viewer, complete one of the following steps:
- Right-click the table and click **Used By**.
- Select the table and click the **Used By** icon in the Composer toolbar.

**Copying text from the Dependency Viewer**
You can copy information in the Dependency Viewer in IBM® Cognos® Incentive Compensation Management and paste it into another file.

**Procedure**

1. In the Dependency Viewer window, press Ctrl and select the text that you want to copy, or press Shift and select a range of text.
2. Right-click the selection and click **Copy**.
   - The text from the dependency viewer can then be pasted into a spreadsheet or other document.

**Adding a global table**
In the Composer window in IBM® Cognos® Incentive Compensation Management, you can make tables global to make them visible to all users.

**About this task**

A table cannot be made global if it has the same name as a connection or if it is a View table.

**Procedure**

1. Right-click the table and click **Global**.
   - An image of a globe is displayed on the table element.
2. Clear **Global** to make the table local again.

**Globalizing and replacing connections**
In the Composer window of IBM® Cognos® Incentive Compensation Management, you can make tables that are already being used in connections global.

**About this task**

When you make a table global, you automatically remove any connections and change the sources of any objects (for example, calculations, web forms, and Presenter reports) to use the global table.

**Procedure**

Right-click the table and click **Globalize and Replace Connections**.
Navigating between tables

From within any table in the Composer window in IBM® Cognos® Incentive Compensation Management, you can easily navigate to any related table by using the Jump To feature. The Jump To feature is not available in View tables.

About this task

You can use the Jump To feature only if the table is saved.

Procedure

1. To open the table in a new tab, complete one of the following steps:
   • Double-click the table.
   • Right-click the table and click View/Edit.
2. Right-click a value in a pick list column and click Jump To. You can navigate directly to the tables that the selected column picks from.
3. Select the table to jump to.

Results

The table opens in the current tab and the table results are filtered by the value that you selected in step 2.

Clearing tables

In the Composer window in IBM® Cognos® Incentive Compensation Management, you can delete the entire contents of a table but not the table itself.

About this task

You receive a warning message when you try to clear a table that contains a key column that is pick listed by other tables. You can choose to continue with the deletion or cancel the action. You can click the Details button to view the dependent tables that are affected by the table clearing. The warning message can be turned off in the User Preferences window.

To use the clearing tables feature, you must have view and edit permission for Composer as well as the component in which the table resides. If the table is in the top level of Composer, then you must have Top > Edit permission. You must also have view and edit permission for the structure of the table that you want to clear.

Table clearing can also be scheduled by using the Scheduler module.

Table clearing cannot be undone.

Procedure

Right-click the table and click Data > Clear Table.

Finding and replacing data in a table

Use the data transformation feature to find and replace data in any table in the Composer window in IBM® Cognos® Incentive Compensation Management.
**About this task**

This procedure is useful when there is an error in source data that affects multiple rows of data in a table. Rather than manually adjusting each row, you can make the change simultaneously across multiple rows.

**Procedure**

1. Right-click the table and click **Data > Transform**.
2. Type the original value that you want to be replaced in the **Find what** field.

   **Important:** In the **Find what** field, asterisks (*) act as wild cards and underscores ( _ ) act as placeholders. If the **Find what** field is left blank, the engine searches for empty cells in the specified column.

3. Select the table where the data transformation will occur in the **Look in** field.
4. Select the column that contains the value that will be replaced in the **Make change in** field.

   **Important:** The search engine completes the find and replace operation only in the specified column.

5. In the **Change to** field, type the new value that will replace the original value.
6. If you want to save the transformation, select the **Save Transformation** check box and name the transformation.

   After a data transformation is saved, it can be accessed for editing or deletion through the Manage Saved Transformations window. Saved data transformations can also be scheduled to run at predefined times through the Scheduler module.

7. Click **OK**.

**Results**

For each row where the **Look in** column cell value equals the **Find what** value, the corresponding cell in the **Make change in** column contains the **Change to** value.

---

**Effective dates**

In IBM® Cognos® Incentive Compensation Management, you can create **Hierarchy**, **Custom**, and **Structural** tables that include effective start and end dates.

Multiple versions of the same record can be added to a date effective table by setting different effective start and end dates for each record. Cognos Incentive Compensation Management maintains the start and end dates for all records as changes occur to the data over time. For example, you can change the job code for an employee on February 1, 2015 and both job codes for the employee can exist in the table with different start and end dates.

Records are viewed as of a defined date that is known as the effective date. A user’s selected effective date must fall between a record’s start and end dates.

If a table with effective dates contains a column that pick lists to another table with effective dates, the records that are available to pick from in the list are based on the selected effective date. If a value in the pick listed table does not exist for the selected effective date, it is not displayed in the list.
Adding tables with effective dates

In IBM® Cognos® Incentive Compensation Management, you can add effective dates to records in Hierarchy, Custom, and Structural tables.

About this task

The effective start date is automatically added with the user-identified columns as part of the table's primary key.

Procedure

1. In Composer, add a hierarchy, Custom, or Structural table.
2. Type a name for the table.
3. Ensure that the Effective Dated check box is selected.

Results

An Effective start column and an Effective end column are automatically added to the table.

Viewing data in tables with effective dates

In IBM® Cognos® Incentive Compensation Management, you can view data in an effective dated table as of a defined date.

About this task

When you first open a table, the effective date that is selected is based on the Locked Through date in the calendar. The effective date defaults to the first calendar day after the latest Locked Through date. When you open a table and set a new effective date, the application saves the effective date to be used across all tables for your individual session.

Procedure

1. Right-click an effective dated table and click View/Edit Data.
2. Select an effective date by which to filter data.

Results

Data that is valid on the selected date is displayed.

Viewing multiple versions of data in tables with effective dates

In IBM® Cognos® Incentive Compensation Management, you can view all versions of a record in an effective dated table.

Procedure

1. Right-click the effective dated table and click View/Edit Data.
2. Select the effective date.
3. Select the record for which you want to view all versions.
4. In the toolbar, click Versions.
Adding data to tables with effective dates

In IBM® Cognos® Incentive Compensation Management, you can add multiple records that are the same but have different start and end dates. The application ensures that each version does not overlap with another version of the same record.

About this task

When a record is added, Cognos Incentive Compensation Management matches the start date of the record with the effective date that you selected. The application also checks to see if future versions of the same record exist. If so, the application displays those records for you.

The application also gives you the option to choose to keep future versions or overwrite future versions. If you choose to overwrite future versions, the future record is deleted. If you choose to keep future versions, both records remain but the start and end dates are different.

If you click View All, all the records in the table as displayed.

Procedure
1. In Composer, double-click the table with effective dates.
2. Select an effective date by which to filter data.
3. Add a record.
   The effective start date is set to your selected effective date and the effective end date defaults to the end of time (12/31/9998). Both of these columns are populated by the application.
4. To add a version of the record with a different effective start date, in the toolbar, in the Effective Date field, select a new effective date.
5. Make the necessary changes to the record with a different effective start date.
   The application automatically adds the new version of the record and updates the previous version's effective end date.
6. If you change a record in which edits to that record occur with a future effective date, the Manage Future Versions window opens. Select Overwrite future versions or Keep future versions.

Adding end dates to records in tables with effective dates

In IBM® Cognos® Incentive Compensation Management, you can select a date on which the record is no longer effective.

About this task

The effective end date is the date on which you want the record to no longer be effective. The effective end date is set to one day before the date that is selected in the Effective Date field.

Procedure
1. Right-click the effective dated table and click View/Edit Data.
2. Select the effective date.
3. Select the record to which you want to add an effective end date.
4. In the toolbar, click Set End Date.
Results

The application refreshes the window and displays that the record's effective end date was updated.

Deleting multiple versions of records in tables with effective dates

In IBM® Cognos® Incentive Compensation Management, you can remove one or more versions of a record in a table with effective dates.

About this task

If you remove a single version of a record, a gap in time for the record might occur. If a gap occurs, the effective dates of other records can be adjusted to fill the gap.

Procedure

1. Right-click the effective dated table and click View/Edit Data.
2. Select the effective date.
3. Select the record for which you want to view all versions.
4. In the toolbar, click Versions.
5. Select the version of the record that you want to remove and click Delete.
6. If a gap in time occurs because of the record deletion, you must choose one of the following options to fill the gap:
   • From Past: The previous version is effective for the deleted time frame.
   • From Future: The future version is effective for the deleted time frame.
   • None: No changes are made to the effective dates of the existing versions.

Table history

You can choose to enable or disable the recording of history for tables in the Composer window in IBM® Cognos® Incentive Compensation Management. You can also clear the history that is collected for tables to improve the performance of your model.

When you add a data, custom, or structural table, a corresponding history table is also added. The purpose of history tables is to track any insertions, updates, and deletions of data into the tables.

Administrators can grant users permission to purge the history of tables, and they can also enable or disable the recording of history for tables. If tables are recording history in Cognos Incentive Compensation Management, and you have the appropriate permission, you can clear the history for tables from the Composer module or schedule the clearing of history for tables in the Scheduler module.

Disabling table history collection for a specific table

By default, changes to tables are logged in IBM® Cognos® Incentive Compensation Management, and history for all tables is recorded. You can choose to disable the collection of history for a specific table in the Composer module.
**Procedure**

1. In Composer, right-click the table for which you want to disable history recording, and click **Data > History > Track History**.
2. In Composer, right-click the table for which you want to disable history recording, and click **Data > History > Track History**.

**Purging table history**

You can delete the recorded history of a table in IBM® Cognos® Incentive Compensation Management.

**About this task**

If you want to purge the history of a data table, you must specify a date range. Only items that fall in the data range selected are removed. Administrators must grant users permission to purge history.

**Procedure**

1. In Composer, right-click a table and click **Data > History > Purge History**.
2. If you selected a data table, select a date range for which to purge history.

**Web data**

Use the web data edit feature to enable specified tables for review and edit through the IBM® Cognos® Incentive Compensation Management web client.

**Web data edit feature**

In IBM® Cognos® Incentive Compensation Management, there might be instances where data imported from a source system is incomplete or contains errors.

To correct missing or incorrect data, tables can be enabled for web review and certain columns can be made editable. Specified users can then log in to the web client and edit the erroneous table data.

For example, a compensation plan might require managers to supply weekly performance ratings for their subordinates. Managers can submit these metrics through the **Data Edit** tab on the web client.

**Defining accessible information for the web client**

You can define the information that must be accessible to specified users through the IBM® Cognos® Incentive Compensation Management web client.

**Procedure**

1. In Composer, right-click the table that you want to enable for web editing and click **Web Data Edit > Edit Column Permissions**. You can then select the fields that can be edited by the web user.
2. Check the field boxes next to the payee that you want to give editing permission to.

   **Important**: After a table is enabled for web review, you cannot restrict which columns are available for review. All columns are displayed.
3. To enable an entire group of payees to be able to edit a particular column, click **Enable Group**.
For example, you might want all payees with the job title Sales Manager to be able to edit the Quota column of the selected table.

a. Select a Source that can be used to define the payee group and click Next.

b. Define your restrictions based on that source and click Next.

   For example, if you want only account executives to be able to edit certain columns, then drag Title to the pane on the right and make it equal to Account Executive.

c. Define the columns that the restriction applies to, and click Finish.

   After you set your restrictions, every payee in your defined group can edit the specified columns.

4. Click Close.

Restricting visible rows in tables on the web client

You can restrict the rows that are displayed on the IBM® Cognos® Incentive Compensation Management web client.

About this task

For example, you might want to make sure that payees can view and edit only their own information. In this case, you can restrict results to a subset of all data in a particular table.

Procedure

1. In Composer, right-click the table and click Web Data Edit > View Restrictions.
2. Define the parameters of your restrictions.
3. Click OK.

Enabling direct editing on the web client

If you enable direct editing, users can make changes to tables through the IBM® Cognos® Incentive Compensation Management web client without administrator approval.

About this task

All users with web access to the selected table can edit column information without requiring approval. Typically, all edits that are made in the web client must be approved by an administrator before the change can be stored permanently in the database.

Enable direct editing with caution. If it is not enabled, administrators can approve each edit individually, or approve all edits at once.

Procedure

In the Cognos Incentive Compensation Management client, right-click the table and click Web Data Edit > Direct Edit.

Editing data through the web client

After you enable tables for review, web users can go to the Data Edit tab in the IBM® Cognos® Incentive Compensation Management web client to edit data in the columns that they are enabled for.
About this task

This procedure demonstrates the general tasks that are completed by users and administrators.

Procedure

1. Users select tables from the Available Tables menu.
2. Users can change any data that appears in a white box.
3. If direct editing is not enabled, the updated results are submitted to the compensation plan administrator. The administrator can choose to accept or decline the change.
4. Users click the Submit button to communicate changes. After users click Submit, they cannot make any more changes.

Approving web data edits

After web users have submitted changes, administrators can approve or reject those changes through the IBM Cognos Incentive Compensation Management Composer module. If the table name is in bold letters, edits (web form or web data edit) must be reviewed by an administrator.

Procedure

1. In Composer, right-click the table and click Web Data Edit > Approve /Reject Edits to see a list of changes that have been made.
2. Click Approve to commit those changes to the table.

Important: Period locking will not be permitted if there are pending edits that affect the period. This prevents any changes from being made to data in locked periods. If you must lock Month 1, all pending data edits for Month 1 must first be approved.
Chapter 8. Data imports

Use the Import Data wizard in IBM® Cognos® Incentive Compensation Management to import data into any Hierarchy, System, Data, Custom, or Structural table.

You can import data from text files, Microsoft Excel files, any ODBC-compliant database, Salesforce.com, Microsoft Dynamics CRM, XML files, and EBCDIC text files. Cognos Incentive Compensation Management extracts the EBCDIC data and imports it directly into the model, unpacking any packed decimal files in the process.

Text or Microsoft Excel files are the easiest sources to use when you build your model. A direct link to existing databases saves time after you define the layout of your model.

Related concepts:

“Access permissions” on page 288
When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

“Import data security” on page 304
You can grant a role permission to import data into tables in the Composer module in IBM® Cognos® Incentive Compensation Management.

Step 1. Selecting the table and import type

You can select the table and import type when you import data into IBM® Cognos® Incentive Compensation Management.

Procedure

1. In Composer, right-click a table and click Data > Import.
2. Select Import from my computer or Import from the server.

Important: If you are importing from a server, an import directory must be specified in the Cognos Incentive Compensation Management Windows Service configuration file.
   a. Select the Save this Import as check box if you want to save the current import for processing at a later time through the Scheduler model.
      If you save an import, it is saved in the file location defined in the Service configuration file. For more information on configuration files, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide. After imports are saved, they are accessible from the Manage Saved Imports window. Users can delete saved imports or edit details of the import, such as the data source or the destination table.
3. Click Next.

Step 2. Selecting a data source

You can select your data source for the import into IBM® Cognos® Incentive Compensation Management.
Procedure
1. In step 2 of the Import Data wizard, select the type of data source that you are importing from.

   **Important:** While Cognos Incentive Compensation Management offers the flexibility of supporting data imports from multiple sources, you might want to consider using only one source system for all imports. The more source systems you use, the more time you will have to spend ensuring that the source system information is accurate, up-to-date, and accessible.

2. Click Next.

Step 3. Checking required columns

The third step in the Import Data wizard presents the columns that the selected table requires for the import of data into IBM® Cognos® Incentive Compensation Management. Each required field is needed in the data source for the import to run successfully.

Procedure
1. In step 3 of the Import Data wizard, verify that the data file has the columns required to complete the import.
2. Click Next.

Step 4. File selection

You must choose the file that contains the data that you want to import into your tables in IBM® Cognos® Incentive Compensation Management.

The steps that you must follow to select the data file depends on the type of data source that you selected in step 2 of the Import Data wizard.

Selecting a text file as a data source

You can choose a text file as your data source for a table in IBM® Cognos® Incentive Compensation Management.

Procedure
1. In step 4 of the Import Data wizard, click **Browse** to select a text file to import.
2. Select the language of the file that you are importing.
   The date and numeric format of the values in the imported file are based on the language selected.
3. Check the **First record is a header** check box if the first row of your text file contains labels for each column.
   This indicates that the first row should not be processed as data, as it is a label for each column.
4. Select the delimiter from the **Fields delimited by** check box.
   When importing from a text file, you can choose a special character to import fields that contain a delimiter. You can choose from the following five delimiters: comma, tab, vertical pipe (|), semicolon, and period. This is useful if you have data that contains a comma but is importing from a comma delimited file. Without some sort of special character, there would be no way to import a field containing a comma from that kind of file.
5. Click **Preview** to make sure the data you have selected is correct.
Selecting a Microsoft Excel file as a data source

You can choose a Microsoft Excel file as your data source for your tables in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. In step 4 of the Import Data wizard, click **Browse** to select the file to import.
2. Select the language of the file that you are importing.
   The date and numeric format of the values in the imported file are based on the language selected.
3. If the first row of your Microsoft Excel file contains labels for each column, select the **First record is a header** check box.
4. Select the worksheet you want to import.
5. Click **Select** to choose the range of cells to import.
   The Microsoft Excel file opens.
6. Highlight the cell range containing your data in the Microsoft Excel file.
7. In the Import Data wizard, click **Preview** to ensure the data you have selected is correct.
8. Click **Confirm**. The Microsoft Excel file closes.

**Important:** Microsoft Excel must be closed when you are importing data into a table.

Selecting ODBC Compliant Database file option 1 as a data source

If you choose ODBC Compliant Database as your data source, you can choose this option to complete step 4 of the Import Data wizard in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. In step 4 of the Import Data wizard, select a **Driver**.
2. Click **Browse** to select your file.
3. Select the language of the file that you are importing.
   The date and numeric format of the values in the imported file are based on the language selected.
4. Select the **first record as header** check box.
5. Type your user ID and password or select the **Use Advanced Settings** check box to enter a custom connection string.
6. Click **Next**.
7. Type an SQL statement.
8. Click **Preview** to display the first 1000 rows of your selected data.

Selecting ODBC Compliant Database file option 2 as a data source

If you choose ODBC Compliant Database as your data source, you can use this option to complete step 4 of the Import Data wizard in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. In step 4 of the Import Data wizard, select a **Driver**.
2. Select the Server name or select the **Use Advanced Settings** check box to type a custom connection string.

3. Type the **Database** name.
   For example, type `ForODBCExport`.

4. Type your user ID and password.

5. Click **Next**.

6. Type a SQL statement.

7. Click **Preview** to display the first 1000 rows of your selected data.

---

**Selecting Salesforce.com as a data source**

You can choose Salesforce.com as your data source for your tables in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In step 4 of the Import Data wizard, type your Salesforce.com user name, password, and security token.

   **Important:** You must be set up with an administrator profile in Salesforce.com to import data.

2. Select the table and columns that you want to import.
   The menu lists all of the Salesforce.com tables that you have access to. The tables include all the default Salesforce.com columns, as well as any custom fields you have added.

3. To add custom columns to import from the selected table, complete the following steps:
   a. Select the **Enable Custom Columns** check box.
   b. Click **Add**.
   c. Type the name of the column from the table you want to import and click **OK**.

4. Click **Preview** to view the contents of the Salesforce.com table prior to running the import. Use the **Preview** feature to see exactly what your Salesforce.com data looks like before you import. Previewsing data also eliminates guesswork if you are unsure of the name of the Salesforce.com table that contains the import data you need.

---

**Selecting a Microsoft Dynamics CRM file as a data source**

You can choose Microsoft Dynamics CRM as your data source for your tables in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In step 4 of the Import Data wizard, type your user name and password.

2. Type the domain, organization, and host.

3. Click **Next**.

4. Select the table that you want to import.

5. Click **Preview** to view the contents of the table prior to running the import.

---

**Selecting an EBCDIC file as a data source**

You can choose an Extended Binary Coded Decimal Interchange Code (EBCDIC) text file as your data source for your tables in IBM® Cognos® Incentive Compensation Management.
**Procedure**

1. In step 4 of the Import Data wizard, click **Browse** to select the EBCDIC text file to import.
2. Select the language of the file that you are importing.
   - The date and numeric format of the values in the imported file are based on the language selected.
3. Select the **Encoding**.
4. You can select the **Ignore first record** and **Ignore last record** check boxes.
5. Click **Next**.
6. Increase or decrease the record length.
7. Add more fields.

   **Important:** The record length must match the number of fields.
8. Click **Preview** to make sure the data that you selected is correct.

**Selecting a Microsoft Excel file from TerrAlign as a data source**

You can choose a Microsoft Excel file from TerrAlign as your data source for your tables in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In step 4 of the Import Data wizard, click **Browse** to select the file to import.
2. Select the language of the file that you are importing.
3. If the first row of your Microsoft Excel file contains labels for each column, select the **First record is a header** check box.
4. Select the worksheet you want to import.
5. Click **Select** to select the range of cells to import and highlight the cell range containing your data.
6. Click **Preview** to make sure the data you selected is correct.
7. Click **Confirm**.

   **Important:** You must have Microsoft Excel closed when you are importing data into a table.

**Selecting an XML file as a data source**

Data stored in XML format can be imported into a table in Composer in IBM® Cognos® Incentive Compensation Management.

**About this task**

The XML file should contain nodes that represent rows. These nodes should be nested at the same level for each row. The columns of the row are expected to be the children of the row node. If a row does not have a child that another row has, the value for it will be empty.

**Procedure**

1. In step 4 of the Import Data wizard, click **Browse** to select the file to import.
2. Select the language of the file that you are importing.
The date and numeric format of the values in the imported file are based on the language selected.

3. Select the row node to import data from.

4. Click Preview to make sure the data you have selected is correct.

5. Click Next.

---

**Step 5. Mapping columns**

You must match the table columns in IBM® Cognos® Incentive Compensation Management to the columns in your data source.

**Procedure**

1. Go to step 5 of the Import Data wizard.
2. Click Automatch or drag each field from your data source onto the mapping column next to its corresponding field.

**Effective date columns**

When you import data into tables with effective dates in IBM® Cognos® Incentive Compensation Management, you must map the effective date columns to the appropriate date columns in the import.

Optionally, you can click Defaults to access the Effective Date Defaults window where you can select a default effective start date and a default effective end date to use for all imported records.

The effective start date is a key column so it must be mapped to a date field in the import file or set to a default date. The values cannot be empty or null.

The effective end date is not a key column so it does not have to be mapped. If the effective end date is unmapped, imported records have a date of 12/31/9998.

Imported effective start and effective end values must follow the rules of effective dating. That is, the dates must be between 1/1/1753 and 12/31/9998 and the effective start date must be the same day or earlier than the effective end date. The import file cannot contain multiple records with matching keys and overlapping effective dates.

The effective start date and effective end date mapping can be modified when editing a saved import in the Manage Saved Imports window.

**Adding sub-items**

In the Import Data wizard in IBM® Cognos® Incentive Compensation Management, you can add a new field to columns. Sub-items are a segment of the data in an existing column.

**Procedure**

1. In step 5 of the Import Data wizard, right-click any data source column to add a sub-item of that field, and click Create New Field.
2. Type a new field name.
3. To add a sub-item, complete one of the following steps:
   - Select Create a sub-item by selecting characters to include and type the selection. For example, type 1-5 if you want to include the first five characters of the field.
• Select **Use the following delimiter to create a sub-item for this field**, type a delimiter and select the **Index**. For example, if you have a Name field that contains first and last names separated by a space (for example, Dan Huddle) and you want to add a First Name field, you would type a space as the delimiter and select an Index of 1 since the first name is the first item before the delimiter.

**Important:** You can confirm if your selection is correct by looking at the example in the Create New Field window.

4. Click **OK**.

**Results**

You can see your sub-item in the data fields column on the map columns window.

**Merging fields**

In the Import Data wizard in IBM® Cognos® Incentive Compensation Management, you can combine two columns in your data source into one column. For example, if you have a month and a year field, you can merge the two and create one date field.

**Procedure**

1. In step 5 of the Import Data wizard, right-click any data source column and click **Merge Fields**.
2. Type a merge fields name.
3. Select at least two data fields to merge by dragging a field from the left to the right column.
4. Type a delimiter. The delimiter is placed between the merged fields.

**Important:** You can confirm if your selection is correct by looking at the example in the Create New Field window.

5. Click **OK**.

**Results**

You can see your merged field in the data fields column on the map columns window.

---

**Step 6. Selecting save and run options**

In the last step of the Import Data wizard in IBM® Cognos® Incentive Compensation Management, you can choose how you want the import to run.

**Procedure**

1. Navigate to step 6 of the Import Data wizard.
2. Select any or all of the following options:

   **Add new members as needed**
   
   Indicates that new members should be added.

   **Update existing rows**
   
   Indicates that existing rows of data should be updated with data contained in the rows being imported.
Run this import now
Indicates that the Cognos Incentive Compensation Management Client should run the current import immediately. Clear this check box if you want to save the current import and process it at a later date.

Use Incremental Import
Indicates that the Cognos Incentive Compensation Management Client should import rows to the database in smaller batches instead of committing the entire import in one batch. Use this option to process database calls, such as report generation in the web client, during a large data import.

3. Click Finish.

Step 7. Tracking import progress in the Activity module
After you finish the Import Data wizard, the Activity window opens in IBM® Cognos® Incentive Compensation Management and tracks the progress of the data import into the table.

While the import is progressing, you can open a new module or continue working in a previously opened module. If the import ran successfully, you can see a message indicating that the data import was successful in the Activity module. You can then review the imported data in the Composer module by double-clicking the table.

After a successful import, the selected table contains records that correspond to the source file. If the import was unsuccessful, an error message is displayed in the Activity module and also in the Audit log.

Viewing import exceptions reports
If a data import is unsuccessful, an exception report detailing the problems with the import is automatically generated in the Import log in IBM® Cognos® Incentive Compensation Management.

Procedure
1. In the Audit module, click the Import tab.
2. From within the Import log, you can complete the following actions:
   • Clear all error reports.
   • Copy the report text.
   • View all reports within a specified date range.

Changing the import escape character
You can set the import escape character to import files that contain a delimiter into the IBM® Cognos® Incentive Compensation Management client.

About this task
The following import escape characters are available: (/ \ * ^ '). For example, if you choose a quotation mark as the import escape character, Payee, Date, Value from a comma delimited file would import as First Name, Last Name, 1/1/2009, 50.
**Important:** By default, the import escape character is a quotation mark. This setting is a global setting for all imports. Make sure that your data does not contain the import escape character that you specify; otherwise, your import will fail.

**Procedure**
1. Click **Admin > Administrative Options**.
2. On the **General** tab, type the **Import Escape Character**.
3. Click **OK**.

**Managing saved imports**

You can use the Manage Saved Imports feature in IBM® Cognos® Incentive Compensation Management to delete saved or local imports or edit details of the import. For example, you can delete the name of the import, the data source, the destination table, or column mapping.

**About this task**

Users can also run client-side imports from this window. Server-side imports can be run only from the Scheduler module.

**Important:** To edit a server import, you must specify an import directory in the Cognos Incentive Compensation Management Service configuration file.

**Procedure**
1. Click **Admin > Manage Saved Imports**.
2. Click the **Local** or **Server** tab.
3. Select the import.
4. Click **Edit**, **Delete**, or **Run**.

**Using a remote directory for saved imports**

Before you can use a remote directory for saved imports, you must change the login credentials for the administrator that runs the Scheduler and Service in IBM® Cognos® Incentive Compensation Management to match an account with access to the directory with the saved import.

**About this task**

The Service user credentials can be edited from the Service Properties window.

**Procedure**
1. In the Cognos Incentive Compensation Management service configuration file, indicate the location of the import file directory:
   ```xml
   <add key="ImportFileDirectory" value="\Network\DirectoryName"/>
   ```
   **Important:** The user must have full rights to the specified directory.
2. To access the Service Properties window, go to **Control Panel > Administrative Tools > Services**.
3. Right-click the Cognos Incentive Compensation Management Windows Service and click **Properties**.
4. On the **Log On** tab, select **This account** and type the account information.
5. Click OK.

6. In the Cognos Incentive Compensation Management client, use the Import Data wizard to save clients.

7. Click Browse on the Step 4 window of the Import Data wizard to access the files available in the specified import file directory.

---

**Data from IBM Cognos Territory and Quota Management**

Assignment detail reports created in IBM® Cognos® Territory and Quota Management can be imported and used as sources in calculations and reports in IBM® Cognos® Incentive Compensation Management.

After you create the Cognos Territory and Quota Management object in the Cognos Incentive Compensation Management client, you can synchronize data manually through a right-click option or at predetermined intervals with the Scheduler module.

**Adding an IBM Cognos Territory and Quota Management object in Composer**

Details of credit assignments from IBM® Cognos® Territory and Quota Management are pulled into a Cognos Territory and Quota Management object in the IBM® Cognos® Incentive Compensation Management client.

**Before you begin**

Make sure you configured access to your Cognos Territory and Quota Management instance in the Cognos Incentive Compensation Management Windows service configuration file. For more information, see the *IBM Cognos Incentive Compensation Management Installation and Configuration Guide*.

**Procedure**

1. In Composer, drag the Territory Management object from the Palette tab onto the Composer window.

2. In the Sync with Territory Management window, type valid Cognos Territory and Quota Management login credentials and click Login.

3. Select the detail report that you want to link to Cognos Incentive Compensation Management and type a name.
   The Cognos Incentive Compensation Management application creates a table with columns that are identical to the assignment report.

   **Name of Territory Management table**
   
   This is the display name for the Cognos Territory and Quota Management object in Cognos Incentive Compensation Management. The name cannot contain any spaces.

   **Choose a report**
   
   This is the assignment detail report that you are importing.

   **Column Name Preview**
   
   You can change the column types of the report that you are importing. A text column can be changed to a date or numeric column. A date column can be changed to a text column. A numeric column can be changed to a text column.
IBM Cognos Territory and Quota Management data synchronization

After you add your IBM® Cognos® Territory and Quota Management object to your model, you can synchronize data from Cognos Territory and Quota Management with the data in the IBM® Cognos® Incentive Compensation Management client at any time.

When data is synchronized, all the data in the Cognos Territory and Quota Management object is deleted and replaced with the current data in the Cognos Territory and Quota Management assignment report.

Loading data manually into an IBM Cognos Territory and Quota Management object

You can load data into the IBM® Cognos® Territory and Quota Management object in Composer in IBM® Cognos® Incentive Compensation Management.

Procedure

In Composer, right-click the Cognos Territory and Quota Management object into which you want to load data and click Synchronize.

Results

An Activity tab opens to display the progress of the synchronization.

Scheduling an import from IBM Cognos Territory and Quota Management

You can load data into your IBM® Cognos® Territory and Quota Management object by using the Scheduler module in IBM® Cognos® Incentive Compensation Management.

Procedure

1. In Scheduler, add or select a process folder to which you want to add the table synchronization.
2. Select the Territory Management Table Synchronization task from the Add Task list in the toolbar.
3. Select the Cognos Territory and Quota Management object to import into and click OK.
4. Right-click the task and set the schedule.

Switching the report that is associated with an IBM Cognos Territory and Quota Management object

You can change the report that is associated with your IBM® Cognos® Territory and Quota Management object in IBM® Cognos® Incentive Compensation Management.

About this task

The original report and target report must have matching schemas.

Procedure

1. In Composer, right-click the Cognos Territory and Quota Management object, and click Edit Territory Management Source.
2. Select the report that you want to switch to.
3. Click Import.
Data from IBM Cognos Producer Lifecycle and Credential Management

You can import tables from IBM Cognos Producer Lifecycle and Credential Management into IBM® Cognos® Incentive Compensation Management. You can then use them as sources in tables, calculations, and reports.

After a Cognos Producer Lifecycle and Credential Management object is added to Composer, data can be synced manually or at predetermined intervals by using the Scheduler module. Cognos Producer Lifecycle and Credential Management can be synchronized only with Unicode models in Cognos Incentive Compensation Management. When empty effective dates are imported into Cognos Producer Lifecycle and Credential Management, the date is transformed to 12/31/9998 and numeric IDs are converted to text.

Calculations and reports cannot be made inside the Cognos Producer Lifecycle and Credential Management component. The Cognos Producer Lifecycle and Credential Management tables are imported as global tables. Global tables can be used as sources from within any component in Composer.

Data and custom tables can pick list to Cognos Producer Lifecycle and Credential Management tables that have exactly one string-type key column after synchronization.

Adding an IBM Cognos Producer Lifecycle and Credential Management object

You can add tables from IBM® Cognos® Producer Lifecycle and Credential Management into your object in Composer in IBM® Cognos® Incentive Compensation Management.

About this task

You can add only one Cognos Producer Lifecycle and Credential Management object in Composer.

Procedure

1. In Composer, from the Palette tab, click-and-drag the PLCM object onto the Composer window.
2. Type the password that you use to log in to Cognos Producer Lifecycle and Credential Management.
3. Click Login.

IBM Cognos Producer Lifecycle and Credential Management data synchronization

After you add your IBM® Cognos® Producer Lifecycle and Credential Management object to your model, you can synchronize data from Cognos Producer Lifecycle and Credential Management with the data in the IBM® Cognos® Incentive Compensation Management client at any time.

When you run a data synchronization, the tables from Cognos Producer Lifecycle and Credential Management are imported into the Cognos Producer Lifecycle and Credential Management object as global tables. Global tables can be used as sources within any component in Composer.
Data can be synchronized with Unicode models only in Cognos Incentive Compensation Management. When data is synchronized, all the data in the Cognos Producer Lifecycle and Credential Management object is deleted and replaced with the current data in the Cognos Producer Lifecycle and Credential Management application.

**Loading IBM Cognos Producer Lifecycle and Credential Management data into an object manually**
You can load data into your IBM® Cognos® Producer Lifecycle and Credential Management object through Composer in IBM® Cognos® Incentive Compensation Management.

**Procedure**

In Composer, right-click the Cognos Producer Lifecycle and Credential Management object and click **Synchronize PLCM**.

**Results**

The Activity module displays the progress of the synchronization.

**Scheduling an import of IBM Cognos Producer Lifecycle and Credential Management data into an object**
You can load data into your IBM® Cognos® Producer Lifecycle and Credential Management object by using the Scheduler module in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In Scheduler, add or select a process folder to which you want to add the table synchronization.
2. From the **Add Task** list in the toolbar, select **PLCM Synchronization**.
3. Right-click the task and set the schedule.
Chapter 9. Activity tab

The Activity tracking tab in IBM® Cognos® Incentive Compensation Management opens automatically when you run an activity such as an import, model optimization, migration, calendar lock or unlock, calculation, task generation, and task run.

When you begin one of these processes, the Activity tab opens and tracks the progress of the process. You can work in other modules while the process is running.

The Activity tab records up to 100 activity logs per user. However, running activities are shown only in the session in which they were started. You can delete records of individual activities or all activities from the tab. If an activity results in an error, you can view the error message in the Activity tab.

Important: Users are only able to see their own activities, not all activities that are completed in the model.

Viewing the Activity tab

You can use activity tracking in IBM® Cognos® Incentive Compensation Management to delete activities or view the details of an activity.

Procedure
1. Right-click a tab and click Activity.
2. From within the Activity tab, you can complete the following tasks:
   • To delete an activity, click the X next to the activity that you want to delete.
   • To delete all the listed activities, click the Clear All button.
   • To view details of an activity that resulted in an error, click Details.

Viewing error details on the Activity tab

When an activity does not complete in IBM® Cognos® Incentive Compensation Management, details of the error are displayed. The error details remain until the activity entry is deleted by the user.

Procedure
1. On the Activity tab, to view details of an activity that resulted in an error, click Details.
2. To copy the text of the error message, highlight the text, right-click, and click Copy. The text is now ready to be pasted into an email for troubleshooting.

© Copyright IBM Corp. 2005, 2015
Chapter 10. Input forms

Use input forms in IBM® Cognos® Incentive Compensation Management to control the tables and table fields that are viewable and editable by particular administrators.

Often there are situations when someone must be able to edit specific information in a certain table, but it would not be prudent to grant that person complete access to every table. To ensure data integrity, it is important that data changes can only be made by authorized users. By adding an input form, you can not only define what table is editable, you can also select which table fields to display and what type of data can be entered in editable fields.

Important: After changes are made through an input form, they are applied directly and immediately to the table.

Adding an input form

In IBM® Cognos® Incentive Compensation Management, you can define what tables and table fields are viewable and editable to users by adding an input form to the table in Composer.

Procedure

1. In Composer, select the table that you want to make available for editing or review.
2. Right-click the table and click Input Forms > Add Input Form.
3. Type a Name for the input form and click Next.

   Important: The primary key columns are automatically displayed as selected columns.

4. Drag the columns you want to be viewable and editable to users from All Columns to Selected Columns, then click Next.

   Tip: The primary key field must be selected.

5. To set default values for a column, click the Default Values link.
   a. Select the Enable Default Value check box.
   b. Select the default value you want to use from the Default Value menu.
   c. Click OK.

6. To mark individual columns as read-only, select the Read Only check box.

7. To configure reference column options for an input form column, click the Options link.
   a. To add a tab in the input form based on a reference column in the input form, select the Tab check box and type a Tab Name.
      A tab cannot have an empty name.
   b. Leave the Jump To check box selected to enable the Jump To feature for reference columns.
   c. Click OK.

8. Click Next.

9. Define any restrictions and click Next.
Important: Restrictions can be used as static filters.

10. To change the display name of a column, complete one of the following steps:
    • Double-click the column to change the display name.
    • Right-click the column and click Edit Column Name.

11. Click Finish.

Assigning security to input forms

After you add an input form in IBM® Cognos® Incentive Compensation Management, you must grant users the ability to view, edit, and delete the form.

Procedure

1. Click Admin > Manage Roles.
2. Select an existing role, or add a role and highlight it.
   All the flags are red by default, which indicates that this role has no access to the items in the Cognos Incentive Compensation Management client.
3. To find your input form, click Composer > Table > Table where you created your input form > Input Forms.
   Notice that default input forms are created for each table.
4. Right-click your input form and click Grant or expand the input form and right-click Add, Delete, Edit, History, or View and click Grant.
   The flag becomes green, indicating that the role has access to the input form. Users must have view permission for input forms to complete any of these actions.
5. To allow the user to view the Composer module, collapse Table, right-click View, and click Grant.
6. To allow the user to add, edit, and delete input forms, right-click Input Forms and click Grant.
   The user must also have edit permission for Composer. If the table the input form belongs to is in a component, the user must also have view and edit permission for the component.
7. To allow the user to add, edit, or delete input forms, expand Input Forms, right-click Add, Edit, or Delete, and click Grant. Users must have view permission for the input form to be able to edit or delete the form.

Assigning users to the input form role

After you add a role in IBM® Cognos® Incentive Compensation Management, you must assign specific users to that role so that they can have input form permissions.

Procedure

1. Go to Admin > Manage Users.
2. Click Add, or highlight a user ID and click Edit.
   a. If you clicked Add, type a user ID, user name, email, and password for the user.
3. Select the input form role in the Role menu.
4. Click OK.
Adding input form validation rules

After you add an input form in IBM® Cognos® Incentive Compensation Management, you can define validation rules to make sure that data in a particular field is valid. These rules are applied to specified columns and can be number or text-based.

**Procedure**

1. In Composer, right-click the table element that contains the input form and click **Input Forms > Edit Validation Rules**.
2. In the Validation Rules window, click **Add**.
3. Select **Numeric** or **Text** for the validation rule type, and click **Next**.
   - **Important**: Additional sources cannot be joined to the table to add a validation rule.
4. Type a rule name.
5. Type an invalid input message that will be displayed to the user when the rule is violated.
   - For example, if you selected a numeric rule type, then the rule might be called Greater than or equal to zero and the invalid input message would be Value must be greater than or equal to zero.
6. If you selected **Numeric**, complete the following steps:
   - a. Drag the column into the formula box.
   - b. Add your formula.
      - For example, drag the **Product Quota** column into the formula box, click > = and type 0.
7. If you selected **Text**, complete the following steps:
   - a. Select the column from the column menu that you want to add a regular expression for.
   - b. Type a regular expression.
   - c. Type sample text.
   - d. Click **Test** to test your regular expression.
      - A message that states: The sample is a match to your regular expression indicates that you used the correct expression.
   - **Important**: Regular expressions are used for text-based rule validation to make sure that data that is entered a particular field is valid.
8. Click **Finish** and click **Close**.

Viewing an input form

After an input form is added in IBM® Cognos® Incentive Compensation Management, the administrators with appropriate access can view the input form.

**Procedure**

1. Double-click the table that contains the input form.
2. In the Input Form Selector window, select the input form you want to view and click **OK**.
   - The input form opens in a new tab.
Change submission through an input form

IBM® Cognos® Incentive Compensation Management administrators with appropriate access can add data or make changes to the specified table fields. When a change is made through the input form, it is applied directly to the table.

Adding a new row to an input form

In IBM® Cognos® Incentive Compensation Management, you can add a new row to an input form by entering the data directly in the columns of the first blank row in the table and pressing Enter to submit the row. You can also use the Row Editor to add a new row.

Procedure
1. Open the input form.
2. Click the Show Row Editor icon.
3. In the top panel of the Row Editor, click the Add Row icon or the Add button, and enter the data in the blank fields.
4. Click Submit. You can also submit the row to the table by clicking Add.

Editing a row in an input form

In IBM® Cognos® Incentive Compensation Management, you can edit a row in an input form by selecting the cell containing the data and making the changes directly in the table, or you can also use the Row Editor.

Procedure
1. In the table, select the row that you want to edit.
2. Click the Show Row Editor icon.
3. In the top panel of the Row Editor, edit the data in the fields and click Submit. When you click Add, you also submit changes to the table.
4. To move to a row before the selected row in the table, click the Previous Row icon or click the Edit Prev button.
5. To move to a row after the selected row in the table, click the Next Row icon or click the Edit Next button.
Chapter 11. Calculation creation

In IBM® Cognos® Incentive Compensation Management, the process of transforming your company's data into compensation results begins with calculations.

Calculations enable the model administrator to select records from the source data, complete operations on the data, segment the results, and begin another calculation based on those results.

When the Calculation wizard is first launched, you are prompted to select a calculation type. Cognos Incentive Compensation Management offers a selection of many different types of calculations. User-defined calculations are the most common because they offer complete flexibility when you select data sources, define mathematical formulas, and partition results.

The calculation engine can create highly complex, multi-step calculations that can accommodate any compensation plan or analytical calculation requirements. Calculation templates make it easier to set up certain common calculations. Every calculation is created with the Calculation wizard, which uses five steps for calculation creation.

**Tip:** To access help related to each step of the Calculation wizard, press F1.

Calculation types

You can use several kinds of calculations in Composer in IBM® Cognos® Incentive Compensation Management to create compensation results.

**Table 8. Calculation types**

<table>
<thead>
<tr>
<th>Calculation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-Defined</td>
<td>If the standard templates do not address the complexity of your compensation calculations in a single step, select this item to define a user-defined calculation. Administrators can use multiple data sources and custom formulas in user-defined calculations.</td>
</tr>
<tr>
<td>Sort</td>
<td>A custom-defined sort calculation. You can use this more flexible and powerful interface to select top performers or to identify areas for improvement.</td>
</tr>
<tr>
<td>Time Shift</td>
<td>A calculation type that is used to shift results across time periods. This calculation type is useful for examining results from previous periods.</td>
</tr>
<tr>
<td>Category</td>
<td>A calculation type that is used to evaluate each row of a source against an unlimited series of restrictions. Category values are added to the rows, depending on the restriction that applies to it. This calculation type can be used to organize records in tables or calculations into different categories.</td>
</tr>
</tbody>
</table>

In the first step of the Calculation wizard, you must name the calculation and select a type of calculation. Additionally, you can type a description for the calculation. The description can be viewed as a header in Payee Ledger if the calculation is added to a compensation plan.
Data sources for calculations

Each calculation in IBM® Cognos® Incentive Compensation Management begins with data.

Initially, any non-system table is available as a calculation source.

After you create one or more calculations, you can select any other calculation result as a source for a new calculation. You can also use draw results as data sources.

After you select a source, the fields of the table (or calculation result) are displayed in the Add Data Source pane of the Calculation wizard.

Changing the size of Calculation wizard icons

You can increase or decrease the size of the icons in the Calculation wizard in IBM® Cognos® Incentive Compensation Management to minimize the amount of scrolling that is required to view table columns.

Procedure

1. In step 2 of the Calculation wizard, in the Add Data Source pane, click the arrow next to the Preview button.
2. Select Large Icons, Medium Icons, or Small Icons.

Calculation wizard column icons

To help you evaluate the type of data in the Calculation wizard in IBM® Cognos® Incentive Compensation Management data source, different types of columns, such as date and numeric columns, have different icons.

The following table describes column icons in the Calculation wizard. If a column displays a key icon, the column is a key column in the table.

Table 9. Column icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder Icon" /></td>
<td>Any links that connect the selected source to other tables are denoted with a folder icon. You can access the contents of the linked tables by double-clicking the folder icon.</td>
</tr>
<tr>
<td><img src="image" alt="Date Icon" /></td>
<td>Date fields are denoted with a blue calendar icon.</td>
</tr>
<tr>
<td><img src="image" alt="Text Icon" /></td>
<td>Text fields and email fields are denoted with a page icon.</td>
</tr>
<tr>
<td><img src="image" alt="Calendar Icon" /></td>
<td>A field that links to a calendar is denoted by a red calendar icon. You can drill into a period to access the Time ID, Level, Parent, and Starting and Ending dates.</td>
</tr>
<tr>
<td><img src="image" alt="Value Icon" /></td>
<td>Numeric fields are denoted with a value icon.</td>
</tr>
</tbody>
</table>
Table 9. Column icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="dialog_icon.png" alt="Image" /></td>
<td>Comment and URL fields are denoted with a dialog icon.</td>
</tr>
</tbody>
</table>

**Calculation wizard keyboard shortcuts**

You can use several keyboard shortcuts to find and add sources in the Calculation wizard in IBM® Cognos® Incentive Compensation Management.

*Table 10. Keyboard shortcuts*

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Keys</td>
<td>To move up, down, left, and right through the sources in the Available Sources pane, use the arrow keys.</td>
</tr>
<tr>
<td>Enter</td>
<td>To add a selected source to the Add Data Source pane, press Enter.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>To open the Available Sources pane and focus on the Search field, click Ctrl + F.</td>
</tr>
</tbody>
</table>

**Multiple sources**

More than one data source must be referenced in a single calculation in IBM® Cognos® Incentive Compensation Management.

For example, one table might contain all of the sales data that is required to calculate total sales, and another might contain quotas and compensation rates that must be applied. Multiple sources are required for this calculation.

The Cognos Incentive Compensation Management model administrator can add multiple additional sources to the current source. Depending on your calculation and the data in your tables, you can add either rows or columns to your source table.

**Important:** Adding columns produces the same result as creating a View in Composer. However, Views cannot be used as sources in calculations.

**Columns**

In IBM® Cognos® Incentive Compensation Management, you can join two or more tables or calculations together to define the data sources for your calculation by adding columns.

Normally, you join data sources together based on a point of commonality by defining restrictions for the join.

For example, consider a situation where you join a product table to a payee table to display the products that were sold by each payee. If you restrict, or join, your results based on the payee ID, you can get the results shown in the following tables.
Table 11. Payee table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacobs</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
</tr>
</tbody>
</table>

Table 12. Product table

<table>
<thead>
<tr>
<th>ProductID</th>
<th>ProductName</th>
<th>PayeeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Printer</td>
<td>001</td>
</tr>
<tr>
<td>234</td>
<td>Cable</td>
<td>001</td>
</tr>
<tr>
<td>345</td>
<td>Monitor</td>
<td>003</td>
</tr>
</tbody>
</table>

Table 13. Result of joining the Payee table and Product table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>ProductID</th>
<th>ProductName</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>345</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

Important: No data is displayed for Sue Jacob (002) or Mary Scott (004) because there are no corresponding rows in the Product table for those payees.

You can use restrictions to join each new source to an existing source based on a point of commonality. For example, if the initial source contains transactional data for each payee, and the second source contains compensation rates to be applied to sales, you must specify how to associate the two types of payee data. If the compensation rates vary based on job title, and Title ID is contained in both tables, they can be joined on that basis, for example, ERP.TitleID = Rates.TitleID.

Adding restrictions is an important part of adding a data source. If you do not create restrictions, each row in the new source is added to each row in the existing source. This action creates many more rows than either source would have individually.

For example, if the first source had 100 rows and the second had 50 rows, the result of a join with no matches would be 100 x 50 = 5000 rows, or a row for each possible combination of rows in the two sources.

While restrictions are normally necessary, there might occasionally be instances where you want to display all the possible row combinations when you join two tables. Imagine that you have a product table and a payee table, and you want a table that shows each product that might potentially be sold by each payee.

Table 14. Payee table

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
</tr>
</tbody>
</table>
Table 14. Payee table (continued)

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>004</td>
<td>Mary Scott</td>
</tr>
</tbody>
</table>

Table 15. Product table

<table>
<thead>
<tr>
<th>ProductID</th>
<th>ProductName</th>
<th>PayeeID</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Printer</td>
<td>001</td>
</tr>
<tr>
<td>234</td>
<td>Cable</td>
<td>001</td>
</tr>
<tr>
<td>345</td>
<td>Monitor</td>
<td>003</td>
</tr>
</tbody>
</table>

Imagine that you complete the following steps:
1. Define the payee table as your first source.
2. Add columns to the payee table from the product table.
3. Decline to add restrictions.

Your join produces the results in the following table.

Table 16. Imposing restrictions example

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Name</th>
<th>ProductID</th>
<th>ProductName</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>John Smith</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>001</td>
<td>John Smith</td>
<td>345</td>
<td>Monitor</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>002</td>
<td>Sue Jacob</td>
<td>345</td>
<td>Monitor</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>003</td>
<td>Marc Frederick</td>
<td>345</td>
<td>Monitor</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
<td>123</td>
<td>Printer</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
<td>234</td>
<td>Cable</td>
</tr>
<tr>
<td>004</td>
<td>Mary Scott</td>
<td>345</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

Important: This example represents an unrestricted join, where every row on the first table is matched to every row on the second table. It is important to carefully define joins to make sure that your information is returned as intended.

Adding additional sources by columns

In IBM® Cognos® Incentive Compensation Management, you can join two or more data sources together in a calculation to compare the data sources or use the data in a formula.

Procedure
1. In the Define Data Sources step of the Calculation wizard, drag the first source from the Available Sources pane to the Add Data Source pane.
2. Drag the second source from the Available Sources pane and place it after the first source in the Add Data Source pane.
3. To rename the additional source, double-click the source name in the Add Data Source pane.

4. If you do not want to define restrictions, click Next without joining any columns.

5. If you want to define restrictions, select the second source in the Add Data Source pane.

   The source is outlined in blue. The Calculation wizard automatically create restrictions between the sources. Any text, date, email, or pick list columns that have the same name and column type in the two sources are joined.

6. To manually define the restrictions for the join, complete the following steps:
   a. In the Define Restrictions pane, right-click and click Add New Restriction or drag a column from the source to the Define Restrictions pane.
   b. To create the restriction, drag a column from a data source in the Add Data Source pane and place it in the first restriction field.
   c. Select an operator for the restriction from the Operator menu.
   d. Select a value from the menu in the second restriction field, or drag another column to the second restriction field to define the restriction.

7. If you want to remove all the restrictions for the selected source, click Clear.

8. When you finish joining sources, click Next.

**Anchor feature**

You can use the Anchor feature in the Calculation wizard in IBM® Cognos® Incentive Compensation Management to join sources with a left outer join.

This join type displays rows for all records for the first data source even if the join does not find matching records in the second data source. Only matched records from the second data source are returned. If the second data source returns one row and the first data source returns more than one matching row for it, the values in the second source are repeated for each distinct row in the first data source.

Consider a situation where you have the following two data sources:

**Table 17. Source 1**

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
</tr>
<tr>
<td>Brain Acton</td>
<td>001</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
</tr>
</tbody>
</table>

**Table 18. Source 2**

<table>
<thead>
<tr>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>002</td>
<td>Development</td>
</tr>
<tr>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>005</td>
<td>Training</td>
</tr>
</tbody>
</table>
When you preview from step 2 of the Calculation wizard, when the Anchor feature is used, records from the first data source are returned even when there is no matching record in the second source.

Table 19. Results from joining the sources and using the anchor feature

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>Brain Acton</td>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
<td>Development</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you partition an anchored source, any partitions that have null results are removed. When you preview from step 4 with Name, Department ID, and Department Name as partitions, Chris Ackles is removed from the data set. However, if you partition by Name only, Chris Ackles is included.

Adding a left outer join in a calculation

When you join sources by columns in IBM® Cognos® Incentive Compensation Management, you can use a left outer join to display rows for all records for the first data source even if the join does not find matching records in the second data source.

Procedure

1. In the Define Data Sources step of the Calculation wizard, add an initial source.
2. Add a second source and apply a join restriction.

   **Important:** If you have many joined sources, at least one join restriction is required to add a left join.

3. Right-click the first source and click Anchor Base Source to enable left join functionality.

Results

A blue anchor icon is displayed on the first source.

Renaming a joined source

You can give an alias to sources that are joined by columns in IBM® Cognos® Incentive Compensation Management.

Procedure

1. In the Add Data Source pane, select the joined source.
2. Double-click the name of the source and type the new name.

   **Important:** If you are using Large Icon or Medium Icon mode, the original name of the source is displayed in brackets after the alias name. If you are using Small Icon mode, you can view the original name of the source by hovering your mouse over the alias name.
Switching a joined source
A joined source can be switched in the Add Data Source pane of the Calculation wizard in IBM® Cognos® Incentive Compensation Management. When a source is switched, it retains its original name and join restrictions.

Procedure
1. To switch a joined source, right-click the source in the Add Data Source pane of the Calculation wizard and click Switch Source.
2. Type the name of the source in the search field, or select the source that you want to switch to from the list.

Joining sources automatically
You can use the Auto Join button to join a source to any additional source in the Calculation wizard in IBM® Cognos® Incentive Compensation Management.

About this task
When the Auto Join button is clicked, any matching columns between the two sources are joined. The columns must have the same column type (date, text, email, or pick list) and name.

For information on enabling joins to occur automatically, see [Enabling automatic joins in calculations](#).

Procedure
1. In step 2 of the Calculation wizard, select the first source in the Add Data Source pane.
2. In the Define Restrictions pane, from the Join With list, select the source to which you want to join the first source.
3. Click Auto Join.
4. To remove the restrictions for the selected source, click Clear.

Rows
In the Calculation wizard in IBM® Cognos® Incentive Compensation Management, you can create a union between data sources.

You might find that joining sources (adding columns) does not organize your data in a way that creates the results that you want. If so, you can append sources by adding rows. This feature is similar to adding columns in that both options are used to relate information from multiple sources.

Consider a plan that pays compensation to employees based on their total sales minus any returns that are made by month. Look at the information for employee 001.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Total Sales</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>1500</td>
<td>Month 1</td>
</tr>
<tr>
<td>001</td>
<td>250</td>
<td>Month 1</td>
</tr>
<tr>
<td>001</td>
<td>700</td>
<td>Month 2</td>
</tr>
<tr>
<td>001</td>
<td>500</td>
<td>Month 3</td>
</tr>
</tbody>
</table>
Table 21. Return data table

<table>
<thead>
<tr>
<th>Employee</th>
<th>Returns</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>-100</td>
<td>Month 1</td>
</tr>
<tr>
<td>001</td>
<td>-50</td>
<td>Month 2</td>
</tr>
</tbody>
</table>

If you follow these steps to add rows from the return data table to the sales data table, the results match the **Results of adding rows** table.

1. Add rows from the return data table to the sales data table.
2. Look for a sum of the total sales.
3. Partition the results by months.

Table 22. Results of adding rows

<table>
<thead>
<tr>
<th>Total Sales</th>
<th>Months</th>
</tr>
</thead>
<tbody>
<tr>
<td>1650</td>
<td>Month 1</td>
</tr>
<tr>
<td>650</td>
<td>Month 2</td>
</tr>
<tr>
<td>500</td>
<td>Month 3</td>
</tr>
</tbody>
</table>

A result is shown for Month 3, even though there is no record for that month in the return data table. If you link these tables by adding columns, the row containing March would not be displayed.

All columns in the source table must be mapped to a column in the union table. For this reason, the columns in the source table must be similar to the columns in the union table. For example, both the Sales data table and the Return data table had employee ID, amount, and date columns.

**Adding additional data sources by rows**

You can join two or more data sources together by rows when you create a calculation in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In the Define Data Sources step of the Calculation wizard, drag the first source from the Available Sources pane to the Add Data Source pane.
2. Drag the second source from the Available Sources pane and place it on top of the first source in the Add Data Source pane.
   The second source is highlighted in gray.
3. To define the join, click the second source.
4. To make changes, click the **Clear** button to remove the column mapping.
5. When you finish defining the column mapping for the unions, click **Next**.

**Data preview**

After you select your data sources, you can use the **Preview** button to display the rows of data that you want to use in your calculation in IBM® Cognos® Incentive Compensation Management.

You can examine the results that are generated by adding columns or rows to your data source before you run a calculation. Only the top 100 rows are displayed.
Formulas

In the Define Formula step of the Calculation wizard in IBM® Cognos® Incentive Compensation Management, you can create the multiplier (or a more complex formula) for the calculation.

Any numeric value can be pulled directly from the sources tree into the formula window.

You can use various formulas (for example, SUM, MIN, MAX, IF, AND, OR, and NOT) to set up the calculation that you want.

In addition, you can click the Preview button to examine the results of each formula before you proceed.

**Important:** Each formula must satisfy only a portion of the requirements of the entire compensation calculation. For example, consider a compensation plan that requires the following calculations: totaling product sales for the month, determining the appropriate compensation rate based on the sales amount, and then calculating the compensation payout. This plan might be conceptually understood more easily in three calculations than in a single step. You can create three separate calculations that build on each other to obtain the final result.

**Formula operators**

You can use several formula operators to set up the calculations that you want to create in IBM® Cognos® Incentive Compensation Management.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SUM()</strong></td>
<td>This operator takes the aggregate of whatever is within the brackets and provides a total.</td>
<td>To calculate 5% of the value of each sale as commission: $\text{SUM(SourceTable.ValueColumn)} \times 0.05$</td>
<td>$\text{SUM(Value)}$</td>
<td>The use of SUM is recommended for most calculations as it will not only provide you with the proper summed amount for your calculation, but will also enable clear reporting in Payee Ledger. If you are showing negative values in Payee Ledger, make sure your formula is using the SUM operator.</td>
</tr>
<tr>
<td><strong>COUNT()</strong></td>
<td>This operator gives a value of 1+ for each record that has a value. The value of each record is one more than the previous amount.</td>
<td>To calculate the total number of deals in a period: $\text{COUNT(SourceTable.ValueColumn)}$</td>
<td>$\text{COUNT(Value)}$</td>
<td>If the data is partitioned by PayeeID and Month, the count will reset back to zero after each month and start again.</td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Example</td>
<td>Syntax</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>MAX()</td>
<td>This operator takes the maximum value of a set of results.</td>
<td>If, for each deal, you receive a 5% commission but there is a minimum of $5 per deal you earn, you can use the following formula to determine whether the 5% commission is higher than the $5 minimum: MAX(Data.Value*0.05, $5)</td>
<td>MAX(Value1, Value2, Value3, etc.)</td>
<td>If you have an if statement similar to the following example: IF(A&gt;B,A,B), you may want to use the MAX operator.</td>
</tr>
<tr>
<td>MIN()</td>
<td>This operator takes the minimum value of a set of results.</td>
<td>If 5% commission is paid on each deal to a maximum of $100, the following formula pays either 5% commission or $100, whichever is less: MIN(Data.Value*0.05 , 100)</td>
<td>MIN(Value1, Value2, Value3, etc.)</td>
<td></td>
</tr>
<tr>
<td>AVG()</td>
<td>This operator takes the average of the value within the brackets.</td>
<td>If a product has a set price, but sales reps can sell above or below this price, the following formula compares their average monthly sale value to the set price and pays commission based on their gross margin: (AVG Sale - Set Price)/ Set Price</td>
<td>AVG(Value)</td>
<td></td>
</tr>
<tr>
<td>IF()</td>
<td>You can use this operator to perform a logical test and provide a true and false result.</td>
<td>If the sale amount is greater than $100, you receive a 5% commission. Otherwise, you receive a 2% commission. IF(Data.Value &gt; 100, Data.Value * 0.05, Data.Value * 0.02)</td>
<td>IF(Logical Test, True Result, False Result)</td>
<td>Nested IF() example: If your sale amount is greater than $100, you receive 5% commission. If your sale is greater than $50, you receive 3%; otherwise, you receive 2%. IF(Data.Value &gt; 100, Data.Value * 0.05, IF(Data.Value &gt; 50, Data.Value * 0.03, Data.Value * 0.02))</td>
</tr>
<tr>
<td>ISNULL()</td>
<td>This operator takes a date or numeric field and provides a true result if the field does not have a value (the equivalent of NULL in the database).</td>
<td>If(IsEmpty(Payee.DateOfHire), DefaultDate, Payee.DateOfHire)</td>
<td>ISNULL(Value)</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Example</td>
<td>Syntax</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td><strong>AND()</strong></td>
<td>This operator returns results if all conditions are true. If you use the AND operator to return results for Logical Test 1 and Logical Test 2, results that include both Value 1 and Value 2 are returned.</td>
<td>If you want to show results for transactions that are bigger than $1,000 and less than $10,000, use a formula similar to the following example: AND(SourceTable.ValueColumn &gt; 1000, SourceTable.ValueColumn &lt; 10000)</td>
<td>AND(Logical Test 1, Logical Test 2)</td>
<td></td>
</tr>
<tr>
<td><strong>OR()</strong></td>
<td>This operator returns results if one or more conditions are true. If you use the OR operator to return results for Logical Test 1 or Logical Test 2, any records with either value are returned.</td>
<td>If you want to show a result of 1 for values that fall between 10,000 and 20,000 and a result of zero for all other values, use a formula similar to the following example: IF(OR(SourceTable.ValueColumn &lt; 10000, SourceTable.ValueColumn &gt; 20000), 0, 1)</td>
<td>OR(Logical Test 1, Logical Test 2)</td>
<td></td>
</tr>
<tr>
<td><strong>NOT()</strong></td>
<td>This operator returns results when a condition is not met. You can use this function to exclude records from your results.</td>
<td>If you want to apply a 5% commission to all transactions, except when the transaction value is less than $1,000, use a formula similar to the following example: SUM((SourceTable.ValueColumn)*0.05, NOT(SourceTable.ValueColumn &lt; 1000))</td>
<td>NOT(Logical Test)</td>
<td></td>
</tr>
<tr>
<td><strong>ABS()</strong></td>
<td>You can use this operator to take the value within the brackets and show the number as a positive, regardless of whether the value within the brackets is positive or negative.</td>
<td>If you want to show the difference between this month’s sales and last month’s sales as a percentage, but you do not want the percent change to be a negative value, use a formula similar to the following example: ABS((Current - Prior)/Prior)</td>
<td>ABS(Value)</td>
<td></td>
</tr>
</tbody>
</table>
Table 23. Formula operators (continued)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUND()</td>
<td>This operator uses Banker’s Rounding to round the results in the brackets. For example, 0.5 rounds to 0, but 0.51 rounds to 1.</td>
<td>If you want to round your results to the nearest cent, use a formula similar to the following example: ROUND(Result, 2)</td>
<td>ROUND (Value, Decimal Places)</td>
<td>You must specify the value you want to round, then the amount of decimal places you want to round to. Type 0 for a whole number, 1 for one decimal place, 2 for two decimal places, etc.</td>
</tr>
<tr>
<td>ROUNDDOWN()</td>
<td>This operator rounds any number down towards zero by the number of decimal places that you define in the formula.</td>
<td>If you want to round your results down to two decimal places, use a formula similar to the following example: ROUNDDOWN(Result, ValueColumn, 2)</td>
<td>ROUNDDOWN (Source Table, ValueColumn, num_digits)</td>
<td>num_digits in the number of digits to which you want to round the number. If num_digits &gt; 0, then the number is rounded down to the specified number of decimal places. If num_digits = 0, then the number is rounded down to the nearest integer. If num_digits &lt; 0, then the number is rounded down after the decimal point.</td>
</tr>
<tr>
<td>MULT()</td>
<td>This is used to multiply numerous numbers together.</td>
<td>If you wanted to multiply all the values in your data table together, use a formula similar to the following example: MULT(Data.Value)</td>
<td>MULT(Value)</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Example</td>
<td>Syntax</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>PREV()</td>
<td>The PREV() operator references to the previous value of the calculation you are editing along its accumulating partition. This is important any time you have a situation where you must have explicit access to the previous iteration of the calculation you are editing to come up with the required current period results.</td>
<td>If a minimum of $500 is to be paid each month to each rep but if commissions fall short, they have to be clawed back in subsequent months, use a formula similar to the following example: MAX(0, PREV() + Monthly Minimum.Value - Monthly Sales.Value)</td>
<td>PREV()</td>
<td>PREV does not have any values inserted in the brackets. This function will only work properly if your data only has one row per partition in the calculation table.</td>
</tr>
<tr>
<td>POW()</td>
<td>This is used to create an exponent. Instead of using A^B for A to the power of B, Cognos Incentive Compensation Management will use the formula POW(A, B).</td>
<td>If you want to calculate the value of a deal which is sold today but paid upon completion in 5 years, use a formula similar to the following example: Present Value = Future Value / (1+Interest Rate)^Term. If you will be paid 20,000 in 5 years where the interest rate is 5% the formula would look like this: 20,000 / POW((1+.05),5)</td>
<td>POW(Value, Exponent)</td>
<td></td>
</tr>
</tbody>
</table>

### Formatting formulas

In IBM® Cognos® Incentive Compensation Management, you can format formulas in the Calculation wizard.

### About this task

After you type a formula and click the **Format Formula** button, the formula is separated into new lines and becomes indented. Functions in the formula are blue in color, variables are teal, and numbers are purple. Formatting a formula cannot be undone. Formatting a formula counts as a change to the calculation; therefore, you must re-calculate the calculation to view the results.

### Procedure

1. In step 3 of the Calculation wizard, create a formula.
2. Click **Format Formula**.
Partitions

Partitions define how the results of the calculation are displayed in IBM® Cognos® Incentive Compensation Management by offering the option of dividing a single calculated result into subresults.

All column types except comment columns can be used to partition calculation results.

For example, your formula might be: \( \text{Sum(Data.Value)} \times 0.01 \) (or 1% of the sum of the amounts in the value column of the data table). If the result of this formula is 1,000,000 and no partitions are defined, the following data is displayed:

**Table 24. No Partitions**

<table>
<thead>
<tr>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,000,000</td>
</tr>
</tbody>
</table>

If you partition the calculation by PayeeID, you have results similar to the following table:

**Table 25. Partitioned by PayeeID**

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>150,000</td>
</tr>
<tr>
<td>10002</td>
<td>275,000</td>
</tr>
<tr>
<td>10003</td>
<td>312,000</td>
</tr>
<tr>
<td>10004</td>
<td>363,000</td>
</tr>
</tbody>
</table>

A partition replaces a single calculated result with multiple results, equal in total to the original single number. Multiple partitions are also possible, and are frequently required. In the example, imagine partitioning by PayeeID and Date, instead of simply by PayeeID. The result might look something like the following table.

**Table 26. Multiple Partitions**

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Period</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Period 1, 2013</td>
<td>90,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 2, 2013</td>
<td>50,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 3, 2013</td>
<td>10,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 1, 2013</td>
<td>85,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 2, 2013</td>
<td>95,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 3, 2013</td>
<td>60,000</td>
</tr>
<tr>
<td>10002</td>
<td>Period 4, 2013</td>
<td>35,000</td>
</tr>
</tbody>
</table>

**Important:** Each compensation plan requires results to be partitioned by payee and by period. If a calculation result does not include a payee and date, Cognos Incentive Compensation Management cannot calculate compensation. Partitioning is required for calculations within compensation plans.
Empty partitions

You can choose to have the Calculation wizard in IBM® Cognos® Incentive Compensation Management display a result of zero in all empty partitions.

Sometimes a calculated result partition is empty. For example, payee 10001 generated sales results for only periods one, two, and three in 2007. In this case, no result is generated for periods four and later, and typically this result is fine.

However, you might want to calculate a result for each payee and period within a plan, even if that result is zero. For example, consider a situation in which you want to calculate compensation for each payee in the following situations:

- Totaling their sales for a period
- Subtracting their discounts
- Paying 5% commission on the net value

Imagine that you calculated the following results for payee 10001:

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Period</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Period 1, 2009</td>
<td>90,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 2, 2009</td>
<td>50,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 3, 2009</td>
<td>10,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Period</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Period 1, 2009</td>
<td>7,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 2, 2009</td>
<td>2,000</td>
</tr>
<tr>
<td>10001</td>
<td>Period 3, 2009</td>
<td>1,500</td>
</tr>
<tr>
<td>10001</td>
<td>Period 4, 2009</td>
<td>1,950</td>
</tr>
</tbody>
</table>

To complete this calculation, Cognos Incentive Compensation Management requires results for each period. The net results for period four cannot be calculated since there are no values in the first calculation that corresponds to this period.

You can select Include Empty Partitions in the Partitions step. If you do so, Cognos Incentive Compensation Management adds a prompt and indicates that zeros must be added to any empty results. In this example, payees and periods are extended to include zeros in partitions that would otherwise be empty.

Accumulated partitioning

You can use the accumulating partitioning option to display an accumulated total of results in IBM® Cognos® Incentive Compensation Management. For example, you might choose to display the year-to-date value of transactions for each payee rather than the individual value of each transaction.

With regular partitioning, the results reset at every partition. If you want each result to show an accumulated value, select the Accumulating Partitioning option on the Define Partitions step.
Table 29. Results with accumulating value

<table>
<thead>
<tr>
<th>Time</th>
<th>PayeeID</th>
<th>ProductID</th>
<th>Partition Value</th>
<th>Accumulating Partitioning Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month 1</td>
<td>A250</td>
<td>Product A</td>
<td>175</td>
<td>175</td>
</tr>
<tr>
<td>Month 2</td>
<td>A250</td>
<td>Product D</td>
<td>150</td>
<td>325</td>
</tr>
<tr>
<td>Month 3</td>
<td>A250</td>
<td>Product C</td>
<td>125</td>
<td>450</td>
</tr>
<tr>
<td>Month 4</td>
<td>A250</td>
<td>Product F</td>
<td>175</td>
<td>625</td>
</tr>
<tr>
<td>Month 5</td>
<td>A250</td>
<td>Product B</td>
<td>119</td>
<td>735</td>
</tr>
<tr>
<td>Month 6</td>
<td>A250</td>
<td>Product A</td>
<td>250</td>
<td>985</td>
</tr>
<tr>
<td>Month 7</td>
<td>A250</td>
<td>Product B</td>
<td>500</td>
<td>1,485</td>
</tr>
<tr>
<td>Month 8</td>
<td>A250</td>
<td>Product C</td>
<td>135</td>
<td>1,620</td>
</tr>
<tr>
<td>Month 9</td>
<td>A250</td>
<td>Product A</td>
<td>125</td>
<td>1,745</td>
</tr>
<tr>
<td>Month 10</td>
<td>A250</td>
<td>Product E</td>
<td>100</td>
<td>1,845</td>
</tr>
</tbody>
</table>

Defining partitions in a calculation

In IBM® Cognos® Incentive Compensation Management, you can divide your calculated results into subresults based on columns that are selected from the data source.

Procedure
1. In the Define Partitions step of the Calculation wizard, drag the columns from the data sources to the Define Partitions pane.
2. If you select a date column as a partition, the Partition By window opens. Complete the following steps:
   a. Select the Calendar to use for the partition.
   b. Select the time interval to group by from the Calculation list.
   c. Select when to reset the accumulated values to zero from the Accumulate list.
   d. You can also select a starting and ending date for the partition.
3. To change the order of the partitions, drag the partitions in the Define Partitions pane and place them in the order that you want.
4. To set accumulating partitioning, click the arrow next to the Preview button and click Accumulating Partitions.
5. To include empty partitions in the results, click the arrow next to the Preview button and click Include Empty Partitions.

Restrictions

In IBM Cognos Incentive Compensation Management, you can use restrictions to exclude certain records from the calculation.

You might not want your calculation results to include every record in the source data table or all of the results from a prior calculation.

By defining a restriction, you can limit the records included in the calculation by specifying conditions for their selection. For example, to define the records that are
included in your calculated results, you might impose restrictions on sales that
include product 2 or transactions that exceed $50,000 and are sold to a customer in
New York.

For each restriction, you must define a data source, an operator, and a value to
determine whether the restriction must be applied. The following operators are
available:
• = (equals)
• <> (does not equal)
• < (is less than)
• > (is greater than)
• <= (is less than or equal to)
• >= (is greater than or equal to)
• is empty
• is not empty

Restrictions can be defined based on both individual values and calculation
sources. For example:
Value: PayeeID = 1234
Source: Payee ID in calculation source 1 = Payee ID in calculation source 2

Defining a restriction for a calculation

In IBM® Cognos® Incentive Compensation Management, you can restrict the
calculation to show specific results. For example, you can restrict a calculation to
show only the sales of a specific product for each month.

Procedure

1. In the Define Restrictions step of the Calculation wizard, right-click in the
   Define Restrictions pane and click Add New Restriction, or drag a column
   from the data source to the Define Restrictions pane.

   Tip: Pick list columns are denoted by a folder icon in the Data Source pane.
   You can double-click the folder icon to access the columns of the pick listed
table.

2. Drag the column that you want to restrict from the data source to the first
   restriction field in the Define Restrictions pane.
   For example, drag the ProductID column.

3. If the column is a pick list, a menu displays the columns from the pick listed
table. You can select any column from the pick listed table for your restriction.
   For example, select the ProductID.Name field.

4. Select an operator from the list.
   For example, select the equal operator.

5. To select a value from the selected column to define the restriction, click the
   arrow in the second restriction field.
   For example, select the equal operator.

6. To select another column from a data source to define the restriction, drag the
   column from the Data Source pane to the second restriction field in the Define
   Restrictions pane.
Deleting a restriction for a calculation

In the Calculation wizard in IBM® Cognos® Incentive Compensation Management, you can remove restrictions if necessary.

Procedure

1. In step 5 of the Calculation wizard, select the restriction in the Define Restrictions pane.
2. Right-click the restriction and click Delete.

Multiple restrictions that use AND or OR groups

In IBM® Cognos® Incentive Compensation Management, if you need to get two sets of results in one calculation, you can use OR within AND restrictions.

For example, you can show all data that is either Product ID 001 and Payee ID Huddle or all data that is Payee ID 001 and Payee ID Young.

AND Groups

When multiple restrictions are defined, they are separated with an AND operator by default. For example, if you define the following restrictions, you get results for payee 1234 in January:

- Payee ID = 1234
- Month = January

OR Groups

You can use Any groups to define the following type of restriction: Payee ID = 1234 or Payee ID = 3456.

Adding an AND or OR group

In IBM® Cognos® Incentive Compensation Management, you can define multiple restrictions for your calculation results by adding AND or OR groups.

Procedure

1. In the Define Restrictions step of the Calculation wizard, right-click and click Add AND Group or Add OR Group.
2. Select the AND or OR group, right-click, and click Add New Restriction.
3. Define the restriction.

Adding a user-defined calculation

In IBM® Cognos® Incentive Compensation Management, you can add a user-defined calculation to perform mathematical operations on data.

Before you begin

Before you add a calculation, analyze the business requirement to determine the data that you need to perform the calculation, the formula that you need to apply to the data, how you need to group the results, and whether you need to exclude any data.

Procedure

1. To add a calculation, complete one of the following steps:
   - Drag the Calculation element onto the Composer window.
   - Right-click and click Add Calculation.
2. Type a name for the calculation, select **User-Defined Calculation** as the calculation type, and type a description for the calculation.

3. Click **Next**.

4. Drag a source from the **Available Sources** pane into the **Add Data Source** pane.

   **Important:** You can use the Search field to find a specific source in the Available Sources window.

5. To join another source, click-and-drag a second source into the **Add Data Source** pane.

6. Define restrictions for the join.

7. Click **Next**.

8. Drag columns from the **Data Source** pane into the **Define Formula** pane to add your calculation.

9. Click **Next**.

10. Drag columns from the Data Source pane to the Define Partitions pane of the window to define the partitions.

    a. To include empty partitions, click the menu next to the **Preview** button and click **Include Empty Partitions**.

    b. To include accumulating partitioning, click the menu next to the **Preview** button and click **Accumulating Partitions**.

11. Click **Next**.

12. To add a restriction, right-click in the **Define Restrictions** pane and click **Add New Restriction**.

    a. Drag a column from the **Data Source** pane to the first empty restriction field.

    b. Select an operator for the restriction from the **Operator** menu.

    c. To restrict results by a value in the selected column, click the menu in the second restriction field.

        For example, you can restrict results to include only the payees whose job title is Account Executive (TitleID = AE).

    d. To add a second source column to add the restriction, drag the column that you want from the **Data Source** pane to the second restriction field.

13. To use an OR operator to separate your restrictions, right-click in the **Define Restrictions** pane and click **Add OR Group**.

14. You can continue to define more restrictions.

15. When you are finished adding restrictions, click the **Preview** button to check the calculation.

16. Click **Finish**.

---

**Adding a sort calculation**

In IBM® Cognos® Incentive Compensation Management, data can be organized from lowest to highest or highest to lowest using a sort calculation. You can also limit the number of results that are returned after the sort is applied to produce, for example, a list of top performers.

**Procedure**

1. To add a calculation, complete one of the following steps:
   - Drag the **Calculation** element onto the Composer window.
• Right-click and click **Add Calculation**.

2. Type a name for the calculation, select **Sort** as the calculation **Type**, and type a description for the calculation.

3. Click **Next**.

4. Drag a table or calculation from the **Available Sources** pane into the **Add Data Source** pane.

   **Important:** You can use the **Search** field to find a specific source in the Available Sources window.

5. To join another source, drag a second source into the **Add Data Source** pane and define restrictions for the join.

6. Click **Next**.

7. Drag a column to sort by from the **Data Source** pane to the **Sort Data** pane.

8. Select **Sort Ascending** or **Sort Descending**.

9. You can select the **Limit to** check box and select the number of records per partition.

10. From the **Sequential Ranking** menu, select the ranking option that you want.

   **Dense Ranking**
   Ranks ties in the following way: 1,2,2,3.

   **Sequential (default)**
   Does not rank ties.

   **Standard Ranking**
   Ranks any ties in the following way: 1,2,2,4.

11. Click **Next**.

12. Drag columns from the **Data Source** pane to the **Define Partitions** pane to define partitions for the calculated results.

   For example, if you want to sort the list for each payee, drag the **Payee** column to the Define Partitions pane.

13. Click **Finish**.

---

**Adding a time shift calculation**

In IBM® Cognos® Incentive Compensation Management, you can add a calculation that offsets the results of another calculation by a specified number of time periods. This approach is helpful to compare results from a previous period with the results from a current period.

**Procedure**

1. To add a calculation, complete one of the following steps:
   • Drag the **Calculation** element onto the Composer window.
   • Right-click and click **Add Calculation**.

2. Type a name for the calculation, select **Time Shift** as the calculation **Type**, and type a description for the calculation.

3. Click **Next**.

4. Select the calculation that you want to time shift from the **Pick a source** menu.

   **Important:** The **Source** menu lists all available calculations in alphabetical order. If you enter the first letter of the data source in the text box, the first source that begins with that letter is displayed.
5. Type the number of time periods to shift the calculation or use the minus (-) or plus (+) icons.
6. Click Next.
7. To specify a starting date for the calculation, select the Starting check box and specify the date.
8. To specify an ending date for the calculation, select the Ending check box and specify the date.
9. Click Finish.

Adding a category calculation

In IBM® Cognos® Incentive Compensation Management, you can use the Category calculation type to separate large volumes of transactional data into different groups.

Procedure
1. To add a calculation, complete one of the following steps:
   • Right-click and click Add Calculation.
   • Drag the Calculation element onto the Composer window.
2. Type a name for the calculation, select Category as the calculation Type, and type a description for the calculation.
3. Click Next.
4. Drag a table or calculation from the Available Sources pane into the Add Data Source pane.

   Note: You can use the Search field to find a specific source in the Available Sources window.
5. To join another source, drag a second source into the Add Data Source pane, and define restrictions for the join.
6. Click Next.
7. If you selected a calculation with a time partition as the source, you must define the start and end dates of the calculation, and then click Next.
8. To add a category, click Add, and type a category name for the new category.
9. To define a set of restrictions for the category, select the category.
   a. In the restrictions pane at the bottom of the window, right-click and click Add New Restriction.
   b. Drag columns from the Data Sources pane to the fields in the Define Restrictions pane to add the restriction for the category.

   Important: If a category has no restrictions, every row that does not fall into a higher ordered category is placed in the category with no restrictions.
10. To import categories and their restrictions from a Microsoft Excel or text file, click Import.

   Important: Before you use a text file to import or export, you must change the default Import Escape Character in the Administrative Options window from a quotation mark to another symbol that is not used in your category restrictions, such as a tilde (~).
   a. Select Microsoft Excel or Text as the file type to import and click Next.
   b. Click Browse and select the Microsoft Excel file or text file to import.
c. If the first row of the file contains a header, select **The first record is a header** check box.

d. If you selected Microsoft Excel file, select the worksheet from the menu.

e. Click Select to choose the cell range to import, and then click **Confirm**.

f. If you selected a text file, select the **Fields delimited by** character.

g. If you want the selected categories to replace existing ones, select the **Overwrite existing categories** check box.

h. Click **Finish**.

**Important:** If you are using Microsoft Excel 2003, you cannot import from a Microsoft Excel file with a cell that contains more than 255 characters.

11. To change the order of the categories, select a category and drag it to the position you want on the list.

**Important:** The order of the categories is important. If a row falls into two categories, it is categorized by whichever category is higher on the list.

12. To export all categories and their restrictions to a Microsoft Excel or text file, click **Export**.

   a. Select Microsoft Excel or **Text** as the file type that you want to export.

   b. If you selected **Text**, click **Next**.

   c. Select the delimiter and click **Finish**.

13. When you are finished, click **Next**.

14. Define any restrictions to filter the final results.

15. Click **Finish**.

**Important:** When you view current values or preview the category calculation, rows that do not fall into any category are not displayed in the results.

**Copying and pasting categories in a category calculation**

You can copy and paste previously created categories in the Calculation wizard in IBM Cognos Incentive Compensation Management.

**About this task**

If you must create many categories, you can edit a copied category instead of creating a new one.

**Procedure**

1. Navigate to the Define Categories step in the Calculation wizard.

2. Select a category to copy, right-click, and click **Copy**.

   **Tip:** To select multiple categories to copy, press Ctrl+click or Shift+click.

3. Right-click in the Category window and click **Paste**.
Chapter 12. Working with calculations

You can right-click any calculation to preview, view the current values, view history, see a list of compensation plans, tailored reports, or Presenter reports that use the calculation, and edit the calculation in IBM® Cognos® Incentive Compensation Management.

Related concepts:
- “Access permissions” on page 288
  When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.
- Chapter 28, “Calculate module,” on page 281
  Administrators can use the Calculate module in IBM® Cognos® Incentive Compensation Management to run the calculate engine, view the summary of the last calculations that are run in the model, and view the Computation log.

Related tasks:
- “Setting Calculate module security” on page 316
  You can grant a role permission to view the Calculate module in the IBM® Cognos® Incentive Compensation Management client and to run a calculation on any items in the Calculation Type menu. To preview or view calculation data in the Composer model, users who are assigned to this role must also have view permission for the Calculate module.

Previewing a calculation

In IBM® Cognos® Incentive Compensation Management, you can generate results for a calculation that include any edits that were made since the last time they were saved. You can examine the results that are generated by your changes before you run a calculation.

Procedure
1. In Composer, right-click the calculation that you want to preview and click Preview.
   If the Show warning when previewing calculations check box was selected in the Administrative Options window, a warning message is displayed.
2. Click OK.

Results

A table with the top 100 rows of calculation data opens in a new tab.

Running individual calculations

In IBM® Cognos® Incentive Compensation Management, you can calculate a selected calculation.

About this task

You can use this feature to quickly test a new or edited calculation. Running an individual calculation uses the existing results from the selected calculation’s sources and can lead to an out of sync model. A model can be brought back in
sync by running a full calculation. To use this feature, you must have Individual Calculation access granted to you from the Manage Roles window. An individual calculation is a global action and the event is recorded in the Audit module.

**Procedure**

In Composer, right-click the calculation that you want to calculate and click Advanced > Run Individual Calculation.

### Viewing current calculation values

In IBM® Cognos® Incentive Compensation Management, you can view calculation values as of the last calculation. This option shows results of any changes that were made since the last time the calculation was calculated, but you can view the current calculated results.

**Procedure**

In Composer, right-click the calculation whose values you want to view, and click View Current Values.

**Results**

A table with the current values of the calculation opens in a new tab.

### Filtering calculation data

In IBM® Cognos® Incentive Compensation Management, you can filter the results of calculations while you are previewing or viewing them.

**About this task**

When you preview a calculation, only the first 1000 rows are displayed. If you filter the results, only the first 1000 rows that are displayed are filtered. To filter all the calculation results, use the View Current Values feature.

**Procedure**

1. While you are previewing or viewing calculations, click the filter icon in the column header.
2. Set filter parameters. You can filter results based on a range of values or by a specific value.
3. Click Filter. You can choose multiple columns to filter results by.

### Viewing calculation history

Each time that a calculation is edited, IBM® Cognos® Incentive Compensation Management records the name of the user who changed the calculation, the date and time that the calculation was edited, and the type of change that was made.

**About this task**

The data is recorded in the calculation history viewer. Calculation history changes are recorded regardless of whether the calculation is locked.
Procedure
1. Right-click a calculation and click View History.
2. To view the details of the calculation at the time the change was made, double-click the row entry of a version of the calculation.

Viewing sources that use the calculation
In IBM® Cognos® Incentive Compensation Management, you can view the calculations, compensation plans, Presenter reports, and tailored reports that use the calculation as a source.

Procedure
1. To show only the calculation and the objects that use the calculation as a source in the Composer window, complete one of the following steps:
   • Right-click the calculation and click View > Used By Tree.
   • Select the calculation and click the Used By icon.
2. To show all the objects in the Composer window again, complete one of the following steps:
   • Right-click a blank area in Composer and click View > All.
   • Click the All icon in the Composer toolbar.

Viewing sources that the calculation uses
In IBM® Cognos® Incentive Compensation Management, you can view the sources that the calculation uses.

Procedure
1. To show only the calculation and the sources that it uses in the Composer window, complete one of the following steps:
   • Right-click the calculation and click View > Uses Tree.
   • Select the calculation and click the Uses icon.
2. To show all the elements in the Composer window again, complete one of the following steps:
   • Right-click a blank area in Composer and click View All.
   • Click the View All icon in the Composer toolbar.

Viewing a calculation description
You can view calculation descriptions from Composer in IBM® Cognos® Incentive Compensation Management.

Procedure
In Composer, hover your mouse over the calculation.

Results
The name of the calculation is displayed in bold along with the description.
**Editing a calculation**

In IBM® Cognos® Incentive Compensation Management, you can edit a calculation after it is created.

**About this task**

You can edit most details of a calculation, but you cannot edit the calculation type.

**Procedure**

1. In Composer, right-click the calculation that you want to edit and click **Edit**.
2. Make the necessary changes in the Calculation wizard.
3. Click **Finish** to save the changes.

**Locked calculations**

When a calculation uses a source that is associated with a locked calendar in IBM® Cognos® Incentive Compensation Management, you can edit the calculation source, unions, joins, restrictions, and formula.

You cannot, however, edit the type of calculation and the partitions of the calculation, or add or delete partitions.

If you changed your calculation source, you might need to change your partitions to reference the new source. In this case, you can change the partitions if the partition columns are the same in both sources. For example, you can delete a payee partition that references your old source and add a payee partition that references your new source. You cannot delete a payee partition that references your old source and add a product partition that references your new source.

You can never change the calendar accumulation or start date of the time partition of a locked calculation. If you delete a date partition and add a date partition to reference a new source, the starting date is in the first unlocked period for the associated calendar.

Formulas for locked calculations can be changed, unless the calculation uses accumulating partitioning. If the **Accumulating Partitions** option is selected, you can make changes only to arguments of aggregate functions and make changes to the structure of the formulas.

Locked calculation results do not change. Calculation results for any unlocked periods change to reflect any edits that were made to the calculation. When you view results in the Payee Ledger on the web client, the results are displayed seamlessly. Payees cannot detect when a change in the calculation was made.

**Copying a calculation**

In IBM® Cognos® Incentive Compensation Management, you can copy a selected calculation along with the calculations and tables that it uses or depends upon. The copied group of calculations then appears in a new element.

**Procedure**

1. In Composer, right-click the calculation that you want to copy and click **Copy**.
2. To ensure that you do not have two calculations with the same name and you can distinguish copied calculations from the originals, type a Paste suffix.
3. To specify the new source, click Automatch or select a source.
   You must map the old sources to the new sources.
4. Click OK. All connections (if any) stay intact.

Important: If any calculations in the selected group are locked, you can generate new calculations, beginning with the first unlocked period and continuing until the end of the calendar.

Publishing a calculation

You can use the Publisher feature to publish data from your model in IBM® Cognos® Incentive Compensation Management directly to a Microsoft Excel file, Microsoft Dynamics CRM database, PDF file, Salesforce.com, or text file.

Procedure
1. In Composer, right-click a calculation element and click Publish Calculation.
2. Select Publish to my computer or Publish to the server. If you want to save this published file, type a name in the Save this publication as field.
3. Click Next.
4. Select where you want to save the file and click Finish.

Publishing a calculation to a Microsoft Excel file

You can use the Publisher feature to publish data from your model in IBM® Cognos® Incentive Compensation Management directly to a Microsoft Excel file.

Procedure
1. In Composer, right-click a calculation element and click Publish Calculation.
2. Select Publish to my computer or Publish to the server. If you want to save this published file, type a name in the Save this publication as field.
3. Click Next.
4. Format the headers and cells and click Next.
5. Select where you want to save the file and click Finish.

Publishing a calculation to a Microsoft Dynamics CRM database

You can use the Publisher feature to publish data from your model in IBM® Cognos® Incentive Compensation Management directly to a Microsoft Dynamics CRM database.

Procedure
1. In Composer, right-click a calculation element and click Publish Calculation.
2. Select Publish to my computer or Publish to the server.
3. If you want to save this published file, type a name in the Save this publication as field.
4. Click Next.
5. Select Microsoft Dynamics CRM database to publish the calculation and click Next.
6. Type your login credentials.

**Publishing a calculation to a PDF file**

You can use the Publisher feature to publish data from your model in IBM® Cognos® Incentive Compensation Management directly to a PDF file.

**Procedure**

1. In Composer, right-click a calculation element and click Publish Calculation.
2. Select Publish to my computer or Publish to the server.
3. If you want to save this published file, type a name in the Save this publication as field.
4. Click Next.
5. Select Portable Document Format to publish the calculation and click Next.
7. Select the Use header image check box if you want to display an image as the header on each PDF file and click Browse to locate the file.
8. Select the Include page numbers check box to show page numbers in the footer. You can also select the Show total page number check box and type a Footer.
9. Click Next.
10. Format the headers and cells and click Next.
11. Select where you want to save the PDF file and click Finish.

**Publishing a calculation to Salesforce.com**

You can use the Publisher feature to publish data from your model in IBM® Cognos® Incentive Compensation Management directly to a Salesforce.com file.

**Procedure**

1. In Composer, right-click a calculation element and click Publish Calculation.
2. Select Publish to my computer or Publish to the server.
3. If you want to save this published file, type a name in the Save this publication as field.
4. Click Next.
5. Select Salesforce.com to publish the calculation and click Next.
6. Type your user name, password, and security token for Salesforce.com.

**Publishing a calculation to a text file**

You can use the Publisher feature to publish data from your model in IBM® Cognos® Incentive Compensation Management directly to a text file.

**Procedure**

1. In Composer, right-click a calculation element and click Publish Calculation.
2. Select Publish to my computer or Publish to the server.
3. If you want to save this published file, type a name in the Save this publication as field.
4. Click Next.
5. Select text file to publish the calculation and click Next.
6. Select a delimiter and click **Next**.
7. Select where you want to save the file and click **Finish**.
Chapter 13. Draws

In IBM® Cognos® Incentive Compensation Management, a draw is a guaranteed minimum compensation payment that is paid in advance of performance.

For example, if the draw amount is $2000, but the payee's earnings are $1000, $2000 will still be paid to the payee because the draw amount is guaranteed. However, if the payee's earnings are higher than the draw amount, they receive the full amount of their earnings.

There are two types of draws: recoverable and non-recoverable.

**Recoverable Draw**

If the sales representative's incentive earnings are less than the draw amount, the unearned amount is carried forward to the next performance period and are recovered by the employer after the earnings amount exceeds the draw amount.

**Non-recoverable Draw**

If the incentive earnings do not exceed the draw amount, the draw balance is not carried forward, and the representative can keep the draw.

The following table shows month 1 and 2 results for a guaranteed draw of $2000. Although the earnings are the same in both months for the recoverable and non-recoverable draw, the payment in month 2 is greater with the non-recoverable draw.

<table>
<thead>
<tr>
<th></th>
<th>Month 1 Earnings</th>
<th>Month 1 Payment</th>
<th>Month 2 Earnings</th>
<th>Month 2 Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recoverable</td>
<td>1000</td>
<td>2000</td>
<td>5000</td>
<td>4000</td>
</tr>
<tr>
<td>Non-recoverable</td>
<td>1000</td>
<td>2000</td>
<td>5000</td>
<td>5000</td>
</tr>
</tbody>
</table>

Adding a draw

You can add draws in the IBM® Cognos® Incentive Compensation Management client, and then enable them for the web client. Then, managers can assign payees to appropriate draws and view pre-configured draw reports.

**About this task**

At a high level, complete these steps to define a draw, assign payees to the draw, and view draw reports.

**Procedure**

1. In Composer, add a draw and draw templates.
   
   A draw is a container that holds one or many templates. Templates define the terms of the draw such as draw type (recoverable, non-recoverable), amount, and effective time period.

2. In Portal Access > Web Tabs, add web tabs for Draw Assignment and Draw Reports.
3. In **Portal Access > Assignment**, define report and assignment access for each draw by selecting the appropriate access tree.
4. In the web client, select the **Draw Assignment** tab to assign payees to the appropriate draw template.
5. In the web client, select the **Draw Report** tab to view pre-configured draw reports.

### Adding a draw in Composer
You can add a draw in Composer in IBM® Cognos® Incentive Compensation Management.

#### About this task
At a high level, the following steps describe how to add a draw in Composer.

#### Procedure
1. Add a **Draw** object to house draw templates.
2. Select the **Effective Date Column** to use as a source for the draw.
   The table that is used is the **Payee** table that contains the payee ID for each payee that is assigned to the draw and the draw start date for each payee.
3. Select the **Earnings** calculation to use as a source for the draw.
4. Add one or more draw templates.
   Templates define the terms of the draw such as draw type, amount, and time period.

#### Adding a draw object
A draw is an object in IBM® Cognos® Incentive Compensation Management that can hold one or more draw templates.

#### Before you begin
You must add a draw object to Composer before you can define the terms of the draw.

#### Procedure
1. Right-click in a Composer component and click **Add Draw** or drag the **Draw** object from the **Palette** tab of the Composer sidebar.
2. Give the draw a unique name.
3. Define the **Calendar** for the draw. Select the same calendar that is used by the earnings calculation that draw payments are based on.
   
   **Important:** Only one calendar and period partition can be associated with each draw.
4. Select the time **Earnings Period** to partition the draw results by. Select the same period as the draw earnings calculation time partition.
5. Select the **Draw Start Date** column from the Payee table that contains the draw start date for each payee.
   
   The **Draw Start Date** source for the draw is the Payee table and is automatically connected to the draw. In order for a payee to be assigned to a draw, the date in the **Draw Start Date** column must be in an open period.
Tip: Add a Draw Start Date column to the Payee table to house start dates for
draws and do not use the Date of Hire column. You can change the draw that
a payee is assigned to, if necessary, without having to change the date of hire.

Selecting a draw calculation
After you add a draw object to Composer in IBM® Cognos® Incentive
Compensation Management, you must connect a calculation to the Earnings input
port of the draw.

Before you begin

Before you can apply a draw, the calculation must contain earnings results for all
the payees that will be assigned to the draw. The time partition in the calculation
must be the same as the time period that was selected when the draw was added.
For example, you might want to apply a draw to the earnings of a monthly
commission calculation.

Procedure
1. Turn on Link mode in Composer.
2. Drag the output port from the calculation to the Earnings input port of the
draw.
   If Cognos Incentive Compensation Management cannot automatically match
   the columns in the source to the Earnings input port, the Connection wizard
   opens.
3. Drag the columns from the calculation source to the appropriate draw fields.
   You can click the Automatch button if the column names are the same in both
   the draw and the calculation. Your earnings calculation must have a payee,
time period, and value column.

Adding a draw template
After you add a draw in Composer in IBM® Cognos® Incentive Compensation
Management, you can add templates to the draw.

About this task
Templates define the terms of the draw such as draw type, draw amount, and
effective time period. There is no limit to the number of templates that can be
added to each draw.

Procedure
1. Double-click the draw or right-click and click Manage Templates.
2. Click Add to add a template.
   There is no limit to the number of templates that can be added.
3. Give the template a descriptive Name.
4. Select the Draw Type.

   Recoverable Draw
   If the sales representative's incentive earnings are lower than the draw
   amount, the unearned balance is carried forward to the next
   performance period and are recovered by the employer when the
   earnings amount exceeds the draw amount.
Non-recoverable Draw
If the incentive earnings do not exceed the draw amount, the draw balance is not carried forward, and the rep gets to keep the draw.

5. Add a description to explain the terms of the draw and click Next.
6. Select the duration of the draw. For fixed term draws, the number of periods must be selected. The length of each period is determined by its granularity.

Ongoing
An ongoing draw has no set end date. Draw payment amounts are calculated for all the open periods in the draw calculation.

Fixed-term
A fixed-term draw calculates draw payments for a predefined number of periods. If the Fixed box is cleared, the number of periods can be increased in the web client up to the number of periods that are entered in the max field.

Important: The number of periods that is selected for a fixed term template cannot exceed the number of open periods in the calendar for the selected granularity. For example, if the duration is four periods and the granularity is quarters, there must be four open quarters in the calendar.

7. Define the output draw period of the draw.
This period can be any time period in the calendar that is associated with the draw. The draw period defines the output of the draw results. For example, if the draw period is Months, the draw template output port is partitioned by months.

8. Select Flat Amount or Schedule for the Draw Amount. A flat amount means that the draw payment is the same for each period in the draw. A scheduled amount means that different draw amounts can be paid for each period in a fixed term draw.

Flat Amount
If Flat Amount is selected, enter the amount of the draw. This amount is the fixed draw payment for the duration of the draw. If the Fixed box is unchecked, the draw amount can be changed in the Web Client to any amount that does not exceed the amount that is entered in the Max field.

Schedule
You can select Schedule to enter a different draw amount for each period in the draw. This option is only available for fixed term draws.

9. If you selected Schedule, click Edit and type a draw amount for each period in the schedule.

10. You can type the draw amount in the Set an amount for each period field. This amount is useful if most of the periods in your schedule have the same draw amount.

11. Clear the Fixed check box if you want web users to be able to increase the number of periods via the web client. The number of periods can be increased to the number set in the Max field.

Editing the draw name and earnings period
After you create a draw in Composer in IBM® Cognos® Incentive Compensation Management, you can change its name and the draw start date column. You cannot change the calendar and period length.
Procedure
1. Select the draw, right-click, and click Edit.
2. Change the Name of the draw and the Draw Start Date column and click OK. The Draw Start Date is the column in the Payee table that contains the draw start date for each payee.

Copying and pasting a draw
You can copy draws and remap sources in Composer in IBM® Cognos® Incentive Compensation Management. Draw templates are copied along with the draw structure.

Procedure
1. Right-click a draw and click Copy.
2. In the component where you want to paste the copied draw, right-click and click Paste.
3. Drag the input earnings calculation from the Sources list to the New Source column. The Automatch button can be used to map the exact same sources.

Important: You can use different input sources for the copied draw if the column names and type are identical in the original draw and the copied draw.

Deleting a draw connection
After you add a draw connection in Composer in IBM® Cognos® Incentive Compensation Management, you cannot view or edit the details of the connection. If you are unsure whether you used the correct source or columns for the draw input, delete the connection and create it again.

Procedure
1. Turn on Link mode in Composer.
2. Select the connection to delete and press the Delete key on your keyboard.

Editing draw templates
After you create a template in IBM® Cognos® Incentive Compensation Management, you can change its name, copy it with a new name, or delete it.

Procedure
1. Double-click the draw or right-click and click Manage Templates.
2. Select a template and click Edit, Copy or Delete.

Editing a draw template name
In IBM® Cognos® Incentive Compensation Management, You can edit the name of a draw template.

Procedure
1. Double-click the draw or right-click and click Manage Templates.
2. Select a template and click Edit.
3. Change the name of the template and click Next.
4. If your template has a scheduled draw amount, you can click View to review the details of the schedule.
Copying a draw template
In IBM® Cognos® Incentive Compensation Management, you can copy a draw template.

Procedure
1. Double-click the draw or right-click and click Manage Templates.
2. Select a template and click Copy.
3. Provide a unique name for the copied template.
4. Optional: You can edit the Type, Description, Duration, Granularity, and Draw Amount fields if necessary.

Draw web tab settings
After you create a draw in IBM® Cognos® Incentive Compensation Management, you must define settings for the Draw Assignment and Draw Report tabs in the web client in both Composer and Portal Access.

Defining draw assignment web tab settings
In IBM® Cognos® Incentive Compensation Management, you can define draw assignment web tab settings.

Procedure
1. Right-click the draw and click Draw Assignment Web Tab Settings.
2. Define which payees are visible to the web user in the Draw Assignment tab.
   
   **Use Portal Access Hierarchy**
   Two groups of users must be defined for draws: users who assign other payees to draws and view draw reports, and users who are assigned to draws. If you select the Use Portal Access Hierarchy option, both groups of users are determined in Portal Access by assigning a two-level tree to the draw. The members of the first level of the Portal Access tree are allowed to assign users in the last group to the draw.

   **Allow group selection**
   Select the Allow group selection check box to allow web users to filter based on Portal Access group. When users are viewing the Draw Assignments tab in the web client, they can view and edit the assignment of a selected payee or all payees in a selected group.

   **Define Restrictions**
   If you select the Define Restrictions option, users who can be assigned to draws are determined by creating restrictions on the Payee table. For example, if all Account Executives are eligible to be assigned to a draw, you can determine that all payees with the Account Executive job title must be listed in the web client by creating the appropriate restriction on this window. Users who are specified here cannot view the Draw Assignments tab.

   **Important:** Users who can assign payees to draws and view draw reports are then granted access through Portal Access. This is done by creating a one level access tree in Portal Access that contains all web users that can create draw assignments. All users who are granted access to the draw assignment window through Portal Access can assign the payees defined in the Define Restrictions section to this draw.

   3. The number that is selected in the Rows per page field determines the number of rows that are displayed on each page of the Draw Assignment web tab.
4. The **Numeric Style** selected determines the web client value display.

**Defining draw report web tab settings**

In IBM® Cognos® Incentive Compensation Management, you can determine the appearance of certain elements in the draw report. You can add a logo to the report, change the color of report headers, and define the number of rows to display per page.

**Procedure**

1. Right-click the draw and click **Draw Report Web Tab Settings**.
2. Browse for an image if you want to display a logo on the report in the **Draw Report** tab.
3. Click the box in the **Color scheme** field to select a color for the **Draw Report** headers. The color that you select is used for the draw reports in the web client.
4. Select the **Allow group selection** check box to let web users filter based on Portal Access group. When users are viewing the **Draw Assignments** tab, they can view or edit the assignment of a selected payee or all payees in a selected Portal Access group.
5. Select a number in the **Rows per page** field to determine the number of report rows that are displayed on each page in the web client. By default, 25 rows per page are displayed.
6. Select the **Numeric Style** of the values that are displayed in the report.

**Adding web tabs for draw assignment and draw reports**

In IBM® Cognos® Incentive Compensation Management, after you add draws in Composer, you must add web tabs in Portal Access to make draw assignments and draw reports accessible in the web client.

**About this task**

To be able to assign payees to the draw, you must add a **Draw Assignment Type** tab in Portal Access. For users to view pre-configured draw reports, you must add a **Draw Report** web tab type in Portal Access.

After you create the draw assignment and report tabs and you define appropriate access on the **Assignment** tab in Portal Access, users can access them from the web client.

**Procedure**

1. In **Portal Access > Web Tabs**, right-click and click **Add Web Tab** or click the **Add Web Tab** button on the toolbar.
2. Give your web tab a name. The name is displayed as the label of the tab in the web client.
3. Select a tab **Type** from the first menu and the draw name from the second menu.
   - **Draw Assignment**
     Selected payees can be assigned to the draw.
   - **Draw Report**
     Authorized users can pre-configure draw reports, including an overview, draw assignment report, YTD payouts, and payout by period.
Defining web access for draw report and assignment tabs

In IBM® Cognos® Incentive Compensation Management, you must define access to the contents of each draw report and draw assignment tab in Portal Access.

Procedure

1. In Portal Access, open the Assignment tab.
2. Select the draw assignment or draw report that you want to enable for the web client.
3. In the Access column, select the appropriate access tree from the menu.

Important: Sign off and inquiry functionality is not available for draws, so it is not necessary to assign trees for those categories.

Assigning payees to draws in the web client

After you define a draw and grant appropriate access in the IBM® Cognos® Incentive Compensation Management client, authorized web users can assign payees to draws and view reports.

Assigning payees to draw templates

You can assign payees to draw templates on the draw assignment tab in the IBM® Cognos® Incentive Compensation Management web client.

Procedure

1. Select the draw assignment tab in the web client.
2. Select the Unassigned subtab. All payees that are not yet assigned to a draw are listed here.
3. To populate the list with available payees, select a specific payee, a Portal Access group, or All from the menu and click Apply.
4. Select the draw template that you want to add payees to.
5. Select the check box for each payee that you want to add to the selected draw template. Select the check box in the header to select all payees on the page.
6. Click the Apply button to assign payees to the selected template, and then click Save.

Important: If there are multiple pages of eligible payees, you must set up draw assignments separately for each page. If you click the check box in the header to select all payees, you select only the payees on the current page.

Viewing and editing draw assignments for payees on fixed term draws

You can view or edit draw assignments for payees on fixed term draws from the draw assignment tab on the IBM® Cognos® Incentive Compensation Management web client.

Procedure

1. To view or edit draw assignments for all employees who are assigned to fixed-term draws, select the Draw Assignment tab and then the Fixed Term tab.
2. Select an individual payee, a Portal Access group, or All to display payees who are assigned to a fixed term draw.
3. To change the draw start date, amount that is paid for each period, and the number of periods in the draw for all listed payees, use the Mass Edit section.
   a. Make changes in the Mass Edit section.
   b. To select employees that you want to change, select the check box for each payee's name.
   c. Click Apply and Save.

4. To make changes for individual payees, change individual rows.
   a. Make changes for an individual payee.
   b. Click Apply and Save.

   Important: A setting that is selected at the time that the draw template was created determines whether the number of periods in the draw or the draw amount can be edited here.

Viewing and editing draw assignments for payees on ongoing draws

You can view and edit draw assignments for payees on ongoing draws from the draw assignment tab in the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. To view or edit draw assignments for all employees who are assigned to ongoing draws, select the draw assignment tab, then the Ongoing tab.
2. Select an individual payee, a Portal Access group, or All to display payees who are assigned to an ongoing draw.
3. To change the draw start date and the amount that is paid for all listed payees, use the Mass Edit section.
   a. Make changes in the Mass Edit section.
   b. To select employees that you want to change, select the check box for each payee's name.
   c. Click Apply and Save.

Unassigning payees and hiding inactive payees

You can unassign payees and hide inactive payees on the Draw Assignments tab in the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. To unassign payees that are assigned to a fixed term draw, select the appropriate payee or payees, and click the Unassign button.
2. After you unassign payees, they still appear in the Fixed Term list. To hide them from the list, click the Hide inactive payees check box.

Viewing draw reports in the web client

You can view draw reports in the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. To view preconfigured draw reports, select the Draw Report tab.
2. Select an individual payee or a Portal Access group to define the parameters of the report.
3. Select the **Period** to include in the report.
4. Select the draw **Template**.
5. Click **Apply**.
6. Select one of four following report tabs: **Overview**, **Draw Assignments**, **YTD Payouts**, and **By Period Payouts**.

### Overview report

The **Overview** report on the IBM® Cognos® Incentive Compensation Management web client provides graphical representations of many values related to draws.

The values include the percentage of participants that are assigned to a draw, the percentage of participants who are carrying a negative balance, the average percentage of draw amount that is paid out by month, and draws paid versus commission expenditures.

### Exporting the Overview report to a PDF file

You can send the **Overview** report to a PDF file from the IBM® Cognos® Incentive Compensation Management web client.

#### Procedure

1. Open the **Overview** report on the **Draw Report** tab in the web client.
2. Click the **Generate PDF** icon in the **Overview** report.
3. View and save the PDF file.

### Draw Assignments report

You can view the **Draw Assignments** report from the **Draw Reports** tab on the IBM® Cognos® Incentive Compensation Management web client.

The **Draw Assignments** report shows all payees who are assigned to the selected draw template and their start dates. If you select a fixed term template, the payee's end date is also displayed.

### YTD Payouts report

The **YTD Payouts** report on the IBM® Cognos® Incentive Compensation Management web client displays year-to-date amounts for the selected payees and draw template.

**Important**: If a specific period was selected when report parameters were applied, the data in the report covers the selected period and not the YTD values.

**YTD Earnings**
The YTD earnings based on the earnings source draw input.

**YTD Draw**
The YTD draw payment. This is the guaranteed YTD payout amount less the earnings amount. For example, if the guaranteed YTD payout amount for a payee is $1000 and his or her YTD earnings are $600, the YTD draw is $400.

**YTD Balance**
For recoverable draws, the amount that is still owed. This column is not displayed for non-recoverable draws.

**YTD Payout**
The total payout to date: **YTD Earnings + YTD Draw = YTD Payout**.
By Period Payout report

On the Draw Reports tab in the IBM® Cognos® Incentive Compensation Management web client, you can view the By Period Payout report to see the payout amounts for each payee by period.

**Earnings**
The calculation earnings for the period before a draw is applied.

**Draw**
The amount of the draw for the selected period.

**Period Draw**
The draw amount that is paid for the period. This is the guaranteed period payout amount less the earnings amount. For example, if the guaranteed period payout amount for a payee is $1000 and his or her period earnings are $600, the period draw is $400. If the payee’s earnings for the period exceed the draw amount, the period draw is 0.

**Balance**
For recoverable draws, the amount that is still owed. This column is not displayed for non-recoverable draws.

**Payout**
The total payout for the period: Earnings + Period Draw = Payout.

Exporting report results to Microsoft Excel

The Draw Assignments, YTD Payouts, and By Period Payouts reports in the IBM® Cognos® Incentive Compensation Management web client have similar features to Presenter report data grids.

**About this task**

Users can send the reports to Microsoft Excel or choose to show or hide columns in the report.

**Procedure**

1. Hover over the header of the report.
2. Click the arrow in the header of the last column.
3. To send the report to Microsoft Excel, click the .xls or .xlsx icon.
4. To hide a column, select the column. A check mark is no longer displayed next to the column and it will be hidden on the report.

**Important:** The published report in Microsoft Excel reflects the shown or hidden columns that were selected in the web client.
Chapter 14. Data stores

Data stores are Composer objects in IBM® Cognos® Incentive Compensation Management that you can use to join sources, such as tables, calculations, and draw results, into one large repository.

For example, a data store can be used to pull together results that are required for reporting purposes into one object. The data store can then be used as a source in Presenter to build reports. Reporting users can then easily create reports because all the sources that they require are available in one place. All tables, calculations, and draws within the model can be used as sources in the data store, regardless of the component where the data store is located.

Data stores can be wrapped into components within Composer but they are globally visible. Users can select the data store as a source from anywhere in Composer. Security can also be applied to any data store to give users permission to view, edit, and delete the object.

Related concepts:
- “Access permissions” on page 288
  When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.
- “Data store security” on page 307
  You can grant a role permission to specific data stores in IBM® Cognos® Incentive Compensation Management. You can also grant permission to view, edit, and or delete data store objects in Composer.

Data store creation

Data stores are created in Composer in IBM® Cognos® Incentive Compensation Management. Data stores are available as sources in Presenter and Microsoft Excel by using the Cognos Incentive Compensation Management add-in for Microsoft Excel.

At a high level, complete the following steps to create a data store.

1. Add a data store object in Composer.
2. Join the data sources that you want in the data store.
3. Select the detail columns from the added sources that are available to users from the data store.
4. Define any restrictions to the data that is available to users.
5. Rename the detail columns with meaningful names. The Source wizard is used to create data stores. This wizard contains tabs for each step and you can use the tabs to navigate through the wizard. All required fields must be completed before you can finish the wizard.

Adding a data store object

A data store is a Composer object in IBM® Cognos® Incentive Compensation Management that can contain multiple data sources that are joined together.
Before you begin

The data store object must be added to Composer before the sources can be selected and joined.

Procedure
1. To add a data store, complete one of the following steps:
   - Drag the Data Store element onto the Composer window.
   - Right-click and click Add Data Store.
2. Type a unique name for the data store.
3. Click Next.

Selecting sources for the data store

You can add any tables or calculations to the data store in Composer in IBM® Cognos® Incentive Compensation Management.

About this task

You can add multiple data sources to a data store by joining columns or rows.

Procedure
1. In the Select Sources step of the Source wizard, select an initial source from the Source menu.
2. To add another source, click Add.

Joining a source by columns

You can add a source by columns in your IBM® Cognos® Incentive Compensation Management data store to join together tables or calculations based on a point of commonality.

Procedure
1. In the Select Additional Data window, select the Add Columns option.
2. From the Source menu, select the source from which you want to add columns.
3. In the Name field, you can rename the source.
4. Click Next.
5. If you do not want to define restrictions, click Finish without joining any columns. If you want to define restrictions, complete the following steps:
   a. Drag a column to the restriction definition list.
      You can define the join in the Define Restriction window. For example, if you want to join the sources based on the PayeeID column, drag the PayeeID column from the left to the right.
   b. In the Define Restriction window, select the operator for the restriction.
      For example, to join the PayeeID columns, select the equal operator.
   c. On the Values or Source tab, drag the value or source to the question mark to finish the restriction.
      For example, to join the PayeeID columns, click and drag the PayeeID column from the second source to the question mark.
   d. Click OK.
   e. When you finish defining restrictions for the join, click Finish.
Joining a source by rows
You can join sources by adding table rows from one source to another source in your IBM® Cognos® Incentive Compensation Management data store.

Before you begin
The columns in the source table must be similar to the columns in the union table because all columns in the source table must be mapped to a column in the union table.

Procedure
1. In the Select Additional Data window, select the Add Rows option.
2. From the Add Rows From menu, select the source that you want to add rows from.
3. Click Next.
4. Click Automatch to map the fields. Information from the selected tables is mapped over to the original source table. You can also drag the fields to map them.
5. Click Finish.

Adding a left outer join
You can use a left outer join to join sources for your IBM® Cognos® Incentive Compensation Management data store.

About this task
The left outer join type displays rows for all records of the first data source even if the join does not find matching records in the second data source. However, only matched records from the second data source are returned.

Procedure
1. On the Select Sources tab of the Source wizard, join two sources by columns.

   Important: Restrictions for the outer join must be defined during this step and not on the Select Restrictions tab of the Source wizard.
2. Click the Anchor source rows button. The Anchor source rows feature is enabled when the button is blue. When the button is black, the feature is not in use.

Selecting columns for a data store
After you select and join the sources in your IBM® Cognos® Incentive Compensation Management data store, you must select the columns from the data sources that will be available to users.

Procedure
1. In the Select Columns step of the Source wizard, drag the columns into the detail column list. You can select up to 50 detail columns in a data store.
2. To remove a detail column from the list, right-click the column and click Remove Selected.

Selecting restrictions for a data store
A restriction can be defined to limit the records visible to users in your IBM® Cognos® Incentive Compensation Management data store.
Procedure
1. In the Select Restrictions step of the Source wizard, drag a column from the left into the restriction definition list on the right.
2. In the window that opens, select an operator for the restriction from the Operator menu.
3. To select a value from the selected column to finish the restriction, click the Values tab and drag the value for the restriction to the question mark.
4. To select a column from a source to finish the restriction, click the Sources tab and drag the column from the list to the question mark.
5. Click OK.
6. When you finish defining restrictions for the data store, click Next.

Naming columns in a data store
In the last step of creating your IBM® Cognos® Incentive Compensation Management data store, you can rename the detail columns that you selected to give them meaningful names for reporting users.

Procedure
1. On the Naming Columns tab of the Source wizard, highlight the Display Name and type a new name.
2. Click Finish.

Results
The data store is added to the Composer window.

Data store security
You can grant access to specific data stores in IBM® Cognos® Incentive Compensation Management.

You can grant permission for users to view, edit, and delete the data store object in the Manage Roles window in Composer.

Setting permission for a role to view a data store
You can grant view-only permission for roles for specific data stores in IBM® Cognos® Incentive Compensation Management.

About this task
Users who are assigned to the role have permission to add the data store to the Favorites list and view the Uses and Used By trees. However, they do not have permission to make changes to the data store.

Procedure
1. Click Admin > Manage Roles.
2. Select or add the role that you want to grant permission for.
3. Expand Composer.
4. Right-click View and click Grant.
5. If the data store is in a component, also grant view access to the component.
6. Expand Data Stores.
7. Expand the data store that you want to grant view permission for.
8. Right-click View and click Grant.

**Setting permission for a role to view and edit a data store**

Roles can be granted permission to view and edit the data store object in Composer in IBM® Cognos® Incentive Compensation Management.

**About this task**

Users who are assigned to the role can open the Source wizard and make changes to the data store.

**Procedure**

1. Click Admin > Manage Roles.
2. Select or add the role that you want to grant permission for.
3. Expand Composer.
4. Right-click View and click Grant.
5. Right-click Edit and click Grant.
6. If the data store is in a component, also grant view and edit permission for the component.
7. Expand Data Stores.
8. Expand the data store that you want to grant view and edit permission to.
9. Right-click View and click Grant.
10. Right-click Edit and click Grant.

---

**Exporting data from a data store to Microsoft Excel**

You can export records that are contained in data stores into Microsoft Excel by using the IBM® Cognos® Incentive Compensation Management add-in for Microsoft Excel.

**About this task**

For information about installing the Cognos Incentive Compensation Management add-in for Microsoft Excel, see the *IBM Cognos Incentive Compensation Management Installation and Configuration Guide*.

After the Cognos Incentive Compensation Management add-in for Microsoft Excel is installed, you can export data from any data stores in your model into Microsoft Excel. The data can then be used to create pivot tables, charts, and graphs for reporting purposes. If changes are made to the model, the data in Microsoft Excel can be updated with the most recent data.

**Procedure**

1. In Microsoft Excel, open the Cognos Incentive Compensation Management tab.
2. Connect to your model by typing the Service Address, the Server, and the Database name.
3. Click Login Information and type the user name and password that you use to connect to the Cognos Incentive Compensation Management client.
4. Click Import Data Store.
Important: You cannot export a data store if you are already logged in to the client.

5. Select a data store from the menu.
   The columns that are available in the data store are displayed in the Define Restrictions step.

6. Define the restrictions for the data that you want to export by clicking and dragging columns from the left pane to the right pane.
   a. In the Restriction wizard, select an operator from the menu.
   b. Type a value to define the restriction in the Enter a value field.
   c. Click OK.

7. Click Import Data Store.

**Refreshing data store data in Microsoft Excel**

At any time, users can edit or update the data in Microsoft Excel with the most recent data from the IBM® Cognos® Incentive Compensation Management database. If users are opening a previously saved report, they must first log in to the model to refresh the data.

**Procedure**

1. On the Cognos Incentive Compensation Management tab in Microsoft Excel, click Refresh Data Store Import to update the data.

2. To edit the restrictions that are used in the import, click Edit Data Store Import.

**Exporting data from data stores to Watson Analytics**

Data stores created in IBM® Cognos® Incentive Compensation Management can be imported into Watson™ Analytics to explore trends and relationships in the data.

**Procedure**

1. In Composer, right-click on the data store and select Explore in Watson Analytics.

2. In the Username field, type the user name that you use to log in to Watson Analytics.

3. In the Password field, type the password associated with the user name that you use to log in to Watson Analytics.

4. On the Advanced tab, you can perform the following actions:
   • In the Data Set Name field, type the name of the data set as you want it to be displayed in Watson Analytics.
   • Select the Overwrite data set if exists check box, if you want Watson Analytics to overwrite the data set with the same name if it exists.
   • Select the Open Watson Analytics on completion check box, if you want Watson Analytics to open after the data set is loaded. Clear this check box if you want the export to run in the background and do not want Watson Analytics to open after the data set is loaded.

5. Click Explore.
   If you are currently logged in to Watson Analytics, your data store is displayed in Watson Analytics. If you are not logged in to Watson Analytics, you are redirected to a login page and after entering your information your data store is displayed in Watson Analytics.
Chapter 15. Plans and tailored reports

In Composer in IBM® Cognos® Incentive Compensation Management, you can create reports to display compensation results to payees. Use compensation plans to display calculation results that are related to a payee's compensation.

Tailored reports can be used to analyze compensation results. For example, you might want to view payment amounts segmented by geographic location, or you might want to see a compensation report for payees who passed certain thresholds or failed to meet targets.

Compensation plans

You can add and edit compensation plans through Composer in IBM® Cognos® Incentive Compensation Management.

At a high level, the following steps describe how to create a compensation plan:
1. Define plan parameters: Name the plan and specify the start and end dates.
2. Add calculations. Select data sources and specify the formula.

   **Important:** You can create calculations while you are creating a compensation plan, or you can create them separately and then add them to the plan.
3. Select reporting settings. Indicate how you want results to be displayed in Payee Ledger.
4. Specify payment details, for example, the payee group that this compensation plan belongs to, any holds, payment minimums or maximums, and payment accounts.

Related concepts:

- "Access permissions" on page 288
  When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

- "Compensation plan security" on page 309
  You can grant a role permission to edit compensation plans in the Composer module in IBM® Cognos® Incentive Compensation Management. Users must have access to compensation plans to be able to view compensation results in the Payee Ledger module or to create workspaces in the Scenarios module.

Plans and payee groups

You can use payee groups in IBM® Cognos® Incentive Compensation Management to reduce the time that you spend setting up and maintaining each compensation plan.

A payee group consists of the following items:
- The compensation plans.
- The payee members who belong to each plan.
- Any attached plan documentation.
- Any tailored reports for the payee group.
All compensation plans and tailored reports are created and edited in Composer and assigned to payee groups through the Compensation Plan and Tailored Report wizards. Payee group members and documents are managed in the Payee Groups window.

The payees whose compensation is calculated in the system can be added to a single group, and then a compensation plan can be added to the group to complete the setup process. You can then set up plans for large groups of people at the same time, rather than repeating the process for each individual.

Payees are frequently grouped by title. For example, if all salespeople receive five percent commission on everything that they sell, every salesperson can be added simultaneously to a single payee group in the system. To complete the process, a compensation plan that specifies that each member of this group receives a five percent commission can then be added.

**Tip:** Consider which payees might be grouped together before you create your model.

**Related concepts:**

“Access permissions” on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

---

### Compensation plan creation

In IBM® Cognos® Incentive Compensation Management, you can add calculations to a compensation plan for specific payee groups to display summary and detail information that is related to a payee's compensation.

#### Step 1. Naming the plan and defining the calendar

In the first step of the Compensation Plan wizard in IBM® Cognos® Incentive Compensation Management, you must specify a name and set the start and end dates for the plan.

**Procedure**

1. In Composer, find the component where you want to add the plan.
2. To add a compensation plan, drag the Plan element onto the Composer window.
3. Type a descriptive name for the plan so that it is easily identified for potential editing later.
4. Set the plan’s start and end dates.
5. Type a description for the compensation plan.

#### Step 2. Adding calculations

In the second step of the Compensation Plan wizard in IBM® Cognos® Incentive Compensation Management, you must add the calculations to the compensation plan.

**About this task**

Every compensation plan must contain at least one calculation (many plans contain several calculations). When you design your compensation plans, the complexity of
the calculations determines whether they can be completed in a single step or whether they must be divided into multiple steps.

Procedure
1. In the Compensation Plan Wizard, click **Add** to add an existing calculation to the compensation plan.
2. Select the calculation and click **OK**.
3. To create a new calculation to add to the plan, click **New** in the Payee Ledger Display Options wizard.
4. Click **Colors** to define the appearance of your **Payee Ledger** report for this plan.
   a. Select **Apply to All** if you want to apply the report styles that are defined here to all compensation plans.
   b. When you finish selecting colors, click **OK**.

Selecting Payee Ledger display options
For each calculation that you add to a compensation plan in IBM® Cognos® Incentive Compensation Management, you must specify reporting settings.

About this task
If required, the Payee Ledger module can generate detailed results for each calculation within a compensation plan. It can be helpful to enable these reporting options so that users can review and verify each calculation in a compensation plan.

Procedure
1. To track summary results for each period, for each payee, select the **Show calculation results in Payee Ledger** check box.
2. To show all results, select `<Show All Results>` in the **Show results by PayeeID** field.
3. To show the calculation results by payee, select **PayeeID** in the **Show results by PayeeID** field.
   The calculation must have **PayeeID** as a partition.
4. Type the **Result Name**.
5. Click **Format** to edit the number format style and number of decimal places for the results.
6. Select the **Show transactional details in Payee Ledger** check box to expand the results that are tracked in Payee Ledger to include detailed transaction-by-transaction contribution to the period total.

   **Tip:** Under most circumstances, select **Show calculation results in Payee Ledger** and **Show transactional details in Payee Ledger**. After results are validated, you can review calculations and reduce reporting detail.
7. Optional: Select the **Show prior periods** check box to show the periods that lead up to the selected time period.
8. Optional: Select the **Suppress empty reports** check box to suppress any compensation plan that does not have data for the time period selected.
9. Optional: Select the **Show description as header** check box to show the calculation description as a header in Payee Ledger.
10. Optional: Select the **Suppress summary rows** check box to remove the summary rows in Payee Ledger.
11. Click Next.

12. To select the calculation columns to include in the report, drag available columns from the left to the right.

13. Click Next.

14. Double-click any row to edit the column properties.
   a. Type the Display Name for the column in Payee Ledger.
   b. For a numeric column, select the Operation.
      You can select the sum, average, minimum, maximum, or last operator to have an operation performed on the column and displayed in the report. For example, if you select SUM, all the entries in that column are totaled and the result is displayed at the end of the report.
   c. For a numeric column, select the Style.
      The numeric styles available are standard number, percentage, and currency.
   d. For a numeric column, select the Decimal Places.

15. Click Finish.

Results

After you add calculations for the compensation plan report, click Edit or Delete in the Add Calculation window to change the calculation reporting settings or remove the calculation from the report.

Step 3. Selecting a payee group and defining holds, caps, and guarantees

In the final step of the Compensation Plan wizard in IBM® Cognos® Incentive Compensation Management, you must select the payee group that this plan applies to and define a hold period and any caps or guarantees for the compensation plan.

Procedure

1. In the Payee Groups section of the Compensation Plan Wizard, use the menu to associate this plan with any payee group in the Payee Groups window.

2. In the Payment Rules section, select the Hold type.
   After you add any calculations that are needed for the compensation plan report, click Edit or Delete in the Add Calculation window to change the calculation reporting settings or remove the calculation from the report.

3. Select the This plan includes guaranteed incentive of check box to provide the specified value as the minimum compensation possible for each payee in each period.

4. Select the This plan includes an incentive cap of check box to limit the maximum earnings for each payee in each period to the specified value.

5. In the Accounts section, select the Expense Account and the Cash Account from the menus.

6. Click Finish.

Locked compensation plans

When a compensation plan is locked in IBM® Cognos® Incentive Compensation Management, you can change the end date of the plan, and you can specify whether transactional details are displayed in the Payee Ledger.
You cannot add or delete calculations that are included in the report, change the colors or formatting, or change the payee group that is associated with the plan.

When you edit the Payee Ledger Display Options for a locked compensation plan, the changes take effect in the first unlocked period. Payee Ledger continues to show the original display settings for all locked periods. For example, if you add another display column in the Payee Ledger Display Options - Step 2 window, define the column properties, and click Finish, the added column is visible only in unlocked periods.

**Copying a compensation plan**

You can copy a compensation plan in IBM® Cognos® Incentive Compensation Management into another component. When you do so, you must also create inbound connections in the new component for the calculations that it uses or depends upon.

**Procedure**

1. Right-click the compensation plan that you want to copy and click Copy.
2. Find the component where you would like to copy the plan to, right-click inside the new component, and click Paste.
3. Type a Paste Suffix. The suffix ensures that you do not have two compensation plans with the same name, so you can distinguish copied compensation plans from originals.
4. You must map the old sources to the new sources. Specify the new sources by clicking Automatch or by selecting a source.
5. Click OK.

**Managing documents**

In the Manage Documents window, users can add any files associated with compensation management to the IBM Cognos Incentive Compensation Management database.

Any documents added here are visible from the Portal Access Assignment window and can be enabled for web client review.

**Procedure**

1. Go to Admin > Manage Documents.
2. Click Add.
3. Click Browse.
4. Select the file.
   
   The file will be automatically encoded and saved within Cognos Incentive Compensation Management, available for you to download at any point in the future.

**Related tasks:**

“Adding a link to a document” on page 194

In IBM® Cognos® Incentive Compensation Management, you can add a link to a document from a Presenter report.

**Downloading a document that is associated with compensation management to your computer**

You can select a document from the Document Manager window in IBM® Cognos® Incentive Compensation Management, and save it to your computer.
**Procedure**

1. Click Admin > Manage Documents.
2. Click Save As.
3. Select a location to store the file.
4. Click Save.

---

**Tailored reports**

In Composer in IBM® Cognos® Incentive Compensation Management, you can create tailored reports to analyze compensation results.

At a high level, the following steps describe how to create a tailored report:

1. Name the report, add calculations, and select report settings.
2. Select a payee group.
3. Enable alert generation through Task Manager.

You can use any previously created calculations in the tailored report or you can create a new one specifically for reporting purposes. After you add calculations, you can partition and restrict your results to suit your reporting needs.

Every tailored report must contain at least one calculation. When you design your reports, the complexity of the calculations determines whether they can be completed in a single step, or whether they must be divided into multiple steps.

**Step 1. Naming the report, adding calculations, and selecting reporting settings**

In Composer in IBM® Cognos® Incentive Compensation Management, you can name the report, add calculations, and select reporting settings.

**Procedure**

1. In Composer, find the component where you want to add the report.
2. Drag the Tailored Report element onto the Composer window, or right-click the window and click Add Tailored Report.
3. Type a name for your tailored report.
4. To add a previously created calculation, click Add, select a calculation, and click OK. The Payee Ledger Display Options wizards are displayed.
5. Click New to launch the Calculation Wizard and create a new calculation.
6. Click Edit or Delete to change the calculation reporting settings or to remove the calculation from the report.
7. Click Colors to define the appearance of the report, and make changes in the Report Color Selector window.

**Step 2. Selecting a payee group**

In IBM® Cognos® Incentive Compensation Management, each tailored report calculates results for all payees who are a part of the payee group that the report is associated with.

**About this task**

Payee groups are defined in the Payee Groups window.
Procedure

In the Add/Edit Tailored Report window, select the payee group from the This tailored report is associated with the following payee group menu.

Step 3. Enabling alert generation through Task Manager

In IBM Cognos Incentive Compensation Management, if you created a tailored report that is designed to generate data only when certain milestones or exceptions occur, you can opt to be notified when the report is not empty. When you set up notifications, you do not need to remember to check the results regularly.

About this task

For example, you might want to create a report that lists payees who failed to meet their monthly targets or who exceeded a certain threshold.

Procedure

In the Add/Edit Tailored Report window, select the Create an Alert when this report is not empty checkbox.

Task Manager displays an alert in the Tasks & Alerts tab when the report generates results.

Important: To ensure that the Task Manager alert is generated, the Specified reports generate one or more rows option must be enabled in the Task Manager Alerts tab.

Editing a locked tailored report

When a tailored report is locked in IBM Cognos Incentive Compensation Management, you can change the end date of the plan and whether transactional details are displayed in Payee Ledger.

About this task

You cannot add or delete calculations in the report, change the colors or formatting, or change the payee group that is associated with the report.

Procedure

1. In Composer, right-click the tailored report and click Edit.
2. Make changes and click Finish.

Important: When you edit Payee Ledger display options for a locked tailored report, the changes take effect in the first unlocked period. Payee Ledger continues to display the original display settings for all locked periods. For example, if you add another display column in the Payee Ledger Display Options Step 2 window, define the column properties, and click Finish, the added column is visible only in unlocked periods.

Copying a tailored report

In IBM Cognos Incentive Compensation Management, you can copy a selected tailored report into another component.
Before you begin

Inbound connections must be created in the new component for the calculations that it uses or depends upon.

Procedure
1. To copy a tailored report, right-click the tailored report that you want to copy and click Copy.
2. To paste the tailored report, find the component where you want to add the tailored report. Right-click inside the new component and click Paste.
3. Type a Paste Suffix to ensure that you do not have two tailored reports with the same name.
4. To specify the new sources, click Automatch or select the sources. You must map the old sources to the new sources.
5. Click OK.

Results

The report is copied and connections stay intact.

Report results in Payee Ledger

To view the results of your compensation plan or tailored report in Payee Ledger in IBM® Cognos® Incentive Compensation Management, select the report, period, payee, and calculation from the menus.

Compensation plans are prefixed with the letter P and tailored reports are prefixed with the letter R.

Related concepts:
Chapter 27, “Payee Ledger,” on page 275

Use the IBM Cognos Incentive Compensation Management Payee Ledger module to view summary and detail level reports of compensation plan results, and tailored reports.
Chapter 16. Adjustments

You can use adjustments in IBM® Cognos® Incentive Compensation Management to edit previously calculated compensations.

Use adjustments to correct mistakes while preserving initial data values, so that locked period values always tie out to actual paid compensation.

The adjustments feature automatically calculates deltas that are caused by changes to locked data. The difference, positive or negative, can then be allocated in selected future periods.

When to use an adjustment

In IBM® Cognos® Incentive Compensation Management, you can use adjustments in specific situations after a calendar is locked.

The following situations provide examples of when an adjustment might be used:

• A sales representative recorded incorrect product information for a sale, and as a result, he or she received incorrect compensation.

• A client's sales team neglected to inform payroll that a payee was demoted four months ago. This oversight resulted in months of overpayment and scorecarding ramifications.

• A company regularly manually corrects thousands of rows of transactional source data. It is possible that some manual corrections might be incorrect.

Adding adjustment categories

Because there are many reasons why you might need to make an adjustment, you can use IBM® Cognos® Incentive Compensation Management to set up adjustment categories. Then, you can easily keep track of the types of adjustments that you are making.

Procedure

1. In Payee Ledger, click the Adjustment Details tab.
2. Click the Adjustment Categories icon.
3. Click Add.
4. Type a name for the adjustment category and click OK.
5. When you are finished adding adjustment categories, click Close.

Adjustments and calculation speed

When you perform an adjustment in IBM® Cognos® Incentive Compensation Management, the calculation engine computes the difference between the locked earnings and the adjustment amount to determine a net earnings amount for that period.

Adjustment information is displayed on the Adjustment Details tab in Payee Ledger.
**Important:** Because a calculation is the only way to update results, it must be used to process the results of an adjustment.

In the first calculation that is run after you make an adjustment, there is an increase in calculation time because, in addition to calculating results for data in unlocked periods, Cognos Incentive Compensation Management must also compute the net payment amount after adjustments. Cognos Incentive Compensation Management must recalculate every locked period that is affected by the adjustment to compute the deltas.

**Important:** Your calculation speed is affected only for the first calculation after the adjustment is made.

The number of adjustments has no bearing on calculation time. Whether you make one adjustment or ten, your calculation speed remains the same. However, the number of periods that are affected by the adjustment does have an effect on calculation time.

---

### Manual adjustments

You can create manual adjustments in IBM® Cognos® Incentive Compensation Management for one-time solutions in specific scenarios.

Manual adjustments usually do not have specific rules and are typically applied in the current period. An administrator can add a manual adjustment to any payee for any open period. The date, time, and amount of the adjustment is logged and a comment can be included.

Because manual adjustments do not involve changing a table, they are created through the Adjustment Details tab of the Payee Ledger.

---

### Adding a manual adjustment

You can add adjustments manually through Payee Ledger in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In Payee Ledger, select the Adjustment Details tab.
2. Select the relevant plan and payee.
3. Click the Generate Report icon.
4. Double-click the row of an unlocked period. An unlocked period has a white background.
5. In the Adjustment Viewer window, select the Manual tab and click Add.
6. Enter the Adjustment Value, Adjustment Category, and an optional comment.
7. Click OK, and then click Close.

**Results**

The adjustment amount is displayed in the manual adjustments column. This amount is paid on the same check as the rest of the compensation earnings for the selected month and selected plan.
**When not to use an adjustment**

Do not make adjustments to partial periods in IBM® Cognos® Incentive Compensation Management. If it is imperative that a change be made midway through a period, start and end date columns should be included in the table.

The following tables show how start and end date columns can be effective for changing a commission rate mid-period. To change the commission rate part way through January, this example changes the end date for the 3% rate and adds a row.

*Table 31. Example A*

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Plan</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1, 2009</td>
<td>January 31, 2009</td>
<td>Plan1</td>
<td>3%</td>
</tr>
<tr>
<td>February 1, 2009</td>
<td>February 28, 2009</td>
<td>Plan1</td>
<td>5%</td>
</tr>
</tbody>
</table>

*Table 32. Example B*

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Plan</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 1, 2009</td>
<td>January 14, 2009</td>
<td>Plan1</td>
<td>3%</td>
</tr>
<tr>
<td>January 15, 2009</td>
<td>January 31, 2009</td>
<td>Plan1</td>
<td>4%</td>
</tr>
<tr>
<td>February 1, 2009</td>
<td>February 28, 2009</td>
<td>Plan1</td>
<td>5%</td>
</tr>
</tbody>
</table>

**Start and end dates in adjustments**

Most values do not need to be changed midway through a period in IBM® Cognos® Incentive Compensation Management. As a result, start and end date columns are normally not necessary.

For example, if a commission rate field changes, the change normally takes effect at the beginning of a new period.

Do not use start and end dates, because calculation time will increase. To deal with changes that affect partial periods, make a manual adjustment or prorate instead.

**Payee Ledger reports**

After a period is locked in IBM® Cognos® Incentive Compensation Management, Payee Ledger reports for that period do not change.

If you make an adjustment to a locked period, the adjustment amount is displayed in the **Adjustments** column of the summary ledger for the period that the adjustment amount was allocated to. Adjustments to locked periods might occur in the following scenarios:

- Month 1 is locked
- An adjustment is made to month 1 data
- Adjustment amount is allocated to month 2
- Payee Ledger reports for month 1 does not change
Viewing adjustment details on the web

After you make an adjustment, users of the IBM® Cognos® Incentive Compensation Management web client can view adjustment details through an expandable interface.

Procedure

1. Log in to the Cognos Incentive Compensation Management web client.
2. On the Payee Ledger tab, click the Summary screen link, and open the plan or report for a specific payee.
   In the Net Adjustments columns, there is an information icon next to each adjustment.
3. Click the icon, and then click the information icon, to view details and comments about the selected adjustment.
Chapter 17. Scenarios

You can use scenarios to analyze how variations in the output of a model in IBM® Cognos® Incentive Compensation Management can be apportioned to different sources of variation.

You can use the Scenarios module to build what-if scenarios, view a side-by-side comparison of targets to actual results, and analyze significant variances from the plan. You can test the impact of proposed changes before they are implemented. If you like the changes that you tested in the scenario, you can then promote them to the model for implementation.

When you create a scenario, you can add calculations and tables that are associated with compensation plans to be included in the scenario. You can then complete the following actions:

- Alter the data and logic, including adding or removing data rows
- Determine what changes were made in the scenario
- Calculate the scenario
- Compare scenario results to actual calculated results or other scenarios in a report

Imagine that you have the following basic plan layout, and many calculations are needed in each component to fully build out the logic.

Figure 1. Basic Plan Layout

1. Data
2. Credit
3. Attainment rules
4. Earning rules
5. Payment rules

By creating a scenario based on the basic plan layout in Figure 1, you can create many combinations of what-if modeling, including the following changes:

- A change to crediting rules
- A change to goals or attainment rules
- A change to earnings rules
For example, you might want to view how the Account Executives compensation plan might change if you increase their commission rates by 2%. You can create a scenario based on the Account Executives compensation plan, add the table that contains the Account Executives commission rates, and add a transform change set to the table in which you adjust the commission rates by 2%.

Similarly, you might want to view how the Inside Sales Representatives compensation plan change if you decrease the commission rate on a particular product. You can create a scenario based on the Inside Sales Representatives compensation plan, add the table that contains the product commission rates for Inside Sales Representatives, and add an overwrite change set to the table in which you change the commission rate for the specific product.

Scenarios are based on the current data in tables and calculations in your model. If you change tables or calculations in Composer, these changes are reflected in Scenarios.

You can use the Scenarios module to forecast the impact of changes in compensation plans before you implement changes for budgeting and cost management. You can get visibility into specific individuals who are the most and least impacted by any changes. Then, you can proactively and effectively communicate any plan changes. Scenarios can be created and compared to each other or to the current plan so that you can better understand the impact of prospective changes across historical, future, or current data.

Related concepts:

“Access permissions” on page 288
When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

“Scenarios security” on page 309
Users can be granted permission to create workspaces and scenarios in the IBM Cognos Incentive Compensation Management Scenarios module.

---

**Step 1. Adding a workspace**

Before you add and work with scenarios in IBM® Cognos® Incentive Compensation Management, you must add a workspace to contain your scenarios.

**About this task**

Each workspace must be associated with at least one compensation plan. Only the tables and calculations that are associated with the compensation plans are available for editing in the scenarios in the workspace.

**Procedure**

1. Click the **Add New Workspace** icon.
2. Type the **Name** and **Description** for the workspace.
3. Select **Public** or **Private Accessibility**. A public workspace is available to any user with access to the Scenarios module. A private workspace is available only to the user who added it and users assigned the administrator role.

   **Important:** You can grant users access to private workspaces in the Manage Roles window.
4. To define the periods that are accessible for editing in the scenario, select the start date and end date.
5. Select the compensation plan that you want to use in the workspace.
6. Click OK.

**Editing workspace properties**

You can edit the name, description, and accessibility of a workspace in the Scenarios module in IBM Cognos Incentive Compensation Management.

**Procedure**
1. Open the workspace.
2. Click the **Workspace Properties** icon.
3. Make your changes and click **OK**.

**Searching for and viewing workspaces**

You can view a list of workspaces that you created and filter the list of workspaces in the Scenarios module in IBM Cognos Incentive Compensation Management.

**Procedure**
1. In the Scenarios module, click the **Sidebar** icon.
2. To filter the list of workspaces, type a name in the **Filter** box.

---

**Step 2. Adding a scenario**

In IBM Cognos Incentive Compensation Management, you can use scenarios for side-by-side comparison of data to help with modeling of compensation plans for the next year.

**About this task**

After you add a workspace, you can add scenarios that can make logic changes, edit or delete source data, transform data, and add to source data. For example, if you want to see how changing a payee’s quota affects the total compensation payment for the payee, add the table that contains quotas to your scenario and change the amount.

**Procedure**
1. In a workspace, click the **Add New Scenario** icon.
2. To change the name and add a description to the scenario, click **Edit**.
3. When you are finished, click **Save**.

**Step 3. Adding items**

In IBM Cognos Incentive Compensation Management, you can add tables and calculations to scenarios that are associated with the compensation plans in your workspace.

**About this task**

You might add a quota table to see how changing a payee's quota affects the total compensation payout. The data from added calculations is displayed in table form. The workspace must first be calculated before the table is populated with the
calculated results. You can then edit, add, delete, or transform the calculation results in any way. You can edit results such as attainment or annual compensation without having to go back to source data or early calculation results.

Procedure

1. In the workspace, under the Scenario tab, click the Add New Item icon.

2. Use the Filter field to search for an item, or scroll down and select a table or calculation that you want to edit.

   The item is added to the scenario.

   **Important**: If you add a calculation, a warning sign is displayed next to the item to indicate that the workspace must first be calculated before changes can be made. It might also indicate that the table is too large to be used in the workspace.

3. If you selected a calculation, complete the following steps:
   a. Open the Calculate module.
   b. From the Calculation Type menu, select Scenarios Workspace.
   c. From the Workspace menu, select the workspace that you want to calculate.
   d. Click Calculate.
   e. After the calculation runs successfully, go back to the scenario and click the Refresh icon. The warning sign is no longer displayed and you can edit the calculated results.

---

**Step 4. Change sets**

You can add change sets to edit the data in the tables and calculations that you added to a scenario in IBM® Cognos® Incentive Compensation Management.

There are two types of change sets: overwrite change sets and transform change sets.

Use an overwrite change set to add rows to tables and calculations and change values for columns that are not primary key columns. The table or calculation data is presented in table form and you can edit the data to suit your scenario. This change set is most useful if you want to make a change to a specific value in a table or calculation.

Use a transformation to make changes to a table or calculation across multiple rows for non-primary key columns at the same time. You can create restrictions to replace or adjust specific data in a column of a table or calculation. For example, if you want to change the quota only for managers, you can restrict the data to include only managers. This change set is most useful when you want to make a uniform change to more than one row of data.

**Adding an overwrite change set**

You can add an overwrite change set to make specific changes to each row in a table in a scenario in IBM® Cognos® Incentive Compensation Management. For example, you can use an overwrite change set to view the effects on a compensation plan when you increase the quantity that is sold for a specific payee.

**Procedure**

1. In the workspace, under the Scenario tab, select the table or calculation that you want to add an overwrite change set to.
2. Click the Add Overwrite Change Set icon. Overwrite 1 is added under the selected item.
4. In the table of data, make the changes that you want to the rows. You cannot change primary key columns.
5. Click OK.

Adding a transform change set
In the Scenarios module in IBM® Cognos® Incentive Compensation Management, you can add a transform change set to apply a uniform change over multiple rows. For example, you can use a transform change set to view the effects on a compensation plan when you decrease the quota by 10% for all managers.

Procedure
1. In the workspace, under the Scenario tab, select the table or calculation that you want to add a transform change set to.
2. Click the Add Transform Change Set icon.
   Transform 1 is added under the selected item.
4. In the Transform Data wizard, define any restrictions for the transformation, and then click Next.
   If you want to replace only some of the values in a column, define restrictions here to indicate which values to update. For example, if you want to update values only for John Smith, restrict the data in the table to include records for only John Smith.
5. From the Column menu, select the column that you want to perform the transformation on.
6. From the Transform Type menu, select Replace or Adjust.
   You can replace the data with new data or adjust the data in the column by a percent or value.
   • If you select Replace, in the Replace With field, select a column or type a value. The value that you type or select replaces all values in the selected column.
   • If you select Adjust, in the Adjust Type field, select Value or Percentage, and in the Adjust By field, type a value. You can increase or decrease the values in the selected table by a percentage or a set value.
7. Click Finish.

Editing properties for transform change sets and overwrite change sets
In the Scenarios module in IBM® Cognos® Incentive Compensation Management, you can rename or write a description for a transform change set or overwrite change set.

Procedure
1. In the workspace, under the Scenario tab, select the transform change set or overwrite change set.
2. At the bottom of the scenario window, click the Properties heading.
3. Click Edit.
4. Type a name and description.
5. Click Save.

**Previewing scenario results**

After you create a transform data change set, you can calculate and preview your scenario to see the effects of any changes that you made in the Scenarios module in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In the workspace, under the Scenario tab, select the transform change set that you want to preview.
2. Click Preview.

**Results**

A table opens with the results.

**Editing the order of change sets**

In the Scenarios module in IBM® Cognos® Incentive Compensation Management, when you have multiple change sets for one table or calculation, you can change the order of the change sets. The change set that is listed last is used to calculate the report.

**Procedure**

1. In the workspace, under the Scenario tab, select the change set.
2. To move the change set, drag it up or down in the list, or use the up and down arrows.

---

**Step 5. Generating a report**

You can generate a report to present your results and compare your scenario to the current model or other scenarios in IBM® Cognos® Incentive Compensation Management.

**Before you begin**

Before you generate a report, you must calculate the workspace that you want to generate the report for.

**Procedure**

1. In the workspace, click Reports.
2. From the Report Type list, select to compare results by payee or by period.
3. From the Base Scenario list, select the scenario that you want use to compare to the target scenario.
   
   If you select (Base), your scenario is compared to the current data in the model.
   
   If you created more than one scenario, you can also compare two scenarios to each other.
4. From the Target Scenario list, select the scenario that you want to compare with the base scenario.
5. From the Compensation Plan list, select the compensation plan that you want to generate results for.
6. If you selected **Period Comparison** as the **Report Type**, from the **Payee** list, select a payee to view. If you selected **Payee Comparison**, from the **Period** list, select a period to view.

7. From the **Number of Chart Items** list, select the number of items that you want to display in the chart.

8. Click the **Generate Report** icon.

---

**Step 6. Promoting a scenario**

In IBM® Cognos® Incentive Compensation Management, you can promote a scenario to replace the current data in your model with the new data from the scenario. This action replaces the items in Composer that you used to create your scenario with the edited scenario items.

**Procedure**

1. In the workspace, under the **Scenario** tab, select the scenario that you want to promote.
2. Click **Promote Scenario**.
Chapter 18. Web forms

Use web forms in IBM® Cognos® Incentive Compensation Management to create forms and enable them for web review or data submission.

Web form creation begins with selecting the data sources that you want to use and the detail columns that you want to display. Optionally, you can make any of the columns editable for the web user, or they can be displayed for review only.

After you define the data that you want to display in the form, you can then create restrictions that limit the information that is displayed to individual web users. For example, you might want to create a restriction that allows web users to see only their own information.

Adding a web form

In IBM® Cognos® Incentive Compensation Management, a web form is a completely configurable grid. When you create a web form, the content and design of the form is up to you.

**About this task**

You can select any fonts, cell colors, or text justification that you want.

**Procedure**

1. In Composer, navigate to the component where you want to add the web form.
2. To add a web form, right-click the window and click Add Web Form.
3. Name the web form and click OK.
4. Double-click the web form element to open the web form.

Defining web form filters

In IBM® Cognos® Incentive Compensation Management, you can define filters to restrict the web form data to a certain subset of the results. For example, a web user might want to filter the data to display only rows for a particular payee.

**About this task**

You can create and save as many filters as you like, and then apply them to specified web forms.

**Procedure**

1. Click the Source Filters button.
   
   **Important:** You must define a filter for web forms with sources that have more than 1,000 rows of data.
2. In the Web Form Source Filters window, click Add.
3. Type a filter Name.
4. Select the filter Type. You can select a Simple filter, a Portal Access filter, or a Custom filter.
5. Select the **Matching Operator** to use in your filter.

6. Select the **Display**. You can select a menu or an editable field as the display for the filter.

7. Click **Next**.

8. The next step is determined by the type of filter that you selected in step 4.

**Defining a simple filter**

In web forms in IBM® Cognos® Incentive Compensation Management, simple filters provide web users control over what is displayed on their screen, and users can filter data based on one column in one source table. For example, you can create a simple filter that filters web form data based on job title.

**Procedure**

1. In step 2 of the Add Web Form Source Filter wizard, select the table, the value column, and the name column that you want to use as the source for the filter.

2. Click **Finish**.

**Defining a Portal Access filter**

In web forms in IBM® Cognos® Incentive Compensation Management, you can define a **Portal Access** filter to display payee data based on a compensation plan's **Portal Access** hierarchy.

**About this task**

When you add a **Portal Access** filter, you must select a **Portal Access** plan hierarchy. The plan hierarchy is determined by the access tree that is assigned to the plan in the Portal Access module.

**Procedure**

1. In step 2 of the Add Web Form Source Filter wizard, select a **Portal Access** hierarchy.

2. Click **Finish**.

**Defining a custom filter**

In web forms in IBM® Cognos® Incentive Compensation Management, the custom filter is a generic filter that is completely customizable. Use custom filters to link a given set of sources to the web user to restrict result rows without relying on the **Portal Access** hierarchy.

**Procedure**

1. Select the source for the filter.

2. Select the detailed columns by dragging one value column and one name column to the right side of the screen.

   **Important:** The column that you select determines the values that web form data can be sorted by.

3. Define any restrictions.

4. Click **Finish**.
Adding sources to web forms

You can use any calculated results or tables except the Time table as data sources in your web forms in IBM® Cognos® Incentive Compensation Management.

About this task

When you add data sources, you can select the columns that are editable for the web user, or that are displayed for review only. You can also create restrictions that limit the information that is displayed to individual web users.

Procedure

1. Right-click a cell in the web form and click Add Source.
2. Select a Source.
3. To join another source, click Add.
4. Click Next when you are finished adding sources.
5. Drag columns that you want to display on your form to the pane on the right side.
6. Right-click a column name and click Toggle Editable if you want the column to be editable by web users. Editable columns are displayed in bold.
7. Click Next.
8. Drag columns into the restricted definition list to create a restriction. For example, if you pulled in an ERP data table with a web user table, you can ensure that web users can view only their own results by restricting on the payee ID: web user payee ID = source data payee ID.
9. Click Next.

Adding validation rules to editable web form columns

You can add and assign validation rules to put constraints on the data that can be entered in editable web form columns in IBM® Cognos® Incentive Compensation Management.

About this task

Data can be restricted to a particular numeric, text or date value, or a web form source column.

Procedure

1. In step 4 of the Web Form Source Wizard, click Add.
2. Select the Table and Column that is the source of the validation rule.
3. Select the Operator.
4. Select the Value or Source from the tabs to complete the input rule.
5. Click OK.

Important: If calculation results are appended to a web form source, the joined calculated results can be used to define the validation rule.

Adding a saved web form filter

You can attach saved filters to your web form source in IBM® Cognos® Incentive Compensation Management.
Procedure
1. In step 5 of the Web Form Source wizard, click Add.
2. From the Available Filters menu that you want web users to be able to apply to the source, select the previously created filter.
3. Select the Source Table and the Source Column that the filter applies to.
4. Click OK.

**Important:** Before you can add filters to a web form, you must first define them in the Define Filters wizard on the Web Forms toolbar.
5. Click Finish.

Results
On the form, you can now see the columns that you selected from the source.

---

### Adding a row form

You can create web forms so that enabled users can add rows to a table (as opposed to simply editing existing rows) in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. Right-click an empty cell in the web form and click Add Row Form.
2. Select the Destination Table. The destination table is the table that the rows will be added to and can be a custom or structural table.
3. Click Next.
4. Add any Validation Rules.
5. Click Finish.

**Results**

The rows are displayed in your web form.

### Adding a required flag to a row form

When you add rows to a row form in IBM® Cognos® Incentive Compensation Management, all fields are editable.

**About this task**

If certain fields must be completed, you can add a required flag to particular cells to let web users know that data must be entered in the field before they can submit the row.

**Procedure**
1. Right-click the field in the row form and click Input Options.
2. Select Required.

**Setting a field width**

You can set the width of an editable field in a web form in IBM® Cognos® Incentive Compensation Management.
Procedure
1. Right-click the editable field in the web form and click Input Options > Field Width.
2. Set the Field Width and click OK.

Adding web resources
In web forms in IBM® Cognos® Incentive Compensation Management, you can include company logos, other images, or links to other websites.

Procedure
1. Right-click an empty cell in the web form and click Add Web Resource.
2. Type the name of your web resource.
3. Type the URL for your image or link.
4. Select Image or Link.
5. Click OK.

Results
On the web form, you can see the image or the name of your link underlined in blue.

Adding an admin form column to a web form
In a web form in IBM® Cognos® Incentive Compensation Management, you can add an admin form column. After the user uses the web form to submit data, the admin form displays the data in a column where an administrator can approve or reject the changes.

Before you begin
You must click Administrator approval required in the Web Form Options window. The admin form is not displayed if results are submitted directly to the database.

Procedure
1. In Composer, enable the target table for web data edit.
2. Right-click a cell in the web form and click Add Admin Form.
3. Select the target table that you enabled for web data edit. Approval or rejection data of the changes on this web form are sent to the table.
4. Click Finish.

Formatting a web form
You can edit the font, alignment, and shading of the cells in a web form in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Select the cell that you want to format.
2. To format the cell, right-click and click Format Cells.
3. Click the Format Cells icon. Use the Format Cells window to format the font, alignment, and shading of text in the selected cells.
4. Click OK.

**Setting the cell span**

You can configure the contents of a cell to cover a range of cells in a web form in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. Highlight the number of columns in the web form that you want the cell to span.
2. Right-click the highlighted cells and click **Set Cell Span**.

**Results**

The cell span is outlined in red.

**Copying and pasting web form cells**

In a web form in IBM® Cognos® Incentive Compensation Management, you can move cells that contain text or data.

**Procedure**

1. Select the cells in the web form that you want to copy, right-click the selection, and click **Copy**.
2. Go to the paste location, right-click, and click **Paste**.

**Setting web form options**

You can specify web form options such as filters, export filters, and whether data submission requires administrator approval. You can also specify whether the web form can be displayed in the IBM® Cognos® Incentive Compensation Management web client before the options are set.

**Procedure**

1. In the web form, click the **Form Options** button.
2. Specify whether the web form can be displayed before the options are set.
   - If you select the **Do not show form until filter applied** check box, the filters are displayed after the web form is chosen from the menu. The user must select the filters and click **Apply** to produce the web form.
   - If you clear the **Do not show form until filter applied** check box, the entire web form is displayed as soon as the form is chosen.
3. In the **Date Submission** section, specify whether you want administrator approval for data submission.
   - If you select **Administrator approval required**, a model administrator must approve the changes through Composer before the changes are committed to the database.
   - If you select **Direct to database**, edits are made directly to the database. Because there is no approval process, use caution when you select this option.
4. Select the **Export Filter**. This is the filter that users must apply to view the web form.
5. Click **OK**.
Setting web form preferences

You can specify the default number of rows and columns that are displayed in the editor window of a web form in IBM® Cognos® Incentive Compensation Management.

Procedure
1. In the web form, click the Preferences icon.
2. Select the editor dimensions.
3. If you want the payees available for selection in the web client to be determined by the Portal Access filter, select the Restrict payee selection when Portal Access Filter present check box.
4. Click OK.

Adding JavaScript

You can add JavaScript to a web form in IBM® Cognos® Incentive Compensation Management.

About this task

The JavaScript codes are displayed before the web form and are enclosed in the <script type="text/javascript"> tag. You can also add JavaScript in web form cells.

Procedure
1. In the web form, click the JavaScript button.
2. Type or paste the JavaScript code into the JavaScript window. There is no limit of characters in the JavaScript text box.
3. Click OK.

Reports, web forms, and web pages

You can link web forms together in IBM® Cognos® Incentive Compensation Management by inserting a link on a web form item. You can create the link from text and sources, or you can add it as a web resource.

You can create links to web forms, web pages, and Presenter reports. You can choose to pass parameters from Presenter reports into existing web form filters.

When you link to another web form or Presenter report, you can choose to select an associated web tab. On the web client, when the user clicks the link to the web form or Presenter report, the associated web tab opens. If no associated web tab is selected, then the web form or Presenter report is displayed on the current web tab.

Linking a web form to a Presenter report

You can link text, web resources, or sources in a web form to a Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Select the text, web resource, or source in the web form, right-click, and select Add Link.
2. In the Link to section, select Report.
3. Select the Presenter report from the Report menu.
4. From the Web Tab menu, select the web tab that you want to open when a user clicks the report link. Only web tabs that are associated with the selected report are displayed. If you want the report to display in the current web tab, leave the Web Tab menu blank.
5. To link a parameter, double-click the row with the parameter.
   a. In the Link Parameter window, select the Type and Value of the parameter.
   b. Click OK.
6. Click OK.

**Linking a web form to another web form**

You can link text, web resources, or sources in a web form to another web form in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. Select the text, web resource, or source in the web form, right-click, and click Add Link.
2. In the Link to section, select Web Form.
3. From the Web Form menu, select the web form.
4. From the Web Tab menu, select the web tab that you want to open when a user clicks the web form link. Only web tabs that are associated with the selected web form are displayed. If you want the web form to display in the current web tab, leave the Web Tab menu blank.
5. To link a filter, double-click the row with the filter.
   a. In the Link Parameter window, select the Type and Value of the filter.
   
   When you link to a web form, you do not have to carry over the filters. The filters that you created in the web form are displayed in the Parameter column of the Link Wizard.
   b. Click OK.
6. Click OK.

**Linking a web form to a web page**

You can link text, web resources, or sources in a web form in IBM® Cognos® Incentive Compensation Management to a web page.

**Procedure**

1. Select the text, web resource, or source in the web form, right-click, and click Add Link.
2. In the Link to section, select Web Page.
3. Type the URL that you are linking to in the Address field.

**Publishing a web form**

You can publish a web form in IBM® Cognos® Incentive Compensation Management as a PDF file.

**Procedure**

1. Open the web form.
2. Click the Export to PDF icon.
3. Select Publish from my computer or Publish from the server.
4. Select the Portal Access Group whose members you are generating the report for.
5. If you added filters to the web form, select the filters to apply and click Next.
6. Under PDF options, select Portrait or Landscape and the Scaling options.
7. Select the Use header image check box to display an image as the header on each PDF file and click Browse to find the image.
8. You can select the Include page numbers check box to show page numbers in the footer. You can also select the Show total page numbers check box, and type a Footer.
9. Click Browse to select where you want to save the PDF file.
10. You can define a prefix for the file name of each PDF file. By default, when you publish reports, the file name consists of the web form name, payee name, and date and time that the web form was published to a PDF file.
11. Click Finish.
Chapter 19. Presenter report data components

In IBM® Cognos® Incentive Compensation Management, you can use Presenter to report on your data. In the Presenter module, you can create, compose, and post Presenter reports in the web client for review.

Presenter reports are configurable in terms of both design and content. Presenter reports can also be configured for data submission. Report administrators can create editable fields so that web users can edit or add data through data grids to tables in Composer.

Presenter reports consist of the following main components that are the building blocks for report creation:

- Data components
  - Parameters
  - Values
  - Sources
  - Row form sources
- Presentation components
  - Layout tables
  - Value displays
  - Grids
  - Images, charts, maps, and gauges
  - Controls and Submit buttons

Presenter report creation

You must follow several main steps to create a Presenter report in IBM® Cognos® Incentive Compensation Management.

At a high level, the following steps describe how to create a Presenter report:
1. Create parameters that restrict the results that are displayed.
2. Create values that are based on tables, calculations, and constant values, or computed from existing values.
3. Create a source.
4. Pull calculations, tables, parameters, and values into the Presenter report source.
5. Define the report layout tables for all of the report components.
6. Add report components to the layout tables.

How the pieces fit together

At a high level, calculations, tables, values, and parameters provide the information that is needed to create a report. These pieces then get compiled into a Presenter report source. After a source is created, it can be displayed visually on a report.
Presenter report sources can be used as building blocks for other sources. The steps of gathering and compiling information into sources can be repeated several times before a source is displayed in a grid on a report, as shown in the following example:

- Create source 1
- Source 1 feeds source 2
- Source 2 feeds source 3
- Source 3 is displayed in a grid on a report

**Presenter naming conventions**

Before you start to build a report in IBM® Cognos® Incentive Compensation Management, develop standard naming conventions for your report components.

To save time in the future, it is a good idea to set up your naming conventions in advance. Your naming conventions must apply to all parameters, values, and sources for each report.

**Important:** The following naming convention rules are suggestions only. You can edit them to suit the needs of your organization.

For example, your naming conventions might consist of component type and component purpose.

The first part of the name might specify the type of component. For example:

- Pa = parameter
- Va = value
- So = source

You might also add additional letters to indicate types of values and sources, such as table values. For example:

- SoCc = source with a computed column
- VaTa = table value

The last part of the name must clearly state the purpose of the component. For example, a parameter that is used to filter results by months might be called PaMonthlyDateFilter2013.

**Adding a Presenter report**

To create a Presenter report in IBM® Cognos® Incentive Compensation Management, you must first add a Presenter report to Composer.

**Procedure**

1. In Composer, navigate to the component where you want to add the Presenter report.
2. Complete one of the following steps:
   - Right-click and click **Add Presenter Report**.
   - Drag the **Presenter Report** element onto the Composer window.
3. Type a name for the Presenter report. The Presenter report element is added to the component.
4. Double-click the element to create the Presenter report.
Results

The Presenter report tab opens.

**Data components**

Before you create the layout of your Presenter report in IBM® Cognos® Incentive Compensation Management, you must build the components. Data components include parameters, values, sources, and editable sources.

**Parameters**

Use parameters to place restrictions or rules on the results that are displayed in your Presenter report in IBM® Cognos® Incentive Compensation Management.

Parameters are often used to make sure that report results are displayed only if the parameter is true. Multiple parameters can be included in sources, so you can compose the results in any way that you like. You can combine parameters to access the records that are useful and omit parameters that are irrelevant. The following parameters are examples of parameters that you can include in Presenter reports:

- **Payee filter**
  Used to filter the report to include only results for a selected payee.

- **Date filter**
  Used to filter the report to include only results for a particular date or time period.

- **Threshold filter**
  Used to show results that exceed or fall below certain thresholds, for example, payees who surpassed their quota by more than 10 percent.

The default value of a parameter can be set to another parameter or a Value (stored, calculated, and constant) when the Value option is selected as the Default Value Type. The items that are displayed in the Default Value list include only the items that match the selected parameter type. When User Entered is selected as the Default Value Type, a user-determined value can be typed into the Default Value field.

**Important:** Null values can be default values, but keep in mind that if the parameter is a Required Parameter, the report cannot render with a null value. If a non-null value is the default for a required parameter and the user submits a blank value, the default value is used instead to render the report.

**Adding a parameter**

In IBM® Cognos® Incentive Compensation Management, you can add text, date, or numeric parameters to your Presenter report to restrict and filter the results that are displayed in the report.

**Procedure**

1. To add a parameter, complete one of the following steps:
   - Right-click the parameters folder and select Add Parameter.
   - Select the parameters folder, click the Add icon, and select Add Parameter.
2. Type a name for your parameter.
3. Select a Parameter Type.
4. Select a Default Value Type.
   • If you want to set a static value as the Default Value, select User Entered.
   • If you want to choose another parameter or a stored, calculated, or constant as the Default Value, select Value.
5. You can type a Default Value that populates the parameter when a web user opens the report.
6. If you select the Required Parameter check box, the data in the report is not rendered until the user specified a parameter.

   **Important:** You must type a Default Value for a Value Parameter if you select the Required Parameter option.
7. If you select the Use Current Web User check box, any payee parameter is populated with the Payee ID of the user who is logged in to the web client.
8. Click OK.

   **Important:** Parameters cannot function on their own. They must be joined into a Presenter report source to function as intended. In the Presenter report Source wizard, you can set restrictions on source fields or values to identify the data that must be restricted by the parameter.

**Report parameter links**
Parameters that are used in one Presenter report in IBM® Cognos® Incentive Compensation Management can be carried over into a linked report.

The following example explains how a linked report with linked parameters might work:
• Filter Report 1 by payee and month
• Create a link from Report 1 to Report 2
• Display records in Report 1 for John Smith in Month 1
• Select link to Report 2
• Report 2 shows only records for John Smith in Month 1

To link reports and parameters, click the Link button in the report component wizards. When you link to another report, you do not need to carry over the parameters. If you choose to carry over parameters, you must drag them from the current report to corresponding parameters in the report that you are linking to.

**Values**
Values are variables that you can apply to your Presenter report in IBM® Cognos® Incentive Compensation Management to display additional data. Use values to scale back the results of a report or table to single cell.

There are three types of values; stored, calculated, and constant.

Often values are used to feed other values. For example, different types of values can act as building blocks for other values to retrieve the information that must be displayed in a report cell or on a fixed grid.

**Adding a stored value**
A stored value returns a single value from a table in IBM® Cognos® Incentive Compensation Management. The value can be retrieved from any table in Composer or any Composer or Presenter calculation in the model.
Procedure

1. To add a stored value, complete one of the following steps:
   - Right-click the Value folder and click Add Value > Stored.
   - Select the Value folder, click the Add icon, and click Add Stored Value.
2. Type a name for the stored value and click Next.
3. Select a source and click Next.
4. To pull a single value from a table, indicate which column and row to pull data from. Select a Value Column. The Value Column is the table column that contains the information that you need.
5. Double-click the first row to enter an ID Value. An ID Value must be specified for each ID column that contains the primary keys of the table. The ID Value is the value that must be inputted by the user to determine which row to pull data from.
   - To set the ID Value as a parameter, right-click the row and click Select.
   - Select the parameter from the menu and click OK. The value type populates automatically. If you select a parameter for the ID value, the value type is Selected. If you enter in a constant, the value type is User Entered.
6. Click Finish.

Stored value examples:

A stored value can be used to pull specific information from the Payee table in IBM® Cognos® Incentive Compensation Management and display it in a report.

If you have a table that contains payees and their commission rates, you might create a stored value that pulls a payee's commission rate from the table and displays it in the report.

Imagine that the following information is contained in your commission rate table.

*Table 33. Commission Rate Table*

<table>
<thead>
<tr>
<th>PayeeID</th>
<th>Job Title</th>
<th>Commission Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Account Executive</td>
<td>2%</td>
</tr>
<tr>
<td>002</td>
<td>Sales representative</td>
<td>4%</td>
</tr>
<tr>
<td>003</td>
<td>Account Executive</td>
<td>3%</td>
</tr>
</tbody>
</table>

You might create a stored value using the commission rate table as your source.

Because the commission rate field contains the data that you want to display, the commission rate field is selected as the Value column. The payee ID is the primary key in the table, so you might use a payee restricting parameter to pull the appropriate rate for the payee into the report. This value can then be pulled into a report. If payee 001 is selected on the report, the resulting value is displayed on the report.

Adding calculated values

You can use calculated values to perform calculations on other numeric values in a Presenter report in IBM® Cognos® Incentive Compensation Management.
About this task

For example, if you have a numeric value that shows a payee’s total sales and another value that displays monthly quota, you might pull these two values into a calculated value that shows the percentage of quota that was achieved.

Procedure

1. To add a calculated value, complete one of the following steps:
   - Right-click the Value folder and select Add Value > Calculated.
   - Select the Value folder, click the Add icon, and click Add Calculated Value.
2. Type a Name for the calculated value.
3. Add a formula by using Value Sources. The result of the computed value can now be displayed on the report.
4. Click OK.

Adding constant values

A constant value is a single value that is added to your Presenter report in IBM® Cognos® Incentive Compensation Management. A constant value can be a date, text, or numeric value.

About this task

Constant values can be used as sources in calculated values. If you must calculate a numeric value that is based on a value that does not change, you can use a constant value.

Procedure

1. To add a constant value, complete one of the following steps:
   - Right-click the Value folder and click Add Value > Constant.
   - Select the Value folder, click the Add icon, and select Add Constant Value.
2. Type a name for the constant value.
3. Select the type of constant value. You can choose from Date, Numeric, or Text.
4. Type a Value.
5. Click OK.

Sources

You can use a source in IBM® Cognos® Incentive Compensation Management to pull relevant information together into a single object that is well-structured for inclusion in a Presenter report. Sources can include any combination of calculations, tables, parameters, and values.

For example, imagine that you have the following pieces:
- A calculation that calculates total sales for each payee that is partitioned by payee, product, and month
- A calculation that calculates total commission paid to each payee that is partitioned by payee, product, and month
- A calculated value that will show the total commission paid for the year
- A parameter that restricts by payee
- A parameter that restricts by product
You can pull all these items together into a Presenter report source. You can then add this source to a data grid on the layout tab to show a report that contains value columns from each calculation, filters for payee and product, and a computed cell that displays the sum of the values displayed.

Sources can be data sources or transformations.

**Adding a data source**

You can add a calculation, data store, or table from Composer in IBM® Cognos® Incentive Compensation Management, and also information from the Audit log as a source for your Presenter report.

**Procedure**

1. To add a data source, complete one of the following steps:
   - Right-click the Sources folder and click **Add Source > Add Data Source**.
   - Select the Sources folder, click the Add icon, and click **Add Data Source**.

   **Tip:** The Source wizard window is resizable.

2. Type a name for the source and click **Next**.

   **Important:** You can also use the tabs to navigate to different steps in the wizard. However, all required fields must be completed before you can finish the wizard.

3. Select a calculation, table, or the Audit log as a source. Whether or not the Audit log is displayed as a source depends on the permissions that are set up for the user in the Manage Roles window.

4. Click **Add** if you want to add additional data to use in the source. You will be prompted to define restrictions for the data sources.

   **Tip:** You can use parameters that were created in Presenter as additional data.

5. If you have joined sources and you want empty fields to be included when there is no matching data (outer join), click the **Anchor Source Row** button.

   **Important:** Restrictions for the outer join must be defined during this step and not on step 4 of the Data Source wizard.

6. Click **Next**.

7. To select the fields to display in your report, drag columns into the right pane.

   **Tip:** To remove a selected field, right-click the field and click **Remove Selected**.

8. Click **Next**.


   If you added a parameter as an additional source, you must define the parameter restriction. For example, if you created a parameter that requires users to select a payee to generate the report, the payee parameter must be linked to the payee ID in the source as follows: Payee Parameter ID = Payee Source ID.

   **Important:** If you used the anchor feature to create an outer join, restrictions for that join cannot be defined here. Restrictions defined on Step 4 of the wizard define an inner join and rows that do not match do not appear.

10. Click **Next**.

11. To rename a column, click under **Display Name** and type a new name.
This step is necessary if you have two columns with the same name. For example, if you joined two calculations that both contain a value column, you must give one of your value columns a new name.

**Important:** If you change the column name in this step, you do not change the display name of the column on the actual report. To change the display name of the column on the actual report, use the Data Grid wizard.

12. Click Finish.

**Anchors in Presenter report sources:**

Use the **Anchor Source Rows** button in the Add Data Source wizard in IBM® Cognos® Incentive Compensation Management to join sources using a left outer join.

The anchor join type displays rows for all records of the first data source even if the join does not find matching records in the second data source. However, only matched records from the second data source are returned. If the second data source returns one row and the first data source returns more than one matching row, the values in the second source are repeated for each distinct row in the first data source.

For example, consider the situation where you have the following two data sources.

**Table 34. Data source 1**

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
</tr>
<tr>
<td>Brian Acton</td>
<td>001</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
</tr>
<tr>
<td>John March</td>
<td>003</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
</tr>
</tbody>
</table>

**Table 35. Data source 2**

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td></td>
<td>Sales</td>
</tr>
<tr>
<td>002</td>
<td></td>
<td>Development</td>
</tr>
<tr>
<td>003</td>
<td></td>
<td>Services</td>
</tr>
<tr>
<td>004</td>
<td></td>
<td>Marketing</td>
</tr>
<tr>
<td>005</td>
<td></td>
<td>Training</td>
</tr>
</tbody>
</table>

When the **Anchor Source Rows** feature is used, records from the first data source are returned even when there is no matching record in the second source. The following table displays typical results:

**Table 36. Results using Anchor Source Rows feature**

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dan Huddell</td>
<td>004</td>
<td>Marketing</td>
</tr>
<tr>
<td>Brian Acton</td>
<td>001</td>
<td>Sales</td>
</tr>
<tr>
<td>Jill Avery</td>
<td>002</td>
<td>Development</td>
</tr>
</tbody>
</table>
Table 36. Results using Anchor Source Rows feature (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>DepartmentID</th>
<th>Department Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>John March</td>
<td>003</td>
<td>Services</td>
</tr>
<tr>
<td>Chris Ackles</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Transformations
After you create an initial data source in a Presenter report in IBM® Cognos® Incentive Compensation Management, you can use it to create additional sources. The new sources are called transformations, because you can use them to transform the appearance of your source to present the data in a different way.

The following transformations are available:
• Aggregate transformation
• Computed column
• Transpose

Important: When you create a transformation based on a data source, you create a brand new source. The original source is not changed.

Adding an aggregate transformation:

Use aggregate transformations to create a new source that performs a calculation on a set of data from the original source in a Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure
1. In Presenter, expand the Sources folder.
2. To add an aggregate transformation, complete one of the following steps:
   • Right-click the data source that you want to use for the transformation and click Add Source > Add Transformation > Add Aggregate Transformation.
   • Select the data source that you want to use for the transformation, click the Add icon, and click Add Aggregate Transform.
3. Type a name for the aggregate transformation and click Next.
4. Select a numeric column within the source and apply a formula to it.
5. Click Next.
6. Select partitions to display. Use aggregate transformations to redefine the partitions of the original source to completely change the rows and columns that are displayed. Values can then be applied to further refine the data.
7. Click Finish.

Results

The result is a new source with an aggregated results column.

Adding a computed column:

You can add a computed column to a source to append an additional column to the source in a Presenter report in IBM® Cognos® Incentive Compensation Management. The data in the computed column is the result of applying a formula to numeric columns in the original source. Numeric values can be pulled into the formula as well.
About this task

The following examples show scenarios for which you might use a computed column:

% Attainment Column: If your original source displays total sales for each payee, you might want to add a computed column that displays their quota attainment percentage. In this case, your computed column displays the results of a calculation that divides the sales amount by the quota amount.

Based on this example, your results might be comparable to the following computed column table.

<table>
<thead>
<tr>
<th>Table 37. Original source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payee</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 38. Computed column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payee</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
</tbody>
</table>

Procedure

1. Expand the Sources folder.
2. To add a computed column, perform one of the following steps:
   - Right-click the data source you want to add a computed column to and select Add Source > Add Transformation > Add Computed Column.
   - Select the data source you want to add a computed column to, click the Add icon, and select Add Computed Column.
3. Type a name for the computed column.
4. Type a new column name.
5. Click Next.
6. Define the formula.
7. Click Finish.

The result of a computed column transformation is a new source that displays the same information as the original source, along with an additional column that displays results of your computation.

Adding a transpose:

You can use a transpose to transpose rows into columns to change the way your data is displayed in a Presenter report in IBM Cognos Incentive Compensation Management.
About this task

Transpose can be helpful if the data that you want to present is displayed in a different format than the final source results.

Table 39. Original data

<table>
<thead>
<tr>
<th>Payee</th>
<th>Month</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>Month 1</td>
<td>10</td>
</tr>
<tr>
<td>John Smith</td>
<td>Month 2</td>
<td>20</td>
</tr>
<tr>
<td>John Smith</td>
<td>Month 3</td>
<td>30</td>
</tr>
<tr>
<td>John Smith</td>
<td>Month 4</td>
<td>40</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 1</td>
<td>15</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 2</td>
<td>25</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 3</td>
<td>35</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>Month 4</td>
<td>90</td>
</tr>
</tbody>
</table>

Table 40. Transpose original data

<table>
<thead>
<tr>
<th>Payee</th>
<th>Month 1</th>
<th>Month 2</th>
<th>Month 3</th>
<th>Month 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
</tr>
<tr>
<td>Jennifer Williams</td>
<td>15</td>
<td>25</td>
<td>35</td>
<td>90</td>
</tr>
</tbody>
</table>

Before the transpose functionality can be available, it needs an explicit key structure to work with. Create an aggregated transformation of your source and partition by all of the columns. Then you can create a transposed source from the original source.

Procedure

1. Expand the Sources folder.
2. To add a transpose, complete one of the following steps:
   - Right-click the data source and click Add Source > Add Transformation > Add Transpose.
   - Select the data source, click the Add icon, and click Add Transpose.
3. Type a name for the transposed source and click Next.
4. Select the column to transpose.
5. Name the new column and click Next.
6. Select the rows in the Row Value column and select >> to move them to the New Columns pane.
7. Click Finish.

Workflow Form ID

In a Presenter report in IBM® Cognos® Incentive Compensation Management, the Workflow Form ID is an auto-generated number that you can use to distinguish results that are submitted by a specific workflow.

The Workflow Form ID number can be used to restrict data submitted in a workflow that can be viewed only by users who view the same workflow.

For example, if User A starts a workflow that submits Vacation Form 1 and User B starts a workflow that submits Vacation Form 1, then the Workflow Form IDs can...
be used so that the manager of both User A and B can view User A’s vacation form without seeing User B’s vacation form at the same time.

To build a report like this, you must enter the Workflow Form ID into a table when users are starting the workflow. Then this table is used as the source of the data grid for the record approver and the source must be restricted by the Workflow Form ID parameter.

**Portal Access Inquiries source**

The **Portal Access Inquiries** source contains inquiry information that can be reported on in a Presenter report in IBM® Cognos® Incentive Compensation Management.

You can use the **Portal Access Inquiries** source to create a custom report on inquiries. You can report on the ID of the inquiry, the person who created the inquiry, the person who is assigned the inquiry, the date the inquiry was created, updated, and closed, and the category of the inquiry. You can also use this source to determine the age of an inquiry by using a computed column in a data grid and subtracting the **Created date** column from the **Updated date** column.

**Row form sources**

You can use a row form source to create an input row form that can be used by web users to submit rows of data to a table from a Presenter report in IBM® Cognos® Incentive Compensation Management.

You can create a row form source only from a table. You can then use this source to create a data grid on the layout tab. The data grid displays table data with an input row that is located before or after the data grid for web users to submit data.

Optionally, report administrators can choose to display only the input row and not the table data. Administrators can also choose whether to display this input row vertically or horizontally on the report.

**Adding a row form source**

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add an input row form to a data grid that allows web users to submit data. To add the input row form, you can use a Composer table as a source.

**Procedure**

1. To add a row form source, complete one of the following steps:
   1. Right-click the **Row Form Sources** folder and click **Add Row Form Source**.
   2. Select the **Row Form Sources** folder and click the **Add** icon.
2. Type a name for the input row source and click **Next**.
3. Select the table that you want web users to be able to submit data to from the menu and click **Next**.
4. Drag the detail columns that you want users to be able to view and submit data to from the left pane to the right pane.
5. When you are done defining the detail columns click **Next**.
6. Drag a column to the right to create a restriction for the data visible to web users.

**Tip:** Click the **Preview** button to view the first 100 records of table data that is visible.
7. Click **Finish**.
Chapter 20. Presenter report layout and display options

After you create parameters, sources, and values for your Presenter report in IBM® Cognos® Incentive Compensation Management, you must add layout tables and report components.

Related concepts:

“Access permissions” on page 288
When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Chapter 21, “Working with completed Presenter reports,” on page 205
After you complete a Presenter report in IBM® Cognos® Incentive Compensation Management, it can be edited, previewed, published, and linked to other reports, web forms, or web pages.

“Presenter report security” on page 311
You can grant a role permission to edit Presenter reports in IBM® Cognos® Incentive Compensation Management and use the Audit log as a source in Presenter.

Layout tables

After you create report building blocks in IBM® Cognos® Incentive Compensation Management, you are ready to start building the report in the Layout tab.

Preparing the layout for a Presenter report

Although every report is different, you can use the following methodology to lay out the rows and columns in your Presenter report in IBM® Cognos® Incentive Compensation Management in a logical manner.

Before you begin

Plan your Presenter report before you start to build your table.

Procedure

1. Create a layout table with three rows and three columns.
   You use only the middle cell for the report, so make the other cells as small as possible. The outside cells are used for padding.
2. Add a nested table with five rows and one column in the center column.
3. Add more nested tables to subdivide the rows as needed.

Adding a layout table

You must create a layout table to contain the components of a Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure

1. Select the Layout tab.
2. Right-click and click Add Layout Table.
3. Give the layout table a name.

   Tip: Naming the layout tables is useful when you create workflows in the Workflow Manager module. As part of the workflow in Workflow Manager, you can select the layout tables in the report that you want to be viewable and editable by web users.

4. Select the number of rows and columns for your table.
5. To enter row heights or column widths for the layout table, click the Set Row Heights or Set Column Widths links.
   a. Enter the percentage height or width for each row or column. The total percentage must equal 100%.
   b. Click OK.
6. When you are finished creating the layout table, click OK.

   Important: You cannot merge cells and columns, but you can add nested tables into cells. You can also resize cells by selecting the cell border and dragging the grid lines.
Locking and unlocking a layout table
You can lock and unlock a Presenter report in IBM® Cognos® Incentive Compensation Management. You might want to lock layout tables to prevent accidental resizing.

Procedure
1. To lock a layout table in a Presenter report, click the Lock Layout Table button.
2. To unlock the layout table, click the Lock Layout Table button again.

Deleting a layout table
You can remove a layout table from the Layout tab in a Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Select the table.
   - The selected area is highlighted in blue.
2. Right-click and click Delete.

Editing a layout table
You can change the number of columns and rows in a layout table in a Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Select the table.
   - The selected area is highlighted in blue.
2. Right-click and click Edit Layout Table.
3. Edit the number of columns and rows.

Swapping two layout tables
You can swap two layout tables in a Presenter report in IBM® Cognos® Incentive Compensation Management if one layout table is not the parent of the other.

Procedure
1. Click the border of the table that you want to swap.
2. Press Ctrl, and click the border of the other table.
3. Right-click and click Swap.

Resizing cells in a layout table
You can resize the row heights and column widths of a layout table in a Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Complete one of the following steps:
   - Drag the borders of the cells to the size that you want. A percentage of the layout table width or height is displayed.
   - Right-click the layout table and click Edit Layout Table.
2. Click the Set Row Heights link to change the percentage of each row height and click OK.
3. Click the Set Column Widths link to change the percentage of each column width and click OK.
4. Click OK.

Report components

After you create the structure of your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add components such as text, data grids, charts, and maps.

Adding text and links

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add text and format text into a selected cell and you can also add links.

Procedure

1. Right-click a cell in your layout table and click Add Text.
2. Type your text.
3. Click Link to create a link from the text to another Presenter report, web form, or web page.
4. Format the text.

Related concepts:

“Presenter report edits” on page 207
After you add a Presenter report in IBM® Cognos® Incentive Compensation Management, you can edit specific objects or the whole layout table.

“Chart, report, and web page links” on page 205
IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

Setting the default font

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can set the default font and size of the text.

About this task

The default font is applied automatically to any object with a configurable font that is added to the layout table.

Procedure

1. Click the Preferences button.
2. Under Default Font, click Font.
3. Select the Font, Font Style, Size, Effects, and Color that you want.
4. Click OK.

Adding a date value display

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add the current date into a selected cell.

Procedure

1. Right-click a cell in your layout table and click Add Data Value Display.
2. Type a name for the date value display.
3. Select the Value Source.
4. Select either the LongDate format, for example, Monday, January 17, 2013, or ShortDate format, for example, 1/17/13.
5. Click Link to create a link from the date value to another Presenter report, web form, or web page.
6. Click OK.

Related concepts:
“Chart, report, and web page links” on page 205
IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

Adding a numeric value display
In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add a numeric value display to add a numeric value to a selected cell.

Procedure
1. Right-click a cell in your layout table and click Add Numeric Value Display.
2. Type a name for the numeric value display.
3. Select the Value Source. You can choose from any saved constant, calculated, or stored values based on a numeric column.
4. Select the Decimal Places.
5. Select the number Type.
6. Click Conditional Formatting to set the format conditions for the numeric value display.
   For more information, see “Setting conditional formatting” on page 200.
7. Click Link to create a link from this value to another Presenter report, web form, or web page.
   For more information, see “Chart, report, and web page links” on page 205.
8. Click OK.

Related concepts:
“Chart, report, and web page links” on page 205
IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

Related tasks:
“Setting conditional formatting” on page 200
You can specify different text and numeric formatting for values in a data grid column of your IBM Cognos Incentive Compensation Management Presenter report when certain conditions are true.

Adding a text value display
In your Presenter report in IBM® Cognos® Incentive Compensation Management, from any saved constant or stored value, you can add a text value to a selected cell.

Procedure
1. Right-click a cell in your layout table and click Add Text Value Display.
2. Type a name for the text value display.
3. Select **Show Value**. You can choose from any saved constant or stored values based on a text column.

4. Click **Link** to create a link from this value to another Presenter report, web form, or web page.

5. Click **OK**.

**Related concepts:**

“Chart, report, and web page links” on page 205

IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

---

**Adding a data grid**

You can use a data grid to display the results of a single data source in a table in your Presenter report in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. To add a data grid to the layout table, complete one of the following steps:
   - Right-click a cell in your layout table and click **Add Data Grid**.
   - Drag the source that you want to use in the data grid onto a cell in the layout table.

2. In the Display Selector window, select **Data Grid** and click **OK**.

**Important:** If you drag a source into a layout table that does not contain a numeric column, a data grid is created automatically.

3. Right-click the data grid and click **Edit Data Grid**.

4. Type a name for the data grid.

5. Select a source. You can select any Presenter report sources to add to your grid. If you dragged a source onto the layout tab, this field is pre-populated with the source.

6. Click **Next**.

7. Drag a column from the left to the right screen to sort the data. You can select more than one column to sort by. Right-click the column, and click either **Order Ascending** or **Order Descending**. If a column is sorted at the time of data grid creation, it is not sortable in the web client. Columns must be sorted separately for each section of the grid. Sorting does not extend beyond section breaks.

8. Click **Next**.

9. Select your data grid display options.

10. Click **Next**.

11. If you are sorting your data source by a date column from a table and you want to create section breaks by time, select a calendar from the **Calendar** menu to associate with the date column.

**Important:** You must select a calendar only if you are sorting your grid by a date column that does not have a calendar that is associated with it. For example, you have a custom table with a date column and you want to create a section break by time period. If you are not sorting your data grid by a date column, you do not need to select a calendar. If you are sorting your data grid by a time partition, all potential section breaks are associated with the calendar that is tied to the data grid source, and the calendar menu is disabled.
12. To delete any repeated group partitions, select the **Suppress Repeated Partitions** check box.

13. If you want payees to be able to export this grid to Microsoft Excel through the web client, select the **Enable Export to Microsoft Excel** check box.

14. To display headers for each section, select the **Show Section Headers** check box.

15. To lock the header row of the data grid so that it displays continuously while a user scrolls down the report in the web client, select the **Freeze Header Row** check box.

16. Click **Add** to specify any section breaks and to add information to the sections.
   a. Select a section to add from the menu and click **OK**.
   b. To edit the section break, select it and click **Edit**.

17. Select a section break and click **Base Font** to format, align, and select the shading for section breaks.

18. Drag the section breaks to change their order.

   **Important:** Section breaks display in the order that they appear in the window.

19. Click **Finish**.

**Related concepts:**

[“Data grid display options” on page 195](#)

You can use configurable display options for data grids in a Presenter report in IBM® Cognos® Incentive Compensation Management.

[“Access permissions” on page 288](#)

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

**Adding a data grid with an input row form**

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add a row with data submission fields to a data grid. You can also display it alone so that web users can submit data to a table.

**Procedure**

1. Use a row form source to add a data grid to the layout table.

2. To display only the input row and not the entire data grid, select the **Display only input row** check box in step 4 of the Data Grid wizard.

3. Select where you want the input row to be placed.
   - If you select **Display only input row** check box, you can choose to display the input row vertically on the report by selecting the **Show vertical** check box.

4. In the **Local** column menus, select **Blank**, **Auto-Generate**, or an existing parameter for any primary key columns.
   - If you select **Blank**, the field is displayed as empty on the report. For each non-primary key column, you can select **Blank** or an existing parameter to fill the input field.
   - If you select **Auto-Generate**, a new primary key is automatically created in the field.

5. If you have a pick list column, to choose how a pick list input row is displayed, complete these steps:
a. Click the Configure Pick List button.
b. In the Pick List Control window, select the field that you want to display as the description.
c. Select to sort the pick list by the ID or by the Description.
d. Select Ascending or Descending as the Sort Order.
e. You can choose to Hide ID or Hide Description in the pick list.
f. Click OK.

6. To add validation rules for each input field, complete these steps:
   a. Click Add.
   b. Select the column that you want to add the validation rule to.
   c. Select the operator.
   d. Select the Value, Source, or Parameter to finish the validation rule.

7. To add filters to the pick list columns, complete these steps:
   a. Click Add.
   b. Select the Column to Filter.
   c. Type a Filter Name.
   d. Click Next.
   e. Define the filter restrictions.

8. Finish the Data Grid Wizard.

Adding a data grid template
In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add a template that can be used with data grids.

About this task
You can select a template as the default template. When a data grid is created, it has the same formatting as the default template. You can select a different template in the third step of the Data Grid wizard. The format that is set in the template does not affect any date, numeric, or conditional formatting set in the data grid. If you have sections added in the data grid, in the Edit Data Grid Template window, you can edit styling of the objects in the section and display section headers for each record.

Procedure
1. In the Presenter toolbar, click Manage Templates.
2. Click Add Template.
3. Type a name for the template. Template names must be unique and cannot contain more than 100 characters, cannot have leading or trailing white space, or special characters.
4. Select the type of row that you want to edit.
5. Select the type of formatting that you want to apply to the row.
6. Click Save.

7. Click the Toggle Default Template icon, to make the template the default data grid template.

Related tasks:
“Selecting a data grid template” on page 197
When you create a data grid in your Presenter report in IBM® Cognos® Incentive Compensation Management, you can change the template that is used in the data
Applying a template to data grids
In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can apply different templates to your data grids.

Procedure
1. In Presenter, press Ctrl and click the data grids that you want to apply the template to.
2. In the toolbar, click Apply Template.
3. From the Templates, select the template that you want to apply to the data grids.

Adding a fixed grid
A fixed grid is a static number of rows and columns that is used to display items in your Presenter report in IBM® Cognos® Incentive Compensation Management. You can use a fixed grid to display more than one value.

Procedure
1. Right-click a cell in your layout table and click Add Fixed Grid.
2. Type a name for the fixed grid.
3. Drag the value sources from the list into the grid.
4. Enter the Date Value, Numeric Value, or Text Value display information and click OK.
5. To add text, select the cell and type in the text you want to be displayed.
6. Right-click any cell to resize the grid, resize the columns, show grid lines, change the font, edit the cell, or delete the cell.
   You can select multiple cells of the same type to edit at the same time by using Ctrl + click.
7. To add a submit button, right-click a cell, and select Add Submit Button.
8. To add a text control, right-click a cell, and select Add Text Control.
9. To add a pick list control, right-click a cell, and select Add Pick List Control.
10. Use the toolbar to format the cells of the fixed grid.
11. If you want payees to have the ability to export this grid to Microsoft Excel via the web client, select the Enable Export to Microsoft Excel check box.
12. Click OK.

Exporting data grids and fixed grids to Microsoft Excel
You can allow web users to export a data grid or fixed grid in a Presenter report in IBM® Cognos® Incentive Compensation Management to Microsoft Excel. You can use the .xls or .xlsx format in Microsoft Excel.

Before you begin
Make sure that the grid is not empty. The export to Microsoft Excel option is not displayed if the grid is empty.

Procedure
1. To export a data grid, select the export file type from a menu on the report header.
2. To export a fixed grid, click the appropriate icon above the grid.
Adding images

You can add a logo or other image to your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. Right-click a cell in your layout table and select **Add Image**.
2. Type a name for the image.
3. Click **Browse** to locate the image on your computer.
4. Click **Link** if you want the image to act as a link to another Presenter report, web form, or web page.
5. Click **OK**.

Adding a single series chart

A single series chart displays the results of one source on your IBM Cognos Incentive Compensation Management Presenter report.

Procedure
1. To add a single series chart, perform one of the following steps:
   - Right-click a cell in your layout table, and select **Add Single Series Chart**.
   - Drag the source you want to use in the single series chart onto a cell in the layout table.
2. In the Display Selector window, select **Single Series Chart** and click **OK**.
3. Right-click the chart component, and select **Edit Single Series Chart**.
4. Type a name for the single series chart and click **Next**.
5. Select a **Chart Type**.
   a. Select **Classic Style** or **Solid Style** from the drop-down menu.
   b. Click **Next**.
6. Select the chart **Source**.
   - If you have clicked and dragged a source onto the layout tab, this field will be pre-populated with the selected source.
   - **Tip**: Any sources created in Presenter can be used.
7. Select the **Display Column**.
8. Select the **Value Column**.
9. Click **Add Link** if you want the chart to act as a link to another Presenter report, web form, or web page.
10. Click **Next**.
11. Select the Chart Details by performing the following steps:
    a. Type a **Name** for the chart, and click **Font** to change the style of the text.
    b. Type the **Axis Titles**, and click **Font** to change the style of the text.
    c. Select the **Size** of the chart in pixels
    d. Click **Next**.
12. Select the Additional Chart Details by performing the following steps:
    a. Set the **Font** for the X-axis and Y-axis labels, and select the X-axis style from the drop-down menu.
    b. To sort the X-axis by an ascending or descending order, select the Sort X-axis check check box, and select either **Order Ascending** or **Order Descending**.
c. To have no values displayed on the chart, select the **Hide Value Labels** check box.

d. You can define a **Value Prefix** and **Value Suffix**. Typical examples include $ or %.

e. Select the **Percentage** check box to display results as a percentage.

f. Select a decimal or comma as the **Decimal Separator** for the displayed results.

g. Select the **Number of Decimal Places** for the displayed results.

h. Select a comma or period as the **Thousand Separator** for the displayed results.

i. If you select the **Number Scaling** check box, larger values will be shortened and represented by K or M (for example, 50K instead of 50,013). If you do not select the **Number Scaling** check box, the full value will be displayed.

13. Click **Finish**.

### Adding a multi-series chart

You can add a multi-series chart to display the results of more than one source in a Presenter report in IBM® Cognos® Incentive Compensation Management.

#### Procedure

1. Right-click a cell in your layout table and click **Add Multi-Series Chart**.
2. Type a name for the multi-series chart and click **Next**.
3. Select a **Chart Type**.
   a. Select **Classic Style** or **Solid Style** from the menu.
   b. Click **Next**.
4. To set the sources for the chart, complete the following steps:
   a. Click **Add**.
   b. Select the chart **Source**.
   c. Select the **Display Column**.
   d. Select the **Value Column**.
   e. Click **OK**.
5. Right-click a row and click **Set Link** if you want the chart to act as a link to another Presenter report, web form, or web page.
6. You can select a row, and click **Up** or **Down** to reorder the sources.
7. You can select a row, and click **Remove** to delete the source.
8. You can select a row, and click **Edit** to edit the source.
9. Click **Next**.
10. To select the **Chart Details**, complete the following steps:
    a. Type a name for the chart, and click **Font** to format the title.
    b. Type names for the **Axis Titles**, and click **Font** to format the titles.
    c. Set the **Size** of the chart.
    d. Select the **Show Legend** check box, and select the position and format of the legend.
    e. Click **Next**.
11. To set the **Additional Chart Details**, complete the following steps:
    a. Select **Horizontal** or **Slanted** for the X-axis labels.
b. Click **Font** to edit the text and click the colored square to edit the font color.

c. Select the **Hide Value Labels** if you do not want to show the value labels on the chart.

d. Select the **Sort X-axis check** box to set the sort order of the X-axis to ascending or descending.

e. You can define the **Value Prefix** and **Value Suffix**.

f. Select the **Percentage** check box to display results as a percentage.

g. Select a decimal or comma as the **Decimal Separator** for the displayed results.

h. Select the **Number of Decimal Places** for the displayed results.

i. Select a comma or period as the **Thousand Separator** for the displayed results.

j. If you select the **Number Scaling** check box, larger values are shortened and represented by K or M (for example, 50K instead of 50,013). If you do not select the **Number Scaling** check box, the full value is displayed.

12. Click **Finish**.

**Adding a map**

You can add a map to view values of data sources for regions in territories in a Presenter report in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. To add a map to your layout table, complete one of the following steps:
   - Right-click a cell in your layout table and click **Add Map**.
   - Drag the source that you want to use in the map onto a cell in the layout table.

2. In the Display Selector window, select **Map** and click **OK**.

3. Right-click the map component and click **Edit Map**.

4. Type a **Name** for the map and click **Next**.

5. Select a **Map Type** to display the results of the selected cell and click **Next**.

   **Important**: Territory codes must be set up in a **Territory** table in Composer. Cognos Incentive Compensation Management provides the Microsoft Excel data to import.

6. Select the chart **Source**, **Display Column**, and **Value Column**.
   If you dragged a source onto the **Layout** tab, the source field is pre-populated.

7. Click **Next**.

8. To add value ranges to color code the map, complete the following steps:
   a. Click **Add**.
   b. Type a **Name** for the label.
   c. Select the **Min** and **Max** ranges.
   d. Select the **Color**.
   e. Click **OK**.

9. When you finish adding value ranges, click **Next**.

10. Click **Add** to specify links for the map drill-down.
    a. Type the **Display Value**. The **Display Value** is the ID of the map that you want to link to.
11. Click Next.

12. To select the map details, complete the following steps:
   a. Click Font to format the map labels, and click the colored square to change the font color.
   b. You can select the Hide Value Labels check box to stop values from appearing on the map.
   c. You can define the Value Prefix and Value Suffix.
   d. Select the Percentage check box to show the values as a percentage.
   e. Specify the width and height in pixels.
   f. Select the Show Legend check box to display a legend for the map, select On Bottom or On Right to set the position of the legend, and format.
   g. Select a decimal or comma as the Decimal Separator for the displayed results.
   h. Select the Number of Decimal Places for the displayed results.
   i. Select a comma or period as the Thousand Separator for the displayed results.
   j. If you select the Number Scaling check box, larger values are shortened and represented by K or M (for example, 50K instead of 50,013). If you do not select the Number Scaling check box, the full value is displayed.

13. Click Finish.

Adding a gauge

Gauges can be created to represent calculations that do not contain partitions on your IBM Cognos Incentive Compensation Management Presenter report. Gauges show the result of the calculation.

About this task

Gauges can be useful when you want to look at a total value. You need at least three numeric values to create any gauge, including minimum, maximum, and current values.

Procedure

1. Right-click a cell in your layout table and select Add Gauge.
2. Type a name for the gauge and click Next.
3. Select either an Angular, Cylinder, or Horizontal Linear gauge type.
   a. Select either Classic Style or Solid Style from the drop-down menu.
   b. Click Next.
4. Select the Min Value Source, Max Value Source, and Current Value Source.
5. You can select the Show Trendpoint check box, and select a trendpoint value source.
6. Click Set Link if you want the chart to act as a link to another report, web form, or web page.
7. Click Next.
8. To add a value range, perform the following steps:
   a. Click Add to add a value range.
   b. Type a Name for the label.
   c. Select a Min, Max, and Color.
d. Click OK.

Tip: You should have three ranges such as weak, average, and strong.

9. Click Next.

10. Select the gauge details by performing the following steps:
   a. Type and format the Limit and Tick Labels.
   b. Select and format the Size of the gauge, the Pointer Value, and the Trendpoint.

11. Click Finish.

Adding a text control

You can add a text box that a user can use to enter information for a selected parameter in a Presenter report in IBM® Cognos® Incentive Compensation Management.

Before you begin

To use a text control, you must have a Submit button on the form.

About this task

If you added a parameter to your Presenter report source, you must create a place on the report for the user to select the parameter. You can do so by creating either a text control or a pick list control. For example, if you add a text control that fills a parameter based on payee ID, the user can type the payee ID into the box to render report information.

If you want web users to be able to perform a wildcard search of a data source for the value to enter in the text control, you can set up the search in the Cognos Incentive Compensation Management client.

Procedure

1. Right-click a cell in your layout table and click Add Text Control.
2. Type a name for the input box.
3. Select a parameter that is related to the input box.
4. You can select the Hide Value For Export check box to make sure that the value is not displayed on a published report.
5. To allow web users to type the exact value or use an asterisk to perform a wildcard search for a value to enter in the text control, complete these steps:
   a. Select the Enable Wild Card Search check box.
   b. From the Source menu, select the data source that contains the values that you want to search for in the text control.
   c. From the Column menu, select the column of the data source that contains the values that you want to search for in the text control.
6. Click OK.

Adding a pick list control

You can create a pick list control to create a drop-down menu in a Presenter report in IBM® Cognos® Incentive Compensation Management, based on a source table. The item that the user selects from the list is used to fill the selected parameter.
About this task

For example, if you add a pick list control based on the Payee table that fills a parameter based on payee ID, the user selects the payee ID to render report information. You can configure pick lists to display ID, description, or both in the drop-down menu. You can also set up the pick list to sort by either the description or ID field in ascending or descending order.

Procedure

1. Right-click a cell in your layout table and click Add Pick List Control.
2. Type a name for the pick list control.
3. Select the Source.
4. Select column from the source for the Description.
5. Select a parameter.
6. Select ID or Description for the Sort By option.
7. Select the Sort Order.
8. You can select the Hide ID Column check box to show only the Description column in the pick list.
9. You can select the Hide Value For Export check box to make sure that the pick list control is not displayed on published reports.

Filtering pick lists based on selected parameters

Options listed in pick list controls can be filtered based on what was selected in another pick list control in your IBM Cognos Incentive Compensation Management Presenter report, for example, a pick list that only displays employees that report to a selected manager.

Procedure

1. Create structural tables to use as sources for pick list controls.
   For example, you could create one table that contains territories to be selected and another table that contains cities. The table containing cities would have a pick list field linked to the territories table.
2. Create parameters needed for your pick list controls.
   For example, create a Territory parameter and a City parameter.
3. Add your first pick list control by right-clicking a cell and selecting Add Pick List Control.
4. Define the pick list control by selecting its data source and the parameter it fills.
   For example, create a pick list control that fills the territory parameter.
5. Create a Presenter source for your second pick list control. This source will be linked to the parameter used for your first pick list control.
   For example, this source would contain the city table and the territory parameter: CityTable.Territory = PaTerritory.Territory.
6. Add the second pick list control.
   For example, use the source created in step 4 as the source for the pick list control.
7. Add a submit button and complete the report.
**Adding a workflow dashboard**

Links to workflows created in the Workflow Manager module can be included in an IBM Cognos Incentive Compensation Management Presenter report. When a web user clicks the workflow link in the Presenter report, the workflow opens.

**Procedure**

1. Right-click the layout table, and select **Add Workflow Dashboard**.
2. Type a name for the workflow dashboard control.
3. From the **Workflow Status** drop-down menu, select the status of the workflows that you want to display on the dashboard.
   For example, if you want the dashboard to display links to pending workflows, select **Pending** from the drop-down menu.
4. If you do not want headers displayed on the workflow dashboard, unselect the **Enable Headers** check box.
5. Select the additional columns that you want to display.
6. Use the toolbar to set the format of the dashboard.
7. Click **OK** to save your changes.

**Adding a link to a document**

In IBM® Cognos® Incentive Compensation Management, you can add a link to a document from a Presenter report.

**About this task**

The document must be added to the Manage Documents window.

**Procedure**

1. Right-click a cell in your layout table and click **Add Document Link**.
2. Type the text for the document link. This field has a 1000 character limit.
3. Click **Link**.
4. Select the document that you want to link to.
5. Click **OK**.

**Related tasks:**

[“Managing documents” on page 139](#)

In the **Manage Documents** window, users can add any files associated with compensation management to the IBM Cognos Incentive Compensation Management database.

**Adding a signature control**

You can add a signature control to add agreement text and accept or reject options in a Presenter report in IBM® Cognos® Incentive Compensation Management.

**About this task**

Payees who access the report can either accept or reject the agreement text in the signature control. Their responses are recorded in the Audit log. Each report can have many signature controls, which are identified by their Signature ID. Reports with signature controls must also contain a **Submit** button.
Procedure
1. Right-click a cell in your layout table and click **Add Signature Control**.
2. Type an ID for the signature control. There is a 100 character limit to this field.
3. In the **Agreement** field, type the agreement text that you want to display on the report. There is a 4300 character limit to this field.
4. Click OK.

**Adding a Submit button**
You can add a **Submit** button for selected parameters in a Presenter report in IBM® Cognos® Incentive Compensation Management. Pick list and text controls require a **Submit** button for the selected or entered parameter to populate.

Procedure
1. Right-click a cell in your layout table and click **Add Submit Button**.
2. Type the button text.
3. Click OK.

**Deleting layout table contents**
The contents of the selected cell in the layout table of your IBM Cognos Incentive Compensation Management Presenter report can be cleared.

Procedure
Right-click a component in your layout table, and select **Delete**.

**Data grid display options**
You can use configurable display options for data grids in a Presenter report in IBM® Cognos® Incentive Compensation Management.

When you are adding a data grid, you can use the toolbar in the Data Grid Display Options step to format the cells in the grid. Alternatively, you can select a column or row and right-click it to show several other available options.

From the Data Grid Display Options window, you can specify report formatting, set conditional formatting, set alternating row fonts, or set links by right-clicking the appropriate column.

**Related tasks:**
"Adding a data grid" on page 184
You can use a data grid to display the results of a single data source in a table in your Presenter report in IBM® Cognos® Incentive Compensation Management.

**Adding an editable column**
You can allow web users to edit existing data in Composer tables through Presenter data grids in IBM® Cognos® Incentive Compensation Management

Procedure
1. In the **Data Grid Display Options** step of the Data Grid wizard, highlight the column that you want to make editable.
2. Right-click the column and click **Toggle Editable**.
3. To add validation rules for the editable column, click **Next**.
4. In step 4 of the Data Grid wizard, click Add.
5. In the Input Rule window, select the Column that you want to make the validation rule for, and select an Operator from the menu.
6. To add the Constraint, use the Value, Source, or Parameter tabs.
7. Click OK.

What to do next

After you add an editable column to a data grid, you must add a Submit button to the report.

Related tasks:

"Adding a validation rule for submitted data grid values"
You can create a rule that validates the data that web users submit through a data grid or row form in the IBM® Cognos® Incentive Compensation Management web client.

Adding a validation rule for submitted data grid values

You can create a rule that validates the data that web users submit through a data grid or row form in the IBM® Cognos® Incentive Compensation Management web client.

About this task

Validation rules are used to validate an aggregation of data for the whole data grid, such as a maximum or minimum, average, or sum of all the data. If a web user enters data that does not follow the validation rule, a user-defined error message opens when the user clicks the Submit button.

For example, a regional sales manager might have a discretionary bonus of $1000 that he can distribute among the members of his team as a reward for high performance. You can create a computed row in the data grid to calculate the total amount of the bonuses that he distributes. Then, you can add a validation rule to ensure that the total amount does not exceed $1000 before the regional sales manager can submit the data.

The validation feature does not validate individual rows of data that a user enters into the data grid.

Procedure

1. Create a data grid with at least one editable column or a data grid by using a row form source.
2. In the Data Grid Display Options step of the Data Grid wizard, right-click the data grid and click Add/Edit On Submit Validation Rules.
3. Click Add.
4. Create the validation rule in the Rule pane. You must add a Submit button to the report a
5. In the Set error message pane, type the message that you want web users to receive if they try to submit invalid data.
6. Click OK.

Related tasks:

"Adding an editable column" on page 195
You can allow web users to edit existing data in Composer tables through
Presenter data grids in IBM® Cognos® Incentive Compensation Management

Setting the show or hide columns feature for the web client
You can enable a feature that lets web users show or hide data grid columns in the IBM Cognos Incentive Compensation Management web client.

When web users export a data grid to a PDF file or Microsoft Excel, only columns that are visible at the time of export are included.

Procedure
1. In the Data Grid Display Options window, right-click and select Enable Show/Hide Columns.
   Users can select which columns in the data grid to show or hide via the web client.
2. After the option has been enabled, right-click a column and choose Select Column.
3. Right-click the selected column, and select Column Display, and then select Hidden or Initially Hidden.
   - If Initially Hidden is selected, the column will not be initially displayed when the user loads the report in the web client. But the user will have the option to show the column.
   - If Hidden is selected, the column will not display in the web client, and the user will not have the option to show the column.
   - If the Enable Show/Hide Columns option is selected, and no Column Display option is selected for a column, the column will be initially displayed. The user will have the option of hiding the column.

   Important: Showing or hiding columns will not change column ordering.

Selecting columns
When you set display options for a data grid in your Presenter report in IBM® Cognos® Incentive Compensation Management, you can select one or more columns that you want to change.

Procedure
1. In the Data Grid Display Options window, click the header of the column that you want to change.
   Tip: To select more than one column, press Ctrl and click.
2. In the toolbar, click Select Column(s).

Selecting a data grid template
When you create a data grid in your Presenter report in IBM® Cognos® Incentive Compensation Management, you can change the template that is used in the data grid.

Procedure
1. In the Data Grid Display Options window, click Select Data Grid Template.
2. From the Templates menu, select the template that you want to use in the data grid.
3. Click OK.
Related tasks:

**“Adding a data grid template” on page 186**

In your Presenter report in IBM Cognos Incentive Compensation Management, you can add a template that can be used with data grids.

### Renaming a data grid column

You can change the display name of a data grid column in your Presenter report in IBM Cognos Incentive Compensation Management.

**About this task**

You can use special characters in the column header but the column name cannot end in an underscore.

**Procedure**

1. In the Data Grid Display Options step, double-click the column header.
2. Type a name for the column and click OK.

### Resetting the name of a data grid column

You can change the column name of a data grid back to its original name in your Presenter report in IBM Cognos Incentive Compensation Management.

**Procedure**

1. In the Data Grid Display Options step of the Data Grid wizard, highlight all the cells in the column.
2. Right-click the column and click Reset Column Name.

**Results**

The name of the column reverts to its original name.

### Setting the width of a column

When you create a data grid or a fixed grid in your Presenter report in IBM Cognos Incentive Compensation Management, you can specify the width of columns and tables. Specify the width as a percentage of grid columns to have more control over the appearance of the report.

**Procedure**

1. In the Data Grid Display Options step, right-click the column and click Set Column Widths.
2. Set a width for each column as a percentage of the total width of the data grid. The widths of all the columns must add up to 100.

   **Tip:** Press the Tab key to move from one column to another.

3. You can click Reset to allocate all column widths evenly.
4. Click OK. The Total % number is dynamically updated.

### Adding a computed column

You can add columns to a data grid to display the value of simple math functions in your Presenter report in IBM Cognos Incentive Compensation Management. There is no limit to the number of computed columns that you can add to a single data grid.
**Procedure**

1. In the **Data Grid Display Options** step, right-click the data grid and click **Add Computed Column**.
2. Type a name for the column and click **OK**.
3. To create a formula, highlight the computed column, right-click it, and click **Computed Column Formula**.
4. In the **Formula** pane, type the formula for the cell by using the **Available Sources**.
5. Click **OK**.

**Adding a computed row**

You can add rows to a data grid to display the value of simple math functions in your Presenter report in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In the **Data Grid Display Options** step, right-click the data grid and click **Add Computed Row**.
2. To add text to a cell, highlight the column that contains the cell, right-click the column, click **Computed Row Formula**, and complete the following steps:
   a. Select **Text** and type the text into the **Text** field.
   b. Click **OK**.
3. To add a formula to a cell, highlight the column that contains the cell, right-click the column, click **Computed Row Formula**, and complete the following steps:
   a. Select **Formula**.
   b. In the **Formula** pane, type the formula for the cell by using the **Available Sources**.
   c. Click **OK**.

**Links**

You can create a link from an item in a column to another Presenter report, web form, or web page in IBM® Cognos® Incentive Compensation Management.

**Related concepts:**

[“Chart, report, and web page links” on page 205](#)

IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

**Clearing links**

You can clear links in a data grid column in your Presenter report in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In the **Data Grid Display Options** step in the Data Grid wizard, highlight all the cells in a column.
2. Right-click the column and click **Clear Link**.

**Results**

Any link that was added is cleared.
Formatting columns

You can format headers, apply conditional formatting, and set the numeric format of values in a data grid in your Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure

1. To edit column headers, complete one of the following steps:
   - Select a header or press Shift and highlight all the headers. Use the toolbar to set the font, font size, font style, font color, background color, and alignment of the column headers you selected.
   - Select a header, right-click, and click Format Headers > All Headers. In the Format Cells window, select the font, alignment, and shading for the cells.

2. To edit a numeric column, complete one of the following steps:
   - Highlight the numeric column, and select the number style and number of decimal places from the menus in the toolbar.
   - Highlight the numeric column, right-click the column, and click Format Column > Numeric Format. Set the Decimal places and numeric format Type and click OK.

Changing column format to follow row text alignment

When you set display options for data grids in your Presenter report in IBM® Cognos® Incentive Compensation Management, you can change the format of a column to follow the text alignment that is set in the rows.

About this task

By default, the text alignment in a column follows the text alignment set in the header. By default, numeric type columns are aligned to the right.

Procedure

1. In the Data Grid Display Options step, select the column.
2. Right-click the column and click Format Column > Use Row Text Alignment.

Suppressing data grid headers in the web client

You can choose not to display the headers of a data grid in your Presenter report in IBM® Cognos® Incentive Compensation Management.

About this task

When you select this option, data grid headers are not displayed in the web client. This option applies to the entire grid, not to specific columns.

Procedure

1. In the Data Grid Display Options step, right-click the data grid.
2. Select Format Headers > Suppress Headers.

Setting conditional formatting

You can specify different text and numeric formatting for values in a data grid column of your IBM Cognos Incentive Compensation Management Presenter report when certain conditions are true.
For example, when a value in the results column is less than a certain amount, you may want to display those numbers in red.

**Procedure**

1. In the Data Grid Display Options step of the Data Grid Wizard, highlight a column, then right-click the column.

   **Note:** Conditional formatting can only be applied to numeric columns.

2. Select Format Columns > Conditional Formatting.

3. Click Add.

4. Drag an available column into the condition pane.

5. Type a condition. To define the condition, you can use any of the formulas that are available in Composer. To define multiple conditions, type \texttt{AND(<condition1>,<condition2>).} For example, type \texttt{AND(Source.YTDSales>=0,Source.YTDCommission<0)}.

6. Use the toolbar to indicate what formatting should be applied to values that meet the condition and click OK.

   **Tip:** To make sure the conditional formatting does not interfere with the alternate row formatting of the data grid, set the cell shading color to transparent.

7. Repeat the steps above to add as many conditions as necessary. Multiple conditions can be applied to a column.

8. Use Up and Down to order multiple conditions. Formatting will be applied in the order that the conditions are listed.

9. When you are done adding conditional formatting, click OK.

**Related tasks:**

- “Adding a numeric value display” on page 183

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add a numeric value display to add a numeric value to a selected cell.

### Setting alternating row fonts

You can define different formatting for odd and even rows in your Presenter report in IBM® Cognos® Incentive Compensation Management. If you do not apply alternating row fonts, the same formatting is applied to all rows.

**Procedure**

1. In the Data Grid Display Options step, highlight a column.

2. Right-click the column and click Format Rows > Allow Alternating Row Fonts.

### Formatting data grid rows

You can edit the format of the rows in the data grid of your Presenter report in IBM® Cognos® Incentive Compensation Management. If you set alternating rows, you must define formatting for both odd and even rows.

**Procedure**

1. Complete one of the following steps:
   - If you set alternating rows, select an odd or even row in the data grid. All odd or even rows are highlighted.
• If you did not set alternating rows, select any row in the data grid. All the rows are highlighted.

2. Use the toolbar to set the font, font size, font style, font color, background color, and alignment of the rows.

Showing the date and time in data grid columns

Users can display either date only or date and time for a date column in a data grid in your Presenter report in IBM® Cognos® Incentive Compensation Management.

Procedure

In step 3 of the Data Grid wizard, complete one of the following steps:

• Right-click a date column, click Select Column, and click Date or Date and Time from the menu in the toolbar.

• Right-click a date column, click Format Column > Date Format, and click Date or Date and Time.

Results

When the date and time format is applied to the Audit.Time column, the recorded time is added to the end of the date.

If the Date and Time option is selected for a date column that does not have a time, 12:00AM is appended to each date.

Showing grid lines

By default, grid lines do not appear in data grids in your Presenter report in IBM® Cognos® Incentive Compensation Management. You can set up your report to show grid lines.

Procedure

1. In the Data Grid Display Options step of the Data Grid wizard, highlight a column.

2. Right-click the column and click Show Grid Lines.

Null numeric values in data grids

Null numeric values are displayed as empty in the data grid of your Presenter report in IBM® Cognos® Incentive Compensation Management.

If a data grid contains an empty row (because it has null partitions or empty string partitions with null numeric values), it is not displayed in the data grid.

How null values are handled in Presenter

The result of null values in your Presenter report in IBM® Cognos® Incentive Compensation Management might vary, depending on the particular formula.

Table 41. Effects of using the null value

<table>
<thead>
<tr>
<th>Formula</th>
<th>Effect of using the null value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add (x+y)</td>
<td>If any argument is empty, the result is empty.</td>
</tr>
</tbody>
</table>
Table 41. Effects of using the null value (continued)

<table>
<thead>
<tr>
<th>Formula</th>
<th>Effect of using the null value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Divide (x/y)</td>
<td>If any argument is empty, the result is empty. If the denominator is 0, the result is 0.</td>
</tr>
<tr>
<td>Subtract (x-y)</td>
<td>If any argument is empty, the result is empty.</td>
</tr>
<tr>
<td>Multiply (x*y)</td>
<td>If any argument is empty, the result is empty.</td>
</tr>
<tr>
<td>Negation (-x)</td>
<td>The negative of an empty value is empty.</td>
</tr>
<tr>
<td>Equal (x=y)</td>
<td>If both operands are empty, then the result is True. If only one operand is empty, then the result is False.</td>
</tr>
<tr>
<td>Not Equal (x!=y)</td>
<td>If both operands are empty, the result is False. If only one operand is empty, the result is True.</td>
</tr>
<tr>
<td>Greater (x&gt;y) and (x&gt;=y), Less(x&lt;y) and (x=&lt;y)</td>
<td>If any operand is empty, then the result is False.</td>
</tr>
<tr>
<td>AVG(x)</td>
<td>The sum of non-empty items is divided by the count of non-empty items.</td>
</tr>
<tr>
<td>COUNT(x)</td>
<td>The count returns the number of rows.</td>
</tr>
<tr>
<td>MAX(x,y+) and MIN(x,y+)</td>
<td>If all values are empty, it returns empty. Otherwise, it returns the maximum or minimum of non-empty values.</td>
</tr>
<tr>
<td>MAX(x) and MIN(x)</td>
<td>These formulas get the aggregate maximum or minimum. If all values are empty, they return empty. Otherwise, they return the maximum or minimum of all non-empty values.</td>
</tr>
<tr>
<td>MULT(x)</td>
<td>If all values are empty, it returns empty. Otherwise, it returns the result of multiplying all the non-empty values.</td>
</tr>
<tr>
<td>SUM(x)</td>
<td>This formula aggregates all the non-empty values and returns their sum. If all values are empty, then the result is empty.</td>
</tr>
<tr>
<td>IF(x,y,z)</td>
<td>This formula has the same behavior as version 7.1.0</td>
</tr>
<tr>
<td>AND(x,y+) and OR(x,y+)</td>
<td>These formulas have the same behavior as version 7.1.0</td>
</tr>
<tr>
<td>NOT(x)</td>
<td></td>
</tr>
<tr>
<td>POW(x,y)</td>
<td>If either value is empty, it returns empty.</td>
</tr>
<tr>
<td>PREV()</td>
<td>If the previous value is empty, it returns empty. For the first row, the PREV value is considered to be 0.</td>
</tr>
<tr>
<td>ROUND(x,y) and ROUNDDOWN(x,y)</td>
<td>If either value is empty, it returns empty.</td>
</tr>
</tbody>
</table>

Chapter 20. Presenter report layout and display options  203
Freezing the header row in the web client

You can choose to lock the header row of a data grid so that it displays continuously as you scroll down the Presenter report in the IBM® Cognos® Incentive Compensation Management web client.

About this task

You can set this feature independently for different data grids. The menu in the header remains frozen along with the header if you select this feature. If you choose to suppress data grid headers, then the freeze header row option is disabled.

This feature does not work when a user previews a Presenter report in the Cognos Incentive Compensation Management client or when a user views the Cognos Incentive Compensation Management web client with Internet Explorer 7 and 8.

Procedure

1. Go to the last step of the Data Grid wizard.
2. Select the Freeze Header Row check box.

Allowing web client users to copy data grid rows into inquiries

In IBM® Cognos® Incentive Compensation Management, you can allow web client users to copy a row of data from a data grid into an inquiry.

Procedure

1. Go to the last step of the Data Grid wizard.
2. Select the Enable Inquiry Copy check box.

Results

When web users view the Presenter report in the web client, they can click the Copy icon next to a row in the data grid to copy the data into the comment field of an inquiry.

Adding pagination to data grids on the web client

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can enable pagination for data grids.

About this task

When you enable pagination for data grids, you can set the default number of rows that are visible on each page on the web client. This feature is useful if you have a data grid with many rows.

Procedure

1. Go to the last step of the Data Grid wizard.
2. Select the Paginated check box.
3. From the Default Page Size menu, select the number of rows that you want to display on each page on the web client.
Chapter 21. Working with completed Presenter reports

After you complete a Presenter report in IBM® Cognos® Incentive Compensation Management, it can be edited, previewed, published, and linked to other reports, web forms, or web pages.

Related concepts:
Chapter 20, “Presenter report layout and display options,” on page 179
After you create parameters, sources, and values for your Presenter report in IBM® Cognos® Incentive Compensation Management, you must add layout tables and report components.

“Access permissions” on page 288
When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

“Presenter report security” on page 311
You can grant a role permission to edit Presenter reports in IBM® Cognos® Incentive Compensation Management and use the Audit log as a source in Presenter.

Chart, report, and web page links

IBM Cognos Incentive Compensation Management Presenter reports can be linked to web forms, web pages, or other Presenter reports by inserting a link on a report item.

A link can be created from an image, text, or the contents of a report column. Links can be made to web forms, web pages, Presenter reports, and parameters. You can set a link to a web form, web page, or other report using parameters. This functionality is available for text, numeric, and date values, both directly in the layout and in a fixed grid.

When linking to another Presenter report or web form, you can choose to select an associated web tab. On the web client, when the user clicks the link to the web form or Presenter report, the associated web tab opens. If no associated web tab is selected, then the Presenter report or web form is displayed on the current web tab instead.

Related concepts:
“Links” on page 199
You can create a link from an item in a column to another Presenter report, web form, or web page in IBM® Cognos® Incentive Compensation Management.

Related tasks:
“Adding a text value display” on page 183
In your Presenter report in IBM® Cognos® Incentive Compensation Management, from any saved constant or stored value, you can add a text value to a selected cell.

“Adding a numeric value display” on page 183
In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add a numeric value display to add a numeric value to a selected cell.

“Adding a date value display” on page 182
In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add the current date into a selected cell.
In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add text and format text into a selected cell and you can also add links.

**Linking a Presenter report to another Presenter report**

You can link an image, text, or the contents of a report column to another Presenter report in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. When you add an image or text to the layout table, click the **Link** button.
2. When you add a link to the contents of a report, right-click the column and click **Set Link**.
3. In the **Link to** section, select **Report**.
4. From the menu, select the **Report** that you want to link to.
5. From the **Web Tab** menu, select the web tab that you want to open when a user clicks the report link. Only web tabs that are associated with the selected report are displayed. If you want the report to display in the current web tab, leave the **Web Tab** menu blank.
6. Double-click the row to select the **Parameter Type** and **Value**.
   When you link to another report, you do not have to carry over the parameters. If you choose to, you must drag the parameters from the current report to corresponding parameters in the report that you are linking to.

**Linking a Presenter report to a web form**

You can link an image, text, or the contents of a column in a Presenter report in IBM® Cognos® Incentive Compensation Management to a web form.

**Procedure**

1. When you add an image or text to the layout table, click the **Link** button.
2. When you add a link to the contents of a report, right-click the column and click **Set Link**.
3. In the **Link to** section, select **Web Form**.
4. From the menu, select the web form that you want to link to.
5. From the **Web Tab** menu, select the web tab that you want to open when a user clicks the web form link.
   Only web tabs that are associated with the selected web form are displayed. If you want the web form to display in the current web tab, leave the **Web Tab** menu blank.
6. Double-click the row to select the **Parameter Type** and **Value**.
   When you link to a web form, you do not need to carry over the parameters. The filters that you created in the web form are displayed in the **Parameter** column of the Link wizard.

**Linking to web pages**

You can link an image, text, or the contents of an IBM Cognos Incentive Compensation Management Presenter report column to any HTTP, HTTPS, FTP, or MAILTO location.

**Procedure**

1. When adding an image or text to the layout table, click the **Link** button.
2. When adding a link to the contents of a report, right-click the column and select Set Link.
3. In the Link to section, select Web Page.
4. Type in the URL that you are linking to in the Address field.

**Presenter report link with parameters example**

When you are planning links from your Presenter report in IBM® Cognos® Incentive Compensation Management, you might find it helpful to view an example.

In the following scenario, you have two Presenter reports. One report contains a summary of each payee’s total sales for each month, and the other contains detailed transactional information for each payee’s sales for each month.

You want users to be able to view the first report for specific payees in specific months. Then, you want users to be able to link to the detailed report without having to reselect the appropriate payee and month.

At a high level, the following steps describe how to create the link:
1. Create Report 1, which contains a summary of each payee's total sales for each month.
2. Add two parameters to this report: a payee and a month filter.
3. Create Report 2, which contains detailed transactional information for each payee’s sales for each month.
4. Add two parameters to this report: a payee filter and a month filter.
5. Add the following text to a cell in the first report: Link to detailed report. Create a link from that text.
7. Match the payee filter from Report 1 to the payee filter in Report 2, and match the month filter from Report 1 to the month filter in Report 2.

**Presenter report edits**

After you add a Presenter report in IBM® Cognos® Incentive Compensation Management, you can edit specific objects or the whole layout table.

You can edit the font, cell shading, and alignment of text in the layout table in your IBM Cognos Incentive Compensation Management report. You can edit one object at a time, or you can select multiple objects of the same type to edit at the same time.

**Tip:** To select multiple object of the same type, right-click and click Select All With Same Type in the menu, or press Ctrl + click.

**Related tasks:**

[“Adding text and links” on page 182]

In your Presenter report in IBM® Cognos® Incentive Compensation Management, you can add text and format text into a selected cell and you can also add links.

**Editing the font in Presenter reports**

You can edit the font, cell shading, and alignment of text in the layout table in your IBM Cognos Incentive Compensation Management Presenter report.
**Procedure**
1. In the layout table, select an object to edit.
2. Use the toolbar to edit the font, cell shading, or alignment.

**Editing the padding in a layout table**
You can specify the amount of space in pixels that you want to display outside a component in your Presenter report in IBM Cognos Incentive Compensation Management.

**Procedure**
1. In the layout table, select an object to edit.
2. Right-click and click **Edit Padding**.
3. Set the **Top**, **Bottom**, **Left**, and **Right** padding in pixels.
4. Click **OK**.

**Editing the border in a layout table**
Each component added to the IBM Cognos Incentive Compensation Management Presenter report can have a border around it.

The top, bottom, left, right, or outside border can be set.

**Procedure**
1. In the layout table, select an object to edit.
2. Right-click and select **Edit Border**.
3. Set the **Width** and **Color**, or set the **Top**, **Bottom**, **Left**, and **Right** border **Width** and **Color**.
4. Click **OK**.

**Editing alignment in a layout table**
You can set the alignment of an object within the cell of the layout table in your Presenter report in IBM Cognos Incentive Compensation Management.

**About this task**
You can choose from nine different types of alignment. You can set horizontal and vertical alignment for nested layout tables and also for the objects that are contained within the tables.

**Procedure**
1. In the layout table, select an object to edit.
2. Right-click the object and click **Edit Alignment**.
3. Select the alignment and click **OK**.

**Undoing and redoing actions in a Presenter report**
You can correct mistakes in your Presenter report in IBM Cognos Incentive Compensation Management up to and beyond the last save.

**About this task**

**Restriction:**

208 IBM Cognos Incentive Compensation Management Version 9.0.0: User Guide
If you click **Save As** or **Refresh**, the actions in the undo history are cleared and you cannot undo or redo any actions.

**Procedure**
1. To undo an action, click the **Undo** icon.
2. To redo an action, click the **Redo** icon.

---

**Previewing a Presenter report**

After you have created an IBM Cognos Incentive Compensation Management Presenter report on the **Layout** tab, you can view what the report will look like to web users.

Preview the report to make sure the Presenter report will be displayed as you want in the web client.

**Procedure**
1. First, set the parameter values for the report by clicking the **Set Parameter Values** icon and performing the following steps:
   a. Select the **Current Web User** from the drop-down menu.
   b. Select any other parameters required in the report.
   c. Click **OK**.
2. Click the **Preview** tab.

**Printing a Presenter report chart**

From the **Preview** tab, you can choose to print charts that you added to your Presenter report in IBM® Cognos® Incentive Compensation Management.

**Procedure**

Right-click the chart and click **Print Chart**.

**Enabling rotation or slicing movement in a chart**

For some charts, you can enable rotation or slicing movement when the chart is viewed in the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. Right-click a chart.
2. Select **Enable Rotation** or **Enable Slicing Movement**.

---

**Publishing a Presenter report**

You can publish a Presenter report from the IBM® Cognos® Incentive Compensation Management client and web client as PDF files. Before you publish a Presenter report, make sure that you selected the appropriate PDF options and preferences.

**Selecting publishing preferences**

Options selected in the **Preferences** window are displayed in the **Preview** tab of the IBM Cognos Incentive Compensation Management Presenter module and when viewing the Presenter report in the web client.
Procedure
1. In Presenter, click the Preferences icon.
   In the web client, the report will resize to fit to the screen.
2. Define the dimensions in pixels of the report when previewing the report in Presenter.
3. Select the Accessible by report list check box to make a report accessible from the available reports drop-down menu in the web client.
4. Select the Allow PDF export check box so web users can generate PDF files of the Presenter report from the web client.
   If a report has a payee drop-down list, the web user will have the ability to publish reports for each payee to a PDF file.
5. You can select a color for the background of the Presenter report from the Color drop-down menu.
6. Click Choose Image to select an image to display on the background of your Presenter report.
7. You can perform the following steps to edit the image:
   a. Click Remove Image to delete the image from the Presenter report.
   b. From the Image Tile drop-down menu, select whether the image will repeat Vertically, Horizontally, Both, or None.
   c. From the Image Scroll drop-down menu, select Scroll to have the image move when the user scrolls down the report, or Fixed to have the image remain in the same position.
   d. From the Image Position drop-down menu, select Absolute to set the image location on the X and Y axes in pixels, or select Percent to set the image location by percentage.

Selecting PDF options
Users can define PDF options for publishing Presenter reports from the IBM Cognos Incentive Compensation Management web client in the Presenter module.

Procedure
1. In Presenter, click the PDF Options icon.
2. Select the Orientation and Scaling.
3. You can select Include page numbers to have the page number display, and select Show total page numbers to have the total number of pages in the report displayed on the page.
4. You can type a Footer to include on the published report.
5. Click OK.

Publishing a Presenter report from the client
You can generate a Presenter report in IBM® Cognos® Incentive Compensation Management as a PDF file for specific payees. You can then save the PDF file to your computer or server.

Procedure
1. Open the Presenter report.
2. Select the Publish icon.
3. Select Publish to my computer or Publish to the server.
If you publish from the server, define a **Saved Publisher File Directory** in the service configuration file. For example, edit the service configuration file in the following way:

```xml
<!-- Saved Publisher File Directory -->
<add key="PublisherFileDirectory" value="C:\Presenter Reports\"/>
```

4. Click **Next**.
5. Select the **Portal Access** group for which you want to generate reports.
   A report is created for each member in the **Portal Access** group.
6. Depending on the Presenter report, you might need to select a **Parameter** from the menu.
7. Click **Next**.
8. Select the **Orientation** and the **Scaling**.

**Important**: If you previously set the web PDF options, these settings are pre-populated.

9. To add an image in the header of the document, select the **Use header image** check box.
   If you want to use a header image, the image must be in the **Saved Published Image Directory** that is specified in the service configuration file. For example, edit the service configuration file in the following way:

```xml
<!-- Saved Publisher Image Directory -->
<add key="PublisherImageDirectory" value="C:\Presenter Reports\"/>
```

10. In the **Footer** section, you can select the **Include page numbers** and **Show total page number** check boxes and type in a footer.

11. If you want to publish all the reports for each member of the selected **Portal Access** group in one PDF file, select the **All statements in one PDF file** check box. If you want to publish a separate PDF file for each member of the selected **Portal Access** group, do not select this option.

12. Click **Next**.
13. If you selected **Publish from my computer**, click **Browse** to select a location on your computer.
14. You can add a prefix to the file name.
15. Click **Finish**.

   By default, when you publish a report, the file name consists of the Presenter report name, the payee name, and the date and time that the Presenter report was published to a PDF file.

**Important**: When you publish a Presenter report with a data grid, headers show in the PDF file even if there is no data in the column.
Chapter 22. Workflow Manager

The task of compensating sales forces typically involves the cooperation of many groups of individuals, processes, and tools in a workflow. You can use the Workflow Manager in IBM® Cognos® Incentive Compensation Management to create and manage your workflows.

Processes in Workflow Manager are triggered by specific business events, rather than static times in a calendar. Processes can also initiate communications to users and relay contextual information based on the current state of the system.

For example, a Presenter report might specify compensation details for sales representatives. You can create a workflow for the approval process of the compensation details in the Presenter report. All sales representatives must approve or escalate their compensation details reports. If the report is escalated, it is sent to their regional sales manager to make corrections. After the corrections are made, the report is sent back to the sales representatives for approval.

At a high level, the following steps describe how to create a workflow:

1. Create a workflow.
2. Add swim lanes for each user or group of users who are involved in the workflow.
3. Create action, alert, and process nodes, or any combination of the nodes, for each step of the workflow.
4. Connect the nodes to create the path for the workflow.
5. Start the workflow.

Workflows

Use workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module to create logic to automatically push a Presenter report into the next required state based on predefined business rules.

Each workflow is associated with one Presenter report and consists of a series of alert, action, and process nodes that are linked together. The path created by linking the nodes together defines the logical flow of the business process.

Two different types of workflows can be created in Workflow Manager: admin-initiated and user-initiated workflows.

**Admin-initiated workflow**

This type of workflow prevents users from submitting additional data until the original submission has been completed. After the original submission has completed, it is up to the administrator to start the workflow again. For example, an admin-initiated workflow can be created for an MBO self-scoring form in which a user submits scores for various objects that must be approved by a manager. However, the user cannot submit more than one set of scores per quarter.

**User-initiated workflow**

Use this type of workflow to submit additional data, even if the originally submitted data has not yet completed the workflow process. Each time a
user submits data, an instance of the workflow starts. For example, a user-initiated workflow can be created for an expense report in which a user must submit more than one expense at a time.

**Adding a workflow**

The first step to creating a business process is to create an admin-initiated or user-initiated workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**Procedure**

1. To create a new workflow, perform one of the following steps:
   - Click the **New Workflow** icon in the toolbar.
   - Right-click in the **Workflows** sidebar, and select **Add Workflow**.
2. In the Workflow Manager Wizard, type a name for the workflow, and give it a description.
3. Select the workflow type.
   - To create a workflow where data can be submitted multiple times, select **User Initiated**.
   - To create a workflow where data can be submitted only once, select **Admin Initiated**.
4. Click **Next**.
5. Select the Presenter report that the workflow will be associated with.
6. To use the Presenter report's default value for a parameter, leave the **Use Report Default Value** check box selected.
7. To select or enter a different value for a parameter, unselect the **Use Report Default Value** check box.
   - To select the web user or form initiator for a parameter, select **Value** from the drop-down menu next to the parameter, and then select the value from the next drop-down menu.
   - To type a constant value for a parameter, select **Constant** from the drop-down menu next to the parameter, and then type the constant value in the field.
8. Click **Next**.
9. If you selected a user-initiated workflow, select which layout tables in the Presenter report will be **Visible** and **Editable** to the form initiator.
10. Click **Next**.
11. Select the workflow type.
    This determines the payee that makes up the first swim lane.
    - To choose the payee to be the form initiator, select **Explicit User**.
    - To select the payee to be the form initiator based on restrictions, select **Define Restriction**.
12. Click **Next**.
13. Add any additional data sources required to define the form initiator.
    Any table or calculation with a payee partition can be used as a source.
14. Click **Next**.
15. Define the restrictions for the payees.
16. If you selected **Define Restrictions**, click **Finish**.
17. If you selected **Explicit User**, click **Next**.
18. Select the payee you want to add from the Available Payees pane and click Move Right.
19. When you have finished selecting payees, click Finish.

Editing a workflow

You can make changes to a workflow after it has been created in the IBM Cognos Incentive Compensation Management Workflow Manager module.

About this task

To change the form initiator, you must edit the Form Initiator swim lane. If the workflow is in progress, you can open the Workflow Manager Wizard, but you will not be able to make any changes.

Procedure

1. In the Workflows sidebar, select the workflow you want to edit.
2. Click the Edit Workflow button in the toolbar.

Deleting a workflow

If a workflow is not in progress, you can remove it from Workflow Manager in IBM® Cognos® Incentive Compensation Management.

Procedure

In the Workflows sidebar, right-click the workflow that you want to delete and click Delete Workflow.

Copying a workflow

In Workflow Manager in IBM® Cognos® Incentive Compensation Management, you can copy workflows.

About this task

When you copy a workflow instance, the process copies the configuration of the workflow, such as the workflow type and the linked Presenter report, along with the swim lanes and nodes. The process does not copy the workflow state, such as errors, pending actions, or history, of any running workflows. You can copy a running workflow, but a copied workflow is initially in a stopped state.

Procedure

1. In Workflow Manager, select the workflow that you want to copy.
2. In the toolbar, click Copy Workflow.
3. Click the list of workflows.
4. In the toolbar, click Paste Workflow.
5. Type a name for the copied workflow.

Setting default parameters for a workflow

If a group of payees is assigned to the form initiator swim lane, you can select one payee to be the default form initiator in Workflow Manager in IBM® Cognos® Incentive Compensation Management. Default parameters are useful when you create additional swim lanes, because you can preview the selected payees who are defined by a restriction by using the form initiator.
**Procedure**

1. In the **Workflows** sidebar, select the workflow that you want to set default parameters for.
2. Click the **Set Defaults** button in the toolbar.
3. Select a **Form Initiator** from the menu.

**Starting a workflow**

An administrator must initiate workflows in Workflow Manager in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In the **Workflows** sidebar, select the workflow that you want to start.
2. Click the **Start Workflow** button in the toolbar.

**Adding payees after a workflow has started**

Payees can be added to swim lanes in the IBM Cognos Incentive Compensation Management Workflow Manager module after a workflow has begun.

**Procedure**

1. After starting a workflow, click the **Add Workflow Payees** button in the toolbar.
2. If payees have been defined using restrictions, click **Yes** in the window that is displayed.

   **Important:** If payees have been defined using restrictions, you can choose to schedule the addition of workflow payees in the Scheduler module.

3. If you selected **Explicit User** to define swim lane payees, in the Add Workflow Payees wizard, add any sources required to define the additional workflow payees.
4. Create the restrictions to define the additional payees you want to add to the workflow.
5. Select the payees you want to add to the workflow.

**Organizing workflows**

To organize your workflows, you can create folders in the **Workflows** sidebar in Workflow Manager in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. Right-click in the **Workflows** sidebar and click **Add New Folder**.
2. Type a name for the folder.
3. Drag workflows into the folder.
4. To add a workflow to a folder, right-click the folder and click **Add Workflow in Folder**.

**Searching for a workflow**

A specific workflow can be found by using the search field on the sidebar of the IBM Cognos Incentive Compensation Management Workflow Manager module.
Procedure

In the workflow sidebar, type the name of the workflow in the Search field.

Swim lanes

When you create a workflow in Workflow Manager in IBM® Cognos® Incentive Compensation Management, the workflow contains two swim lanes by default. The two swim lanes are a System swim lane and a Form Initiator swim lane.

The System swim lane contains start and end nodes for the workflow. This swim lane, and the nodes inside it, are not configurable.

The Form Initiator swim lane is configured based on the workflow initiators that were selected when the workflow was created. The Form Initiator swim lane can be edited after the workflow is created and additional swim lanes can be added.

Swim lanes in a workflow define the person or group who are expected to take action, or the person or group who receive a notification. For example, if a swim lane is defined as any payee with the title Sales Reps, then any notifications in this swim lane are sent to payees with the title Sales Reps, or any forms in this swim lane must be acted upon by payees with the title Sales Reps.

Editing the Form Initiator swim lane

When you create a workflow in Workflow Manager in IBM® Cognos® Incentive Compensation Management, you must defined payees for the Form Initiator swim lane.

About this task

In an admin-initiated workflow, the Form Initiator is the payee who is expected to perform an action as the first step of the workflow.

In a user-initiated workflow, the Form Initiator is the payee who is expected to start the workflow. You can edit the Form Initiator after the workflow is created.

Procedure

1. Select the workflow, right-click the Form Initiator swim lane, and click Edit Current Swim Lane.
2. You can rename the swim lane and type a description.
3. Select the swim lane type.
   - Select Explicit User if you want to select specific payees who will be involved in the workflow step. Then, select the payees from the list and click Move Right to create the list of users who are involved in the first step of the workflow.
   - Select Define Restriction if you want to select a group of payees who will be involved in a workflow step, based on a restriction. Then, add the data sources for the restriction.
4. Click Next.
5. Create restrictions to define the payees who are involved in the first workflow step.
**Adding a swim lane**

To define other payees who are involved in the process, you can add additional swim lanes to the workflow in Workflow Manager in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. Select the workflow and click the *Add Swim Lanes* button.
2. Type a name and description for the swim lane.
3. Click *Next*.
4. Add any tables, the current date, Presenter report parameters, or calculations that include a payee partition to define your source.
5. Click *Next*.
6. Define the restrictions to define the payees who are involved.

**Deleting a swim lane**

You can delete swim lanes from the workflow in Workflow Manager in IBM® Cognos® Incentive Compensation Management, along with any nodes that are contained in the swim lane.

**Procedure**

1. Select the workflow, right-click the swim lane that you want to delete, and click *Delete Current Swim Lane*.
2. In the Warning window, click *Yes*.

**Adding and removing columns in a swim lane**

You can add or delete columns in a swim lane in Workflow Manager in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. To remove an extra column, right-click the column and click *Remove Column*.
2. To add a column, right-click the column and click *Add to Left* or *Add to Right*.

**Important:** Each workflow can contain a maximum of 32 columns.

---

**Nodes**

In addition to swim lanes, a workflow in Workflow Manager in IBM® Cognos® Incentive Compensation Management also contains a series of nodes. Each node represents a step in the workflow that notifies payees, requires payees to take action, or requires the system to run an action.

There are several types of nodes: *Start* nodes, *End* nodes, *Alert* nodes, *Action* nodes, and *Process* nodes.

When a workflow is created, a *Start* node and *End* node are added by default to the *System* swim lane.

**Start node**

This default node defines the beginning of the workflow.

**End node**

This default node defines where the workflow process stops.
Alert node
Use this node to send customizable notifications to users by email or through web messages that are delivered to the web client. You can use this type of node to notify specific users or groups of users when a workflow requires their input or action to proceed.

Action node
This node defines the path that the workflow takes, based on an action that is taken by a user. Each action node contains action paths that are associated with a Presenter report and different routes in the workflow. For example, if a user has the choice to either approve or cancel a report, the action node defines a different workflow path that is followed based on which option the user selects.

Process node
This node runs a saved Scheduler process. The scheduled process runs only when the Scheduler is refreshed. By default, Scheduler refreshes every hour. You can change the frequency by changing the refresh seconds value in the Scheduler module. The process runs only with the Cognos Incentive Compensation Management Windows service and not the console service. The Scheduler user must not be logged into the client at the same time.

Conditional node
This node routes users to different paths in the workflow, depending on defined conditions.

After the nodes for the workflow are created in the appropriate swim lanes, you can then connect them to create the workflow process.

Editing the Start node
You can edit the Start node so that users can submit report data and move the report to the next step in the workflow when they click the Start button in the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. In a workflow, right-click the Start node and click Edit Node.
2. Select the Submit when selected check box.

Adding an Alert node
You can use an Alert node to notify payees or groups of payees through the IBM® Cognos® Incentive Compensation Management web client or by email when a Presenter report requires their input. You can also configure an Alert node to send emails to users who are not involved in the workflow.

Procedure
1. In the workflow, click the column in the swim lane where you want to place the Alert node.
2. In the Add Node wizard, type a name and description for the node.
3. Select Alert Node and click Next.
4. Select the message type that you want to send and click Next.
   - Select Internal Message to send a web message to the payees through the web client.
   - Select Specified Email to send a message to specified email addresses only.
• Select **Internal Message and Email Notification** to send a web message to the payees through the web client and external email addresses that are specified in the **Payee** table.

5. Type the subject for the message in **Email Subject** field.

6. If you are sending an email, type the email address of the payee in the **To** and **BCC** field, and click **Add**.

**Tip:** To remove an email address, click the red X next to the email address.

7. Type the message. You can click the buttons to insert the following variables into the message:

**Form Initiator**
- Adds the name of the payee who is specified by the **Form Initiator** swim lane.

**Recipient Name**
- Adds the name of the payee who receives the message.

**Report Name**
- Adds the name of the Presenter report that is specified by the workflow.

**Report Name with Link**
- Adds the name of the report and links to the Presenter report on the web client. This variable is available only when a message is sent through the web client and requires configuration of the **Base URL** in the **Administrative Options** window.

**Tip:** It is helpful to add the **Report Name with Link** variable to the web message so that web users can quickly find the report.

### Configuring the Report Name with Link variable in an alert node

For the **Report Name with Link** variable to function correctly in the message sent through Workflow Manager to the IBM Cognos Incentive Compensation Management web client, the **Base URL** for the web client must be configured in the Administrative Options window.

**Procedure**
1. Go to **Admin > Administrative Options**.
2. Click the **Web** tab.
3. In the **Base URL** field, type the URL of your WAR file. For example, type the following address: `http://localhost:8080/ICM`, where `ICM` is the name of your WAR file.
4. Click **OK**.

### Adding an Action node

You can use an **Action** node to define actions that can be performed on a report in a particular step in the workflow in Workflow Manager in IBM Cognos Incentive Compensation Management.

**Procedure**
1. In the workflow, click the column in the swim lane where you want to place the **Action** node.
2. In the **Add Node** wizard, type a name and description for the node.
3. Select **Action Node** and click **Next**.
4. To define the action paths for the web users, complete the following steps:
   a. Click **Add New Action**.
   b. Click the arrow next to the **New Action Path** and select **Rename**.
   c. Type a name for the action path.
   d. To set the action path button in the web client to both send the report to the
      next step in the workflow and submit the data, select the **Submit when
      selected** check box.
   e. If all initiated workflows that are defined by the proceeding swim lane
      must reach the **Action** node before the action path is visible, select the
      **Required by all** check box.
   f. If all payees in the swim lane must perform the action before the workflow
      can move on, select the **Submit by all** check box.
      This option can be selected for only one action and it cannot be combined
      with the **Required by all** selection.
   g. Click **Next**.

5. In this step, select the layout tables that must be visible, or both visible and
   editable, to the payees.
   • Select or clear individual check boxes next to the appropriate layout tables.
   • Select or clear the **Visible** or **Editable** column check boxes to select or clear
     all the layout tables in the column.

   **Important:** The only fields that are editable in the report are the fields that
   were marked as editable in the data grids in Presenter. If you do not select the
   **Editable** check box in the Add Node wizard, the fields are not displayed as an
   editable part of the workflow, regardless of the Presenter settings.

6. Click **Finish**.

**Adding a process node**

A process created in the Scheduler module can be added as a step in the workflow
in the IBM Cognos Incentive Compensation Management Workflow Manager
module.

**Procedure**

1. In the workflow, click the column in the swim lane where you would like to
   place the process node.
2. In the **Add Node** wizard, type a name and description for the node.
3. Select **Process Node** and click **Next**.
4. Select the **Scheduler** process folder you want the node to run.
5. Click **Finish**.

   **Important:** If an error occurs when running the defined process, the workflow
   will either stop and be put into an error state or will continue running based
   on the configuration of the **Stop Process on Error** option in the Cognos
   Incentive Compensation Management Scheduler module.

**Creating conditional nodes**

You can define conditions that must be met in a particular step in the workflow in
the IBM Cognos Incentive Compensation Management Workflow Manager module.
About this task

The entry path to a conditional node must be from an action node. Conditional nodes must have two exit paths. You can configure conditions with the following variables: parameters, editable value columns, stored values, and dates. A maximum of five conditions can be created in each conditional node.

Procedure

1. In the workflow, click the column in the swim lane where you want to place the conditional node.
2. In the Add Node wizard, type a name and description for the node.
3. Select Conditional Node and click Next.
4. Click Add New Conditional Path.
5. Right-click the new conditional path to rename it.
6. Click-and-drag the available parameters into the Formula window to create the required condition.
7. Click Finish.

Editing or deleting a node

Nodes can be edited or removed from the workflow in the IBM Cognos Incentive Compensation Management Workflow Manager module.

The node type cannot be changed after the node has been created. Start and End nodes cannot be changed or deleted.

Procedure

1. To edit a node, right-click the node and select Edit Node.
2. To delete a node, right-click the node and select Delete Node.

Cutting, copying, and pasting a node

You can copy and paste nodes into different columns in the same workflow, or to columns in a different workflow, in Workflow Manager in IBM® Cognos® Incentive Compensation Management.

Procedure

1. Right-click the node that you want to move and click Cut or Copy.
2. Right-click an empty column in the same workflow or a different workflow, and click Paste.

Connecting nodes

After nodes have been created, they must be connected to define the workflow process in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure

1. Connect the Start node to the first node of the process by performing the following steps:
   a. Right-click the Start node, and select Connect Node.
   b. Select the node you want to connect the Start node to.
2. Connect the rest of the nodes to the workflow process in the same way.
3. To connect an action node with multiple action paths, perform the following steps:
   a. Right-click the action node, and select **Connect Node**.
   b. Select the node you want to connect an action path to.
   c. Select the action path you want to connect to the node, and click **Finish**.
   d. Repeat the steps above to connect the other action paths to the appropriate nodes.
4. Connect the last nodes in the workflow process to the end node to complete the workflow.
   You can select whether the last nodes result in the workflow being approved or rejected.

**Editing or deleting a connection**

You can edit or delete a connection between nodes in Workflow Manager in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. To remove a connection, select the connection line and press the Delete key on your keyboard.
2. To reconnect a connection, right-click the node with the connection that you want to edit and click **Connect Node**.
3. Select the node that you want to connect it to.

**Workflow value submission in pending state**

In IBM® Cognos® Incentive Compensation Management, you can create workflows that allow web users to submit values that are in a pending state until the workflow is approved.

First, the workflow must be associated with a Presenter report that has an editable column in a data grid. Then, the workflow must contain an **Action** node that has at least one approved path and one reject path to the **End** node. Web users can open the workflow in the web client and edit columns in the data grid. These edits remain in the pending state, and cannot be seen by other web users, until the workflow is approved.

**Workflow errors and reports**

Workflow history is logged in two modules in IBM® Cognos® Incentive Compensation Management. General workflow history is tracked in the Audit log, and node-specific history is tracked in Workflow Manager.

If a workflow encounters an error, you can view the details of the error in the **Errors** log in Workflow Manager. You can view the error and identify the node that caused the error.

When an **Action** node encounters an error, such as when the next payee involved in the workflow cannot be determined, an error is recorded on the **Action Node Errors** page.

When an **Alert** node encounters an error, such as an invalid email address, an error is recorded on the **Service Node Errors** page.
For the workflow to advance, an administrator must intervene.

**Viewing workflow errors**

In IBM® Cognos® Incentive Compensation Management, you can view workflow errors on the Errors page in Workflow Manager.

**Procedure**

1. Select the workflow.
2. To view Action node errors, click Errors.
3. To view Alert node errors, click Alert Node Errors.
4. To view service errors, such as invalid email address, click Service Node Errors.

**Resolving action node errors**

An error encountered by an action node can be fixed in the Action Node Errors log in the IBM Cognos Incentive Compensation Management Workflow Manager module.

**Procedure**

1. Select the workflow that encountered the error.
2. Click Errors.
3. In the Action Node Errors log, right-click the error, and select Resolve Error.
4. You can handle the missing payee in one of the following ways:
   - Select Reassign Payee to choose another payee to perform the action required by the node.
   - Select Remove from Workflow to remove the action from the workflow, and click Finish.
5. If you selected Reassign Payee, select the payee you want to reassign to the node, and click Finish.

**Viewing workflow events in the Audit module**

In IBM® Cognos® Incentive Compensation Management, you can view general workflow actions such as adding, deleting, starting, and stopping workflows, in the Audit log.

**Procedure**

1. Open the Audit module.
2. View the Audit log.

**Viewing workflow events in Workflow Manager**

The history of individual nodes is tracked in the Workflow Manager History window in the IBM Cognos Incentive Compensation Management Workflow Manager module.

The history tracks who has performed actions or received notifications.

**Procedure**

1. In Workflow Manager, select the workflow for which you want to view the node history.
2. Click the History button.
Viewing pending actions

In IBM® Cognos® Incentive Compensation Management, you can view the Action node that is involved in the current step of the workflow, and the payees who must perform an action, in the Pending Actions window of Workflow Manager. If the Scheduler service started after the workflow started, you can also see any process nodes that were unable to initiate in the workflow.

Procedure

1. In Workflow Manager, select the workflow that contains the pending actions that you want to view.
2. Click the Pending Actions button.

Rerunning a Process node

In IBM® Cognos® Incentive Compensation Management, if a Process node was stopped because the Scheduler service was started after the workflow began, you can restart the Process node.

About this task

Alternatively, you can choose to not run the process node and move on to the next step in the workflow.

Procedure

1. Select the workflow that contains the Process node that you want to rerun or skip.
2. Click the Pending Actions button.
3. To rerun the Scheduler process, right-click the process node and click Rerun Process.
4. To move to the next step in the workflow, right-click the process node and click Move to next.

Filtering workflow errors, pending actions, or history

In IBM® Cognos® Incentive Compensation Management, you can filter specified errors, actions, and events on the Errors, Pending Actions, or History pages in Workflow Manager.

Procedure

1. Select the workflow.
2. Click Errors, Pending Actions, or History.
3. In the header of a column, click the pin icon.
4. Select the options that you want to filter the errors by and click Filter.

Exporting errors, pending actions, or history to Microsoft Excel

In IBM® Cognos® Incentive Compensation Management, you can save history events, action node errors, and Service node errors from Workflow Manager as a Microsoft Excel file.
Procedure
1. Select the workflow.
2. Click Errors, Pending Actions or History.
3. Click the Export button.

Clearing the pending actions or history
All the events on the Pending Actions or History page in the IBM Cognos Incentive Compensation Management Workflow Manager module can be deleted.

Procedure
1. Select the workflow.
2. Click Pending Actions or History.
3. Click the Clear button.

Workflow Manager in the web client
You can access all activity for Presenter reports that are involved in workflows through the message center in the IBM© Cognos© Incentive Compensation Management web client.

Any notifications that are sent to payees through the web client can be viewed in the payees’ inboxes. Any reports that require the web user to perform an action can be accessed from the Workflow Manager section of the message center. Presenter reports involved in the workflows do not require tree assignment in the Portal Access module to be viewed in the web client. Presenter report access in the web client is determined through the swim lanes in the workflows of Workflow Manager.

Any user-initiated workflows that are assigned to a web user can be initiated by the web user on the Available Workflows tab in the Workflow Manager section. The web user can open the report, submit the necessary data, and then initiate the workflow from the report. When a web user is required to perform an action in a report, a link to the report involved in the workflow is displayed on the Pending Workflows tab of the Workflow Manager section. The report contains buttons for each action the web user can perform as part of the workflow. Web users can also view completed workflows on the Completed Workflows tab of the Workflow Manager section.

Initiating a workflow
Web users can begin a user initiated workflow from within the IBM Cognos Incentive Compensation Management web client.

Procedure
1. Log in to the web client.
2. Go to the message center.
3. Click Workflow Manager.
4. Click the Available Workflows tab.
5. Click the link to the workflow you want to initiate.
   The report associated with the workflow opens.
6. Click Start.
7. Click Confirm.
Performing an action in a workflow

Web users can approve or edit reports in the IBM® Cognos® Incentive Compensation Management web client. The actions that are available to the web user in the report are defined by the Action node in the workflow.

Procedure
1. Log in to the web client.
2. Go to the message center.
3. Click Workflow Manager.
4. Click the Pending Workflows tab.
5. Click the link to the report.
6. To view the history of the workflow, click the View Workflow History button.
7. Click the appropriate action button.
   For example, if an action path in the workflow is defined as approve, click the Approve button to send the report along that action path.
8. Click Confirm.

Viewing a completed workflow

Web users can view a list of finished workflows on the Completed Workflows tab of the Workflow Manager section in the message center of the IBM® Cognos® Incentive Compensation Management web client. The name of the workflow, the workflow initiator, the date of initiation, and the date of completion are listed on the tab.

Procedure
1. Log in to the web client.
2. Go to the message center.
3. Click Workflow Manager.
4. Click the Completed Workflows tab.
5. To view the history of the workflow, click the link to the workflow.
Chapter 23. Portal Access

You can use the Portal Access module in IBM® Cognos® Incentive Compensation Management to define web tabs, web access, signoff, and responsibility for inquiry handling.

In most cases, users must be included in a Portal Access hierarchy, which plays a role in the process of approvals and sign-offs in the system. Administrators can create web tabs, groups, hierarchical trees, and define assignments, sign off, and inquiries processes.

The following tabs are available in Portal Access:

- Web Tabs
- Groups
- Trees
- Assignment
- Sign Off
- Inquiries

Web tabs

In the Portal Access module in IBM® Cognos® Incentive Compensation Management, you can customize the tabs that are displayed in the web client.

You can select the name, type, and sequence of tabs. You can also build report-driven home pages that are appropriate for different Portal Access groups.

You can create web tabs for individual plans, Presenter and tailored reports, draw assignment and reports, web forms, and external web pages. You can create module tabs by selecting Data Edit, Inquiries, Payee Ledger, Reporting, or Web Forms. Users can organize tabs into web tab groups, which create subtabs in the web client.

When only one object is assigned to a web tab, no subtabs are shown, and the plan, report, or form is rendered immediately. When more than one object is assigned to a tab group, subtabs appear, and users must select something before a form can open. After web tabs are created, administrators must assign access to the tab itself and to the objects that are included in the tab. If users do not have access to the web tab or the subtabs, they cannot see them in the web client.

The following web tabs are available:

- Compensation Plan
- Draw Assignment
- Draw Report
- External URL
- Module
  - Data Edit
  - Inquiries
  - Payee Ledger
Reporting
- Web Forms
  - Presenter Report
  - Tailored Report
  - Web Form

Important: If you are upgrading a 6.0 model, the tabs that you set up appear in the Portal Access module and the web client.

Adding a web tab
You can add web tabs in Portal Access that users will be able to use for navigation in the IBM Cognos Incentive Compensation Management web client.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To add a web tab, perform one of the following steps:
   - Click the Add Web Tab icon.
   - Right-click and select Add Web Tab.
3. Type a name for the web tab, and click Next.
   You can use special characters, such as hyphens and apostrophes, when you add a web tab name.
4. Select the Type of web tab.
5. Select the object that is assigned to the type of web tab.
   For example, if you select the Compensation Plan type, you need to select a compensation plan.
6. Click Finish.

   Important: The first tab listed in Portal Access is the first tab that will be displayed on the web client.

Moving a web tab
You can change the location and order of web tabs in the Portal Access module in IBM® Cognos® Incentive Compensation Management.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. Select a web tab, and hold down the Shift key.
3. Move the web tab to the location that you want.

Editing a web tab
You can change the name, type, and object assigned to the web tab created in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To edit a web tab, perform one of the following steps:
   - Right-click a web tab, and select Edit Web Tab.
   - Select the web tab, and click the Edit icon.
3. In the Web Tab Wizard, make your changes.
Deleting a web tab
You can remove a web tab from the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To delete a web tab, complete one of the following steps:
   • Right-click a web tab and Delete Web Tab.
   • Select the web tab and click the Delete icon.
3. Click Yes in the Question window.

Adding a web tab group
You can create web tab groups where you can place individual web tabs in the Portal Access module in IBM® Cognos® Incentive Compensation Management. For example, you can create a web tab group called Plans, and place the web tabs for individual compensation plans into this group.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. To add a web tab group, complete one of the following steps:
   • Click the Add Web Tab Group icon.
   • Right-click the window and click Add Web Tab Group.
3. Double-click the New Web Tab Group and type a name.
4. Click a web tab and drag it into the web tab group.

Removing a web tab from a group
You can move web tabs from one group to another in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In Portal Access, click the Web Tabs tab.
2. Click a web tab, and move it out of the web tab group while holding down the Shift key.

Setting access to web tabs
The user needs access to both the web tab and the objects inside to view them on the IBM Cognos Incentive Compensation Management web client.

For example, if you have a reporting web tab, you need to set access to the reporting web tab and to the individual Presenter reports.

Procedure
1. In Portal Access, click the Assignment tab.
2. Click under a column to show the drop-down menu arrow.
3. Select the access tree.

Portal Access hierarchy
In Portal Access, you must define groups, create access trees, and assign the access trees to web tabs so that web users can access items in the IBM® Cognos® Incentive Compensation Management web client.
At a high level, the following steps describe how to define a Portal Access hierarchy:
1. Create groups.
2. Make trees.
3. Assign trees to the web, and enable compensation plans, tailored reports, documents, and web forms.

**Adding Portal Access groups**
In the Portal Access module in IBM® Cognos® Incentive Compensation Management, you can add Portal Access groups. Any payees that exist in the model can be added to any group.

**About this task**
Typically, you would add a group for each level of the Portal Access hierarchy, for each plan, report, and so on.

**Procedure**
1. In Portal Access, click the Groups tab.
2. To add a group, complete one of the following steps:
   - Click the Add Portal Access Group icon.
   - Right-click and select Add Portal Access Group.
3. In the Portal Access Group wizard, type the group name.
4. Select or clear the Maintain this group in Task Manager check box, and then click Next. This option adds a copy of the group in Task Manager, so that you can add rules to maintain the group's members.
5. Define the Portal Access group members by using the Payee table as a source, as well as any other sources that you want to append. Click Add to add columns or rows to the Payee table to define your Portal Access group.
6. Add restrictions to define exactly which members of the source can participate in the Portal Access group. For example, to add a Portal Access group that contains only Account Executives, you could define a restriction stating that only payees whose title ID = Account Executive should be included. Defining restrictions is optional. You can also manually select payees from the next screen in the Portal Access Group wizard.

   **Tip:** If you are planning on maintaining your Portal Access group in Task Manager, define your group members on the Define Restrictions window. If you are not maintaining the group in Task Manager, feel free to add members manually as needed.
7. Click Add > or < Remove to add the exact group that you want. Any members that you already selected through the restrictions screen are automatically shown in the Selected Payees pane.
8. Click Finish.

**Payees and Portal Access groups**
If payees are added to the Payee table after Portal Access groups were created in the Portal Access module in IBM® Cognos® Incentive Compensation Management, you can use the Task Manager module to add these payees to your Portal Access groups.
Managing web access
You can enable payees for web access, and edit the web login credentials for any member of a group in the IBM Cognos Incentive Compensation Management Portal Access module.

About this task
When an administrator changes a user’s password through the Manage Web Access window, the password history is not remembered by Cognos Incentive Compensation Management.

Procedure
1. In the Groups tab, perform one of the following steps to manage web access:
   - Select the Portal Access group, and click the Manage Web Access icon.
   - Right-click the Portal Access group, and select Manage Web Access. The Web Users window lists all the group members.
2. Select any member and click Enable.
   You can press the Ctrl key to select and enable multiple payees simultaneously.
3. Type and confirm a password to enable the member for the web client, and click OK.
   After enabled, web users will use the email address defined in the Payee table as their login ID.
   **Important:** The email address cannot be changed from the Portal Access module.
4. If you want to disable a member’s access, select the member and click Disable.
5. If you want to unlock a member who has been locked out of the web client, select the member, and click Unlock.
6. When you are done enabling members for the web client, click Close.
   **Important:** The Task Manager module provides an option for generating passwords and sending emails informing groups of payees of their passwords. This task can be used anytime a new payee is added to a Portal Access group, or to provide existing users with new passwords in the case of a forgotten password. Task Manager can be used to assign passwords to a large group of individuals at once.

Forcing web users to change passwords on next login
When the Change Password On Next Login check box is selected, users will be forced to change their password the next time they log in to the IBM Cognos Incentive Compensation Management web client.

About this task
This option can only be selected for web enabled users. If the User Must Have Strong Password option is selected on the Web tab in the Administrative Options window, the user’s new password will have to adhere to the strong password guidelines.

**Important:** Web users will be forced to enter a password into the New Password field the next time they log in to the web client; however, web users are permitted to reuse passwords. This means that the new password can be the same as the old password.
Procedure
1. In the Groups tab, perform one of the following steps:
   - Select the Portal Access group, and click the Manage Web Access icon.
   - Right-click the Portal Access group, and select Manage Web Access.

   The Web Users window lists all the group members.
2. Select the web enabled user, and click the Change Password On Next Login button.

   A checkmark is displayed next to the user in the Change Password On Next Login column.

Enabling password expiration
In IBM® Cognos® Incentive Compensation Management, you can enable password expiration for each Portal Access group. If you select a folder, all groups in the folder are enabled.

Procedure
1. In Portal Access, click the Groups tab.
2. Select the group for which you want to enable password expiration.
3. In the Password Expiration column, select the check box.

Finding a payee on the Groups tab
After all your groups are created, you might want to find a specific payee in the Portal Access module in IBM® Cognos® Incentive Compensation Management.

About this task
By default, this option searches for an exact match. To perform a wildcard search, use an asterisk (*).

Procedure
1. On the Groups tab, click the Find Payee button.
2. Type the name of the payee.
3. Click Search.

Portal Access trees
From the Trees tab in the Portal Access module in IBM® Cognos® Incentive Compensation Management, you can create hierarchy trees to define access to web tabs, signoffs, and inquiry handling responsibilities.

A tree can have as many or as few groups as you would like, and there is no limit to the level of complexity of the hierarchy. You might want to create different hierarchy trees for web review, signoff, and inquiry handling for each plan.

After a tree is created, it can be assigned to as many plans, reports, web forms, or documents as you like.

Access trees
Access trees are created to define who can see information in the IBM Cognos Incentive Compensation Management web client.
Members at the top of the tree will be able to see their own results and the results of anyone below them in the tree. Group members will not be able to see results for others who are in the same group as them.

Only compensation plans have hierarchical access. For this reason, trees used to define report, web form, or document access should only contain one level (or one group).

**Signoff trees**

Sign off trees in the Portal Access module in IBM® Cognos® Incentive Compensation Management determine the order that payees sign off on results.

Payees in the top group must complete signoff before payees in the next group can begin. To create signoff trees, you must define the hierarchy and decide who can sign off on results, for example, all members or one member in the group.

**Inquiry trees**

Inquiry trees in the Portal Access module in IBM® Cognos® Incentive Compensation Management define the inquiry handling process. For inquiries, information always flows from the top of the tree to the bottom.

Members at the top of the tree can launch inquiries that can be handled by members of the group below them. For example, you can create an inquiry handling tree where inquiries by all Account Executives who launch inquiries are handled by the Regional Sales Manager (RSM). If the RSM chooses, he or she can escalate the inquiry to the vice president by clicking the **Escalate** button on the web client.

**Making a Portal Access tree**

On the **Trees** tab, you can use the Portal Access groups to create access trees in the IBM Cognos Incentive Compensation Management Portal Access module.

**Procedure**

1. On the **Trees** tab, select the **New Tree** button.
2. Type a **Name** for your tree.

   **Important:** You will now see your tree in the trees drop-down menu.
3. Drag groups to create your tree on to the right side of the window.
   a. Place one group on top of another to create the hierarchical structure.
   b. To have two top groups join a single bottom group, place the bottom group on top of one of the top groups, then press Alt, and then drag the bottom group to the second top group.

   **Tip:** There is no limit to the level of complexity that your tree can have.

**Defining hierarchies for signoff**

In the Portal Access module in IBM® Cognos® Incentive Compensation Management, you can specify whether all groups members must sign off, or only one group member must sign off.

**About this task**

These settings apply only to trees that are used to define signoff responsibility.
Important: The Sign Off Type for the group needs to be defined in the tree that is used to define access, not the tree that is used to define signoff.

Procedure
1. On the Trees tab, select the access tree.
2. Right-click any group and click the Sign Off Type.
3. Select All Group Members Must Sign Off or One Group Member Must Sign Off.
   - If you select All Group Members Must Sign Off, all members of the group must sign off on results for the step of the approval process to be complete.
   - If you select One Group Member Must Sign Off, only one member of the group must sign off for the step of the approval process to be complete.

Adding web adjustments
In the Portal Access module, you can grant a group permission to adjust results through the IBM® Cognos® Incentive Compensation Management web client.

About this task
When group members with adjustment privileges log in to the web client, they can make manual adjustments to the results of any members in the group below them on the access tree.

Procedure
1. On the Trees tab, right-click a group in the tree and click Can Adjust On Web.
2. Log in to the web client.
3. Click the Payee Ledger tab.
4. Click the Summary link.
5. Select a plan and a payee.
6. Click Adjust.
   Web users can make a manual adjustment to the data in that row.

   Important: People with adjustment privileges cannot adjust their own results or the results of other members in the same Portal Access group.
7. Type the new Value.
8. Type any comments about the adjustment.

Viewing web adjustments
In the Payee Ledger module of IBM® Cognos® Incentive Compensation Management, you can view changes that were made to compensation plans by web users.

Procedure
1. In the Cognos Incentive Compensation Management client, open Payee Ledger.
2. Click the Summary Ledger tab.
3. Select the plan and payee.
4. Click the Generate Report button.

Results
You can see the adjustment in the Adjustment column.
Using the Portal Access Tree Builder

You can use the Portal Access Tree Builder wizard to automate the creation of trees and the groups that belong in the trees in the Portal Access module in IBM Cognos Incentive Compensation Management.

About this task

Portal Access Tree Builder generates a Portal Access tree hierarchy based on a specified parent-child relationship. After the hierarchy is defined, you can use the Portal Access Tree Builder to automate the partitioning of your child groups, giving breadth to your tree.

Procedure

1. On the Trees tab, click the Tree Builder item.
2. Type the name of your Portal Access tree. The name of the tree must be unique.
3. You can select the Maintain generated Portal Access groups in Task Manager check box to place a copy of all of the groups that are created by this wizard in Task Manager so that they can be maintained with Task Manager rules and tasks.
4. Click Next.
   
   **Important:** Only the groups can be maintained in Task Manager. The tree structure must be maintained manually in Portal Access.
5. To define any additional sources that must be joined to the Payee table to provide the source data that is needed to create the groups and trees, click Add and follow the Select Additional Source wizard.
   
   **Important:** The source data must not contain cycles. That is, there must not be a path from any payee's parent to itself. Also, there can be only one row entry in the source data for each payee selected.
6. Click Next.
7. Define any restrictions on the source data.
   
   Use restrictions to limit the tree to a subset of payees. For example, you might want to create a reporting hierarchy tree that contains only payees from a particular territory region. Also, if more than one entry exists for some payees, you can use restrictions to specify which entry to use.
8. Click Next.
9. Select the Parent Column from the menu.
   
   **Important:** The parent column defines the hierarchical structure of the tree and it gives the tree its depth. The parent column can be any column that is a pick list to the Payee table. For example, if you select the Reports To column, the tree hierarchy is created according to who the payees report to.
10. You can select a Group Definition Column.
    
    **Important:** Specifying a group definition column provides a way to divide each hierarchical level of your tree into multiple groups. The group definition column can be any text-based column in your source. For example, if you select job title as the group definition column, separate groups are created for each job title, at each level of the hierarchy.
11. Click Finish.
The tree is available in the Trees tab and it can be edited by dragging and dropping Portal Access groups. All of the groups that are created for the tree are accessible from the Groups tab inside a folder that uses the following naming convention: Tree Builder - <tree name>.

Assignments

In the Assignment tab of the IBM Cognos Incentive Compensation Management Portal Access module, you can assign the hierarchies created in the Trees tab.

Administrators can validate Portal Access tree assignments and define what periods are available for compensation plan viewing via the web client.

Validating tree assignments

You can check the validity of tree assignments for web tabs, compensation plans, tailored reports, documents, and web forms in the Portal Access module in IBM® Cognos® Incentive Compensation Management.

Procedure

1. On the Assignment tab, click a web tab, compensation plan, report, document, or web form.
2. Click the Validate Assignments button.

Setting compensation plan visibility

You can define the start and end dates that a compensation plan will be visible to payees assigned to the plan in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure

1. On Assignment tab, right-click a plan, and select Set Compensation Plan Visibility.
2. Select the Starting and Ending check boxes, and select the visibility dates.
   - You can opt to not have results prior to or after a certain date available from the web client.
3. Click OK.

Tree assignment

You can assign an access, signoff, or inquiry tree to compensation plans, tailored reports, documents, web forms, and Presenter reports in the Portal Access module in IBM® Cognos® Incentive Compensation Management. If necessary, you can assign the same tree multiple times.

When you assign access, signoff, and inquiry trees to compensation plans, tailored reports, documents, web forms, and Presenter reports, consider the following details:

Compensation plan assignment

For all compensation plans, the access trees can contain multiple levels. Members in the tree can see their own results and the results of any payees in groups below them in the tree.
Tailored report assignment
For tailored reports, access trees can contain multiple levels. Members in the tree can see their own results and the results of any payees in groups below them in the tree.

Document assignment
Any documents that are added to the Document Manager window (accessed from the Admin menu) are listed in the Assignment tab and can be enabled for web review. When you assign trees to documents, keep in mind that access to the document is either granted or denied, and you cannot give partial access to a document. For this reason, the trees that you use to define document access must contain only one group.

Web form assignment
All web forms that are created and saved are listed in the Assignment tab. When you assign trees to web forms, keep in mind that you cannot give partial access to a web form through the Portal Access module. For this reason, the trees that you use to define web form access must contain only one group. To restrict web form access, assign restrictions directly to the form through the Web Forms module.

Presenter report assignment
All Presenter reports that are created and saved are listed in the Assignment tab. When you assign trees to Presenter reports, keep in mind that you cannot give partial access to a Presenter report through the Portal Access module. For this reason, the trees that you use to define Presenter report access must contain only one group. To restrict Presenter report access, assign restrictions directly to the report through the Presenter module.

Assigning tree access
If you want web tabs, compensation plans, tailored reports, documents, web forms, and Presenter reports to be visible to users on the IBM Cognos Incentive Compensation Management web client, you must assign them to Portal Access trees.

Procedure
1. In the Portal Access module, on the Assignment tab, select a compensation plan, tailored report, document, web form, or web tab. The access, signoff, and inquiries columns all contain hidden menus that list every tree that was created in the Trees tab.
2. Click under a column to show the arrow.
3. Select the tree from the menu.

Sign off
The sign off tab in the IBM Cognos Incentive Compensation Management Portal Access module is used to begin or end an approval process, view history of past sign offs, and see the current sign off status.

For each compensation plan, tailored report, document, web form, and Presenter report, you can see what group has signed off, who has yet to sign off, and if necessary, force approvals.

Important: The approval process is not tied to period locking; the process can begin and end at any time.
**Sign off colors**

After you start a sign off in the Portal Access module of IBM® Cognos® Incentive Compensation Management, groups in the tree are no longer blue. A color coding system indicates the status of the sign off process.

*Table 42. Sign off colors*

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Group members have already approved their results.</td>
</tr>
<tr>
<td>Red</td>
<td>Group members must sign off on results.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Group members are waiting for the group before them to complete sign off before they can sign off.</td>
</tr>
</tbody>
</table>

**Starting a sign off**

You can begin the sign off process on the web client from the Portal Access module of IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. On the Sign Off tab, select a plan, report, document, or web form that has a sign off tree that is assigned to it.
2. Click the Start Sign Off icon.
3. Type a name for the sign off.
4. Click OK.

**Signing off in the web client**

After the sign off has started, members in the first sign off group can approve results through the IBM Cognos Incentive Compensation Management web client.

**Procedure**

1. Log in to the web client.
2. Click the Message Center link.
   - There will be a new message saying that the user has been prompted to sign off on a task.
3. Click the Summary link or select Tasks.
   - Members that need to approve results will see an Approve button.
4. Click the Object link to view details of the pending sign off.
5. Click Approve to approve the results.
   - If you return to Portal Access in the Cognos Incentive Compensation Management Client, you will see that the members who approved the results are now green.

**Ending the sign off process**

A sign off process ends automatically after the members of the final group sign off. However, you can cancel the sign off process in the Portal Access module of IBM® Cognos® Incentive Compensation Management before it is complete.

**Procedure**

1. On the Sign Off tab, select the item that you want to cancel the sign off for.
2. Click the Cancel Sign Off icon.
Sending email notification about the sign off process to pending payees

After the sign off process starts in the Portal Access module of IBM® Cognos® Incentive Compensation Management, you can send an email to all members in the tree to inform them that the sign off process is underway.

Procedure
1. On the Sign Off tab, select the tree from the menu.
2. Click the Email All Groups icon.
3. Type a subject and message.
4. You can select the Send to Pending Payees Only check box to notify only payees in the top node of the sign off tree.
5. Click Send.

Sending email notification about the sign off process to all members of one group

After the sign off process has started you can send an email to all members of one group in the tree informing them that the sign off process has started from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Sign Off tab, select the tree from the drop-down menu.
2. Select the group.
3. Click the Email One Group icon.
4. Type in a subject and message.
5. Click Send.

Forcing sign off approval

The administrator can force approval for any pending sign offs in the Portal Access module of IBM® Cognos® Incentive Compensation Management.

Procedure
1. On the Sign Off tab, select the tree from the menu.
2. 
3. A group with pending sign offs is highlighted in red. Right-click a group that has pending sign offs, and click Force Approve All.

Results

After you force approve results, sign off moves on to the next group of payees.

Viewing sign off status for group members

You can open a table that displays all members in a group in IBM® Cognos® Incentive Compensation Management. For any members who signed off, the sign off date and approval type are also listed.

Procedure
1. On the Sign Off tab, select the sign off tree from the menu in the toolbar.
2. Right-click a group in the sign off tree and click View Members.
If Approved is listed in the Approval Type column, the member signed off on results through the web client. If Force Approved is listed, then the company’s administrator forced approval through the Cognos Incentive Compensation Management client.

3. Click Close.

Inquiry process

The Inquiries tab is used to handle web inquiries in the IBM Cognos Incentive Compensation Management Portal Access module.

The ability to launch inquiries can be enabled or disabled for any plan or report from this tab. Cognos Incentive Compensation Management automatically enables inquiries for plans and reports.

Disabling inquiries

You can choose to prevent users from being able to launch inquiries from the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. On the Inquiries tab, select the object for which you want to disable inquiries.
   
   **Important:** An inquiry tree must be assigned to the object.
2. Click the Disable Inquiries icon.
3. Click Yes in the Question window.

Enabling inquiries

By default, users can launch inquiries for compensation plans, tailored reports, documents, and Presenter reports from the IBM® Cognos® Incentive Compensation Management web client. If you disabled this function, you can enable it again.

Procedure
1. In the Portal Access module, on the Inquiries tab, select the compensation plan, tailored report, document, or Presenter report that you want to enable inquiries for.
   
   **Important:** An inquiry tree must be assigned to the object.
2. Click the Enable Inquiries button.
3. Click Yes in the Question window.

Sending email notifications about inquiries to pending payees

You have the option to send an email to all groups in the inquiry tree from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Inquiries tab, click the Email All Groups icon.
2. Type in a subject and message.
3. You can select the Send to Pending Payees Only check box to notify only payees in the top node of the sign off tree.
4. Click Send.
Sending email notifications about inquiries to all members of one group
You can send an email to all members of one group in the Inquiry tree from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Inquiries tab, select the group.
2. Click the Email One Group button.
3. Type in a subject and message.
4. Click Send.

Submitting an inquiry from the web client
If an inquiry handling tree is enabled for a compensation plan or tailored report, all payees in the tree can launch inquiries through the IBM® Cognos® Incentive Compensation Management web client.

Procedure
1. Log in to the web client.
2. Go to the Payee Ledger tab.
3. In the Details or Summary window, click Inquire.
4. Select the inquiry category.
5. Attach any supporting documents.
6. Enter any details of the inquiry.
7. Click Submit.

Results
The inquiry is automatically assigned to the next group in the tree (the group immediately after the group of the member who launched the inquiry). The payee who submitted the inquiry sees a new message in his or her Message Center that confirms that he or she has an open inquiry.

Handling inquiries
When an inquiry is launched, users who are assigned to handle the inquiry will have the option to view, assign, unassign, escalate, or return the inquiry via the IBM Cognos Incentive Compensation Management web client.

If Return To Submitter has been enabled in Portal Access, users will also be able to resubmit a returned inquiry to the original assignee.

Procedure
1. Log in to the web client.
2. Click the Message Center.
3. Select Inquiries.

Important: You can also view inquiries through the Inquiries tab in the Portal Access module.
4. Click View to see the details of an inquiry.
5. Select one of the following items.
Assign
Assigns the inquiry to yourself.

Unassign
Removes yourself as handler of the inquiry.

Escalate
Submits the inquiry to the next person on the inquiry handling chain.

Return
Rejects the inquiry.

Resubmit
Sends the inquiry back to the user who returned the inquiry to you. This option is only available if the Return To Submitter option is enabled in Portal Access.

**Viewing inquiry details**
If you select any compensation plan or report in the IBM Cognos Incentive Compensation Management Client, the inquiry handling tree associated with it will be displayed in the right pane.

If any group is highlighted in red, there is an inquiry assigned to that group or an inquiry has been made by that group.

**Procedure**
1. On the Inquiries tab, right-click the red group.
2. Select View Inquiries Assigned to this Group.
   A screen will be displayed showing any comments or attachments that have been posted with this inquiry. The status and category of the inquiry can be changed from this location.
3. Double-click an entry to see the inquiry details.

**Viewing details of an inquiry that was made by a group**
You can view the details of an inquiry that is assigned to a group, or an inquiry that was made by a group, in the IBM® Cognos® Incentive Compensation Management Portal Access group.

**Procedure**
1. On the Inquiries tab, right-click the red group and click View Inquiries Made by this Group.
2. Double-click an entry to see the inquiry details.

**Viewing the details of an inquiry that is assigned to the administrator**
You can view the details of an inquiry that was assigned to the administrator from the Portal Access module in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. On the Inquiries tab, click the Inquiries Assigned To Admin button.
2. Double-click an inquiry.
3. You can change the status or the category.
4. You can add comments on attachments.
Adding and editing inquiry categories

You can add and edit inquiry category names in the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. On the Inquiries tab, click the Inquiry Category icon.
2. Click Add or Edit.
3. Type the name.
4. When you have finished adding inquiry categories, click Close.

Enabling inquiry resubmission

You can enable web users to resubmit a returned inquiry to the same assignee that returned the inquiry to them from the IBM Cognos Incentive Compensation Management Portal Access module.

Procedure
1. In the Portal Access module, open the Inquiries tab.
2. Right-click the object that you want to enable inquiry resubmission for, and select Resubmit To Returner.
Chapter 24. Scheduler

You can use the Scheduler module in IBM® Cognos® Incentive Compensation Management to create and schedule processes such as imports, calculations, and calendar locking.

Keeping a model up-to-date is essential. Without regular transactional data updates, Cognos Incentive Compensation Management cannot calculate up-to-date compensation amounts. You can use Scheduler to manage the import process. Structural and data loads that are saved in the application are accessible in Scheduler and can be grouped as steps in a single process. Each process can be run either on demand or on a scheduled basis, keeping your compensation model in sync with the latest data from your source systems.

In addition to data imports, Scheduler can be used to schedule all administrative tasks that need to be run regularly. Scheduler can also be used to automate the process of calculating results, locking periods, and generating administrative tasks that are created in Task Manager.

Related concepts:
- "Access permissions" on page 288
  When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.
- "Scheduler security" on page 313
  You can grant a role permission to view or edit the Scheduler module in IBM® Cognos® Incentive Compensation Management.

Setting Scheduler properties

You can select Scheduler options such as stopping a process if the Scheduler module in IBM® Cognos® Incentive Compensation Management encounters an error.

About this task

You can use Scheduler properties to set the maximum run time for an external tool, stop an external tool after it exceeds the set run time, and send email warnings when Scheduler encounters an error or runs successfully.

If you change a Scheduler property, you must restart the Scheduler service.

Procedure

1. Click the Properties button in the toolbar.
2. In the External Tools section, select the Maximum Run Time check box, and type the maximum time that you want Scheduler to allow an external tool to run.
3. In the External Tools section, select the Stop On Timeout check box if you want the external tool to no longer run after it exceeds the maximum run time.
Important: If the external tool is not running on the same computer as the Cognos Incentive Compensation Management client, stopping the external tool after the timeout cannot be guaranteed.

4. In the Refresh Interval field, type the number of seconds that you want Scheduler to wait before updating to include any changes that the user made in the Scheduler module. The refresh interval must be 1 - 432000 seconds.

5. Select the Stop Process On Error check box if you want to stop the whole Scheduler process if it encounters an error while it is running a task.

6. Select the On error, send email to these addresses check box if you want Scheduler to email users when processes or tasks complete with errors or fail, and type the users’ email addresses in the field.

7. Select the On success, send email to these addresses check box if you want Scheduler to email users when processes or tasks complete successfully, and type the users’ email addresses in the field.

8. Restart the Scheduler service.

Adding processes

You can use the Scheduler module in IBM® Cognos® Incentive Compensation Management to create processes that can be run on demand or on a schedule.

About this task

Processes can include tasks such as calculations, imports, publications, calendar locking, and task generating. Each process folder that you add must have a unique name.

Procedure

1. To add a process, complete one of the following steps:
   - Click the Add Process icon.
   - Right-click in Scheduler and click Add Process.
2. Type a Process Name.
3. Click OK.

   Tip: It is a good idea to create processes first, and then organize a combination of structural and data imports and calculations into process folders.

Adding subfolders

In the Scheduler module in IBM® Cognos® Incentive Compensation Management, you can add subfolders to a process folder to organize the tasks in the process.

About this task

Folders do not have the function of processes. For example, you cannot edit properties, set the stop on errors functionality, or configure separate email recipients. Tasks run in their sequential order according to the task or folder location.

Procedure

1. In Scheduler, select the parent process folder and click Add Process.
2. Type a name for the folder.
3. Select the Add to <name of parent process> check box.
4. Click OK.

Tasks

In IBM® Cognos® Incentive Compensation Management, tasks are the items that you must add to a process folder to create a process.

You can schedule tasks to run individually or as part of the complete process. You can also run a task manually from the Scheduler module.

Adding a task

To create a process in IBM® Cognos® Incentive Compensation Management, you must add a task to a process folder.

Procedure

1. To add a task to a process folder, complete the following steps:
   a. Select the process folder.
   b. Click Add Task.
2. By default, if the process folder contains tasks, the new task is added to the top of the task list. To add a task below an existing task in a process folder, complete the following steps:
   a. Select the existing task.
   b. Click Add Task.

Adding a calculation

You can add a calculation of the whole model to your process folder in IBM® Cognos® Incentive Compensation Management.

Procedure

To add a calculation to a process folder, complete one of the following steps:

- Select the process folder, click the Add Task icon, and select Add Calculation.
- Right-click a process folder and click Add Calculation.

Adding plan calculations

You can add a calculation of one or all compensation plans to a process folder in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure

1. To add a plan calculation to a process folder, perform one of the following steps:
   - Select the process folder, click the Add Task icon, and select Plan Calculation.
   - Right-click a process folder, and select Add Plan Calculation.
2. Choose a compensation plan, or select All.
3. Click OK.

Adding a tailored report calculation

You can add a calculation of one or all tailored reports to a process folder in IBM® Cognos® Incentive Compensation Management.
Procedure
1. To add a tailored report calculation, complete one of the following steps:
   • Select the process folder, click the Add Task button, and select Tailored Report Calculation.
   • Right-click a process folder and click Add Tailored Report Calculation.
2. Select a tailored report, or select All.
3. Click OK.

Adding a Presenter report calculation
You can add a calculation of one or all Presenter reports to a process folder in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure
1. To add a Presenter report calculation, perform one of the following steps:
   • Select the process folder, click the Add Task button, and select Presenter Report Calculation.
   • Right-click the process folder, and select Add Presenter Report Calculation.
2. Choose a Presenter report, or select All.
3. Click OK.

External tools
Scheduler can optionally be used to schedule and run processes that exist outside of IBM Cognos Incentive Compensation Management.

An external tool is any program that can be run from the command line in the Service configuration file.

For example, if you have a scheduled import or calculation, you can schedule an external tool, such as Notepad, to run immediately after the import or calculation finishes. If you type in the name of the file in the arguments (or value) line in the External Tools window, then that specific Notepad file will open.

Setting up external tools
Before you add external tools to a process folder, you must first edit the IBM Cognos Incentive Compensation Management Windows Service configuration file to prepare for external tools.

Procedure
1. In the Cognos Incentive Compensation Management Windows Service configuration file, uncomment the External Tools section.
   For example, edit the following section of the Cognos Incentive Compensation Management Windows Service configuration file:
   ```xml
   <!-- External Tools -->
   <add key="ExternalToolDirectory" value="C:\Program Files\IBM Cognos ICM\Service\Tools"/>
   <add key="ExternalToolMaxRunTime" value="3600"/>
   ```
2. Restart the Service.
3. Place items such as batch files and scripts in the external tool directory.
   For example, place them in the following directory: C:\Program Files\IBM Cognos ICM\Service\Tools
Scheduling external tools
You can schedule an external tool in the External Tools directory in the Scheduler module in IBM® Cognos® Incentive Compensation Management.

Procedure
1. To add a scheduled external tool, complete one of the following steps:
   - Select the process folder, click the Add Task icon, and select External Tool.
   - Right-click a process folder and click Add External Tool.
2. Select from a list of available tools.
3. In the Arguments field, type the name of the file.
4. Click OK.

Adding imports
Any imports saved in IBM Cognos Incentive Compensation Management can be added to the Scheduler module to be run on demand or at predefined intervals.

Procedure
1. To add an import to a process, perform one of the following steps:
   - Select the process folder, click the Add Task icon, and select Import.
   - Right-click a process folder and select Add Import.
2. Select a saved server import.
3. Click OK.

Adding IBM Cognos Territory and Quota Management table synchronization
You can schedule data synchronization between IBM® Cognos® Territory and Quota Management objects in the IBM® Cognos® Incentive Compensation Management client.

About this task

Important: You can synchronize data between Cognos Territory and Quota Management and Cognos Incentive Compensation Management through Scheduler only if Cognos Territory and Quota Management connection settings are configured in the Windows Service configuration file.

Procedure
1. To add a Cognos Territory and Quota Management table synchronization, complete one of the following steps:
   - Select the process folder, click the Add Task button, and select Territory Management Table Synchronization.
   - Right-click the process folder and click Add Territory Management Table Synchronization.
2. Select the Cognos Territory and Quota Management object to import, and click OK.

Publications
If you have publications that were created in the Publisher tool, you can save and schedule them in the Scheduler module in IBM® Cognos® Incentive Compensation Management.
You can schedule the following publications to run at predefined times in Scheduler:

- Tables in Composer that were published to Microsoft Excel, Microsoft Dynamic CRM, PDF file, Salesforce.com, or text delimited files.
- Calculations in Composer that were published to Microsoft Excel, Microsoft Dynamic CRM, PDF file, Salesforce.com, or text delimited files.
- Detail ledgers in Payee Ledger that were published to Excel, PDF file, or text delimited files. The detail ledger publishes for selected or all compensation plans and payees and filters on period and calculation. For example, the ledger publishes all plans for a selected payee, or publishes a selected compensation plan for all payees who are filtered on a selected period and calculation.
- Presenter reports published to PDF files, for example, batch export PDF files for each payee or export PDF files for selected payee.
- Web forms that are published to PDF files, for example, batch export PDF files for each payee or export PDF files for selected payee.

To save a publishing event so that you can rerun it in Scheduler, you must specify a Saved Publisher File Directory in the Cognos Incentive Compensation Management Windows Service configuration file.

The Saved Publisher Image Directory is the location where Cognos Incentive Compensation Management looks for image files that can be used as header graphics for scheduled PDF file publishing. This setting must refer to a directory on the same computer as the Windows Service.

The following example shows a Cognos Incentive Compensation Management Window Service configuration file that is edited to point to a Saved Publisher File Directory and a Saved Publisher Image Directory.

```
<add key="PublisherFileDirectory" value="C:\Program Files\IBM Cognos ICM\Publisher Files"/>
```

```
<add key="PublisherImageDirectory" value="C:\Program Files\IBM Cognos ICM\Publisher Images"/>
```

Related concepts:

- "Access permissions" on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Managing saved publications

You can edit, remove, and run saved publications from the Manage Saved Publications window in IBM® Cognos® Incentive Compensation Management.

Procedure

1. Go to Admin > Manage Saved Publications.
2. Select a Publish Name, and click Edit, Delete, or Run.
3. Click Close.

Adding a publication

Publications can be run using the IBM Cognos Incentive Compensation Management Scheduler module.
Procedure
1. To add a publish to a process, perform one of the following steps:
   • Select the process folder, click the Add Task button, and select Publish.
   • Right-click a process folder, and select Add Publish.
2. Select an available publication.
3. Click OK.

Email publications
You can send publication through email on demand, or you can schedule them in the Scheduler module in IBM® Cognos® Incentive Compensation Management. You can schedule web forms, Presenter reports, and Payee Ledger Detail reports.

You can send publications by email only when you select the Publish from the Server option.

To email a publication, you must define a Saved Publisher file Directory in the Cognos Incentive Compensation Management Windows Service configuration file.

When you send publications through email, the following options are available:
• If you create a separate report for each payee, you can email each individual payee his or her own report.
• You can specify an email address.
• You can select email addresses from the Payee table.

Adding a task generation
After defining groups, creating rules, or enabling alerts in the IBM Cognos Incentive Compensation Management Task Manager module, task generation can also be scheduled in Scheduler.

Procedure
To add task generation to a process, perform one of the following steps:
• Select the process folder, click the Add Task button, and select Task Generation.
• Right-click a process folder, and select Add Task Generation.

Adding a task run
After tasks have been generated in the IBM Cognos Incentive Compensation Management Task Manager module, the tasks can then be scheduled to run at a specific time in the Scheduler module.

You can automate the process of adding new users to Portal Access groups and granting them web access.

Procedure
To add task generation to a process, perform one of the following steps:
• Select the process folder, click the Add Task icon, and select Task Run.
• Right-click a process folder and select Add Task Run.
Populating star schemas

If star schemas have been created in the IBM Cognos Incentive Compensation Management Composer module, they can be populated on a scheduled basis using the Scheduler module.

Procedure

1. To add a star schema population to a process, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Star Schema Population.
   - Right-click a process folder, and select Add Star Schema Population.
2. Select an available star schema, and click OK.

Adding data transformations

If data transformations have been defined in the IBM Cognos Incentive Compensation Management Composer module and saved, the transformations can be scheduled to run at predefined intervals.

If your source system data is in a format that is different than the data in your table, you may want to save a transformation and schedule that transformation to run after every scheduled import.

Procedure

1. To add a data transformation to a process, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Data Transformation.
   - Right-click a process folder and select Add Data Transformation.
2. Select a saved data transformation.
3. Click OK.

Scheduling the deletion of table contents at a specified time

You can use the Scheduler module in IBM® Cognos® Incentive Compensation Management to delete the contents of a table at a specified time.

About this task

To use the clearing tables feature, you must have view and edit permission for Composer and the component that contains the table. If the table is in the top level of Composer, you must have Top > Edit permission.

You must also have view and edit permission for the structure of the table that you want to clear.

Procedure

1. To add a table clearing to a process, complete one of the following steps:
   - Select the process folder, click the Add Task button, and select Table Clearing.
   - Right-click a process folder and click Add Table Clearing.
2. Select a table in the Table Selector window.
3. Click OK.
Scheduling model optimization during off-peak hours

When you schedule model optimization, you can save time and avoid the necessity of completing extra steps manually. You can use the Scheduler module in IBM Cognos Incentive Compensation Management to schedule model optimization in during off-peak hours.

About this task

You can use the Scheduler module to run the optimize model feature on demand, or you can schedule the feature to run at predefined intervals.

Procedure

To run an optimize model, complete one of the following steps:
- Select the process folder, click the Add Task icon, and select Optimize Model.
- Right-click a process folder and click Add Optimize Model.

Add period locking

You can add period locking for a specific calendar to the next period in the IBM Cognos Incentive Compensation Management Scheduler module.

Important: You can only schedule locking one period at a time.

Procedure

1. To add period locking to a process, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Period Locking.
   - Right-click a process folder, and select Add Period Locking.
2. Select the calendar you want to lock to the next period, and click OK.

Temporarily enabling and disabling the web client

You might want to prevent web users from logging in to the IBM Cognos Incentive Compensation Management web client and making changes while the model is being updated. You can use the Scheduler module to disable the web client temporarily, and then to enable it again.

Procedure

1. To add a task that temporarily disables the web client, complete one of the following steps:
   - Select the process folder, click the Add Task button, and select Web Status.
   - Right-click the process folder and click Add Web Status.
2. Select the Disable Web option.
3. Click OK.
4. To add a task that enables the web client, complete one of the following steps:
   - Select the process folder, click the Add Task icon, and select Web Status.
   - Right-click the process folder and click Add Web Status.
5. Select the Enable Web option.
6. Click OK.
Scheduling the addition of workflow payees

If swim lanes were defined with restrictions in Workflow Manager, you can schedule the addition of payees to a workflow in IBM® Cognos® Incentive Compensation Management.

Procedure
1. To add a task that adds payees to the workflow, complete one of the following steps:
   - Select the process folder, click the Add Task button, and select Add Workflow Payees.
   - Right-click the process folder and click Add Workflow Payees.
2. Select an available workflow and click OK.

Unassigning idle inquiries

A task can be created to unassign a user from an inquiry if the user has not updated the inquiry in the IBM Cognos Incentive Compensation Management web client after a specified number of days.

After the inquiry has been unassigned, it is returned to the same Portal Access group to be reassigned. A comment is added to the inquiry indicating the assignee has been unassigned from the inquiry because it was inactive for the specified number of days.

Procedure
1. To add a task that unassigns a user from an idle inquiry, perform one of the following steps:
   - Select the process folder, click the Add Task button, and select Unassign Idle Inquiries.
   - Right-click the process folder and select Add Unassign Idle Inquiries.
2. Type the number of days the user has to update the inquiry before it becomes idle in the Number of Days to Expiry field.
3. Click OK.

Clearing history from selected tables

You can create a task in the Scheduler module in IBM® Cognos® Incentive Compensation Management to clear the history for selected tables.

Procedure
1. In Scheduler, select or add a process folder.
2. In the toolbar, click Add Task.
4. Select the table or tables that you want to remove history data from.
5. If you select a data table, select a date range for the table data that you want to remove history data from.

Viewing a scheduled history purge

You can view the tables and date ranges selected for scheduled history purge in IBM Cognos Incentive Compensation Management.
Procedure
1. In Scheduler, in the process folder, right-click the Purge Table History task.
2. Select View Scheduled Purge.

Disabled tasks and processes

In IBM Cognos Incentive Compensation Management, you can prevent processes, or tasks within a process, from running.

A task or process that is disabled cannot be run manually or within a scheduled process until it is enabled again. This can be useful when you do not want a certain task within a process to run, such as a saved import. You can also choose to disable tasks and process for the next scheduled run only. After the next scheduled run, the task or process is automatically enabled again.

The Disable, Enable, and Disable For Next Scheduled Run Only options can be accessed by right-clicking on the task or process folder.

Searching for an item

You can use the Search icon in the toolbar to locate a specific task or process in the Scheduler module in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click the Find icon in the toolbar.
2. In the Find Node window, type the name of the task or process that you want to find.
3. Click Search.

Results

The task or process is highlighted in the Scheduler window.

Scheduling an item

You can set the minute, hour, day of the month, day of the week, and month for a process or item to run in the IBM Cognos Incentive Compensation Management Scheduler module.

Procedure
1. Make sure the Scheduler Service is running.
2. Select the process folder or the item in the process folder that you want to schedule a run time for, and perform one of the following steps:
   • Click the Schedule Item button.
   • Right-click the process folder or item, and select Schedule.
3. Select the Minute you want the process or task to run on.
4. Select the Hour you want the process or task to run on.
5. Select either the day of the month or day of the week on which you want the process or task to run.
6. Select the Month when you want the process or task to run.
7. Click OK.
After an item is scheduled, the check box in the Scheduled column will be selected.

**Unscheduling an item**

If an item is scheduled, you can unschedule it in the Scheduler module in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. Select the process folder or the item in the process folder that you want to unschedule, and complete one of the following steps:
   - Click the **Schedule Item** button.
   - Right-click the process folder or item and click **Schedule**.
2. Click **Unschedule**.
3. Click **OK**.

**Running an item**

You can make a process or item run immediately from the Scheduler module in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. To run a process or specific item immediately, complete one of the following steps:
   - Select the process folder or item, and click the **Run Item** icon.
   - Right-click the process folder or item and click **Run**.
2. In the Question window, click **Yes**.

**Scheduler timing**

Sometimes you might find that a scheduled process does not run at exactly the time that you specified in the Scheduler module in IBM® Cognos® Incentive Compensation Management. The discrepancy might be caused by time changes in the system.

For example, you might set Scheduler to run at exactly 11:00 p.m. The next day, you might notice that the Scheduler log file shows that the item ran at 11:02 p.m.

This discrepancy might be caused by time changes in the system. For example, Windows Time Services periodically makes minor adjustments to the system time. These adjustments can interfere with Scheduler running at exactly the specified time.

**Scheduler time conflicts**

When scheduling tasks in the IBM Cognos Incentive Compensation Management Scheduler module, keep in mind that two tasks cannot run at the same time.

If one process is scheduled at 11:00 p.m. and another at 11:01 p.m., the second will not run if the first has not been completed. If the second task is unable to run, an error message will be displayed indicating that the task could not be run due to a scheduling conflict. The conflict will need to be resolved before Scheduler can run successfully.
Scheduler has a ten-minute window to run before the task will be skipped. This means that if Scheduler misses the 11:00 p.m. scheduled time due to a scheduling conflict, it will continue to attempt to run the task until 11:09:59 p.m. If the task is unable to run in the ten-minute window, the task will be skipped.

Important: The Scheduler Service can only run one process at a time. If more than one model is using the same Scheduler Service, scheduled processes need to occur at different times for each model. If scheduled model administration needs to occur simultaneously on more than one model, each model should point to a different service.

Scheduler error notification

When the Scheduler module in IBM® Cognos® Incentive Compensation Management runs scheduled items, some items might not run. If any items do not run, you are notified.

If an item runs successfully, a green check mark is displayed in the Status column. The Last Run column records the last successful and error-free completion of each task.

If an item does not run, the following actions occur:
• A message instructs you to see the Audit log for more information.
• A red stop sign is displayed under the Status column.
• No time is displayed in the Last Run column of the Scheduler module.
• The Audit log captures all Scheduler activity.

When a scheduled item does not run, the scheduled task is skipped. Scheduler tries to run the task item at the next scheduled interval.

If the first item in a process does not run, by default, Scheduler tries to run the remaining items in the process.

If you do not want Scheduler to try to run the remaining items in the process after a task fails, set the SchedulerStopProcessesOnErrors values in the Cognos Incentive Compensation Management Windows service configuration file to true. For example, you can edit the configuration file in the following way:

```
<add key="SchedulerStopProcessesOnErrors" value="true"/>
```

To prevent problems that might be associated with a lost import, you can configure Scheduler to send an email to an individual or distribution list about the error. You can also configure Scheduler to send an email notification upon successful completion. The email message is sent to the address in the Cognos Incentive Compensation Management Windows Service.exe.config file.

Accessing the Scheduler log

The date, time, step the process failed on, and other vital information is copied into the IBM Cognos Incentive Compensation Management Scheduler log file and the error report is recorded.

Procedure
1. To view the Scheduler log, open the Audit module.
2. Click the Scheduler tab.
Chapter 25. Task Manager

You can use the Task Manager module in IBM® Cognos® Incentive Compensation Management to maintain your model. Task Manager simplifies the process by generating lists of model maintenance and Portal Access tasks to be completed, based on defined criteria.

You can also use tasks to alert administrators when certain situations arise, such as when active payees are not included in a compensation plan, or terminated payees continue to be active in a plan.

When you create a task, you specify the process of performing various actions when data in the model changes, such as when new payees are imported into the Payee table. With tasks, you can easily define payee groups and create rules to perform administrative actions on those groups. After the customized task list is generated, click Run to complete model maintenance.

Task creation

You can use the Task Manager module in IBM® Cognos® Incentive Compensation Management to perform common model maintenance activities.

At a high level, the following steps describe how to create a task:

1. Add a group.
2. Add a rule.
3. Generate task list.
4. Administer the tasks.
5. Add email notification and enable alerts.

Step 1. Adding a group

To organize the tasks that are performed on payees, you can add a group in the Groups tab of the Task Manager module in IBM® Cognos® Incentive Compensation Management.

About this task

The Payee table is used by default to add groups. However, you can add any tables or calculated results to the Payee table to define the source of the payees. You can then use restrictions to specify which payees to include in the group.

When you add groups, think about the actions that you want to perform on those groups, such as what rule you want to apply to the group. For example, you might add a Task Manager group that includes all payees whose status is terminated, and then you might add a rule to remove those payees from their payee group.

The groups that you added in Portal Access appear in the Groups tab.

Procedure

1. On the Groups tab, complete one of the following steps:
   • Select a folder and click the Add Group icon.
• Right-click a folder and click **Add Group**.

2. Type a name for your group and click **Next**.

3. Define your data sources and click **Next**.

4. Define any restrictions.

5. Click **Finish**.

**Step 2. Adding a rule**

You can use the **Rules** tab in the Task Manager module in IBM® Cognos® Incentive Compensation Management to specify the actions that you want to perform on specified groups of payees.

**About this task**

The payee groups that are added or removed are defined in the **Groups** tab of the Task Manager module.

Several rule options are available.

*Table 43. Task Rules*

<table>
<thead>
<tr>
<th>Module</th>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payee Groups</td>
<td>Add payees to a payee group</td>
<td>Add payees in a defined group to a specified payee group. The start date for the added payees is the first day of the fiscal year. Example: Add all payees with job title Inside Sales Rep to the Inside Sales Rep payee group. Payee start date is the first day of the fiscal year.</td>
</tr>
<tr>
<td>Payee Groups</td>
<td>Add payees to a payee group as of today</td>
<td>Add a defined group of payees to a payee group with today's date as their start date. Example: Add all payees with job title Inside Sales Rep to Inside Sales Rep payee group. Payee start date is the day that the task is run.</td>
</tr>
<tr>
<td>Payee Groups</td>
<td>Remove payees from a payee group</td>
<td>Remove payees in a defined group from a specified payee group. <strong>Important</strong>: When you remove payees from a payee group, you remove all their history from Payee Ledger. Instead, you can set end dates for payees (see next rule). Example: Remove all terminated payees from a specified payee group.</td>
</tr>
<tr>
<td>Payee Groups</td>
<td>Set end dates for payees in a payee group</td>
<td>Set end dates for a group of payees for anywhere from today to 180 days from today. Example: Set end dates for all terminated payees.</td>
</tr>
<tr>
<td>Portal Access</td>
<td>Add payees to a Portal Access group</td>
<td>Add a group of payees in a defined group to a Portal Access group. Example: Add all Account Executives to the Account Executive Portal Access group.</td>
</tr>
</tbody>
</table>
### Table 43. Task Rules (continued)

<table>
<thead>
<tr>
<th>Module</th>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Access</td>
<td>Enable a group of payees for web and notify them of their passwords.</td>
<td>Grant web access to specified payees. Random passwords are generated and emailed to the address in the Payee table. Important: This rule does not add payees to a Portal Access group; you need to perform this task separately.</td>
</tr>
<tr>
<td>Portal Access</td>
<td>Maintain payees in a Portal Access group</td>
<td>Adds and removes payees from the group in Portal Access. Important: This rule is created by default for Portal Access groups that users set up to be maintained in Task Manager.</td>
</tr>
</tbody>
</table>

**Procedure**

1. On the Rules tab, complete one of the following steps:
   - Select a folder and click the Add Rule icon.
   - Right-click a folder and click Add Rule.

2. Type a name for your rule and click Next.

3. Select the type of action for this rule to perform, and click Next.

4. Select the group, payees, or numbers.

5. Select the groups that you want to email and use Add > to move them from the All Roles column to the Selected Roles column.

6. If you do not want to enable email notification for a rule, select Finish without selecting any roles.

   Important: Email notification can be sent to administrators when a task is generated by Task Manager. Email notification is defined individually for each rule and is sent to all users who are assigned to the selected user role. The user role is defined in the Manage Roles window.

7. Click Finish.

**Step 3. Generating a task list**

You can generate your task list to view a list of tasks to be performed based on the rules that you created in the Task Manager module in IBM® Cognos® Incentive Compensation Management. Task generation can be done manually or within Scheduler.

**Procedure**

1. On the Tasks & Alerts tab, click the Generate button to populate the tab with a list of tasks to be run based on the rules specified.

   For example, if you have created a rule to add all payees in a particular group to Portal Access, Task Manager will generate a list of all the payees that need to be added to a Portal Access group. Task generation can also be scheduled in Scheduler.

2. Review the generated list of tasks.
Step 4. Administering tasks

After you generate a task list, you can see administrative tasks in the Tasks & Alerts tab in the Task Manager module in IBM Cognos Incentive Compensation Management. You can close, defer, or run a task.

Procedure

1. On the Tasks & Alerts tab, select a task.
   
   **Tip:** To select multiple tasks, press Ctrl and click.

2. To delete a task, complete one of the following steps:
   - Click the Dismiss icon.
   - Right-click the task and click Dismiss.

3. To run a task, complete one of the following steps:
   - Click the Run icon.
   - Right-click the task and click Run.

4. To defer a task to a later date, complete one of the following steps:
   - Click the Defer icon.
   - Right-click the task and click Defer.

5. Select the date that you want to generate the selected task on.

Results

When you defer a task, it is removed from the Tasks & Alerts tab and placed in the Deferred Tasks tab on the specified date.

Canceling a deferral

If a task is deferred, you can cancel the deferral in the Task Manager module in IBM Cognos Incentive Compensation Management.

Procedure

On the Deferred Tasks tab, select the task, and complete one of the following steps:

- Click the Cancel Deferral icon.
- Right-click the task and click Cancel Deferral.

Results

The tasks are placed in the Tasks & Alerts tab.

Step 5. Adding email notifications

You can define which administrators receive an email notification if a rule generates a task in the IBM Cognos Incentive Compensation Management Task Manager module.

Procedure

1. On the Tasks & Alerts tab, select the Modify Email Role button.
2. Select the administrator role that you want email notifications sent to, and click Next.
3. Select the rules you want to prompt an email notification, and click Add.
4. Click Finish.
Important: Anytime a task is generated for a rule in the Selected Rules column, the administrator will receive an email notification.

Step 6. Alert options

To simplify the maintenance of payee groups, administrators can use the Task Manager module in IBM Cognos Incentive Compensation Management to set up notifications when certain situations arise.

Administrators can be notified in the following situations:

- Payees exist in more than one plan.
- Payees are not in a plan.
- Terminated payees are still active in a payee group. If a payee is marked as terminated in the Payee table but is still active in a payee group (the end date does not match the termination date), you can choose to be notified.
- Specified tailored reports generate one or more rows. If you created a tailored report that is meant to generate data only when certain milestones or exceptions occur, you can be notified when the report is not empty. If you do so, you do not have to remember to check the report results regularly.

Important: Tailored reports must be enabled for this alert from Composer.

Activating a payee alert

You can enable specific, default alerts through the Alert Options tab in the IBM Cognos Incentive Compensation Management Task Manager module.

If payees fall into any of the enabled alert categories, the alert will be displayed on the Tasks & Alerts tab.

Procedure

On the Alert Options tab, right-click an alert, and select Enable. The check box in the Enabled column will be selected.

Disabling a payee alert

You can disable alert options that were enabled in the Task Manager module in IBM Cognos Incentive Compensation Management.

Procedure

On the Alert Options tab, right-click an alert and click Disable.
Chapter 26. Audit

The IBM Cognos Incentive Compensation Management Audit module monitors all activity by all users, provides lists of errors, and lists of scheduler and task messages.

Multiple logs can be accessed so users can view a list of errors generated, the date and time the error occurred, a description of the error, and the error type.

From within each log, users can optionally copy the contents of the log, clear the contents of the log, or refresh the data. With the exception of the Computation log, users can also view log entries for a specified date range.

All logs in the Audit module, except for the Error log, show information specific to the model the user is currently logged in to. The Error log is user-specific and not model-specific, so it will show information for all models.

The following logs are available in the Audit module:

- Audit log
- Computation log
- Error log
- Service Error log
- Import log
- Export log
- Scheduler log
- Task log

Audit log

By default, the Audit log monitors all activity by all users in IBM® Cognos® Incentive Compensation Management. It logs any database creation, modification, and deletion activity, and presents those activities in the form of a filter-capable grid for administrator review.

If you need to retrace your steps, the Audit log provides all the key information that you need to determine the exact process that was used to build your model.

In addition to monitoring all activity in the Cognos Incentive Compensation Management client, the Audit log also displays web data edit and Portal Access entries that were made by web client users. The user types for changes are administrator for the Cognos Incentive Compensation Management client and web user for the web client.

Model Converter events, including start, end, and success messages, are also stored in the Audit log.

Audit log functionality

The Audit log can be used for reviewing events and actions taken by administrators in the IBM Cognos Incentive Compensation Management Client.
The following events can be viewed in the Audit log:

- Adding user roles
- Administrator log on and log off
- Allocations
- Category calculation changes
- Calculation started, stopped, canceled, and completed
- Changing user role permissions
- Column added and removed
- Connections made between components
- Configuration change
- Created or deleted tables, Views, compensation plans, tailored reports, or Presenter reports
- Data and assignments saved
- Data import begun and concluded
- Favorites section modifications
- Folder created and deleted
- Inquiry changes made in the Client and web client
- Items scheduled, unscheduled, saved, added, run, renamed, started, and deleted
- Manual adjustments
- Migration log on, log off, ended, and began
- Model Converter tool events
- Modified user information
- Modified View tables
- Modified Category calculations
- New model created
- Number of new rows imported into a table
- Number of rows updated in a table
- Password changed
- Payee enabled for web access
- Plan modified
- Row update submission
- Sign off begun
- Star schema populated
- Started and completed optimization
- Tasks deferred or dismissed
- Task rules edited or added
- Trees and groups created, deleted, edited, and saved
- Updates to Presenter reports
- Upgrade models
- User modified
- Users log on, log on failed, and log off
- Web data edit
- What role the user is when added
- Portal Access entries
- Migrated object and objects deleted during migration
Filtering Audit log results

Results in the IBM Cognos Incentive Compensation Management Audit log can be filtered by user type, user ID, module, and event type.

Procedure
1. On the Audit tab, click the header of the column you want to filter by.
2. Click the arrow to access the drop-down menu.
3. Select an item to filter by.

Important: You can also use the arrows in the toolbar to display the results from most recent to oldest and vice versa.

Viewing details of table edits

You can view details of changes that were made to tables in the Composer module in IBM Cognos Incentive Compensation Management. Only the rows that were edited are displayed in the Show Details window.

Procedure
On the Audit tab, double-click or right-click a row and click Show Details to open the table.

Important: If a data import into a table causes a new payee to be added to the Payee table, the Audit log shows both the update to the data table and the addition of the member to the Payee table.

Cleaning up the Audit log

Use the Release Audit History feature to remove old Audit log entries in IBM Cognos Incentive Compensation Management.

About this task

Cleaning up the Audit log only removes the records from the Audit log user interface. Audit log records are not removed from the tables in the database.

Procedure
1. On the Audit tab, click the Tools icon.
2. Click Release Audit History.
3. Select a date from the drop-down menu.
   Any entries created before and on the date entered in the Release Audit History window are cleared.
4. Click OK.

Exporting Audit logs

Use the Export button to export the contents of the IBM Cognos Incentive Compensation Management Audit log to comma delimited, tab delimited, or Microsoft Excel formats.

This is useful for creating an archive of old Audit log contents.

Procedure
1. On the Audit tab, click the Export button.
2. Choose a destination folder for the Audit log, type a **File Name**, and select the **Save as type**.
3. Click **Save**.

### Computation log

The Computation log in IBM® Cognos® Incentive Compensation Management displays the time breakdown of a calculation by calculated item. If you find that your calculation time is unusually slow, you can use this log to pinpoint the source of the delay.

The Computation log lists the following information:
- Version of Cognos Incentive Compensation Management
- Date and time of calculation
- Each calculation and length to calculate
- Any calculations that are started but not finished. They have a status of **Started**.

### Clearing a log

You can use the **Clean Up** button to erase everything from the logs in the Audit module in IBM® Cognos® Incentive Compensation Management.

### About this task

You can also find the **Clean Up** button in the Error, Service Error, Import, Export, Scheduler, and Task logs.

### Computation log generation

Users must select the **Enable generation of Computation Logs** check box in the Administrative Options window in order for information to be recorded in the IBM Cognos Incentive Compensation Management **Computation log**.

By default, the **Enable generation of Computation Logs** check box is selected. When this check box is selected, all the names of your calculations and how long they took are listed. Each time a calculation is run, the computation log is recorded on a new page. You can navigate through the computation logs by clicking the blue arrows in the toolbar.

### Copying a log

You can copy the IBM Cognos Incentive Compensation Management **Computation** log onto the clipboard and paste it into a document.

You can also copy the **Error, Service Error, Import, Export, Scheduler, and Task** logs.

### Error log

The Error log in IBM® Cognos® Incentive Compensation Management lists details of errors that were generated within the system.

For example, if the Cognos Incentive Compensation Management client cannot connect with the server, an error is logged.

The Error log lists the following information:
• Version of IBM® Cognos® Incentive Compensation Management
• Date and time error occurred
• Environment
• Database
• User ID that created the error
• A statement about the error
• Inner exception
• Error type
• Stack trace

**Setting date filters in a log**
You can filter the Error log in IBM® Cognos® Incentive Compensation Management by a specified date range. You can also set date filters for the Service Error, Import, Export, Scheduler, and Task logs.

**Procedure**
1. Click the **Set Date Filters** button.
2. Using the menus, select the **From** and **To** ranges.
3. Click **OK**.

**Service Error log**
The Service Error log in IBM® Cognos® Incentive Compensation Management provides a list of all errors that were generated in the service.

For example, a failed login attempt or an expired session is listed in the Service Error log.

The Service Error log lists the following information:
• Version of Cognos Incentive Compensation Management
• Date and time error occurred
• A statement about the error
• Inner exception
• Error type
• Stack trace

**Import log**
If import was unsuccessful, the Import log in IBM® Cognos® Incentive Compensation Management provides details about the problem.

The Import log records the primary key value of each failed import line item so that you can troubleshoot import errors and detect problems in the data.

The Import log lists the following information:
• Version of Cognos Incentive Compensation Management
• Date and time error occurred
• Table name
• List of error
• Primary key value
Export log

If an export was unsuccessful, the IBM Cognos Incentive Compensation Management Export log details the problem.

For example, if the user exports a numeric column from a table into a MSCRM or a Salesforce.com date column, the error shows up in the Export log.

The Export log can list the following information:
- Version of Cognos Incentive Compensation Management
- Date and time error occurred
- Name of what is being exported
- List of errors

Scheduler log

All Scheduler errors and successful run information are captured in the IBM Cognos Incentive Compensation Management Scheduler log.

If the user does not have the Scheduler Service running before they schedule an item, an error is displayed in the Scheduler log. Scheduling conflicts may also affect the specified process run time. If a process is scheduled at 11:00 p.m. and another at 11:01 p.m., the second may not run because the first has not been completed. If the second task is unable to run, a message is displayed in the log.

The Scheduler log can list the following information:
- Date and time error occurred
- Description of error

Task log

If an error is generated during task generation, the Task log in IBM Cognos Incentive Compensation Management provides details about the error.

For example, if you generate tasks that try to email payees without a defined email address, you see a message in the Task log.

The Task log lists the following information:
- Version of Cognos Incentive Compensation Management
- Date and time error occurred
- A statement about the error
- Error type
- Stack trace

Signature log

The Signature log in IBM Cognos Incentive Compensation Management indicates whether payees accepted or declined agreements in reports.

The Signature log lists the following information:
- Presenter report name
- Signature ID
• Payee
• Status (accepted or declined)
• Time

You can filter on any column except time.

Performance log

You can view calculation performance on the Performance tab in the IBM Cognos Incentive Compensation Management Audit module.

The following information can be viewed on the Performance tab:

Computations
You can view the duration of computations, which are calculation run tasks.

Single calculation
You can select a specific calculation for which to view performance.

Computation comparison
You can compare two computations to view the difference in duration between the two calculation runs.

Recommendation on changing calculation methods
You can view a list of the top ten longest running calculations in the last calculation run.
Chapter 27. Payee Ledger

Use the IBM Cognos Incentive Compensation Management Payee Ledger module to view summary and detail level reports of compensation plan results, and tailored reports.

The Payee Ledger has the following tabs:
- Detail Ledger
- Summary Ledger

**Related concepts:**
- "Report results in Payee Ledger" on page 142

To view the results of your compensation plan or tailored report in Payee Ledger in IBM® Cognos® Incentive Compensation Management, select the report, period, payee, and calculation from the menus.

**Detail Ledger**

The IBM Cognos Incentive Compensation Management Payee Ledger module provides the link between calculated results and transactional data in the **Detail Ledger**.

If you want to trace each record that contributed to earnings for each period, Payee Ledger provides that information when you select the **Detail Ledger** tab.

The **Detail Ledger** shows a list of transactions that corresponds to each calculation, their value, and the result of the calculation. The information shown can be edited when adding a calculation to the compensation plan.

For compensation plans with more than one calculation, the **Detail Ledger** shows results for each calculation. For example, consider a compensation plan that performs the following actions:
- Calculates year-to-date sales for each sales rep
- Calculates the difference between year-to-date sales and quota
- Pays a commission on the difference

This would appear in the **Detail Ledger** as three separate calculations, one after the other, each including results for all periods.

**Filtered plans by selected payee**

When you select the information that you want to display in the Payee Ledger module in IBM® Cognos® Incentive Compensation Management from the menus, you can filter the list of available plans by payee or by plan.

**Generating a Detail Ledger report**

When a report is created in the **Detail Ledger** tab of the Payee Ledger module in IBM® Cognos® Incentive Compensation Management, a list of calculated results and transactional data for a specific plan, payee, and period is displayed.
Procedure
1. Click the Detail Ledger tab.
2. Select a plan or report, payee, and period.
3. Select a calculation.
4. Click the Generate Report button.

Results
The list of calculated results and transactional data for a specific plan, payee, and period are displayed.

Filtering out payees with no earnings
Payees with no earnings for a selected plan (or report) and period can be filtered out of the payee selection box in the IBM Cognos Incentive Compensation Management Payee Ledger module.

Procedure
1. Select the plan or report.
2. Click the Hide Payees with No Earnings button.
   When the earnings filter is turned on, only payees with earnings for the selected plan and period displays in the payee drop-down menu.

Viewing source data
While looking at the Detail Ledger in the IBM Cognos Incentive Compensation Management Payee Ledger module, you can optionally review the underlying details of an individual transaction.

Procedure
1. On the Detail Ledger tab, select the plan or report.
2. To view the row information from the data source of the calculation, double-click the transaction.
   Viewing the source data will display the row information from the primary source of the calculation. If you appended tables by adding rows or columns, Payee Ledger will only display the row information from the first data source.

Exporting Payee Ledger results
You can use the Send To button to export any values from the Payee Ledger module in IBM® Cognos® Incentive Compensation Management into a Microsoft Excel workbook or delimited text file.

About this task
The Send To option exports only what is visible on the screen.

Procedure
1. Click the Send To button.
2. Select Microsoft Excel or Delimited Text File.
3. Click OK.
Publishing Payee Ledger results

The entire IBM Cognos Incentive Compensation Management Payee Ledger module (all compensation plans for all payees) can be exported using the Publish button.

The Publish feature provides many options, including creating individual Microsoft Excel workbooks for each payee. This is useful if Microsoft Excel workbooks are distributed to payees as commission statements.

Procedure
1. Click the Publish button.
2. Select how you would like to perform the publication, and click Next.
3. Select a destination, and click Next.
   Depending on the destination you selected, perform one of the following steps:
   • If you selected Microsoft Excel, select the Microsoft Excel options and click Next.
   • If you selected Portable Document Format, select the PDF Options, and click Next.
   • If you selected Text File, select the Text Options and click Next.
4. Select the Payee Ledger Options, and click Next.
5. Select the file destination, and click Finish.

Summary Ledger

By selecting the Summary Ledger tab, you will prompt the IBM Cognos Incentive Compensation Management Payee Ledger module to present the results for each period, showing base earnings, net earnings, pending payment, and payment.

You can view summary details according to any combination of plan or report and payee.

Generating a Summary Ledger report

In the Summary Ledger in the Payee Ledger module in IBM® Cognos® Incentive Compensation Management, you can see the final calculation results of each calculation that is included in the plan.

Procedure
1. Select the plan or report and payee.
2. To filter the available payees, click the Hide Payees With No Earnings button.
3. Click the Generate Report icon.
4. To export the data on the screen, click the Send To button.

Results with caps and guarantees

When you view compensation results in the Summary view of the Payee Ledger module in IBM® Cognos® Incentive Compensation Management, you can see results of the final earnings after caps and guarantees are applied.

By contrast, the Detail Ledger view shows results of the final calculation, not including caps and guarantees.
Tip: To view consistent results, include caps and guarantees as part of the final calculation. Do not define them in the payment rules section of the Compensation Plan wizard.

Adjustment Details

The Adjustment Details tab in the IBM Cognos Incentive Compensation Management Payee Ledger module provides a report of adjustment details for the selected plan and payee.

If allocated adjustments have been created in Composer, the Adjustment Details tab is used to allocate the change-due-to-adjustments amount to selected open periods.

Generating an Adjustment Details report

To view the adjustment details in the Payee Ledger module in IBM® Cognos® Incentive Compensation Management, you must select a plan and payee and then generate the report.

Procedure
1. Click the Adjustment Details tab.
2. Select a plan and payee.
3. Click the Generate Report button.

Adding an adjustment category

You can add adjustment categories to define the type of adjustment that you create in the Payee Ledger module in IBM® Cognos® Incentive Compensation Management.

Procedure
1. On the Adjustment Details tab, select the Adjustment Categories button.
2. Click Add.
3. Type a name for the category and click OK.
4. When you finish adding categories, click Close.

Viewing adjustments

In the Adjustment Viewer in the Payee Ledger module in IBM® Cognos® Incentive Compensation Management, you can view, add, edit, and delete allocated adjustments and manual adjustments.

Procedure
1. Select a row in the report on the Adjustment Details tab.
2. Double-click the row, or right-click and click Adjustments.

Adding manual adjustments

Manual adjustments are one-time solutions that are applied in specific scenarios in the IBM Cognos Incentive Compensation Management Payee Ledger module.

An administrator (or adjuster) can add a manual adjustment to any payee for any open period.
Procedure

1. On the Adjustment Details tab, double-click the row of an unlocked period (unlocked periods have white backgrounds) or right-click the row and select Adjustments.
2. Select the Manual tab.
3. Click Add.
4. Select the Adjustment Value.
5. Select the Adjustment Category.
6. Add a Comment.
7. Click OK.
Chapter 28. Calculate module

Administrators can use the Calculate module in IBM® Cognos® Incentive Compensation Management to run the calculate engine, view the summary of the last calculations that are run in the model, and view the Computation log.

Use the Calculate module to specify the timing of a calculation or update. After you load data or make structural changes to your model, you must run a calculation to view updated results. Use the Calculate module to run a calculation while you are working in other areas of Cognos Incentive Compensation Management. However, users cannot complete any other global actions while the calculation is running.

Important: Compensation plans do not show updated values until a calculation is run.

Related concepts:
- Chapter 12, “Working with calculations,” on page 109
  You can right-click any calculation to preview, view the current values, view history, see a list of compensation plans, tailored reports, or Presenter reports that use the calculation, and edit the calculation in IBM® Cognos® Incentive Compensation Management.
- “Access permissions” on page 288
  When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Related tasks:
- “Setting Calculate module security” on page 316
  You can grant a role permission to view the Calculate module in the IBM® Cognos® Incentive Compensation Management client and to run a calculation on any items in the Calculation Type menu. To preview or view calculation data in the Composer model, users who are assigned to this role must also have view permission for the Calculate module.

Calculation types

When performing a calculation, IBM Cognos Incentive Compensation Management lets you determine the specific items to include.

There are several different types of calculations that you can select from.

Table 44. Calculate Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Active Plans and Reports</td>
<td>This option includes all compensation plans and tailored reports.</td>
</tr>
<tr>
<td>Compensation Plans and Associated Reports</td>
<td>This option will calculate the compensation plan along with any reports associated with the plan.</td>
</tr>
<tr>
<td>Compensation Plans</td>
<td>Use this option to calculate results for either all compensation plans or for a specific one.</td>
</tr>
<tr>
<td>Tailored Reports</td>
<td>Use this option to calculate results for either all tailored reports or for a specific one.</td>
</tr>
</tbody>
</table>
Table 44. Calculate Items (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results for a Specific Payee</td>
<td>Use this option to select a payee and calculate all plans and reports that the specified payee is a member of.</td>
</tr>
<tr>
<td>Web Forms</td>
<td>Use this option to calculate results for either all web forms or for a specific one.</td>
</tr>
<tr>
<td>Presenter Reports</td>
<td>Use this option to calculate results for either all Presenter reports or for a specific one. When calculating for individual Presenter reports, any Composer calculations used as sources will be calculated as well.</td>
</tr>
<tr>
<td>Scenarios Workspace</td>
<td>Use this option to calculate results for all Scenario workspaces or for a specific one.</td>
</tr>
</tbody>
</table>

Calculating results

After creating a report, plan, web form, and Scenarios workspace, you can calculate the results in the IBM Cognos Incentive Compensation Management Calculate module.

Procedure

1. To open the Calculate module, perform one of the following steps:
   - Go to View > Calculate.
   - Right-click the tab bar, and select Calculate.
2. From the Calculation Type drop-down, select the items you want to calculate.
3. Click the Calculate button to begin the calculation process.
   
   You will see a progress bar displaying the elapsed and remaining calculation times.

   Important: A progress bar for the calculation will also be displayed in the Activity module. After the calculation has completed, a message detailing successful completion or any errors will be displayed in the Activity module.

Canceling a calculation that is in progress

You can cancel a calculation that is in progress in the Calculate module in IBM® Cognos® Incentive Compensation Management.

Procedure

In the Calculate module, click the Cancel button next to the progress bar.

Results

When the Cancel button is clicked, anything that was calculated up to that point remains calculated, and calculations do not revert to their previous state. The cancellation occurs as soon as you confirm your intent to cancel.

The Summary pane

In the Summary pane in IBM® Cognos® Incentive Compensation Management, you can see the date and time of the last full calculation, the date and time of the last calculation, and the elapsed time of the last calculation.
**Computation log**

While a calculation is running, the IBM Cognos Incentive Compensation Management Computation Log displays each completed calculation and the time it took to run.

When an error occurs during a calculation, the name of the calculation that caused the error is displayed in the Computation Log.

**Clearing the Computation log**

You can erase the data in the Computation log in the Calculate module in IBM® Cognos® Incentive Compensation Management.

**Procedure**

Right-click in the Computation Log pane and click Clear.

**Incremental calculations**

When you run a calculation on a model in IBM® Cognos® Incentive Compensation Management, the calculation engine recalculates only the changes that were made since the last calculation was run.

If you want to run a complete calculation and recalculate the entire model, regardless of whether any changes were made, select the complete calculate option from the Calculation Type menu. The complete calculate option is typically used only for testing and comparison purposes.

**Adjustments and calculation speed**

In the first calculation that you run after you make an adjustment in IBM® Cognos® Incentive Compensation Management, a calculation takes more time to run.

In addition to calculating results for data in unlocked periods, Cognos Incentive Compensation Management also computes net payment amounts after adjustments. To do this calculation, Cognos Incentive Compensation Management needs to recalculate every locked period that is affected by the adjustment to compute the deltas. If adjustments were made since the last calculation, a window provides information on how many periods were affected by recent adjustments.

**Important:** A calculation is the only way to update results. If you generate a preview during compensation plan creation or maintenance, your model results are not updated.

**Using incremental calculation to increase calculation speed**

You can specify whether to use existing results that are still current (for example, nothing was changed to potentially change the result) during the calculation to speed up the overall calculation time in the IBM® Cognos® Incentive Compensation Management client.

**Procedure**

1. Click Admin > Administrative Options.
2. On the Calculation tab, select the Enable incremental calculation check box.
   By default, the Enable incremental calculation option is selected.
3. Click OK.
Enabling data tier performance optimization
The data tier performance optimization feature can improve calculation performance in the IBM Cognos Incentive Compensation Management Client, especially in models that have a large number of calculations that perform multiplication and division operations.

About this task
Use this feature to process a larger portion of calculations by the database and reduce the need for transfers between the database and Service. For more information on configuring this feature, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Procedure
1. Go to Admin > Administrative Options.
2. On the Calculation tab, select the Enable data tier performance optimization check box.
3. Click OK.

Enforcing single row formulas
In IBM® Cognos® Incentive Compensation Management, when you create a calculation, you can prevent users from creating a formula that is not aggregated.

About this task
If you use Cognos Incentive Compensation Management Premium, this option is not enabled. When you create a new model, this option is enabled. When you upgrade an existing model, this option is not enabled. Users can enable this feature after an upgrade. When you migrate to a model where the Enforce best practice formulas is enabled, calculations that have invalid formulas are displayed as invalid on the Migration wizard calculation page.

Procedure
1. Click Admin > Administrative Options.
2. On the Calculation tab, select the Enforce best practice formulas check box.

Participating in the statistics monitoring program
You can choose to participate in an optional statistics monitoring program that alerts IBM® Cognos® Incentive Compensation Management whenever a client’s calculation or import process fails without accessing the data, plans, or confidential information that are associated with that process. The Cognos Incentive Compensation Management support team can then contact you to resolve the situation promptly.

About this task
Each time an import or calculation is completed, information is gathered, packaged, and transmitted to the Cognos Incentive Compensation Management servers. All communication occurs over a secure TCP connection that is established through the Transport Layer Security protocol. This protocol ensures that all information is sent in a secure fashion to an authenticated host.
Procedure
1. Click Admin > Administrative Options.
2. Select the Statistics tab.
3. Select the Yes option.
4. Click Test to test the connection to the statistics server.
Chapter 29. IBM Cognos Incentive Compensation Management Client security

For many tabs and objects, access can be controlled. It can be denied completely, granted for viewing only, or granted for both editing and viewing in the Cognos Incentive Compensation Management model.

If access to a particular feature or module has been denied, and a user tries to gain access, an **Access Denied** message will be displayed.

In the Manage Roles window, color coding is used to indicate whether or not access has been denied, granted, or partially granted.

A red flag indicates that the user does not have access to the object. A green flag indicates that the user has access to the object. A yellow flag indicates that a user has partial access to the object.

For example, a role can be granted partial access to the Portal Access module by granting view privileges but not edit privileges. Any users assigned to this role can view any web tabs, Portal Access groups, or access trees, but they are not permitted to edit content.

**Roles**

To protect the integrity of the data in your model, you can define security roles in IBM Cognos Incentive Compensation Management.

The administrator role is created automatically and has full access to all modules by default. Initially, all administrators will be a part of the administrator user group, but additional roles with varying levels of access can be created and assigned. You can create user roles to restrict access to modules within Cognos Incentive Compensation Management. For each role created, accessible modules are defined.

You may, for example, have an administrator who is responsible for setting up and maintaining the Portal Access hierarchy, but is not authorized to edit tables or compensation plans. In this case, you may want to set up a user group that has access to the Portal Access module, but is prohibited access to the Composer module. You can then assign the Portal Access administrator to a user from the Manage Users window.

When an administrator changes a user's password through the Manage Users window, the password history is not remembered by Cognos Incentive Compensation Management.

**Important:** To manage and assign user roles, you need to be logged in as an administrator with permission to edit and view administrative options.
Adding a role
You can add a role and then assign access permission to the role in IBM® Cognos®
Incentive Compensation Management.

Procedure
1. Go to Admin > Manage Roles.
2. Click the Add Role button.
3. Name the role.
4. Click OK.

Deleting a role
You can remove a role that is no longer needed in IBM Cognos Incentive
Compensation Management; however, you will not be able to delete a role if a user
is still assigned to it.

Procedure
1. Go to Admin > Manage Roles.
2. Select the role, and click the Delete Role button.

Copying a role
You can copy a role, along with its security, in IBM® Cognos® Incentive
Compensation Management.

Procedure
1. Go to Admin > Manage Roles.
2. Select the role and click the Copy Role button.
3. Name the duplicated role and click OK.

Renaming a role
After a role is created, you can give it a different name in IBM® Cognos® Incentive
Compensation Management.

Procedure
1. Go to Admin > Manage Roles.
2. Select the role and click the Rename Role button.
3. Name the role and click OK.

Role permissions
After you have created a role in IBM Cognos Incentive Compensation
Management, you can give the role the ability to access certain items and deny
access to others.

By default, new roles are denied access to everything.

Access permissions
When a user role is given access to a module in IBM® Cognos® Incentive
Compensation Management, certain access rights or privileges go along with the
module or feature.
### Table 45. Access rights

<table>
<thead>
<tr>
<th>Module or feature</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audit log</strong></td>
<td><strong>Edit</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to clean up the Audit log (must also have View permission).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to view, sort, filter, and show details of the data.</td>
</tr>
<tr>
<td><strong>Calculate</strong></td>
<td><strong>Individual Calculation</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to calculate a single calculation at a time.</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to view the Calculate module but not run a calculation on any items in the Calculation Type menu.</td>
</tr>
<tr>
<td></td>
<td><strong>Run</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to run a calculation on any items in the Calculation Type list (must also have View permission).</td>
</tr>
<tr>
<td><strong>Compensation Plans</strong></td>
<td><strong>Plan Name (System Code)</strong></td>
</tr>
<tr>
<td></td>
<td>Used with Composer (View and Edit) and Payee Ledger (View). If a user is granted access to the plan, the user has access to all right-click options for the plan in Composer except editing the plan and changing the In Production status. Granting access to the plan also gives the user permission for the administrator to see results of the compensation plan in Payee Ledger (as long as View permission is also granted for Payee Ledger).</td>
</tr>
<tr>
<td><strong>Composer</strong></td>
<td><strong>Add Views</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to add a View table (must also have View and Edit permission for Composer as well as View and Edit permission for the space where the table will be added, that is, either the component where the user is adding the table or the top level of Composer).</td>
</tr>
<tr>
<td>Module or feature</td>
<td>Privileges</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Component</strong></td>
<td>For each component in Composer, including Cognos Producer Lifecycle and Credential Management object, users can be granted the following actions:</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete the component (must also have View and Edit permission for Composer as well as View and Edit permission for the space that contains the component, that is, either the parent component or the top level of Composer).</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit elements in the component or add elements to the component (must also have View and Edit permission for Composer and View permission for the component).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view the elements inside a component (must also have View permission for Composer).</td>
</tr>
<tr>
<td><strong>Composer</strong></td>
<td><strong>Edit</strong> Gives user permission to edit and add elements to Composer that they are granted View and Edit permission for.</td>
</tr>
<tr>
<td><strong>Input Forms</strong></td>
<td>For all input forms in Composer, users can be granted the following actions (must also have View and Edit permission for Composer as well as View and Edit permission for the space that contains the table, that is, either the component or the top level of Composer):</td>
</tr>
<tr>
<td></td>
<td><strong>Add</strong> Gives user permission to create a new input form for a table.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete input forms (must also have View permission for the input form).</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit pre-existing input forms and their validation rules (must also have View permission for the input form).</td>
</tr>
<tr>
<td>Module or feature</td>
<td>Privileges</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Composer</strong></td>
<td><strong>Table</strong> Users can be granted access to the following actions for input forms and the structure of the table:</td>
</tr>
<tr>
<td></td>
<td><strong>Input Forms</strong></td>
</tr>
<tr>
<td></td>
<td>For each input form, users can be granted access to the following actions (users must have permission to view the input form to complete these actions):</td>
</tr>
<tr>
<td></td>
<td><strong>Add</strong> Gives user permission to add new rows to a table but not to import data.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete existing rows in a table.</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit existing rows in a table.</td>
</tr>
<tr>
<td></td>
<td><strong>History</strong> Gives user permission to click the <strong>History</strong> button when the user is viewing table data.</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to export rows to Microsoft Excel, Publish, View Used By, and Web Data Edit (Edit Column Permissions, View Restrictions, and Direct Edit).</td>
</tr>
<tr>
<td><strong>Composer</strong></td>
<td><strong>Structure</strong> For each table, users can be granted access to the following actions (must also have <strong>View</strong> and <strong>Edit</strong> permission for Composer as well as <strong>View</strong> and <strong>Edit</strong> permission for the space that contains the table, that is, either the component or the top level of Composer):</td>
</tr>
<tr>
<td></td>
<td><strong>Drop</strong> Gives user permission to delete the table.</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to add or remove table columns (must also have <strong>View</strong> permission for the table structure).</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong>: The structure of <strong>Hierarchy</strong> tables cannot be edited.</td>
</tr>
<tr>
<td></td>
<td><strong>History</strong> Gives user permission to purge table history.</td>
</tr>
<tr>
<td></td>
<td><strong>Import</strong> Gives user permission to import data to a table (must also have <strong>View</strong> permission for the table structure). The user does not need <strong>Edit</strong> permission for the component that contains the table.</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view table structure.</td>
</tr>
<tr>
<td>Module or feature</td>
<td>Privileges</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| Composer          | Top: Gives user permission to complete the following action to the top level of Composer:  
|                   |   Edit: Gives user permission to edit the top level of Composer (must also have View and Edit permission for Composer).  
|                   | View: Gives user permission to view the Composer module and the components and elements on the top level. Users must be granted access to components to view the elements inside them. Users with View permission in Composer can also open the Calculation wizard in read-only mode.  
|                   | Web Data Edit: Gives user permission to view restrictions and edit column permissions, approve or reject edits, and enable direct database editing for tables that are enabled for Web Data Edit (must also have View and Edit permission for Composer as well as View and Edit permission for the space that contains the table, that is, either the component or the top level of Composer). |
| Data stores       | Data Store: Users can be granted access to the following actions for data stores:  
|                   |   Add: Gives user permission to create data stores in Composer.  
|                   | Data Store: For each data store, users can be granted access to the following actions (must also have View permission for Composer and the component that contains the data store):  
|                   |   Delete: Gives user permission to remove the data store from Composer (must also have View and Edit permission for Composer and the component that contains the data store).  
|                   |   Edit: Gives user permission to edit the data store.  
|                   |   View: Gives user permission to view the data store object in Composer. |
| File              | New Model: Gives user permission to create a model from the File menu.  
|                   | Tip: The New Model button on the logon window can be disabled in the configuration file. |
Table 45. Access rights (continued)

<table>
<thead>
<tr>
<th>Module or feature</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Administrative Options</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit the <strong>Administrative Options</strong> for the current model (must also have <strong>View</strong> permission for <strong>Administrative Options</strong>).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view the <strong>Administrative Options</strong> for the current model.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Calendars</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit calendars (must also have <strong>View</strong> permission for <strong>Calendars</strong>).</td>
</tr>
<tr>
<td></td>
<td><strong>Period Locking</strong> Gives user permission to lock and unlock all calendars in the model (must also be granted <strong>View</strong> permission for calendars to lock periods).</td>
</tr>
<tr>
<td></td>
<td><strong>Period Purging</strong> Gives user permission to complete all actions in period purging.</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view the list of calendars.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Manage Data Grid Templates</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Add</strong> Gives user permission to add and duplicate templates. Must also have <strong>View</strong> permission.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete templates. Must also have <strong>View</strong> permission.</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit and set default templates. Must also have <strong>View</strong> permission.</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view templates.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Manage History Tracking</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to enable or disable history tracking in the Administrative Options window.</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view the history tracking option in the Administrative Options window.</td>
</tr>
<tr>
<td>Module or feature</td>
<td>Privileges</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Manage Saved Imports</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete saved imports (must have View permission for Saved Imports).</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit saved imports (must have View permission for Saved Imports).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission view the list of saved imports and run saved imports.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Manage Saved Publications</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete saved publications (must have View permission for Saved Publications).</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit saved publications (must have View permission for Saved Publications.)</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view the list of saved publications and run saved publications.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Manage Saved Transformations</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong> Gives user permission to delete saved transformations (must have View permission for Saved Transformations).</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong> Gives user permission to edit saved transformations (must have View permission for Saved Transformations).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong> Gives user permission to view the list of saved transformations and run saved transformations.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td><strong>Manage Theme</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to enable custom headers that appear in the web client.</td>
</tr>
<tr>
<td><strong>Migrations</strong></td>
<td><strong>Edit</strong> Gives user permission to create a migration (must also have Execute permission).</td>
</tr>
<tr>
<td></td>
<td><strong>Execute</strong> Gives user permission to run a migration (must also have Edit permission).</td>
</tr>
<tr>
<td><strong>Optimize Model</strong></td>
<td><strong>Gives user permission to run the Model Optimization SQL process.</strong></td>
</tr>
</tbody>
</table>
Table 45. Access rights (continued)

<table>
<thead>
<tr>
<th>Module or feature</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home page</td>
<td>Payee Groups</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Process Lists</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Home page</td>
<td>Star Schema</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Imports</td>
<td>Advanced</td>
</tr>
<tr>
<td></td>
<td>Data</td>
</tr>
<tr>
<td>Payee Ledger</td>
<td>View</td>
</tr>
<tr>
<td>Module or feature</td>
<td>Privileges</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>Portal Access</strong></td>
<td><strong>Edit</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to edit all items that are contained in Portal Access tabs (must also have <strong>View</strong> permission for Portal Access and access to compensation plans, Presenter, and web forms to view their assignment, sign off, and inquiries in Portal Access).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to view all tabs in Portal Access and the items that are contained within (must also have access to compensation plans, Presenter, and web forms to view their assignments, sign off, and inquiries in Portal Access).</td>
</tr>
<tr>
<td><strong>Presenter</strong></td>
<td><strong>Audit Log</strong></td>
</tr>
<tr>
<td></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to use the Audit log as a data source in Presenter reports (must have <strong>View</strong> permission to Presenter).</td>
</tr>
<tr>
<td></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to complete all functions in Presenter (must have Presenter Audit log <strong>View</strong> access to use the Audit logs as a data source).</td>
</tr>
<tr>
<td><strong>Scenarios</strong></td>
<td><strong>Promote</strong></td>
</tr>
<tr>
<td></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to promote scenarios (must also have <strong>View</strong> permission).</td>
</tr>
<tr>
<td></td>
<td><strong>Workspace</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Workspace Name</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to view and edit the workspace (must also have <strong>View</strong> permission for Scenarios module).</td>
</tr>
<tr>
<td><strong>Scheduler</strong></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to view Scheduler.</td>
</tr>
<tr>
<td></td>
<td><strong>Edit</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to complete the following functions in Scheduler; adding and removing tasks and processes, running tasks and processes, setting the Scheduler properties, pausing and activating the Scheduler service, and enabling and disabling tasks (users must also have <strong>View</strong> permission).</td>
</tr>
<tr>
<td><strong>Task Manager</strong></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to complete all functions in Task Manager.</td>
</tr>
<tr>
<td><strong>Web forms</strong></td>
<td><strong>View</strong></td>
</tr>
<tr>
<td></td>
<td>Gives user permission to complete all functions in web forms (users do not need separate access to tables and calculations to use them in web forms).</td>
</tr>
</tbody>
</table>
Table 45. Access rights (continued)

<table>
<thead>
<tr>
<th>Module or feature</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Manager</td>
<td>Edit  Gives user permission to edit preexisting workflows (must also have View permission for the workflow).</td>
</tr>
<tr>
<td></td>
<td>View  Gives user permission to view the Workflow Manager.</td>
</tr>
<tr>
<td><strong>Workflow Name</strong></td>
<td>For each workflow, the user can be granted the following actions (users must also have View permission for Workflow Manager):</td>
</tr>
<tr>
<td></td>
<td>Execute Gives user permission to start the workflow process (must also have View permission for the workflow).</td>
</tr>
<tr>
<td></td>
<td>Edit  Gives user permission to add workflows in Workflow Manager (must also have View permission).</td>
</tr>
<tr>
<td></td>
<td>View  Gives user permission to view the workflow.</td>
</tr>
</tbody>
</table>

Related concepts:

"Models" on page 5
In IBM Cognos Incentive Compensation Management, your first step is to select a model. The information associated with a model determines the fiscal year, payroll periods, and currencies.

Chapter 4, “Home page,” on page 11
The Home page is your entry point for working with models in IBM Cognos Incentive Compensation Management. It provides a dashboard that you can use to manage your models.

Chapter 5, “Process lists,” on page 15
You can create process lists in IBM Cognos Incentive Compensation Management to help users complete maintenance tasks for models.

"Components” on page 27
A component is a container that is used to organize your model in IBM Cognos Incentive Compensation Management.

Chapter 6, “Composer,” on page 19
Use Composer in IBM Cognos Incentive Compensation Management to view, manage, and build a model.

Chapter 8, “Data imports,” on page 65
Use the Import Data wizard in IBM Cognos Incentive Compensation Management to import data into any Hierarchy, System, Data, Custom, or Structural table.

Chapter 12, “Working with calculations,” on page 109
You can right-click any calculation to preview, view the current values, view history, see a list of compensation plans, tailored reports, or Presenter reports that use the calculation, and edit the calculation in IBM Cognos Incentive Compensation Management.

Chapter 14, “Data stores,” on page 129
Data stores are Composer objects in IBM Cognos Incentive Compensation Management that you can use to join sources, such as tables, calculations, and
draw results, into one large repository.

You can use payee groups in IBM® Cognos® Incentive Compensation Management to reduce the time that you spend setting up and maintaining each compensation plan.

You can add and edit compensation plans through Composer in IBM® Cognos® Incentive Compensation Management.

You can use scenarios to analyze how variations in the output of a model in IBM® Cognos® Incentive Compensation Management can be apportioned to different sources of variation.

After you create parameters, sources, and values for your Presenter report in IBM® Cognos® Incentive Compensation Management, you must add layout tables and report components.

After you complete a Presenter report in IBM® Cognos® Incentive Compensation Management, it can be edited, previewed, published, and linked to other reports, web forms, or web pages.

If you have publications that were created in the Publisher tool, you can save and schedule them in the Scheduler module in IBM® Cognos® Incentive Compensation Management.

You can use the Scheduler module in IBM® Cognos® Incentive Compensation Management to create and schedule processes such as imports, calculations, and calendar locking.

Administrators can use the Calculate module in IBM® Cognos® Incentive Compensation Management to run the calculate engine, view the summary of the last calculations that are run in the model, and view the Computation log.

In IBM® Cognos® Incentive Compensation Management, you can use star schemas to create OLAP cubes for performance analysis.

You can use a data grid to display the results of a single data source in a table in your Presenter report in IBM® Cognos® Incentive Compensation Management.

The logo displayed in the web client can be customized from the Themes window in the IBM Cognos Incentive Compensation Management Client.

You can add different calendars to your model in IBM® Cognos® Incentive Compensation Management. You can also add custom calendars.

Process list security

By default, all administrators can see the IBM Cognos Incentive Compensation Management Home page module. To give roles permission to create, view, edit, duplicate, or delete process lists from the Home page, additional access must be granted.

Related concepts:
You can create process lists in IBM Cognos® Incentive Compensation Management to help users complete maintenance tasks for models.

**Giving roles permission to add a process list**
You can grant a role permission to create process lists in IBM Cognos® Incentive Compensation Management. Users who are assigned to these roles also have permission to edit, duplicate, and delete any process list that they create.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
3. Right-click Add and click Grant.

**Giving roles permission to view a process list**
You can grant a role view-only permission for specific process lists in IBM Cognos® Incentive Compensation Management. Users who are assigned to this role cannot create or edit process lists.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
3. Expand the process list that you want the role to have permission to view.
4. Right-click View and click Grant.

**Giving roles permission to view and edit a process list**
Roles can be granted permission to edit and duplicate specified process lists in IBM Cognos Incentive Compensation Management.

If users assigned to this role create a duplicate of a process list, they will automatically have view, edit, and delete permissions for the new process list.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
3. Expand the process list you want the role to have permission to view.
4. Right-click View, and select Grant.
5. Right-click Edit, and select Grant.

**Giving roles permission to delete a process list**
You can grant a role permission to delete a specified process list from the IBM Cognos Incentive Compensation Management client.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
3. Expand the process list that you want the role to have permission to delete.
4. Right-click View and click Grant.
5. Right-click Delete and click Grant.
Composer security

You can grant a role permission to view and edit the Composer module in IBM® Cognos® Incentive Compensation Management.

You can set security for specific components, tables, and input forms in Composer. You can also grant permission to add Views and Web Form Territory tables, and permission to perform web data edits.

Related concepts:
[Chapter 6, “Composer,” on page 19]

Use Composer in IBM® Cognos® Incentive Compensation Management to view, manage, and build a model.

Giving roles permission to view the Composer module

You can grant a role view-only permission for the Composer module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role can open and view the Composer module and view components and other objects on the top level of Composer, but they cannot drill into components.

About this task

Users with view-only permission can complete the following actions on objects in the top level of Composer:

- View the Uses and Used By trees of objects
- Use the Visibility icons
- Export the Composer diagram
- Publish table and calculation data
- View calculation history
- Open the Calculation wizard in read-only mode
- Edit table descriptions
- Add objects to the Favorites list

Procedure

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Right-click View and click Grant.

Giving roles permission to view and edit the top level of Composer

You can grant a role permission to view the top level of the Composer module in IBM® Cognos® Incentive Compensation Management and to add objects to the top level.

About this task

To add Views to Composer, users must be granted additional permissions.

Procedure

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Right-click View and click Grant.
4. Right-click **Edit** and click **Grant**.
5. Right-click **Top** and click **Grant**.

**Component security**

You can grant or restrict access to each component in the Composer module in IBM® Cognos® Incentive Compensation Management.

To access a component, the role must also have **View** permission for Composer. To edit and add elements to a component, the role must have **Edit** permission for the component as well as Composer.

Security for Cognos Producer Lifecycle and Credential Management objects is handled in the same way as components.

**Related concepts:**

“Components” on page 27

A component is a container that is used to organize your model in IBM® Cognos® Incentive Compensation Management.

**Giving roles permission to view a component**

You can grant a role view-only permission for a component in the Composer module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role can drill into the component and view the objects inside, and they can open the component from the Home page and from Composer.

**About this task**

Users can complete the following actions on the objects inside the component:

- View the **Uses** and **Used By** trees of objects
- Publish table and calculation data
- Preview and view current values of calculations and connections
- Edit table descriptions
- Edit connections
- View the parent component of objects
- Add objects to the **Favorites** list

**Procedure**

1. Click **Admin > Manage Roles**, and select the role that you want to grant permissions for.
2. Expand **Composer**.
3. Right-click **View** and click **Grant**.
4. Expand the component that you want to grant the role permission to view.
5. Right-click **View** and click **Grant**.

**Giving roles permission to view and edit a component**

If a role has **View** and **Edit** permissions for a component in the Composer module in IBM® Cognos® Incentive Compensation Management, you can grant the role permission to add connections to the component, edit calculations in the component, and wrap objects into child components.

**Procedure**

1. Click **Admin > Manage Roles**, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Grant View and Edit permission for Composer. If the component is in the top level of Composer, right-click Top and click Grant.
4. Expand the component that you want to grant the role permission to view.
5. Right-click View and click Grant.
6. Right-click Edit and click Grant.

**Giving roles permission to delete a component**

Roles can be granted permission to delete components in the IBM Cognos Incentive Compensation Management Composer module.

To be able to delete a component, the role must also have view and edit permission for its parent component as well as the Composer module.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer.
3. Grant View and Edit permission for Composer.
   - If the component is in the Top level of Composer, right-click Top, and select Grant.
   - If the component is inside a parent component, grant View and Edit permission for the parent component.
4. Expand the component you want to give the role permission to delete.
5. Right-click Delete, and select Grant.

**Table security**

You can grant a role permission to create, view, and edit input forms and the structure of tables in the Composer module in IBM® Cognos® Incentive Compensation Management. You can also grant permission to complete data imports and web data edits, and add Views.

**Giving roles permission to view the structure of a table**

You can grant a role view-only permission for the structure of a table in the Composer module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to the role can view the table structure, add the table to the Favorites list, edit the table description, publish the table data, and view its uses.

**Procedure**

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Grant View permission for Composer.
3. Grant View permission for the component that contains the table.
4. Expand Table.
5. Expand the table whose structure you want the role to be able to view.
7. Right-click View and click Grant.

**Giving roles permission to view and edit the structure of a table**

Granting a role edit permission for a table's structure grants users assigned to the role the ability to add and remove columns in the table in the IBM Cognos Incentive Compensation Management Composer module.
The role must also have view permission for the table's structure to make changes.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant View permission for Composer.
3. Grant View permission for the component the table is in.
4. Expand Table.
5. Expand the table you want the role to be able to view and edit.
7. Right-click View, and select Grant.
8. Right-click on Edit, and select Grant.

**Giving roles permission to purge change log history**
You can grant a role permission to clear history that is collected for specific tables in the Composer module in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Expand the table that you want to grant the role permission for.
4. Expand Structure.
5. Right-click History and click Grant.

**Giving roles permission to delete a table**
Granting a role permission to drop a table lets users assigned to the role delete the table from the IBM Cognos Incentive Compensation Management Composer module as long as the table does not have any dependencies.

**Procedure**
1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant View and Edit permission for Composer.
3. Grant View and Edit permission for the component the table is in. To delete a table from the Top level of Composer, right-click Top, and select Grant.
4. Expand Table.
5. Expand the table you want the role to be able to delete.
7. Right-click Delete, and select Grant.

**Giving roles permission to add a View table**
You can grant a role permission to add View tables in the Composer module in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Right-click Add Views and click Grant.
4. Grant View and Edit permission for Composer.
5. To add a View table to a component, grant View and Edit permission for the component.

6. To add a table to the top level of Composer, right-click Top and click Grant.

**Giving roles permission to enable web data edit for tables**
You can grant a role permission to enable web data edits for tables in the Composer module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role can view the row restrictions for the table, edit the column permissions, approve or reject edits that are made by web users, and enable direct database editing for tables that were enabled for web data edit.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Right-click Web Data Edit and click Grant.
4. Grant View and Edit permission for Composer.
5. To access the Web Data Edit menu options for a table in a component, grant View and Edit permission for the component.
6. If the table is in the top level of Composer, right-click Top and click Grant.

**Import data security**
You can grant a role permission to import data into tables in the Composer module in IBM® Cognos® Incentive Compensation Management.

If users are importing data from an ODBC-compliant database, you can grant permission for advanced settings. Advanced settings allow the role to enter a custom connection string during data import.

**Related concepts:**
Chapter 8, “Data imports,” on page 65

Use the Import Data wizard in IBM® Cognos® Incentive Compensation Management to import data into any Hierarchy, System, Data, Custom, or Structural table.

**Giving roles permission to import data**
You can grant a role permission to import data into specified tables in the Composer module in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Grant View permission for Composer.
3. Grant Edit permission for Composer.
4. Grant View permission for the component that contains the table.
5. Expand Table.
6. Expand the table that you want to allow the role to import data to.
7. Expand Structure.
8. Right-click Import and click Grant.
9. Right-click View and click Grant.
Giving roles permission to use advanced settings to import data from an ODBC-compliant database

You can grant a role permission to use advanced import settings in the Composer module in IBM® Cognos® Incentive Compensation Management. Users can select the Use Advanced Settings check box in the Import Data wizard to enter a custom connections string when they import data from an ODBC-compliant database.

About this task

The role must have View and Edit permission for Composer.

To import data into a table in a component, the role must have View and Edit permission for the component.

Procedure

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Import.
3. Right-click Advanced and click Grant.
4. Right-click Data and click Grant.
5. Expand Composer > Table.
6. Expand the table that you want to allow the role import data to.
7. Expand Structure.
8. Right-click Edit and click Grant.
9. If the table is in the top level of Composer, right-click Top and click Grant.

Input form security

You can grant a role permission to view input forms, view the history of changes that were made to input forms, and add, edit, and delete rows in specified input forms in the Composer module in IBM® Cognos® Incentive Compensation Management.

Giving roles permission to add an input form

Granting a role permission to add input forms gives users assigned to the role the ability to create input forms for any tables in the IBM Cognos Incentive Compensation Management Composer module.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer > Input Forms.
3. Right-click Add, and select Grant.
4. Grant View and Edit permission for Composer.
5. To add input forms to a table in a component, grant View and Edit permission for the component.
6. If the table is in the Top level of Composer, right-click Top, and select Grant.

Giving roles permission to delete an input form

If a role has View access for a table in the Composer module in IBM® Cognos® Incentive Compensation Management, you can grant the role permission to delete input forms from the table.
Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer > Input Forms.
3. Right-click Delete and click Grant.
4. Expand Table.
5. Expand the table that contains the input form that you want to allow the user to delete.
6. Expand the input form that you want to allow the user to delete.
7. Right-click View and click Grant.
8. Grant View and Edit permission for Composer.
9. To add input forms to a table in a component, grant View and Edit permission for the component.
10. If the table is in the top level of Composer, right-click Top and click Grant.

Giving roles permission to edit input forms
Granting a role permission to edit input forms lets users assigned to the role edit the input form they have been granted access to along with its validation rules in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Grant View and Edit permission for Composer.
3. To edit the input forms of a table in a component, grant View and Edit permission for the component.
4. If the table is in the Top level of Composer, right-click Top, and select Grant.
5. Expand Composer > Input Forms.
6. Right-click Edit, and select Grant.
7. Expand Table.
8. Expand the table you want to let the user edit.
9. Expand the input form you want to let the user edit.
10. Right-click View, and select Grant.

Giving roles permission to add rows to an input form
Users can be granted permission to add rows to a table using an input form in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer > Table.
3. Expand the table that contains the input form you want to let the user add rows to.
4. Expand the input form you want to let users add rows to.
5. Right-click View, and select Grant.
6. Right-click Add, and select Grant.
Giving roles permission to delete rows from a table
You can grant a role permission to remove rows from a table in the Composer module in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer > Table.
3. Expand the table that contains the input form that you want to allow users to delete rows from.
4. Expand the input form that you want to allow users to delete rows from.
5. Right-click View and click Grant.
6. Right-click Delete and click Grant.

Giving roles permission to edit data in a table
Users can be granted permission to edit existing rows in a table in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer > Table.
3. Expand the table that contains the input form you want to let the user edit rows in.
4. Expand the input form you want to let the user edit rows in.
5. Right-click View, and select Grant.
6. Right-click Edit, and select Grant.

Giving roles permission to view the history of a table
Users can be granted permission to use the History button to view the details of edits made to rows in the table in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Composer > Table.
3. Expand the table that contains the input form you want to let the user view the history of.
4. Expand the input form you want to let the user view the history of.
5. Right-click View, and select Grant.
6. Right-click History, and select Grant.

Data store security
You can grant a role permission to specific data stores in IBM® Cognos® Incentive Compensation Management. You can also grant permission to view, edit, and or delete data store objects in Composer.

Related concepts:
Chapter 14, “Data stores,” on page 129
Data stores are Composer objects in IBM® Cognos® Incentive Compensation Management that you can use to join sources, such as tables, calculations, and draw results, into one large repository.
Giving roles permission to view a data store
You can grant a role view-only permission for a specific data store in the Composer module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role can add the data store to the Favorites list and view the Uses and Used By trees, but they cannot edit the data store.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Grant View access to Composer.
3. If the data store is in a component, also grant View access to the component.
4. Expand Data Stores.
5. Expand the data store that you want to grant View permission for.
6. Right-click View and click Grant.

Giving roles permission to view and edit data stores
Roles can be granted permission to view and edit the data store object in the IBM Cognos Incentive Compensation Management Composer module.

Procedure
1. Go to Admin > Manage Roles.
2. Select or add the role you want to grant permission for.
3. Grant View and Edit permission for Composer.
4. If the data store is in a component, also grant View and Edit permission for the component.
5. Expand Data Stores.
6. Expand the data store you want to grant View and Edit permission to.
7. Right-click View, and select Grant.
8. Right-click Edit, and select Grant.

Giving roles permission to view and delete a data store
You can grant a role permission to view and remove data store objects from the Composer module in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Composer.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.
5. If the data store is in a component, also grant View and Edit permission for the component.
6. Expand Data Stores.
7. Expand the data store that you want to grant View and Delete permission for.
8. Right-click View and click Grant.
9. Right-click Delete and click Grant.
Compensation plan security

You can grant a role permission to edit compensation plans in the Composer module in IBM® Cognos® Incentive Compensation Management. Users must have access to compensation plans to be able to view compensation results in the Payee Ledger module or to create workspaces in the Scenarios module.

Related concepts:

“Compensation plans” on page 135
You can add and edit compensation plans through Composer in IBM® Cognos® Incentive Compensation Management.

Giving roles permission to view a compensation plan

You can grant users permission to view the compensation plan object in the IBM Cognos Incentive Compensation Management Composer module, view the objects that use and are used by the compensation plan, and add the plan to the Favorites section.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Compensation Plans.
3. Right-click the compensation plan, and select Grant.
4. To allow the compensation plan object to be viewed in Composer, grant View permission for Composer.
5. To allow a compensation plan in a component to be viewed, grant View permission for the component that contains the compensation plan.

Giving roles permission to view and edit a compensation plan

You can grant a role permission to view and edit a compensation plan in in the Composer module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role can cut, copy, paste, and delete a compensation plan, edit plan details, change the In Production status, and wrap the plan into a component.

Procedure

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Compensation Plans.
3. Right-click the compensation plan and click Grant.
4. Grant View and Edit permission for Composer.
5. To allow a compensation plan in a component to be viewed and edited, grant View and Edit permission for the component that contains the plan.

Scenarios security

Users can be granted permission to create workspaces and scenarios in the IBM Cognos Incentive Compensation Management Scenarios module.

Users can also be granted permission to promote these scenarios to replace the current data in the model. In order to add workspaces, users must also have access to the compensation plans required for the scenarios.

Related concepts:

Chapter 17, “Scenarios,” on page 147
You can use scenarios to analyze how variations in the output of a model in IBM® Cognos® Incentive Compensation Management can be apportioned to different
Giving roles permission to view the Scenarios module and create workspaces

You can grant a role permission to open and view the Scenarios module in IBM® Cognos® Incentive Compensation Management. Because workspaces are associated with compensation plans, you must also grant a role permission for a particular compensation plan in the workspace.

Procedure

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Scenarios.
3. Right-click View and click Grant.
4. To allow the role to create workspaces, expand Compensation Plans, right-click the compensation plan that you want to give the role permission to use in the Scenarios workspace, and click Grant.

Important: When a user creates a public workspace, all users with permission to view the Scenarios module can view the workspace. When a user creates a private workspace, only the user who created the workspace and the administrator can view it. You can change public and private access to the workspace in the Manage Roles window.

Giving roles permission to add and edit scenarios in workspaces

You can grant users permission to view and edit workspaces in the IBM Cognos Incentive Compensation Management Scenarios module.

Users will not be able to add workspaces unless they have permission for one or more compensation plans.

Procedure

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Scenarios.
3. Right-click View, and select Grant.
4. To let the user view and edit scenarios in a workspace, expand Workspace.
5. Right-click the workspace you want to give the role permission to edit, and select Grant.

Giving roles permission to promote a scenario

You can grant a role permission to replace the current data in a model with the new data from their scenario in the Scenarios module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role must also have permission for the compensation plans that are used in the scenario.

Procedure

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
3. Expand Scenarios.
4. Right-click View and click Grant.
5. Right-click Promote and click Grant.
7. Grant the role permission for the workspace that contains the scenarios.
8. Grant the role permission to the compensation plans that are used in the workspace.

**Web form security**

Users can be granted permission to make changes to existing web forms in the IBM Cognos Incentive Compensation Management Composer module.

**Giving roles permission to open and edit web forms**

You can grant a role permission to complete all functions in web forms in the Composer module in IBM® Cognos® Incentive Compensation Management.

**About this task**

Users do not need separate access to tables to use them in web forms. To add web forms to Composer, users also need view and edit permission for Composer and for the component that they want to add web forms to.

**Procedure**

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Web Forms.
3. Right-click View or Web Forms and click Grant.

**Presenter report security**

You can grant a role permission to edit Presenter reports in IBM® Cognos® Incentive Compensation Management and use the Audit log as a source in Presenter.

**Related concepts:**

- Chapter 20, “Presenter report layout and display options,” on page 179
- After you create parameters, sources, and values for your Presenter report in IBM® Cognos® Incentive Compensation Management, you must add layout tables and report components.

- Chapter 21, “Working with completed Presenter reports,” on page 205
- After you complete a Presenter report in IBM® Cognos® Incentive Compensation Management, it can be edited, previewed, published, and linked to other reports, web forms, or web pages.

**Giving roles permission to view the Presenter report object in Composer**

You can grant users permission to view the Presenter report object in the IBM Cognos Incentive Compensation Management Composer module.

Users must also have permission to view Composer and the component the report is in.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Presenter, right-click View, and select Grant.
3. Grant View permission for Composer.
4. Grant View permission for the component the Presenter report is in.
Giving roles permission to open and edit a Presenter report
You can grant a role permission to complete all functions in a Presenter report in the Composer module in IBM® Cognos® Incentive Compensation Management.

About this task
To open existing Presenter reports and add new Presenter reports in Composer, the role must also have view and edit permission for Composer and view and edit permission for the component where they want to add Presenter reports.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Presenter.
3. Right-click View and click Grant.
4. Grant View and Edit permission for Composer.
5. Grant View and Edit permission for the component the report is in.
6. If the report is in the top level of Composer, right-click Top and click Grant.

Giving roles permission to use the Audit log as a source in Presenter
You can grant users permission to add the IBM Cognos Incentive Compensation Management Audit log as a data source in their reports.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Presenter.
3. Right-click View, and select Grant.
4. Expand Audit Log.
5. Right-click View or Audit Log, and select Grant.

Portal Access security
You can grant a role view-only permission for the Portal Access module in IBM® Cognos® Incentive Compensation Management.

To view the assignments, sign offs, and inquiry trees for compensation plans, Presenter reports, and web forms, users must also be granted view permission for compensation plans, Presenter reports, and web forms. Users can also be granted the ability to perform all actions in the Portal Access module. To set Portal Access assignments for compensation plans, Presenter reports, and web forms, user must have view permission for them.

Giving roles permission to view the Portal Access module
You can grant a role view-only permission for the Portal Access module in IBM® Cognos® Incentive Compensation Management.

About this task
To view the assignments, sign off and inquiry trees for compensation plans, Presenter reports, and web forms on the Assignment, Sign Off, and Inquiries tabs, users must have view permission for compensation plans, Presenter reports, and web forms.
Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Portal Access.
3. Right-click View and click Grant.
4. To allow users to view the assignment, sign off, and inquiries for compensation plans, grant permission to compensation plans.
5. To allow users to view the assignment, sign off, and inquiries for Presenter reports, grant View permission for Presenter.
6. To allow users to view the assignment, sign off, and inquiries for web forms, grant View permission for web forms.

Giving roles permission to view and edit the Portal Access module
You can grant users permission to edit all items in the IBM Cognos Incentive Compensation Management Portal Access module.

Users must also have access to compensation plans in order to view and edit the assignment, sign off, and inquiries for the plans.

Procedure
1. Go to Admin > Manage Roles and select or add the role you want to grant permissions for.
2. Expand Portal Access.
3. Right-click View, and select Grant.
4. Right-click Edit, and select Grant.
5. To let users view and edit the assignment, sign off, and inquiries for compensation plans, grant permission to compensation plans.
6. To let users view the assignment, sign off, and inquiries for Presenter reports, grant View permission for Presenter.
7. To let users view the assignment, sign off, and inquiries for web forms, grant View permission for web forms.

Scheduler security
You can grant a role permission to view or edit the Scheduler module in IBM® Cognos® Incentive Compensation Management.

To open the Scheduler module and view processes and tasks, a user must have view-only access to the Scheduler module.

To add processes and tasks, run processes and tasks, change Scheduler properties, pause or activate the Scheduler service, or enable and disable tasks, a user must have edit permission as well as view permission.

Related concepts:
Chapter 24, “Scheduler,” on page 247
You can use the Scheduler module in IBM® Cognos® Incentive Compensation Management to create and schedule processes such as imports, calculations, and calendar locking.

Giving roles permission to view the Scheduler module
You can grant a role permission to see the Scheduler module in IBM® Cognos® Incentive Compensation Management.


**Procedure**

1. Click **Admin > Manage Roles**, and select the role that you want to grant permissions for.
2. Expand **Scheduler**.
3. Right-click **View** and click **Grant**.

**Giving roles permission to edit the Scheduler module**

You can grant a role permission to edit the Scheduler module in IBM® Cognos® Incentive Compensation Management. Users who are assigned to this role can add and remove tasks and processes, run tasks and processes, set Scheduler properties, pause and activate the Scheduler service, and enable and disable tasks.

**Procedure**

1. Click **Admin > Manage Roles**, and select the role that you want to grant permissions for.
2. Expand **Scheduler**.
3. Right-click **View** and click **Grant**.
4. Right-click **Edit** and click **Grant**.

**Setting Task Manager security**

You can grant access users access to the IBM Cognos Incentive Compensation Management Task Manager module to add tasks and alerts.

**Procedure**

1. In the **Manage Roles** window, select the role you want to grant permission for.
2. Expand **Tasks**.
3. Right-click **View**, and select **Grant**.

**Audit module security**

You can grant a role view-only permission for the Audit module in IBM® Cognos® Incentive Compensation Management, or you can grant access to allow users to edit the Audit module.

**Giving roles permission to view the Audit module**

You can grant users view-only permission for the IBM Cognos Incentive Compensation Management Audit module.

This gives users permission to view, sort, filter, and show the details of the data in the Audit module; however, the users are not able to remove data.

**Procedure**

1. In the **Manage Roles** window, select the role you want to grant permission for.
2. Expand **Audit Log**.
3. Right-click **View**, and select **Grant**.

**Giving roles permission to view and edit the Audit module**

You can grant users permission to view and edit the IBM Cognos Incentive Compensation Management Audit module.

This gives users permission to view, sort, filter, show the details of data and clean up the Audit module.
Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Right-click Audit Log, and select Grant.

Setting Payee Ledger security
You can grant users permission to view all the tabs in the IBM Cognos Incentive Compensation Management Payee Ledger module and view tailored reports in Payee Ledger.

To view compensation plan results, users must also have permission for the compensation plans.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Payee Ledger.
3. Right-click Payee Ledger or View, and select Grant.
4. To give users permission to view compensation plan results, grant permission to compensation plans.

Workflow Manager security
You can grant users access to view the IBM Cognos Incentive Compensation Management Workflow Manager module, create new workflows, edit existing workflows, and execute workflows.

Giving roles permission to view the Workflow Manager module
You can grant a role view-only permission to view the Workflow Manager module in IBM® Cognos® Incentive Compensation Management. To view workflows, users who are assigned to this role must also have view access to each workflow.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Workflow Manager.
3. Right-click View and click Grant.

Giving roles permission to view the Workflow Manager module and create workflows
You can grant a role permission to view the Workflow Manager module in IBM® Cognos® Incentive Compensation Management and to add workflows.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Workflow Manager.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view a workflow
You can grant a role view-only permission for a workflow in the Workflow Manager module in IBM® Cognos® Incentive Compensation Management.
Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Workflow Manager.
3. Right-click View and click Grant.
4. Expand the workflow that you want the user to be able to view.
5. Right-click View and click Grant.

Giving roles permission to edit a workflow
You can grant users permission to edit existing workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Workflow Manager.
3. Right-click View and select Grant.
4. Expand the workflow you want the user to be able to edit.
5. Right-click View, and select Grant.
6. Right-click Edit, and select Grant.

Giving roles permission to start a workflow
You can grant users permission to execute workflows in the IBM Cognos Incentive Compensation Management Workflow Manager module.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Workflow Manager.
3. Right-click View, and select Grant.
4. Expand the workflow you want the user to be able to start.
5. Right-click View, and select Grant.
6. Right-click Execute, and select Grant.

Setting Calculate module security
You can grant a role permission to view the Calculate module in the IBM® Cognos® Incentive Compensation Management client and to run a calculation on any items in the Calculation Type menu. To preview or view calculation data in the Composer model, users who are assigned to this role must also have view permission for the Calculate module.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Calculate.
3. To allow the user to view the Calculate module, right-click View and click Grant.
4. To allow the user to view and run a calculation, grant View and Run permission.

Related concepts:
You can right-click any calculation to preview, view the current values, view history, see a list of compensation plans, tailored reports, or Presenter reports that use the calculation, and edit the calculation in IBM® Cognos® Incentive Compensation Management.

Administrators can use the Calculate module in IBM® Cognos® Incentive Compensation Management to run the calculate engine, view the summary of the last calculations that are run in the model, and view the Computation log.

**Administration security**

You can grant a role permission to set administrative options, run and edit saved imports, run and edit saved publications and edit saved transformations in the IBM® Cognos® Incentive Compensation Management client.

By default, all administrator users can see the Home page, including the information in the Admin and Tools menus. Additionally, all administrators can create web messages, manage documents, change their password, and view and export the Model Summary from the Admin menu. All other rights must be granted to a user’s role to allow the user to be able to act upon items.

**Giving roles permission to view administrative options**

You can grant users permission to view the administrative options for the current IBM Cognos Incentive Compensation Management model but not make any changes.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Admin Options.
3. Right-click View, and select Grant.

**Giving roles permission to view and edit administrative options**

You can grant users permission to view and make changes to the administrative options in the IBM Cognos Incentive Compensation Management model.

**Procedure**

1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page.
3. Right-click Admin Options, and select Grant.

**Giving roles permission to view and run saved imports**

You can grant a role permission to view and run saved imports in the IBM® Cognos® Incentive Compensation Management client.

**Procedure**

1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Manage Saved Imports.
3. Right-click View and click Grant.

**Giving roles permission to view, run, and edit saved imports**

You can grant a role permission to view, run, and edit saved imports in the IBM® Cognos® Incentive Compensation Management client.
Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Manage Saved Imports.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view, run, and delete saved imports
You can grant users permission to view, run, and delete saved imports in the IBM Cognos Incentive Compensation Management Client.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Imports.
3. Right-click View, and select Grant.
4. Right-click Delete, and select Grant.

Giving roles permission to view and run saved publications
You can grant users permission to view and run saved publications in the IBM Cognos Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Publications.
3. Right-click View, and select Grant.

Giving roles permission to view, run, and edit saved publications
You can grant a role permission to view, run, and edit saved publications in the IBM Cognos Incentive Compensation Management client.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Manage Saved Publications.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view, run, and delete saved publications
You can grant a role permission to view, run, and delete saved publications in the IBM Cognos Incentive Compensation Management client.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Manage Saved Publications.
3. Right-click View and click Grant.
4. Right-click Delete and click Grant.

Giving roles permission to view saved transformations
You can grant a role view-only permission for saved transformations in a model in IBM Cognos Incentive Compensation Management.
Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Manage Saved Transformations.
3. Right-click View and click Grant.

Giving roles permission to view and edit saved transformations
You can grant a role permission to view and edit saved transformations in the IBM Cognos Incentive Compensation Management client.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Manage Saved Transformations.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view and delete saved transformations
You can grant users permission to view and delete any saved transformation from the IBM Cognos Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Manage Saved Transformations.
3. Right-click View, and select Grant.
4. Right-click Delete, and select Grant.

Giving roles permission to add documents to the Manage Documents window
You can grant a role permission to open the Manage Documents window and add documents in IBM Cognos Incentive Compensation Management. Users who are assigned to this role must also have view and edit permission for the Portal Access module.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Right-click Portal Access and click Grant.

Tools security
From the Tools menu, you can grant a role permissions that are related to tools in the IBM Cognos Incentive Compensation Management client. Users who are assigned to these roles can optimize models, view and edit calendars, view and edit payee groups, view and create star schemas, perform migrations, and manage the client and web theme.

Related concepts:
Chapter 31, “Tools menu,” on page 333
The Tools menu is accessible from any module in the IBM Cognos Incentive Compensation Management client. It includes options such as model optimization, editing calendars, adding payee groups, adding star schemas, and migrations.
Giving roles permission to optimize a model
You can grant a role permission to run the Model Optimization SQL process from the IBM Cognos® Incentive Compensation Management client.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page.
3. Right-click Optimize Model and click Grant.

Giving roles permission to view calendars
You can grant users view-only permission for the list of calendars in the IBM Cognos Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Calendars.
3. Right-click View, and select Grant.

Giving roles permission to view and edit calendars
You can grant a role permission to view and edit the calendars in a model in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Calendars.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view and lock calendars
You can grant a role permission to view and lock calendars in a model in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Calendars.
3. Right-click View and click Grant.
4. Right-click Period Locking and click Grant.

Giving roles permission to view existing payee groups
You can grant users view-only permission for the list of payee group in the IBM Cognos Incentive Compensation Management model.

Procedure
1. In the Manage Roles window, select the role you want to grant permission for.
2. Expand Home Page > Payee Groups.
3. Right-click View, and select Grant.
Giving roles permission to view and edit payee groups
You can grant a role permission to edit the payee groups in a model in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Payee Groups.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view star schemas
You can grant a role view-only permission for the star schemas in a model in IBM® Cognos® Incentive Compensation Management.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to view and edit star schemas
You can grant a role permission to view, delete, and create star schemas in the IBM® Cognos® Incentive Compensation Management client.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
3. Right-click View and click Grant.
4. Right-click Edit and click Grant.

Giving roles permission to perform a migration
You can grant a role permission to perform a migration in the target model in IBM® Cognos® Incentive Compensation Management. The user must use the administrator role user name and password to connect to the source model and must have both edit and execute permission in the target model.

Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page > Migrations.
3. Right-click Edit and click Grant.
4. Right-click Execute and click Grant.

Giving roles permission to enable custom headers
You can grant a role permission to add a logo to a header or change the IBM® Cognos® Incentive Compensation Management web client theme from standard to Salesforce.com. The header image is displayed in both the client and the web client.
Procedure
1. Click Admin > Manage Roles, and select the role that you want to grant permissions for.
2. Expand Home Page.
3. Right-click Manage Theme and click Grant.

User security
You can use the Manage Users window in the IBM® Cognos® Incentive Compensation Management client to add, edit, or delete administrator user IDs, email addresses, and passwords. You can also use the Manage Users window to assign user roles.

From the Manage Users window, each administrator can be assigned a user role that grants them appropriate access rights. Users without sufficient privileges to access a module are denied access.

Whenever a new model is created, Administrator (main administrator) and Scheduler users are automatically created. These users must both have a secure password. By default, the password is blank; however, blank passwords are not allowed in the client. The first time a user logs in using a blank password, a Change Password window is displayed. An email address must also be added if either of these users must receive emails from Cognos Incentive Compensation Management.

Important: The Scheduler password in the Cognos Incentive Compensation Management client must match the Scheduler password in the Windows Service configuration file (IBM Cognos ICM Windows Service.exe.config file and ConsoleService.exe.config file). If the password is changed in the client, an administrator also must change the password in the service configuration file (and vice versa). If these passwords do not match, Scheduler cannot run.

Adding a user
You can add new users and then assign roles that grant them access to the IBM® Cognos® Incentive Compensation Management client.

Procedure
1. Click Admin > Manage Users.
2. Click Add.
3. Type all required information in the User Editor window. Make sure that when a new user is added, a user name is created along with a user ID. The user name is used in the Audit log to track the user’s actions.
4. Assign a role to the user from the Role menu.
5. Click OK.
6. When you finish adding users, click Save.

Changing passwords for client users
You can use the Change Password window in the IBM® Cognos® Incentive Compensation Management client to change your password.

About this task
If an administrator with appropriate access rights wants to change the password of another administrator, the first administrator can do so from the Manage Users
window. Blanks passwords cannot be used.

**Procedure**

1. Click Admin > Change Password.
2. Type and confirm the new password.
3. Click OK.

**Setting user login security options**

From the User tab in the Administrative Options window, you can define security options for the IBM® Cognos® Incentive Compensation Management client. If you do not set options in this window, users have unlimited login attempts, passwords never expire, and users are not required to create strong passwords.

**About this task**

The Audit log tracks all password changes.

**Procedure**

1. Click Admin > Administrative Options.
2. Select the User tab.
3. Select the Disable user after check box to indicate how many attempts users have to log on before their accounts are disabled.
   After an account is disabled, an administrator with permission to edit users will need to re-enable the account by clearing the Disabled check box from the Admin Menu > Manage Users window.
4. Select the Users must have strong passwords check box. Passwords must adhere to the following criteria:
   - Must be at least eight characters in length
   - Must contain at least three of the following character types:
     - Lowercase letter
     - Uppercase letter
     - Number
     - Symbol!@#$%^&*() < >
5. Select the Enable self-service password reset check box to allow users to click the Forgot Your User ID and Forgot Your Password link on the login window.
   In the Reset expires in field, type the number of seconds before the self-service password reset notification expires.
6. Select the Show warning when previewing calculations check box to display a warning message after users click the Preview option.
7. Select the Keep password history for check box to indicate how many times users must create a new password before they can reuse a previous password.
8. Select the User must change his or her password after being set or changed by admin check box to indicate that users must change their password the first time they log in to the client.

**Related concepts:**

“Login window” on page 7

You can access the IBM® Cognos® Incentive Compensation Management client and select a specific environment and language for the client from the login window.
Setting password expiration:

You can configure password expiration options for the IBM Cognos Inventive Compensation Management client.

Procedure

1. Go to Admin > Administrative Options.
2. Select the User tab.
3. Select the Passwords expire after check box to force users to create new passwords at predefined intervals.
   The number of days entered indicates how often users are prompted to create new passwords for themselves. Passwords are tracked by the system before the password expires; this includes password changes made in the Manage Users window and the web client.
   Important: The password assigned to the Scheduler role never expires.
4. Select the Prompt users about passwords expiring check box and type the number of days before password expiration that the system sends notifications to users.
5. In the This will repeat every field, type the number of days that the system will wait before sending out another password expiration notification.
6. In the Show final password warning field, type the number of minutes before the password expires that the system sends the final password expiration notification to users.

Setting web user login security options

From the Web tab in the Administrative Options window, you can set security for the IBM Cognos Incentive Compensation Management web client. If you do not set options in this window, users have unlimited login attempts, users cannot reset forgotten passwords, and users are not required to create strong passwords.

Procedure

1. To temporarily disable the web client while the model is being updated and prevent web users from logging in, clear the Enable Web check box.
2. Select the Users must have strong passwords check box. Passwords must adhere to the following criteria:
   • Must be at least eight characters in length
   • Must contain at least three of the following character types:
     – Lowercase letter
     – Uppercase letter
     – Number
     – Symbol!@#$%^&*() < >
3. Select the Enable self-service password reset check box to let users reset a forgotten password through a link on the web client.
   Web server email settings must be configured before you can use this feature. After you select this feature, you must specify the length of time (in seconds) that web users must reset their password before it expires.
4. Select the Lockout user after check box to indicate how many attempts web users have to log in to the web client before their accounts are disabled.
   After an account is disabled, an administrator with permission to edit users must enable the account again by clearing the Disabled check box from the
Admin Menu > Manage Users window. Additionally, web users can unlock their accounts by using the password reset feature.

5. To force web users to change their passwords after a particular number of days, select the **Password expires after** check box, and type the number of days after which you want the password to expire.

6. Select the **Keep password history for** check box to indicate how many times users must create a different password before they can reuse a previous password.

Setting email address for Request Assistance link on the web client:

You can configure the email address that is used when a user clicks the following links in the IBM® Cognos® Incentive Compensation Management web client: Request Assistance, Forgot your user name and password, and Don't have an account.

Procedure

1. Click **Admin > Administrative Options**.
2. Select the **Web** tab.
3. In the **Help Email** field, type the email address of the user whom you want to notify when a web user requests assistance on the web client.
4. Click **OK**.

Forcing web users to change passwords on first login:

When you select the **User must change the password the first time he or she logs in** option, users must change their passwords the first time they log in to the IBM® Cognos® Incentive Compensation Management web client.

About this task

If the **User Must Have Strong Password** option is checked, the user's new password must adhere to the strong password guidelines. The forced password reset applies to new web users who are logging in for the first time and re-enabled web users who are logging in for the first time after they were re-enabled through the Portal Access module.

**Important:** This option is available only for users who are enabled for web through Portal Access and who do not use LDAP authentication.

Procedure

1. Click **Admin > Administrative Options**.
2. Select the **Web** tab.
3. Select the **User must change the password the first time he or she logs in** option.
4. Click **OK**.

**Important:** Web users must enter a password into the **New Password** field the first time they log in. However, web users are permitted to reuse passwords, which means that the new password can be the same as the old password.
Setting the base URL for the web client:

For the Report Name With Link variable in the IBM Cognos Incentive Compensation Management Workflow Manager module to function correctly in a message by an alert node to the web client, the base URL for the web client must be configured in the Administrative Options window.

Procedure
1. Go to Admin > Administrative Options.
2. Click the Web tab.
3. In the Base URL field, type the URL of your WAR file.
   For example, type the following address: http://localhost:8080/ICM, where, ICM is the name of your WAR file.
4. Click OK.

Disabling a user account
After an account has been created, it can later be disabled when the user no longer requires access to the IBM Cognos Incentive Compensation Management Client.

Procedure
1. Go to Admin > Manage Users.
2. Select the user.
3. Click Edit.
4. Select the Disabled check box.
   When the Disabled check box is selected, the user will be unable to log in to the web client.
5. Click OK.
6. When you have finished disabling accounts, click Save.

Publishing a users and permissions report
A list of users in the IBM Cognos Incentive Compensation Management Client, their roles, and their access permissions in the Client can be exported from the Manage Users window.

Procedure
1. Go to Admin > Manage Users.
2. Click the Export Access button.
3. Choose a destination file, type a file name, and click Save.

Concurrent users
After you define and assign roles to different users, you can log them in to the IBM Cognos Incentive Compensation Management client simultaneously, so that multiple users can complete actions on the model at the same time.

For example, while Administrator User 1 is adding a table to the model, Administrator User 2 can be logged in concurrently to edit a calculation.

The exception to this rule occurs when multiple administrators try to simultaneously perform a global action on the model, such as a calculation or data import. One calculation must be completed before another one can start, and only one data import can occur at a time. If a second administrator tries to perform a calculation or data import while another one is in progress, the second
administrator sees the following warning message: Administrator <user name> started a global action <amount of time passed> ago. No changes may be made while this action is in progress.

The second administrator also sees the global action icon next to the welcome message on the Home page when he or she first logs in, indicating that a global action is being run by another administrator. The second administrator must wait for the first administrator's global action to complete.

In general, when two or more administrators are making unrelated changes in the model, all administrators can make changes without any type of warning. When two administrators are making changes to the same information, the second administrator receives a reminder to refresh data to that is can be saved.

The following table provides examples of multi-administrative situations. This table covers common examples of multiple administrators trying to simultaneously make changes in the same module, as well as administrators trying to make changes while a calculation or import is in progress. In all cases where administrators are making unrelated changes in different modules, all administrators can make and save changes without warnings.

Table 46. Common multi-administrative situations

<table>
<thead>
<tr>
<th>Module/Action</th>
<th>Situation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imports</td>
<td>If multiple administrators try to import data into a table, the first administrator to click <strong>Finish</strong> in the Import Data wizard completes the import without warning. All other administrators are informed that the first administrator's import must complete before they can complete their imports.</td>
</tr>
<tr>
<td>Imports</td>
<td>If an administrator is performing an import and a second administrator tries to add a row to the same table, the second administrator is informed that the first administrator's import must complete before the second administrator can add a row.</td>
</tr>
<tr>
<td>Calculate</td>
<td>If an administrator tries to calculate the model while another calculation is in progress, the second administrator is informed that the calculation cannot proceed because another calculation is in progress.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators try to add or edit different rows in a table, all administrators can make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If an administrator tries to edit a table while another administrator is trying to clear the same table, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators are instructed to refresh the data before they can save.</td>
</tr>
<tr>
<td>Composer</td>
<td>If an administrator tries to edit a table while another administrator is trying to clear a different table, all administrators can make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators are editing the same row simultaneously, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators are instructed to refresh the data before they can save.</td>
</tr>
<tr>
<td>Composer</td>
<td>If two administrators try to add new payee groups, both administrators can make and save changes without warning.</td>
</tr>
</tbody>
</table>
Table 46. Common multi-administrative situations (continued)

<table>
<thead>
<tr>
<th>Module/Action</th>
<th>Situation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composer</td>
<td>If multiple administrators try to add a calculation, compensation plan, or tailored report to the same folder, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators are instructed to refresh the data before they can save.</td>
</tr>
<tr>
<td>Composer</td>
<td>If multiple administrators try to add a calculation, compensation plan, or tailored report to different components, all administrators can make and save changes without warning.</td>
</tr>
<tr>
<td>Composer</td>
<td>If an administrator tries to edit a compensation plan while a model calculation is already in progress, the administrator is instructed to refresh the data before he or she can save.</td>
</tr>
<tr>
<td>Portal Access</td>
<td>If multiple administrators are simultaneously creating Portal Access groups, all administrators can make and save changes without warning.</td>
</tr>
<tr>
<td>Input Forms</td>
<td>If multiple administrators are creating input forms simultaneously, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators are instructed to refresh the data before they can save.</td>
</tr>
<tr>
<td>Web Forms</td>
<td>If multiple administrators create web forms, all administrators can make and save changes without warning.</td>
</tr>
<tr>
<td>Web Forms</td>
<td>If multiple administrators try to add a web resource to the same web form, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators are instructed to refresh the data before they can save.</td>
</tr>
<tr>
<td>Payee Ledger</td>
<td>If multiple administrators try to generate a Payee Ledger report at the same time, all administrators can view the report.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>If multiple administrators try to edit the same scheduled process in Scheduler, the first administrator to click <strong>Save</strong> can save changes without warning. All subsequent administrators are instructed to refresh the data before they can save.</td>
</tr>
</tbody>
</table>

Global action restrictions:

To protect the integrity of the model, users cannot complete certain model edits in IBM® Cognos® Incentive Compensation Management while a global action is in progress.

Additionally, only one global action can be performed at a time. Global actions include calculations, imports, exports, period locking, calendar edits, and migration.

When a global action is running, the global action icon ![global_action_icon] turns red. If you hover your mouse over the icon, you can see which user is performing the global action and how long the global action has been running.

The following actions cannot be performed while a global action is in progress:

- Imports into tables, new table or input form creation, manual submissions to tables and any other edits to the data or structure of a table.
- Generation and edits to a star schema.
• Access to data through the Cognos Incentive Compensation Management add-in for Microsoft Excel.
• Scenario addition, edits, and promotion.
• Addition or edits to calculations.
• Running of the Optimize Model feature.

Role segregation example

The following example outlines role segregation in the IBM Cognos Incentive Compensation Management Client.

You have a compensation plan builder, John, who is responsible for building all of your company’s compensation plans. Since all building is done in the development environment, he should only have access to build in the development environment. He will, however, need to be able to see compensation plan results in the quality assurance (QA) and production environments, so his user role will be different in those environments.

Your company also has a Portal Access manager, Sally, who is responsible for setting up and maintaining the Portal Access hierarchy. She will not require access to the development and QA environment. In the production environment, she requires the ability to assign Portal Access trees and add Task Manager rules, but does not need to have access to any other model component.

Table 47. Role segregation example

<table>
<thead>
<tr>
<th>Role</th>
<th>Development Environment</th>
<th>QA Environment</th>
<th>Production Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>John - Plan Builder</td>
<td>Build plans</td>
<td>View plans</td>
<td>View plans</td>
</tr>
<tr>
<td></td>
<td>Add and edit tables</td>
<td>View Payee Ledger</td>
<td>View Payee Ledger</td>
</tr>
<tr>
<td></td>
<td>Import Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sally - Portal Access</td>
<td>no access</td>
<td>no access</td>
<td>Assign Portal Access</td>
</tr>
<tr>
<td>Manager</td>
<td></td>
<td></td>
<td>trees</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Add Task Manager rules</td>
</tr>
</tbody>
</table>

Environment roles creation

To create different roles for each environment in IBM® Cognos® Incentive Compensation Management, the primary administrator must log in to each environment separately and define appropriate user role access.

First, the primary model administrator must log in to the model to create user roles for the plan builder and the Portal Access manager.

Within the development environment, the primary model administrator creates a user role that grants the plan builder access to all compensation plans, the Composer module, selected tables within Composer, import capabilities, and access to the Payee Ledger module. The plan builder role does not have access to Scheduler, Task Manager, or any other area that is not required for building plans.

Within the development environment, the Portal Access manager role does not have access to any model components.
While the primary administrator is logged in to the QA and production environments, he or she creates slightly different access rights for the plan builder and Portal Access manager roles. In these environments, the plan builder role can view compensation plans, but cannot change them, and he can also view Payee Ledger reports.

The Portal Access manager role can perform actions in the Portal Access and Task Manager modules but cannot perform any other actions in the model. The Portal Access manager must also have access to compensation plans to assign access trees to them in the Portal Access module.

**User role assignment**

After roles have been created in the IBM Cognos Incentive Compensation Management Client, they need to be assigned to specific users.

After roles have been assigned and users log in to their model, they will only be permitted to view and perform actions that are permitted in their user roles. Sally has been assigned to the role of Portal Access Manager. If Sally logs in to the production environment of the model, she will only have access to the Portal Access and Task Manager modules.

When Sally logs in to the production environment, she will have the ability to perform any action in the Portal Access module and Task Manager module.

When John logs into the development environment, he will have access to build and change compensation plans. If he logs into the QA environment, he will be presented with the following message if he attempts to make any plan changes: You do not have sufficient rights to perform this action. Contact your system administrator for assistance.
Chapter 30. Administration

On the Administrative Options window in the IBM® Cognos® Incentive Compensation Management client, you can set administrative options. You can set general options and options for Audit log, Portal Access, and Payee Ledger, user and web user security, calculation options, and statistics information.
Chapter 31. Tools menu

The Tools menu is accessible from any module in the IBM® Cognos® Incentive Compensation Management client. It includes options such as model optimization, editing calendars, adding payee groups, adding star schemas, and migrations.

Related concepts:
“Tools security” on page 319

From the Tools menu, you can grant a role permissions that are related to tools in the IBM® Cognos® Incentive Compensation Management client. Users who are assigned to these roles can optimize models, view and edit calendars, view and edit payee groups, view and create star schemas, perform migrations, and manage the client and web theme.

Optimizing a model

For increased performance, you can use the Optimize Model feature to manually optimize the model in IBM® Cognos® Incentive Compensation Management at the database level.

About this task

Before you use the Calculate module, you can use the Optimize Model feature to ensure favorable calculation time after data is updated. You can also schedule model optimization as part of a process in the Scheduler module.

The database calculates statistics to improve query performance, so that data can be accessed more efficiently. Optimize your model after many changes are made, a period is locked, or a large data import is done.

Important: More frequent use does not necessarily provide a noticeable improvement in calculation time.

Procedure

1. Click Tools > Optimize Model.
2. Click Yes.

Results

The Activity module opens and displays the progress of the optimization process. After the process is complete, a message that indicates that the model was successfully optimized is displayed in the Activity module.

Calendars and period locking

A calendar is created automatically when the model is created or manually by a model administrator in IBM® Cognos® Incentive Compensation Management.

The calendar period locking feature ensures that calculated results never change. In addition, the amount that is paid to each payee corresponds exactly to the values for that payee and period in the application.
Calendar creation
In IBM® Cognos® Incentive Compensation Management, you can create multiple calendars to address the needs of different lines of business.

For example, consider a company that has a sales and a consulting line of business. The sales line of business might define the end of a period as the last day in a month, but the consulting line of business might plan around full weeks, ending their period after the completion of the last full week in any month.

Cognos Incentive Compensation Management can manage the different ways each line of business aggregates data through calendars. Each compensation plan uses a single calendar that tells the compensation plan how to aggregate data in time-based calculations. A set of compensation plans for consulting aggregates correctly based on one calendar, and a different set of compensation plans for sales can simultaneously calculate correctly based on a different calendar.

The selected calendar combines date ranges into periods. Date ranges can be created manually for precision, or automatically with the integrated Add Year button in any existing calendar.

Adding a calendar
You can add different calendars to your model in IBM® Cognos® Incentive Compensation Management. You can also add custom calendars.

Procedure
1. Click Tools > Calendars.
2. Click Add.
3. Type a Name for the calendar.
4. Select the start date.
5. Select the template format.
6. Click Finish.

Related concepts:
“Access permissions” on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Editing a calendar
After a calendar is created in IBM® Cognos® Incentive Compensation Management, you can edit it.

Procedure
1. Click Tool > Calendars.
2. Right-click a calendar and click Edit.
3. Click Add Year, Add (a Period), Edit, or Delete to make changes.
   After multiple ranges are defined, they can then be grouped for calculation and reporting purposes. Ranges must be continuous.
4. Click Next.
5. Click Add (a Time Roll up), Edit, or Delete to edit the time hierarchy.
6. Click Finish.
Multiple calendars
You can use multiple calendars in one model in IBM® Cognos® Incentive Compensation Management, but use only one calendar (or as few as possible) for payout purposes.

Within a compensation plan, certain calculations might reference different calendars, but the calculation that the payment is based on (final calculation in the plan) must be the same for each compensation plan. This approach simplifies the process of period locking by eliminating the need to lock multiple calendars.

Compensation plans for the new year
After you add a new year to your model in IBM® Cognos® Incentive Compensation Management, you must ensure that you have compensation plans for your new fiscal year.

You have the following options:
• If a compensation plan remains unchanged for the new year, you can continue to use the same plan. Edit the plan by extending its end date.
• If you want to change a plan for the upcoming year, create a new compensation plan. The simplest approach is to make a copy of the group of calculations that are used by the compensation plan. You can then make any necessary edits to the copied calculations, and create a new plan.

Period locking
IBM® Cognos® Incentive Compensation Management can calculate highly accurate compensation results based on varied information, and then it can lock the calendar.

Before payees and their managers can approve their compensation calculations, you can use Cognos Incentive Compensation Management to lock periods to prevent accepted results from changing. As a result, Cognos Incentive Compensation Management is not apparent to the administrator and the user. Period locking ensures that the amount on each check that is written for each payee corresponds exactly to the values that are shown for that payee and period in the application.

With period locking, the following actions can occur:
• Administrators can freeze the calculation and record list for closed, commissioned periods.
• The system can protect the results for closed periods and enforce restrictions that ensure that the results are fully auditable and do not change.

Period accuracy
Without period locking, steps must be taken to ensure that the new results agree with the original payment amounts for that period.

All of the following circumstances need to be met in order for Cognos Incentive Compensation Management to be accurate:
• All errors in the data must be corrected prior to the close of a period. All relevant meta data must be up-to-date before the close of each period.
• Records associated with a period will never be added after that period is closed.
• Payee titles, quotas, and other non-period-specific data must not change.
If these circumstances are not met when Cognos Incentive Compensation Management recalculates, the system will determine new results based on any new (or altered) data. The new results will not agree with the original payment amounts for that period.

**How period locking works**
A period is locked for a particular calendar in IBM® Cognos® Incentive Compensation Management and prevents any values from changing through the lock date.

All associated compensation plans and data tables are locked simultaneously, preventing any calculation results (or source data) from changing. This approach ensures the integrity of prior period results.

When periods are locked, all data tables that are associated with that calendar are locked by the date field (but other table types are not locked). If more than one date field in the table is selected as a primary key, you must select a **Lock by Date** when the table is created, to specify the field to look at during the locking process.

Before a period is locked, when the Calculate module is used to calculate all items, Cognos Incentive Compensation Management calculates results for all calculations and all periods. After a period is locked, Cognos Incentive Compensation Management enforces rules that prevent administrative actions that would invalidate locked calculation results. For example, any new calculations that are created after a period is locked can contain only unlocked periods in the results set. If you want to lock multiple calendars consecutively, you can do so without running another full model calculation as long as no further changes are made in the model.

Locked calculations can, however, be edited. Formulas for locked calculations can be changed, as long as the calculation does not use accumulating partitioning. If the **Accumulating Partitions** checkbox is selected, you cannot edit the calculation. Locked calculation results do not change; however, results for any unlocked periods change to reflect any edits that were made to the calculation. When you view results in Payee Ledger on the web client, the results are displayed seamlessly. Payees cannot detect at which point in time a change in the calculation was made.

Although it is possible to unlock locked periods, avoid this action. The purpose of period locking is to prevent accepted results from changing and to ensure that payments always match calculated results. If you unlock a period, even to make a minor change, you might inadvertently change accepted payment results beyond the change that you intended to make.

**Locking a period**
You can lock a period to prevent the results from being edited in IBM® Cognos® Incentive Compensation Management.

**Before you begin**
Perform a calculation before you lock a period to ensure that all calculated results are up-to-date as of the calendar locking.

A calendar lock is considered a change in the model. If you have more than one calendar and another calendar was locked after the last calculation, another calculation is required before you can lock the current calendar.
When you create a data table with more than one date field, you are prompted to select a locked-by date. This is the date that is used when you lock periods.

**Procedure**
1. Click **Tools > Calendars**.
2. Select the calendar that you want to lock.
3. Click **Lock**.
   - The Time Locking wizard shows all compensation plans and data tables that are affected by locking the selected calendar.
4. Click **Next**.
5. Select the **Period** that you are locking through.

   **Tip:** You cannot have open periods that exist before a locked period. For example, if you lock period 1 of 2012, all of 2011 is automatically locked as well.
6. Verify the action.
7. Click **Finish**.
8. Click **Calculate and Lock** or **Lock Only**, and click **OK**. If any changes were made since the last calculation, the **Lock Only** option is not available.
   - The Activity tab shows the progress of the calendar locking process. After the process is complete, a message that the calendar is locked is displayed in the Activity tab.

**Results**

If you go back to Composer and open a data table, you can see that none of the rows with a date in a locked month can be edited. However, you can still edit rows with dates in an unlocked period.

**Unlocking a period**

When you unlock periods, the results for these periods will become editable, therefore potential inconsistencies between payments and results become possible in IBM Cognos Incentive Compensation Management.

**Procedure**
1. Go to **Tools > Calendars**.
2. Select the calendar.
3. Click **Lock**.
4. Select a period prior to the current locked period, or select **Unlock all periods**.
5. Verify the action.
6. Click **Finish**.
   - The Activity module will open to show the progress of the calendar unlocking process. After the process is complete, a message indicating that the calendar is unlocked will be displayed in the Activity module.

   **Important:** Unlocking a period is an irreversible operation. All adjustments for that period will be deleted.

**Period locking and system functions**

The following table provides system function and how they affect and are affected by period locking in IBM Cognos Incentive Compensation Management.
Table 48. System functions and period locking

<table>
<thead>
<tr>
<th>System functions</th>
<th>Effect of period locking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new calculation</td>
<td>Partition may only reference unlocked periods.</td>
</tr>
<tr>
<td>Change an existing calculation</td>
<td>Changes will not be possible if the calculation includes locked periods. Copied calculations will begin in the first unlocked period.</td>
</tr>
<tr>
<td>Create a new compensation plan</td>
<td>The start date of the plan is unrestricted, but only unlocked calculations may be added to a compensation plan.</td>
</tr>
<tr>
<td>Modify an existing compensation plan</td>
<td>If any calculations in a plan have any locked periods, the plan cannot change. Copied plans will begin in the first unlocked period. If there are no unlocked periods, the plan cannot be copied.</td>
</tr>
<tr>
<td>Calculate</td>
<td>If a calculation is performed on a compensation plan that includes locked periods, the locked periods within the plan will not be recalculated.</td>
</tr>
<tr>
<td>Add a member to a payee group</td>
<td>New members can be added to a payee group at any time.</td>
</tr>
<tr>
<td>Modify a calendar</td>
<td>Cannot edit time periods that have been locked.</td>
</tr>
<tr>
<td>Add a new record to a table in Composer</td>
<td>Prohibited from adding a record that contains a date in a locked period.</td>
</tr>
<tr>
<td>Create a new table</td>
<td>Period locking does not affect the creation of a new table.</td>
</tr>
<tr>
<td>Import data</td>
<td>Records containing dates that reside in a locked period will not be imported.</td>
</tr>
<tr>
<td>Edit Portal Access permissions</td>
<td>Locked periods do not affect edit Portal Access permissions.</td>
</tr>
<tr>
<td>Change the Portal Access tree</td>
<td>Editing Portal Access trees is still possible with locked periods.</td>
</tr>
<tr>
<td>Enable and disable a table for web edit</td>
<td>Tables can be enabled and disabled for web edit when periods have been locked.</td>
</tr>
<tr>
<td>Edit web edit permissions</td>
<td>Editing web edit permissions is still possible when periods have been locked.</td>
</tr>
</tbody>
</table>

**Period locking and calculation speed:**

Editing web edit permissions is still possible when periods have been locked in IBM Cognos Incentive Compensation Management.

Because period locking freezes calculated results for prior periods, using the Calculate module to update results will normally not calculate data in locked periods. By marking a large amount of the total system data as inactive, the number of active records included in a recalculation is reduced and, as a result, calculation time speeds up. You will notice that as the number of locked periods in your model increases, your calculation time will decrease.

**Period locking and calendar changes**

Each calendar in IBM® Cognos® Incentive Compensation Management is locked independently so that different companies or divisions can freeze their results at different times.
When you make calendar changes, you can move unlocked periods if the move
does not cause a period to go from locked to unlocked or vice versa. After a period
is locked, it cannot be moved.

Additionally, any new periods that are added to the calendar must be unlocked,
and a locked period can never exist after an unlocked period.

Adding periods to a locked calendar:

You should add periods to a calendar before you lock the final period in your
model in IBM® Cognos® Incentive Compensation Management. However, you can
add new periods to a locked calendar if necessary.

About this task

You can add periods to calendars after the periods are locked only if they contain
at least three hierarchies. You cannot add hierarchies to a locked calendar.

Procedure

1. Click Tools > Calendars.
2. Select the locked calendar and click Edit.
3. Click Next to proceed to step 2.
4. Right-click the node that you want to add levels to, and click Add.
   For example, add the next year to the calendar, and then add the next quarter
to the year.
   a. Type a Name for the level (for example, 2011), and click OK.

   Important: You can only add n-2 levels, where n is the number of
   hierarchies that you have. For example, if you have four hierarchies (such
   as, Total, Years, Quarters, and Months), you can add only two levels (Years
   and Quarters).
5. Click Previous to proceed to step 1.
6. Click Add to add a period.
   a. Type a Name for the period (such as 2011, Month 01).
   b. Select a Period Start date and a Period End date.
   c. Click OK.

Results

The new period moves to the newest level that you created.

Payee groups

IBM Cognos Incentive Compensation Management uses payee groups to reduce
the time spent setting up and maintaining each compensation plan.

The following list outlines the parts to each payee group:
1. The compensation plans.
2. The payee members belonging to each plan.
3. Any plan documentation the administrator has attached.
4. Any tailored reports that have been created for the payee group.
All compensation plans and tailored reports are created and edited in the Composer module and assigned to payee groups through the Compensation Plan and Tailored Report wizards. Payee group members and documents are managed in the Payee Groups window.

The individuals who will have their compensation calculated in the system (payees) can be added to a single group and, subsequently, a compensation plan may be added to the group to complete the setup process. You can then set up plans for large groups of people at the same time, rather than repeating the process for each individual.

Payees are frequently grouped by title. For example, if all salespeople receive five percent commission on everything they sell, every salesperson can be added simultaneously to a single payee group in the system. To complete the process, a compensation plan that specifies that each member of this group will receive a five percent commission can then be added. It is helpful to consider which payees might be grouped together prior to beginning the model creation process.

**Important:** Compensation plans themselves are composed of one (or more) calculations within the system.

**Adding a payee to a group**

Payees must be added to groups to view results on the IBM Cognos Incentive Compensation Management web client and to be part of an inquiry and sign off process.

**Procedure**

1. Go to **Tools > Payee Groups**.
2. Click Add.
3. Type a **Name** for the group, and click Next.
4. Add any tables to the Payee table to use as the source, and click Next.
5. Create restrictions to define exactly which members of the source will participate in the Payee group.
   - For example, to create a payee group that contains only Account Executives, you could define a restriction stating that only payees whose title ID = Account Executive should be included.
6. Click Next.
7. Select the payee group members.
   - Any members you have already selected through the restrictions window will automatically be shown in the selected payees pane.
8. To edit the Start Date and End Date for the payee, right-click the payeeID, and select Edit.
   a. Select the new **Starting** date or **Ending** date.
   b. Click OK.
9. Click Finish.

**Important:** A payee group can contain one or more compensation plans, as well as one or more payee members.

**Deleting a payee from a payee group**

Payees can be removed from a payee group in IBM Cognos Incentive Compensation Management.
Procedure
1. Go to Tools > Payee Groups.
2. Select a payee group, and click Edit.
3. In step 3 of the wizard, select the payee, and click Remove.

Important: This will only remove the payee from the payee group (not from the system).

Star schemas

In IBM® Cognos® Incentive Compensation Management, you can use star schemas to create OLAP cubes for performance analysis.

Star schemas facilitate the export of information to an external analytical software solution. You can create empty fact and dimension tables in Composer, and you can schedule imports in Scheduler. In this window, you can view star schemas and their tables, and you can add or remove a star schema.

The star schema consists of a fact table that references any number of dimension tables. The fact table holds the main data (for example, calculation results), and the dimension tables are joined to describe each value of a dimension. The results of calculations can be analyzed along multiple dimensions. Each dimension table has a single primary key. Fact tables have a compound primary key that consists of the aggregate of relevant dimension keys.

Related concepts:
“Access permissions” on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

Adding a star schema

You can add a star schema based on a fact table that references dimension tables in IBM® Cognos® Incentive Compensation Management.

About this task

Star schemas are created with data stores as of version 8.0.4. If you are upgrading a model that contains star schemas that were built with calculations, the star schemas will be deleted. You must re-create the star schemas with data stores instead.

Procedure
2. Click Add.
3. In the Star Schema Name field, type a name for the star schema.
4. From the Data Store menu, select a data store.
5. Click Finish.

Star schemas imports from Microsoft Excel

The IBM Cognos Incentive Compensation Management add-in for Microsoft Excel gives users an easy way to do self reporting using up-to-date results.
Users can import star schemas created in their model into Microsoft Excel using the IBM Cognos Incentive Compensation Management tab. The data can then be manipulated by creating pivot tables, charts, and graphs. If any changes are made to the model, the data in Microsoft Excel can be updated with the most recent data. Users can save their work in Microsoft Excel and reuse the same report sources and formatting. For more information on installing the IBM Cognos Incentive Compensation Management add-in for Microsoft Excel, see the IBM Cognos Incentive Compensation Management Installation and Configuration Guide.

Connecting to a model

Before you import data, you must enter the correct connection information on the IBM Cognos Incentive Compensation Management tab in Microsoft Excel.

Procedure

1. In Microsoft Excel, click the IBM Cognos Incentive Compensation Management tab.
2. Connect to your model by typing the Service Address, the Server, and the Database name.
3. Click Login Information, and type the user name and password that you use to connect to the Cognos Incentive Compensation Management client.
4. Click Import Star Schema to download data into Microsoft Excel from your model.

Important: You cannot import a star schema if you are already logged in to the client with the same login information that is used on the IBM Cognos Incentive Compensation Management tab in Microsoft Excel, or if you do not have permission to access star schemas.

Importing a star schema

After you are authenticated, you can select from a list of predefined star schemas created in IBM Cognos Incentive Compensation Management.

Procedure

1. To import a star schema into Microsoft Excel, click Import Star Schema.
2. Select a star schema to import from the list.
3. Click Import.
   The fact table and dimension tables are displayed in a Microsoft Excel spreadsheet.

Important: If you have not populated the star schemas using the Add Star Schema Population task in Scheduler, you will not see any data in Microsoft Excel.

4. You can use the data to create and format a report in Microsoft Excel.

Refreshing data

At any time, you can update the data in Microsoft Excel with the most recent data from the IBM Cognos Incentive Compensation Management database. If you are opening a previously saved report, you must log in to the model to refresh the data.

Procedure

1. To update the data, click Refresh.
2. To update the data in pivot tables, click Refresh and then click Refresh PivotTables.

### Changing the web client theme

The logo displayed in the web client can be customized from the Themes window in the IBM Cognos Incentive Compensation Management Client.

**Procedure**
1. Go to Tools > Themes.
2. Select the Enable Custom Header check box.
3. Browse for the image that you want.

**Important:** The image must be less than 250 pixels wide.
4. Select either Standard or salesforce.com for the web client theme.
5. Click OK.

**Related concepts:**
- "Access permissions" on page 288

When a user role is given access to a module in IBM® Cognos® Incentive Compensation Management, certain access rights or privileges go along with the module or feature.

### Turning off the warning message when deleting rows in tables that are pick listed by other tables

You can turn off the warning message that is normally received when rows are deleted from a table with a pick list column in IBM® Cognos® Incentive Compensation Management.

**Procedure**
1. Click Tools > User Preferences.
2. Clear the Warn before deleting rows in a table that may affect one or more other tables check box.
3. Click OK.
Chapter 32. Migration

If there are no conflicts, you can migrate IBM® Cognos® Incentive Compensation Management model elements, along with dependent objects, between models of the same version number.

The following list contains the objects that you can select during migration:
- Composer
- Individual components
- Process lists
- Saved imports
- Portal Access trees
- Roles
- Users
- Workflow Manager workflows
- Web tabs
- Web form filters
- Calendars

Migration between models is done by pulling the data from the source model to your current working model (target model).

The migration process migrates only the selected items, so you must use remapping to resolve dependencies. During migration, you can remap items that are used outside of a component to matching local items. If there is no matching local item, migration cannot proceed.

To ensure that all dependencies are migrated, click the Select Dependencies button in the Migration wizard.

Tip: Individual tables, reports, and calculations cannot be selected in the Migration wizard. To migrate an individual model element, wrap the item into a component and migrate the component.

General practice and rules for migration

In general, migration conflicts are determined and managed based on the name of an object in IBM® Cognos® Incentive Compensation Management. If an object in the source model has the same name as an object in the target model, the object exists in both models, regardless of the object’s composition.

The following list describes general practices and rules for migration:
- If an object from the source model does not exist in the target model, it is created in the target model during migration.
- If an object with the same name exists in both models, and there are no conflicts, it can be migrated.
- If the target model has an item with the same name as an item in the source model and you select the Replace conflicts option, the target model item is overwritten by the source model item during migration.
• If an item exists in the target model, but does not exist in the source model, it is deleted during migration. For example, if you are migrating a component that exists in both the target model and source model, any elements inside the target model component that do not exist in the source model component are deleted.

**Rules for migrating Composer**

If you choose to migrate all of the IBM Cognos Incentive Compensation Management Composer module, then the Composer module in the target model will match the Composer module in the source model exactly after migration is complete.

This means that elements not present in the target model will be added, and any elements that exist in the target model but not in the source model will be deleted. If you want elements in the target model that are not in the source model to remain after migration, it is a good idea to migrate specific components only and not the entire Composer module.

• If the source and target model contain the same table in two different components, it will produce a conflict.

**Important:** If a table is global in both source and target models but exists in different components, there will be no conflict during migration. The global table will stay in the same component in the target model after migration completes.

• When migrating all of Composer, calculations, web forms, Presenter reports, tailored reports, and compensation plans that exist in both models will remain in the same components as the source model after migration and overwrite any objects with the same name in the target model.

• Migration will add columns to tables if needed but will not add key columns or remove columns. If key columns need to be added to a table, it will produce a conflict.

**Rules for migrating components**

There are a few rules you should know when migrating components in IBM Cognos Incentive Compensation Management.

• All sources for connections must exist somewhere in the target model. If the sources for the connections in a component cannot be remapped to sources in the target model, there will be a conflict. For example, if you try to migrate a component containing only a report and the report source does not exist in the target model, the migration will not complete.

• When migrating specific components, any object that exists in the component in the source model but exists in a different component in the target model will be listed as conflicted. You can avoid this by migrating a mutual parent component of both components, such as Composer.

• When migrating a component that exists in both the source and target model, everything inside the component in the target model will be replaced with everything inside the component from the source model. This includes deleting objects in the target model component that do not exist in the source model component.

**Rules for migrating tables with pick lists**

When you migrate tables with pick lists in IBM Cognos Incentive Compensation Management, you must follow certain rules to ensure success.
The following list describes rules for migrating tables with pick lists:

- If a table with a pick list is migrated along with the structural table that it pick lists to, or the structural table exists in the target model, migration completes successfully.
- If a table with a pick list is migrated without the structural table that it picks from, it can be migrated if there is a corresponding structural table in the target model with the same column structure, even if the table name is different. The migration process remaps the pick list to the new structural table as long as it has the same global setting as the table in the source model and the same column structure.
- If a table with a pick list is migrated without its structural table and an appropriate structural table does not exist in the target model, the structural table appears as a conflict.

**Rules for migrating global tables**

When you migrate global tables in IBM® Cognos® Incentive Compensation Management, you must follow certain rules to ensure success.

The following list describes rules for migrating global tables:

- If a table is local in the source model but global in the target model, it appears as conflicted during migration.
- If a table is global in the source model but local in the target model, it is made global in the target model. However, if the table is used by connections on the same level in the target model, it appears as conflicted.
- If a component has a connection with the same name as a global table in the target model, the connection appears as conflicted during migration.
- If a component exists in both the source and target model but the component in the target model contains a global table, the global table is deleted unless objects outside the component use the table as a source.
- If a global table exists in different components in the source and target model, the global table remains in the same component as the target model after migration.

**Rules for migrating web forms and Presenter reports**

When you migrate web form and Presenter reports in IBM® Cognos® Incentive Compensation Management, you must follow certain rules to ensure success.

The following list describes rules for migrating web forms and Presenter reports:

- If a component is migrated that contains a Presenter report or web form that links to another report or web form, the linked report or web form must exist in the target model or be part of the migration.
- If you migrate a component that will delete a Presenter report or web form in the target model component that is linked to another report or web form, the report that would be deleted appears as invalid.
- If you migrate a web form that passes a filter value to a Presenter report parameter that does not exist in the target model’s Presenter report, the report appears as invalid.

**Rules for migrating web form filters**

When you migrate web form filters in IBM® Cognos® Incentive Compensation Management, you must follow certain rules to ensure success.
The following list describes rules for migrating web form filters:

- Web form filters do not overwrite web form filters with the same name in the target model.
- If the table that the web form filter uses does not exist anywhere in the target model or is not included in the migration, the table that the web form filter uses is listed as conflicted.

Rules for migrating web tabs

When you migrate web tabs in IBM® Cognos® Incentive Compensation Management, you must follow certain rules to ensure success.

The following list describes rules for migrating web tabs:

- Items that are used by web tabs are not deleted when Replace conflicts is selected (delta migration).
- Migrating web tabs from the source model always creates new tabs in the target model. Since web tabs can have the same name, there is no conflict when a web tab with the same name as an existing web tab is migrated into a model.
- Migrating web tabs does not automatically include items that are used by them. To migrate dependent items, select the Select Dependencies check box.
- Web tabs can have the same name.

Important: If you want to overwrite existing web tabs in the target model with web tabs with the same name in the source model, you must delete the web tabs that you want to overwrite in the target model before migration.

Rules for migrating process lists

When you migrate process lists in IBM® Cognos® Incentive Compensation Management, you must follow certain rules to ensure success.

The following list describes rules for migrating process lists:

Delta migration of process lists (Replace Conflicts)

When you migrate a process list, if a process list of the same name exists in the target model and the Replace conflicts check box is selected, the process list in the destination model is overwritten. If two or more process lists in the destination model have the same name as the process list that you are trying to migrate (while Replace conflicts is selected), no process list in the destination model is overwritten and an invalid status is displayed. If Replace conflicts is not selected, a new process list is created and no overwriting occurs.

Migrating process list links

When process list tasks are linked to other objects such as components, input forms, Presenter reports, web forms, and tables, links are maintained during migration when possible. If the object that the task links to is being created by the migration or exists in the destination model, the links are maintained as expected. If the linked object does not exist in the destination model, it is then up to you to remap the invalid links. If links are left as invalid, the following message is displayed from the Home page: "This item is no longer available." When process lists link to objects, the following rules govern the possible migration outcomes.

- If the object exists in the target model (same name, type) and that linked object is being migrated, the link is maintained.
• If an object (that is linked to by a process list task) does not exist in the target model but will be created by migration, the task link is maintained. In the remapping window, the task link appears next to the object that it is linked to.

• If an object (that is linked to by a process list task) exists in the target model but will be deleted by migration, or does not exist in the target model and will not be created by migration, the process list's status appears as Needs Review. If you double-click the process list, the remapping window opens. In the remapping window, any links to objects that exist in the source model that do not exist in the target model appear in red. You can remap these links or finish the migration with invalid links.

**Important:** Process list task links work based on name and object type only. When you migrate a process list that has task links, the migration process tries to maintain those links by associating the links with objects in the target model of the same name and type, regardless of component or structure.

**Remapping links during migration**

During migration, you can remap a process list’s task links from the process list page of the Migration wizard. When you double-click any process list, a remapping page opens, regardless of status.

• On the remapping page, you can see a list of all of the tasks in the process list. Next to each task, you can see the destination model object that the task is linked to.

• On the right side of the window, you can see a list of local sources and actions. From the Choose Task Link menu, you can filter the list of local sources by selecting the type of source that you want to view. From the Choose Link Actions menu, you can select the type of action that you want to be performed when the link is clicked. You can then drag any object from the local sources list over to the left to associate that object with a process list task.

• When migration completes, each process list task is linked to the object that it is mapped to on this window, regardless of what the task was linked to in the source model.

**Removing links during migration**

To remove a link during migration without having to remap it to a different task, click and hold the invalid linked object (the one in red), and drag it to the pane on the right side of the window. When the box that contains the name of the linked object becomes empty, the link is cleared.

**Remapping link actions during migration**

During migration, you can remap the action that is selected for a process list’s task link from the process list page of the Migration wizard.

**Rules for migrating Workflow Manager workflows**

When you migrate Workflow Manager workflows in IBM® Cognos® Incentive Compensation Management, you must follow certain rules to ensure success.

The following list describes rules for migrating Workflow Manager workflows:

• The target model must contain a Payee and Title table that has the same columns and global table status as the Payee and Title in the source model.
- The Presenter reports that are associated with the workflows must be migrated along with the workflows, or they must exist in the target model.
- Any Scheduler processes that are associated with process nodes in workflows can be remapped to Scheduler processes that exist in the target model. If you double-click any process node, the Remapping wizard opens, regardless of its status.
  - On the remapping page, you can see a list of all the Scheduler folders.
  - You can select the Scheduler folder that you want to associate with the process node, and click OK.

**Objects that cannot be migrated**

Some objects in IBM® Cognos® Incentive Compensation Management cannot be migrated. These items must be created manually in the target environment by following the same steps that were used to create them in the source environment.

**Portal Access tree assignments**

Workflow groups and trees can be migrated, but the assignment of the trees for web access security, inquiries, or approvals must be done manually in the Portal Access module.

**Portal Access group members**

Because migration brings over structures and not data, Portal Access groups are not populated with any members after a migration. However, if they were created with the **Maintain this group in task manager** option selected, you can generate tasks in Task Manager and then run each task to add the appropriate payees to their respective groups.

**Web-enabled groups**

After you use Task Manager to populate Portal Access groups with members, you might or might not need to web-enable certain groups, depending on whether they were used to populate Portal Access trees that define your web security.

**Import connection strings**

After imports are migrated, the connection strings for each import must be modified to reflect the data sources of the new environment.

**Import schedules**

After imports are migrated and connection strings are modified, any scheduled imports must be rescheduled in the Scheduler module.

**Themes**

Personalized client themes must be reconfigured.

**Saved publications**

Saved publications must be re-created and possibly rescheduled.

**Admin options**

Options that were selected in the **Admin Options** menu must be reconfigured manually in the target system.

**Performing a migration**

You can select elements from a source model to move to a destination model in IBM® Cognos® Incentive Compensation Management.
Procedure

1. Click **Tools > Migration**.

   **Tip:** You can access help for migration by pressing the F1 key.

2. To specify the model that you want to pull data from, use the menu to select the source model.

3. Type your **User ID** and **Password**. To connect to the source model, you must use the administrator role user ID and password.

4. Click **Connect**.
   A list of available objects that can be migrated or pulled into your current model is displayed.

5. Select the elements to migrate.

6. You can click the **Select Dependencies** button to automatically select all items in the source model that an object depends on. This step ensures that all dependent objects are migrated. If this option is not selected, you must use remapping to resolve dependencies. During migration, you are prompted to remap items that are used outside of a component to matching local items. If there is no matching, local item, migration cannot proceed.

7. You can select the **Replace conflicts** check box to overwrite objects with the same name in the target model with those from the source model.
   If this option is not selected, overwriting does not take place and migration cannot proceed if there are conflicts. For example, if two calculations have the same name but their formulas are different, or if they have different sources, the **Replace Conflicts** feature replace the calculations in the destination model with the calculations in the source model.

8. Click **Migrate**.

9. Click **Next** to scroll through the plan components.
   The next series of windows in the Migration wizard display migration statuses for all components of the selected objects.

Table 49. Migration wizard screens

<table>
<thead>
<tr>
<th>Migration Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>The object does not exist in the destination model. The new object is migrated from the source model to the destination model.</td>
</tr>
<tr>
<td>Exists</td>
<td>The object exists in the destination model. There are no conflicts that prevent migration.</td>
</tr>
<tr>
<td>Conflicted</td>
<td>The object exists in the destination model and there are conflicts. Conflicts must be resolved before the migration can take place. If a calculation is listed as conflicted because the calculation in the target model is locked and has a different start date than the calculation in the source model, you can choose to ignore the conflict and proceed with the migration.</td>
</tr>
<tr>
<td>Overwriting</td>
<td>The object exists in the destination model and is different from the source model. The migration process replaces the object in the destination model with the changed object in the source model. Overwriting occurs only if the <strong>Replace conflicts</strong> option is selected.</td>
</tr>
<tr>
<td>Deleting</td>
<td>The object exists in the target model but not in the source model and is removed during migration.</td>
</tr>
<tr>
<td>Needs Review</td>
<td>This status is used for process lists only. The process list contains links to objects that do not exist in the destination model. You can remap those links by double-clicking the process list name or finish the migration with invalid links.</td>
</tr>
</tbody>
</table>
a. For an element to be eligible for migration, none of its objects can be labeled as Conflicted. If there is a conflict, double-click the item to view its cause and resolve it before migration can continue.

b. To copy a migration window, right-click the window and click Copy. The name and status of every object that is migrated, as well as the conflict details message for every object that is invalid, conflicted, modified, overwritten, or required, is copied.

c. For process list migration, if the status is labeled as Needs Review, double-click the name of the process list to remap links. On the remapping screen, links to objects that exist in the source model but not in the target model appear in red. To remap, drag the item that you want to link to from the Local Targets column to the Imported Targets list.
   - Local Targets are objects that exist in the target model that process list tasks can link to.
   - Imported Targets are objects from the source model that process list tasks will be linked to after migration. When imported targets are displayed in red, the links are broken and must be replaced with a valid local target.

10. Click Finish to perform the migration.

### Migrating individual Composer objects

You can move specific objects, such as Presenter reports, calculations, and tables in Composer, from one model to another in IBM® Cognos® Incentive Compensation Management.

**Procedure**

1. In the source model, right-click the Presenter report, calculation, or table that you want to migrate to the target model, and click Wrap.

   **Important:** Compensation plans, tailored reports, and web forms cannot be wrapped without also wrapping their sources.

2. Name the component and click OK.

3. In the target model, click Tools > Migration.

4. In the Migration window, connect to the source model.

5. Expand Composer.

6. Select the component that contains the object that you want to migrate.

7. Select the Replace conflicts check box.

8. Click Migrate.

### Migration methodology and approach

Plan migrations properly in IBM® Cognos® Incentive Compensation Management to reduce the risk of failed or incomplete migrations. After migrations are complete, validate to ensure that the migration was successful.

Do not assume that a migration is successful without testing and verifying.

You must follow several main steps for each phase of the migration:

1. Plan.
   - Determine migration requirements.
Planning phase

Follow certain steps to plan a migration in IBM® Cognos® Incentive Compensation Management.

At a high level, the following steps describe how to plan a migration:

1. Determine migration requirements.
2. Identify migration environments.
3. Create migration plan.
4. Create migration procedures.
5. Create a migration schedule.
6. Create Migration log.
7. Develop test plan.

The amount of planning depends on the size and scope of the migration. The planning process generally involves determining the requirements of the migration, identifying the source and target environment, and documenting the migration plan. During the planning stage, a determination of the migration requirements includes identifying the environments that are involved in the migration. If there are more than two environments, there must be a determination of which environments act as sources to the other environments and in which order the migration must occur. The user who has the correct role and privileges to run the migration between the environments also must be identified.

The migration procedure details the steps to take to accomplish the migration. This procedure involves taking screen captures of the Migration wizard and listing which items to select and in which order. The migration procedure must also include any manual steps that are needed to complete the migration. Some items cannot be migrated by using the migration tool. List out these items to make sure that they are accounted for in your deployment plan, with specific manual steps to replicate them in the source system.
Migration planning can also help define which items to migrate first, whether it is necessary to take applications offline, and which internal and external audiences must be informed regarding the migration. Proper migration planning involves more than just the information technology (IT) staff. The business owners of the applications must also be included, particularly because the IT organization determines how important a particular application or set of data is to the business.

In planning a migration, it is important to understand migration requirements such as source and target environments, time schedule, users who are involved, and the configuration of the software. In looking at the time schedule, the IT organization must create estimates for planning, setup time, migration time, and production cutover. Planning typically accounts for 25 percent of the total schedule.

Table 50. Example of migration plan

<table>
<thead>
<tr>
<th>Action item</th>
<th>Assigned to</th>
<th>Status</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establish a migration management team.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gather availability and production schedules.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document change control procedures so that they can be incorporated into the migration procedures and plans.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document the timeline for activities for both hardware changes and data migration.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Announce the migration at least 30 days before the intended target migration date.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a technical migration team.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inform the security and compliance groups about the migration.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule a pre-migration rehearsal that includes all the members of the migration team and a data sampling that helps the application groups to conduct the pre-migration and post-migration verification process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Follow the required change control process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Establish a migration status call-in process.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use a migration planning checklist to ensure that all the pre-migration planning steps are completed.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following schedule is an example for a simple data migration:

- Planning: two days
- Setup: two hours
- Migration: two hours and 30 minutes for one server
- Production cut over: minimal, performed in offline mode
- Migration team on site: eight hours
- Post-migration validation: two hours

A Migration log identifies objects that must be migrated to the target system and that were tested during and after development by using standard development life cycles and methodology. For example, if you are developing 10 new plans and five new reports for a new fiscal year, you must have a log that identifies those 15 new
objects, their names, if they were fully tested, when they passed testing, and who created or tested those objects. This list is used as a checklist for post-migration validation.

*Table 51. Example of Migration log*

<table>
<thead>
<tr>
<th>Item to be migrated</th>
<th>Assigned to</th>
<th>Status</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component: Quarterly Sales Bonus</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Component: Annual MBO Bonus</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Report: Finance Accruals</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Saved Imports: Payee Promotion History</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
<tr>
<td>Web Form: Revenue Split Approval</td>
<td></td>
<td>Ready to Migrate</td>
<td></td>
</tr>
</tbody>
</table>

You must develop a test plan to validate that all migrated objects are integrated properly into the new target environment and that they work. This test plan is similar to a system integration test (SIT), but at a more granular level for each item that is migrated.

**Migration phase**

There are a few steps you should take to perform the migration in IBM Cognos Incentive Compensation Management.

- Communicate migration and deployment plan.
- Customize any migration procedures.
- Run pre-validation test.
- Back up both source and target models.
- Perform migration.

During the migration phase, the migration team will need to communicate its plans; review and customize any migration procedures, such as manual steps required or not required due to migration limitations; back up all source and target systems; and perform the actual migration. A pre-migration validation test is recommended, in addition to post-migration validation testing. These tests confirm that the objects being migrated are in the same state after the migration as they were before.

The most important part of this stage is the migration itself. In addition to using the Cognos Incentive Compensation Management migration tool, the deployment plan should be followed step-by-step to ensure a successful migration. While the migration tool automates migration of most objects within the model, the key steps to emphasize in the deployment plan are the items which are not automatically migrated by the tool. These items will need to be replicated manually in the target model.

If this is not the first time you have migrated from one environment to another, some of these manual items may have been migrated in the past and may not have changed, or are not items identified in the Migration log to be migrated. This is
where customization of the migration procedure in the deployment plan is necessary. You would identify what items to remove or add to account for objects that cannot be migrated.

**Validation phase**

Follow certain steps to validate a migration in IBM® Cognos® Incentive Compensation Management.

At a high level, the following steps describe how to validate a migration:

- Verify migration completion with the Migration log.
- Run a post-migration test.
- Communicate project information.
- Conduct a migration closeout meeting.
- Perform knowledge transfer.

The items that are being migrated from the source systems must be tested before you plan a migration. Also, a test plan must be in place post-migration that involves validating that the items from the Migration log were migrated and that each one is integrated properly into the new environment.

Testing is especially critical in production environments where poorly tested migrations might cause trouble for users. When you migrate to a UAT environment that is mirrored with a production environment, you can do proper testing and catch any processes from the migration plan that were missed.

After the migration is complete, the team should compile migration statistics and prepare a report to highlight what worked, what did not work, and lessons learned. The report should be shared with all members of the migration team. These types of reports are critical in building a repeatable and consistent process through continuous process improvement—building on what worked and fixing or changing what did not work. Further, documenting the migration process can help train staff and simplify or streamline the next migration, reducing both expense and risk.

**Configuration-only models**

A configuration-only model is an intermediate model between the source environment and the target environment in IBM® Cognos® Incentive Compensation Management. It is a dedicated model that is used for migrations only.

The purpose of the configuration-only model is to validate the migration process. This model contains only build components such as Composer, Portal Access, Scheduler, and Saved Imports. There is no transaction data in this model, and it might or might not have minimal supporting data, such as populated reference tables that are identical and static in all environments.

In some large and complex enterprise models, having a configuration model is the only way to ensure a clean and controlled migration process. For example, the configuration-only model sits between the source development environment and the target environments (UAT, SIT, Performance, Data Integration, and Production).

**Pros and cons of configuration-only models**

There are pros and cons to working with configuration-only IBM Cognos Incentive Compensation Management models.
The following examples are some of the pros of a configuration-only model:

- Clean controlled migration process
- Portability - database footprint is small (easy to send to support for troubleshooting in case of failed migration)
- Seed environment - creation of a model is fast and easy and great as a seed for other environments
- A clean model is maintained

The following examples are some of the cons of a configuration-only model:

- Overhead - extra time required for migration process as well as creation of initial support data
- One extra model for maintenance

**Keys for success**

Using the configuration-only IBM Cognos Incentive Compensation Management model requires careful planning and practice to ensure success.

Migration plans and procedures need to be developed and reviewed periodically for completeness. Developing a plan and list of procedures is required for migrating to the configuration only model as well as from the configuration model to other target models. Discipline in this process and over communication to the teams involved is the main criteria for success.

**Change management**

After IBM Cognos Incentive Compensation Management has been implemented and all the environments have been synchronized, you will need to manage future changes to all the environments.

The following scenarios outline where change is typically required.

*Table 52. Change management*

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Required changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>New year, new plans</td>
<td>New plans are designed by management for the new year and need to be implemented.</td>
</tr>
<tr>
<td></td>
<td>Compensation business rules have changed.</td>
</tr>
<tr>
<td>Build in development</td>
<td>Data structures have been validated for new rules.</td>
</tr>
<tr>
<td></td>
<td>Design of calculations and additional components, reports, and so on.</td>
</tr>
<tr>
<td></td>
<td>Build new components and items.</td>
</tr>
<tr>
<td>Migrate to configure-only model</td>
<td>Prepare migration validation test plan and scripts.</td>
</tr>
<tr>
<td></td>
<td>Prepare migration plan and procedures.</td>
</tr>
<tr>
<td></td>
<td>Communicate to migration team.</td>
</tr>
<tr>
<td></td>
<td>Migrate and execute validation test.</td>
</tr>
<tr>
<td>Scenario</td>
<td>Required changes</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Migrate to QA or UAT</td>
<td>Prepare migration validation test plan and scripts.</td>
</tr>
<tr>
<td></td>
<td>Prepare migration plan and procedures.</td>
</tr>
<tr>
<td></td>
<td>Communicate to migration team.</td>
</tr>
<tr>
<td></td>
<td>Migrate and execute validation test.</td>
</tr>
<tr>
<td>Migrate to production</td>
<td>Prepare migration validation test plan and scripts.</td>
</tr>
<tr>
<td></td>
<td>Prepare migration plan and procedures.</td>
</tr>
<tr>
<td></td>
<td>Communicate to migration team.</td>
</tr>
<tr>
<td></td>
<td>Migrate and execute validation test.</td>
</tr>
<tr>
<td>Communication</td>
<td>Communicate changes to sales field.</td>
</tr>
<tr>
<td></td>
<td>Train necessary support team and users.</td>
</tr>
</tbody>
</table>
Appendix. Accessibility features

IBM Cognos Incentive Compensation Management has accessibility features that help users who have a physical disability to use the product.

Keyboard shortcuts

IBM Cognos Incentive Compensation Management includes keyboard shortcuts to help you navigate the product and perform tasks.

The following keyboard shortcuts are based on U.S. standard keyboards.

Table 53. General keyboard shortcuts in the Cognos Incentive Compensation Management client

<table>
<thead>
<tr>
<th>Applies to</th>
<th>Action</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tabs</td>
<td>Close the tab you are currently viewing.</td>
<td>Ctrl + w</td>
</tr>
<tr>
<td>Tabs</td>
<td>Close the tab your cursor is hovering over.</td>
<td>Middle mouse click</td>
</tr>
<tr>
<td>Tabs</td>
<td>View the next opened tab.</td>
<td>Ctrl + tab.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Open the previous tab.</td>
<td>Ctrl + shift + tab</td>
</tr>
<tr>
<td>Scrolling (in Composer only)</td>
<td>Move the Composer diagram.</td>
<td>Middle mouse click + drag</td>
</tr>
</tbody>
</table>

Table 54. General keyboard shortcuts in the Cognos Incentive Compensation Management web client

<table>
<thead>
<tr>
<th>Applies to</th>
<th>Action</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Perform the command for an active command button.</td>
<td>Enter</td>
</tr>
<tr>
<td>General</td>
<td>Move forward to the next item in the tab index order. Cycle to the first tab index when at the end.</td>
<td>Tab</td>
</tr>
<tr>
<td>General</td>
<td>Move backward to the previous item in the tab index order. Cycle to the last tab index when at the beginning.</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Check boxes</td>
<td>Select or clear the checkbox.</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Menus</td>
<td>Navigate down a menu and select a menu item.</td>
<td>Down arrow and then Enter</td>
</tr>
<tr>
<td>Menus</td>
<td>Navigate up a menu and select a menu item.</td>
<td>Up arrow and then Enter</td>
</tr>
<tr>
<td>Scrolling</td>
<td>Scroll down.</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Scrolling</td>
<td>Scroll up.</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Zooming</td>
<td>Zooming in.</td>
<td>Ctrl and +, or Ctrl+Mouse wheel up</td>
</tr>
<tr>
<td>Zooming</td>
<td>Zooming out.</td>
<td>Ctrl and -, or Ctrl+Mouse wheel down</td>
</tr>
<tr>
<td>Zooming</td>
<td>Return to default zoom level.</td>
<td>Ctrl+0</td>
</tr>
<tr>
<td>Navigation</td>
<td>Reload the current page.</td>
<td>F5</td>
</tr>
</tbody>
</table>
Table 54. General keyboard shortcuts in the Cognos Incentive Compensation Management web client (continued)

<table>
<thead>
<tr>
<th>Applies to</th>
<th>Action</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation</td>
<td>Move backward to the previously opened page.</td>
<td>Alt+Left Arrow, Backspace</td>
</tr>
<tr>
<td>Navigation</td>
<td>Move forward to the previously opened page.</td>
<td>Alt+Right Arrow, Shift+Backspace</td>
</tr>
<tr>
<td>Navigation</td>
<td>Stop a page from loading.</td>
<td>Escape</td>
</tr>
<tr>
<td>Search</td>
<td>Open a search box to perform a search on the current page.</td>
<td>Ctrl+F, F3</td>
</tr>
<tr>
<td>Search</td>
<td>Find the next match of the searched text on the current page.</td>
<td>Ctrl+G, F3</td>
</tr>
<tr>
<td>Search</td>
<td>Find the previous match of the searched text on the page.</td>
<td>Ctrl+Shift+G, Shift+F3</td>
</tr>
</tbody>
</table>

IBM and accessibility

See the IBM Accessibility Center for more information about the commitment that IBM has to accessibility.

The [IBM Accessibility Center](http://www.ibm.com/able) is available online.
Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group  
Attention: Licensing  
3755 Riverside Dr.  
Ottawa, ON  
K1V 1B7  
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
This Software Offering does not use cookies or other technologies to collect personally identifiable information.

**Trademarks**

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “[Copyright and trademark information](http://www.ibm.com/legal/copytrade.shtml)” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.
- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
Glossary

This glossary includes terms and definitions for IBM Cognos Incentive Compensation Management.

The following cross-references are used in this glossary:
• See refers you from a term to a preferred synonym, or from an acronym or abbreviation to the defined full form.
• See also refers you to a related or contrasting term.

To view glossaries for other IBM products, go to www.ibm.com/software/globalization/terminology (opens in new window).

A

Active Directory (AD)  
A hierarchical directory service that enables centralized, secure management of an entire network, which is a central component of the Microsoft Windows platform.

AD  See Active Directory

administrator  
A person responsible for administrative tasks such as access authorization and content management. Administrators can also grant levels of authority to users.

aggregate  
A calculation that returns a single result value from several relational data rows or dimensional members. Typical examples are total and average.

allocated adjustment  
An adjustment to the results of the difference between the original value calculated for a closed period and the value that would be currently calculated based on the new data.

application server  
A server program in a distributed network that provides the execution environment for an application program.

attribute  
In markup languages such as SGML, XML, and HTML, a name-value pair within a tagged element that modifies features of the element.

C

calculation  
The process used to transform a series of records into a new result. Typically a calculation is mathematical, but may also include sorting, shifting, or adding to a prior result. Calculations enable the model admin to select records from their source data, perform operations on the data, segment results, and begin another calculation based on those results.

certificate  
In computer security, a digital document that binds a public key to the identity of the certificate owner, thereby enabling the certificate owner to be authenticated. A certificate is issued by a certificate authority and is digitally signed by that authority.

component  
A container that is used to organize a model. When creating a new model, components should be created first, in order to give the model a framework and ensure that it is easy to navigate. Once components have been created, model elements, such as tables, calculations, and plans can be built.

configuration file  
A file that specifies the characteristics of a program, system device, system, or network.

D

database (DB)  
A collection of interrelated or independent data items that are stored together to serve one or more applications. See also database server

database server  
The server on which the database application and database are installed.
database

delimiter
A character, such as comma or tab, used to group or separate units of text by marking the boundary between them.

digital certificate
An electronic document used to identify an individual, a system, a server, a company, or some other entity, and to associate a public key with the entity. A digital certificate is issued by a certification authority and is digitally signed by that authority.

dimension table
The representation of a dimension in a star schema. Each row in a dimension table represents all of the attributes for a particular member of the dimension.

fact table
A relational table that contains facts, such as units sold or cost of goods, and foreign keys that link the fact table to each dimension table.

inbound connection
A resource that is used to import data from selected outbound connections to a component. They are created to specify which component the selected outbound component should connect to.

join
An action that combines records from two or more tables or calculations based on a point of commonality. Joins are produced by adding columns to the initial data source.

LDAP

Lightweight Directory Access Protocol (LDAP)
An open protocol that uses TCP/IP to provide access to directories that support an X.500 model and that does not incur the resource requirements of the more complex X.500 Directory Access Protocol (DAP). For example, LDAP can be used to locate people, organizations, and other resources in an Internet or intranet directory.

manual adjustment
A one-time change to a value that is applied in specific scenarios. Administrators can add manual adjustments to any payee for any open period.

optimization
The process of achieving improved runtime performance or reduced code size of an application. Optimization can be performed by a compiler, by a preprocessor, or through hand tuning of source code.

outbound connection
A resource that is used to export calculation results or table data from a component. They are created from tables, calculations, and other sources.

parameter (parm)
A value or reference passed to a function, command, or program that serves as input or controls actions. The value is supplied by a user or by another program or process. See also configuration file.

parm
See parameter.

partition
The division of a single calculated result into sub-results. Partitions are used to define how the results of the calculation will be displayed. For example, if the partitioning is by payee ID, the calculation results will show the calculated amount for each payee.
payee  An individual who is being compensated or is approving the compensation results.

period  A date interval that reported values are saved in. An example of a period is December 2000.

pick list  A list of cell values available to a user when entering data into a cell.

primary key  An object that uniquely identifies an entity bean of a particular type.

query  A request for information from a database that is based on specific conditions: for example, a request for a list of all customers in a customer table whose balances are greater than USD1000.

root certificate  The certificate (proof of identity and keys) of the original trusted signer or certificate authority that certifies the authenticity of the end user/entity (or of intermediate signers).

server  A software program or a computer that provides services to other software programs or other computers.

server certificate  An electronic stamp stored in the server's key ring file that contains a public key, a name, an expiration date, and a digital signature. The server certificate uniquely identifies the server.

single sign-on (SSO)  An authentication process in which a user can access more than one system or application by entering a single user ID and password.

SQL  See Structured Query Language.

Structured Query Language (SQL)  A standardized language for defining and manipulating data in a relational database.

V

validation rule  A rule defined on an attribute definition that specifies the criteria that must be met by the data stored in an instance of this attribute for that attribute to be valid.

view  A virtual table that is created by joining two or more tables together. Views can also include the results of calculations.

W

web application server  The runtime environment for dynamic web applications. A Java™ EE web application server implements the services of the Java EE standard.

web client  An interface where payees can review and approve their compensation payments via a web browser. The Cognos ICM web client runs on a variety of servlet containers.

web server  A software program that is capable of servicing Hypertext Transfer Protocol (HTTP) requests.

workflow  The sequence of activities performed in accordance with the business processes of an enterprise.
Index

A
Accounts table 43
  viewing as hierarchy 48
Action Node Errors log 224
  action nodes
    resolving errors 224
Action nodes
  adding 220
  activities
    copying error details 79
    deleting 79
    overview 79
    viewing 79
    viewing error details 79
Activity tab
  overview 79
adjustments
  adding 144
  adding categories 143, 278
  adding manual 279
  associated with calculation speed 143
  generating reports 278
  manual 144
  overview 143
  Payee Ledger 278
  Payee Ledger reports 145
  start and end dates 145
  viewing 278
  viewing in the web client 146
  when appropriate 143
  when not appropriate 145
administration
  permission to add documents to the Manage Documents window 319
  permission to delete saved imports 318
  permission to delete saved publications 318
  permission to delete saved transformations 319
  permission to edit administrative options 317
  permission to edit saved imports 318
  permission to edit saved publications 318
  permission to edit saved transformations 319
  permission to run saved imports 317
  permission to run saved publications 318
  permission to view administrative options 317
  permission to view saved transformations 319
  security overview 317
administrators
  approving web data edits 63
Adobe Acrobat
  See PDF files
Alert nodes
  adding 219
alerts
  activating for payees 265
  configuring the Report Name with Link variable in an alert node 220
  disabling for payees 265
  enabling in tailored reports 141
  overview 265
Anchor feature 90
AND or OR groups
  adding 103
  overview 103
Audit log
  as data source 171
  exporting 269
  filtering results 269
  overview 267, 268
  permission to use as source in Presenter 312
  removing old entries from 269
  Scheduler errors 259
  viewing details of table edits 269
  viewing workflow events in 224
Audit module
  overview 267
  permission to edit 315
  permission to view 314
  security overview 314

B
BPM
  See Workflow Manager
breadcrumbs 28

C
calculated values
  adding 170
calculations
  accumulated partitioning 100
  adding category 106
  adding columns 87
  adding data sources by rows 93
  adding for plans 249
  adding for Presenter reports 250
  adding left outer join in 91
  adding rows 92
  adding sort 104
  adding sources by columns 89
  adding time shift 105
  adding to compensation plans 136
  adding to compensation reports 140
  adding to process folders 249
  adding user-defined 103
  adjustments 143, 283
  Anchor feature 90
  canceling 282
  changing icon size 86
  clearing the Computation log 283
  copying 112
  copying and pasting categories in 107
  data sources for 86
  defining partitions in 101
  defining restrictions for 102
  deleting restrictions for 103
  draw 119
  editing 112
  editing locked 112
  empty partitions 100

© Copyright IBM Corp. 2005, 2015
calculations (continued)
  enabling data tier performance optimization 284
  enabling incremental 283
  filtering 110
  for tailored reports 250
  formatting formulas 98
  formula operators 94
  formulas 94
  icons 86
  increasing speed of 283
  incremental 283
  joining sources automatically 92
  multiple sources 87
  overview 85, 281
  partitions 99
  previewing 93, 109
  publishing 113
  publishing to Microsoft Dynamics CRM database 113
  publishing to Microsoft Excel file 113
  publishing to PDF file 114
  publishing to Salesforce.com 114
  publishing to text file 114
  purging data 22
  renaming joined source 91
  restrictions 101
  running individual 109
  security overview 316
  shortcut keys 87
  speed 283
  speed with period locking 338
  starting 282
  statistics 284
  summary of 283
  switching joined source 92
  types 85, 281
  viewing current values 110
  viewing description of 111
  viewing history of 110
  viewing inbound connection as data source 33
  viewing sources that use 111
  viewing sources used by the calculation 111

calendars
  adding 334
  adding periods to locked 339
  editing 334
  effect of period locking on 339
  multiple 335
  overview 334
  period locking 333
  permission to edit 320
  permission to lock 320
  permission to view 320

category calculations
  See calculations

change sets
  changing the order of 152
  overview 150
  transform 151
  types 151

charts
  adding multi-series to Presenter reports 189
  adding single series to Presenter reports 188
  enabling rotation or slicing movement in Presenter
  Reports 209
  printing from Presenter reports 209

client (continued)
  publishing Presenter reports from 210
  Client Success portal 11
  Cognos Producer Lifecycle and Credential Management
    adding objects in 76
    imports from 76
    loading data manually into 77
    scheduling imports from 77
  Cognos Territory and Quota Management
    adding objects in 74
    imports from 74
    loading data manually into 75
    scheduling imports from 75
    switching reports associated with 75

colors
  publishing preferences 210
  setting for components 29
  setting for draw report headers 123
  setting for gauges 191
  setting for maps 190
  setting for Payee Ledger reports 136
  setting for tailored reports 140
  sign off 240

commonly opened items
  finding 12
  overview 12

compensation plans
  adding calculations 136
  associating with payee groups 135, 136
  copying 139
  defining calendar for 136
  defining holds, caps, and guarantees 138
  locked 139
  main steps to create 135
  Payee Ledge display options 137
  permission to edit 309
  permission to view 309
  security overview 309
  selecting payee groups 138
  tailored reports 140
  using in the new year 335
  viewing reports in Payee Ledger 142

components
  adding 29
  adding documents to 30
  breadcrumbs 28
  columns between in tables 41
  connections between in tables 41
  copying 30
  data flow between 28
  deleting 31
  drilling through 28
  editing connections from 35
  finding 13
  inbound and outbound connections between parent and
    child 29
  inbound and outbound connections between siblings 29
  inbound and outbound connections in 28
  migrating 346
  opening 30
  organizing 27
  overview 27, 29
  permission to delete 302
  permission to edit 301
  permission to view 301
  renaming 30
  security overview 301

370  IBM Cognos Incentive Compensation Management Version 9.0.0: User Guide
components (continued)
  setting color for 29
  unwrapping 32
  wrap and unwrap overview 31
  wrapping 32
Composer
  adding Cognos Producer Lifecycle and Credential Management objects in 76
  adding Cognos Territory and Quota Management objects in 74
  adding objects as favorites 24
  Arrange icon 21
  components 27
  connection lines 25
  connections 32
  finding elements in 26
  fonts in 25
  Format Painter 25
  Go To icon 22
  hiding components and objects 21
  linking components together 20
  migrating 346
  migrating objects in models 19
  multi-edit mode 20
  Navigation tab 24
  overview 19
  Palette tab 24
  permission to edit 300
  permission to view 300
  purging calculation data 22
  purging table data 22
  purging table history 22
  security overview 300
  selecting all elements 21
  selecting objects in 26
  setting color of components 29
  showing components and objects 21
  single-edit mode 20
  tables 41
  titles and descriptions of objects in 27
  Used by icon 21
  Uses icon 21
  viewing data and results of tables or calculations 25
  viewing location of connections 22
  viewing overview of 25
  viewing sidebar 24
  zooming in 26
Composer diagram
  exporting 26
  permission to view 300
  viewing 25
Computation log
  clearing 283
  generating 270
  overview 270, 281, 283
conditional formatting
  setting up in Presenter reports 201
conditional nodes
  adding 222
configuration-only models
  overview 356
connection lines
  collapsing 25
  expanding 25
connections
  adding 33
connections (continued)
  adding inbound and outbound 38
  adding placeholders 37
  between components in tables 41
  constructing from hierarchies in the wizard 36
  definitions 36
  deleting 34
  deleting for draws 121
  editing 34
  editing from inside components 35
  editing mapping for 34
  editing through the wizard 37
  globalizing 55
  inbound and outbound 28, 33
  inbound and outbound between siblings 29
  incompatible 39
  linking tables and calculations for outbound 38
  names 35
  overview 32
  placeholders 37
  replacing 55
  replacing with global tables 34
  specifying columns in the wizard 36
  specifying references in the wizard 36
  tables available for 36
  testing 9
  using inbound as calculation source 33
  using the wizard 37
  viewing current values in 33
  viewing through the wizard 37
  wizard 35
  workflow nodes 223
constant values
  adding 170
CRM
  See Microsoft Dynamics CRM
  currencies
    adding 5
  Currency table 42
  custom tables 44
D
dashboards
  See workflow dashboards
data
  refreshing 342
data grid
    enabling copy of data grid rows into inquiries 204
  data grids
    adding editable columns to Presenter reports 195
    adding fixed to Presenter reports 187
    adding pagination 204
    adding templates to Presenter reports 186
    adding to Presenter reports 184
    adding validation rules for values in Presenter reports 196
    adding with input rows to Presenter reports 185
    applying templates 187
    changing column format to follow row text alignment 200
    exporting to Microsoft Excel 187
    freezing header row 204
    renaming data grid columns for Presenter reports 198
    resetting the name of data grid columns for Presenter reports 198
    selecting a data grid template for Presenter reports 197
    selecting columns for Presenter reports 197
data grids (continued)
setting the width of data grid columns for Presenter reports 198
showing or hiding columns in web client 197
data imports
adding in Scheduler 251
adding sub-items for mapping columns 70
category calculations 106
changing import escape character 72
checking required columns 66
concurrent users 326
data from data stores to Microsoft Excel 133
data from data stores to Watson Analytics 134
effective date columns 70
from Cognos Producer Lifecycle and Credential Management 76
from Cognos Territory and Quota Management 74
logs 271
managing 73
mapping columns 70
merging fields for mapping columns 71
overview 65
permission to delete 318
permission to edit 318
permission to import 304
permission to manage saved 317
permission to use advanced settings when importing 305
scheduling from Cognos Producer Lifecycle and Credential Management 77
scheduling from Cognos Territory and Quota Management 75
security overview 304
selecting data source 66
selecting EBCDIC files as data source 69
selecting Microsoft Dynamics CRM files as data source 68
selecting Microsoft Excel files as data source 67
selecting Microsoft Excel files from TerrAlign as data source 69
selecting ODBC Compliant Database file option 1 as data source 67
selecting ODBC Compliant Database file option 2 as data source 67
selecting Salesforce.com as data source 68
selecting save and run options 71
selecting table and import type 65
selecting text files as data source 66
selecting XML files as data source 69
star schemas 342
statistics 284
through connections 33
tracking import progress in the Activity module 72
using a remote directory for 73
viewing exception reports 72
data stores
adding left outer join 131
adding objects 130
basic steps in creating 129
exporting to Microsoft Excel 133
exporting to Watson Analytics 134
joining sources by columns 130
joining sources by rows 131
naming columns 132
overview 129
permission to delete 308
permission to edit 308
permission to view 308
refreshing data in Microsoft Excel 134
data stores (continued)
security overview 307
selecting columns 131
selecting restrictions 132
selecting sources 130
setting permissions to edit 133
setting permissions to view 132
Data table 44
adding 47
data tier performance optimization enabling 284
dates
adding to Presenter reports 182
setting filters in logs 271
specifying for adjustments 145
specifying for compensation plan visibility 238
specifying for compensation plans 136
specifying for tasks 262
specifying formats for 8
deferrals
canceling 264
dependencies
viewing 21
Dependency Viewer
copying text from 55
deleted components 31
viewing 55
Detail Ledger
copying text from 55
detailing 276
dependencies
viewing 21
documentation
adding links to Presenter reports 194
adding to components 30
downloading 140
managing 139
permission to add to the Manage Documents window 319
draw templates
adding 119
assigning payees 124
copying 122
drawing 121
editing name 121
draws
adding 117
adding draw objects 118
adding web tabs for draw assignments and draw reports 123
assignment reports 126
By period payout report 127
copying 121
defining assignment web tab settings 122
defining draw report web tab settings 123
defining web access for draw assignments and draw reports 124
deleting connections 121
defining draw assignments for payees on fixed term draws 124
defining draw assignments for payees on ongoing draws 125
defining earnings period 121
defining name 121
exporting overview reports to PDF files 126
exporting report results to Microsoft Excel 127
draws (continued)
hiding inactive payees 125
main steps to create in Composer 118
non-recoverable 117
overview 117
overview reports 126
pasting 121
recoverable 117
selecting calculations 119
unassigning payees 125
viewing draw assignments for payees on fixed term
draws 124
viewing draw assignments for payees on ongoing
draws 125
viewing reports 125
YTD payouts report 126

E
EBCDIC
selecting as data source 69
effective dates
adding end dates to records in tables with 59
adding tables with 58
deleting multiple versions of records in tables with 60
mapping columns to import dates 70
overview 57
viewing data in tables with 58
viewing multiple versions of data in tables with 58
elements
finding in Composer 26
unwrapping 32
wrap and unwrap overview 31
wrapping 32
emails
adding notifications 264
errors from Scheduler 259
notifications from Alert nodes 219
notifications from Scheduler 247
passwords from Task Manager 262
publications from Scheduler 253
sending about inquiries to all members of group 243
sending about sign off process to all members of
group 241
sending to pending payees about inquiries 242
sending to pending payees about sign off process 241
setting address for Request Assistance link on the
web 325
Error log
overview 270
setting date filters in 271
exchange character
changing 72
Excel
See Microsoft Excel
Export log
overview 272
exports
Audit logs 269
category calculations 106
Composer diagram 26
data grids to Microsoft Excel 184, 187
defining taglines 9
fixed grids to Microsoft Excel 187
logs 272
overview reports to PDF 126
Payee Ledger results to Microsoft Excel 276
exports (continued)
Payee Ledger results to text file 276
report results to Microsoft Excel 127
through connections 33
web forms to PDF 162
workflow errors, actions, and history to Microsoft
Excel 226
Extended Binary Coded Decimal Interchange Code
See EBCDIC
F
favorites
adding objects to list 24
overview 24
permission to view compensation plan in list 309
permission to view Composer module in list 300
permission to view data stores in list 132
permission to view table structure in list 302
filters
calculation data 110
dates in logs 271
migrating web forms 348
Navigation tab 24
pick lists 47
plans by payee 275
Portal Access 156
saved web forms 158
simple 156
table data 50
web form 155
workflow errors, actions, and history 225
fixed grids
exporting to Microsoft Excel 187
fonts
editing in Presenter reports 208
overview 25
setting alternating in Presenter reports 201
setting in charts 188
setting in data grids 184
setting in multi-series charts 189
setting in Presenter reports 182
setting in web forms 159
Format Painter
overview 25
formulas
computed columns in Presenter reports 199
computed rows in Presenter reports 199
enforcing single row 284
formatting 98
locked calculations 112
null values 202
operators for calculations 94
overview 94
single row 284
user-defined calculations 103
G
gauges
adding to Presenter reports 191
global actions
overview 11
restrictions 328
glossary 365
graphics
See images
Group Member table 42
groups
   AND or OR groups 103
   associating payees with compensation plans 135
   associating payees with holds, caps, and guarantees 138
   category calculations 106
   payees 42, 339
Portal Access 232
   sending emails about inquiries to all members of 243
tasks 261
web tabs 122, 231

headers
   enabling custom in web client 343
   inserting images for PDF files 53, 162
   permission to enable custom 322
   suppressing in data grids in the web client 200
web client 204
help
   accessing 9
   Client Success portal 11
hierarchies
   adding 5
   viewing Accounts table as 48
   viewing Payees table as 48
   viewing Time tables as 48
Hierarchy table 42
Home page
   Client Success portal 11
   finding commonly opened items in 12
   finding components, tables, Presenter reports, and web forms in 13
   finding recently opened items in 12
   global action icons 11
   Online pane 11
   overview 11
   welcome message 11

IBM Cognos Territory and Quota Management
   synchronizing in Scheduler 251
illustrations
See images
images
   adding to Presenter reports 188
   inserting into headers for PDF files 53, 162
   publishing preferences 210
import escape character
   changing 72
Import log
   overview 271
   viewing exception reports 72
imports
See data imports
   incremental calculations 283
input forms
   adding 81
   adding rows to 84
   adding validation rules to 83
   assigning security to 82
   assigning users to 82
input forms (continued)
   editing rows in 84
   overview 81
   permission to add 305
   permission to add rows to 306
   permission to delete 306
   permission to delete rows from 307
   permission to edit 306
   permission to edit data in 307
   permission to view history of 307
   security overview 305
   viewing 83
inquiries
   adding categories 245
   allowing web client users to copy data grid rows into 204
   disabling 242
   editing categories 245
   enabling 242
   enabling resubmission 245
   handling 243
   submitting from web client 243
   unassigning idle 256
   viewing details 244
   viewing details assigned to administrator 244
   viewing details from a group 244

JavaScript
   adding to web forms 161

languages
See multilingual support
layout tables
   editing alignment in Presenter reports 208
   editing borders in Presenter reports 208
   editing padding in Presenter reports 208
locked calculations
See calculations
login
   forcing web users to change passwords on first login 325
   forcing web users to change passwords on next login 233
model environment 8
   options 7, 8
   overview 7
logs
   Action Node Errors 224
   Audit 171, 224, 259, 267
   clearing 270
   Computation 270, 281, 283
   copying 270
   Error 270
   Export 272
   Import 72, 271
   Migration 352
   Performance 273
   permission to purge history 303
   permissions 289
   Scheduler 259, 272
   Service Error 271
   Signature 272
   Task 272

374 IBM Cognos Incentive Compensation Management Version 9.0.0: User Guide
M
maps
adding to Presenter reports 190
Microsoft Dynamics CRM
publishing calculations to 113
publishing tables to 53
selecting as data source 68
Microsoft Excel
connecting to a model with 342
exporting data from data store to 133
exporting Payee Ledger results to 276
exporting report results to 127
exporting workflow errors, actions, and history to 226
importing data grids and fixed grids from Presenter reports 187
publishing calculations to 113
publishing tables to 53
refreshing data store data in 134
selecting as data source 67
selecting file from TerrAlign as data source 69
Microsoft Excel add-in
adding star schemas with 342
migration
components 346
Composer 346
Composer objects 352
configuration-only models 356, 357
global tables 347
main steps for testing and verifying 352
main steps to plan 353
main steps to validate 356
managing future changes 357
migration phase 355
objects that cannot be migrated 350
overview 345
performing 351
permission to perform 321
planning 357
planning phase 353
Presenter reports 347
process lists 348
tables with pick lists 347
validation phase 356
web forms 347
web forms filters 348
web tabs 348
workflows 349
Migration log 352
models
adding 5
adding with multilingual support 6
connecting with Microsoft Excel 342
main steps to create 19
migrating configuration-only 356, 357
optimizing 333
permission to optimize 320
publishing summary 6
renaming 6
scheduling optimization 255
specifying environment for 8
money
See currencies
multilingual support
adding models with 6
date formats 8
languages 8
overview 7

N
naming conventions
Presenter 166
Navigation tab
viewing 24
Navigator tab 12
nodes
action 224
Action 220
alert 220
Alert 219
conditional 222
connecting 222
copying 222
cutting 222
deleting 222
deleting connections between 223
editing 222
editing connections between 223
overview 218
pasting 222
process 221
Start 219
numeric values
how null values are handled in Presenter reports 202
null values in Presenter reports 202

O
objects
adding in Cognos Producer Lifecycle and Credential Management 76
adding in Cognos Territory and Quota Management 74
loading data manually into Cognos Producer Lifecycle and Credential Management 77
loading data manually into Cognos Territory and Quota Management 75
scheduling imports from Cognos Producer Lifecycle and Credential Management 77
scheduling imports from Cognos Territory and Quota Management 75
selecting in Composer 26
switching reports from Cognos Territory and Quota Management 75
titles and descriptions of in Composer 27
ODBC Compliant Database
permission to use advanced settings when importing 305
selecting file option 1 as data source 67
selecting file option 2 as data source 67
OLAP cubes
star schemas 341
Online pane 11
optimization
models 333
models during off-peak hours 255
permission to optimize models 320
overwrite change sets
adding 150
editing properties for 151
overview 150

P
pagination
adding to data grids on the web client 204
Presenter report layout (continued)
  adding editable columns to data grids  195
  adding fixed data grids  187
  adding gauges  191
  adding images  188
  adding links  182
  adding maps  190
  adding multi-series charts  189
  adding numeric values  183
  adding pagination to data grids on the web client  204
  adding pick lists  193
  adding signature control  194
  adding single series charts  188
  adding tables  180
  adding text  182
  adding text controls  192
  adding text values  183
  adding validation rules for data grid values  196
  adding workflow dashboards  194
  allowing web client users to copy data grid rows into
  inquiries  204
  changing column format in data grids to follow row text
  alignment  200
  clearing links  199
  deleting contents  195
  deleting tables  181
  editing tables  181
  filtering pick lists  193
  formatting columns  200
  formatting data grid rows  201
  freezing the header row in the web client  204
  links in  199
  null numeric values  202
  optional null numeric values  202
  planning  179
  renaming data grid columns in  198
  resetting column names in data grid  198
  resizing cells in tables  181
  selecting a data grid template  197
  selecting column for data grids  197
  setting alternating row fonts  201
  setting column widths  198
  setting conditional formatting  201
  setting the default font  182
  showing date in  202
  showing grid lines  202
  showing or hiding columns in web client  197
  showing time in  202
  suppressing data grid headers in the web client  200
  swapping tables  181

Presenter reports (continued)
  editing fonts  208
  editing padding in layout tables  208
  enabling rotation or slicing movement in charts  209
  exporting data grids and fixed grids to Microsoft
  Excel  187
  finding  13
  linked parameters  168
  linking to other reports  206
  linking to web forms  161, 206
  linking to web pages  206
  locking  181
  main steps to create  165
  main steps to create link  207
  migrating  347
  naming conventions  166
  overview  165
  parameters  167
  permission to edit  312
  permission to use Audit log as a source  312
  permission to view in Composer  311
  Portal Access Inquiries sources  176
  previewing  209
  printing charts in  209
  publishing from client  210
  redoing actions  208
  row form sources  176
  security overview  311
  selecting PDF options  210
  selecting publishing preferences  210
  sources  170
  stored value examples  169
  transformations  173
  undoing actions  208
  unlocking  181
  values  168
  Work Form IDs  175
  primary keys  46

process lists
  adding  15
  adding tasks to  16
  changing the order of tabs on Home page  17
  changing the order of tasks in  17
  deleting links from  17
  deleting tasks from  17
  editing  17
  filtering  16
  marking tasks as complete in  17
  migrating  348
  overview  15
  permission to add  299
  permission to delete  299
  permission to edit  299
  permission to view  299
  resizing panes  15
  viewing  16

process nodes
  adding  221
  Process nodes
  rerunning  225

publications
  managing saved  252
  overview  252
  permission to delete  318
  permission to edit  318
  permission to run  318
  sending through email  253

Index 377
Quick Navigation pane  13
finding components, tables, Presenter reports, and web forms in 13

recently opened items
finding  12
overview  12
references
connections for  36
reports
By period payout  127
components  182
draw assignments  126
draw overview  126
draw reports  125
exporting draw report results to Microsoft Excel  127
exporting overview reports to PDF files  126
finding  13
Payee Ledger  145
Presenter reports  161, 165
scenario  152
switching objects associated with Cognos Territory and Quota Management  75
viewing import exceptions  72
YTD payouts  126
required flags
adding to row forms  158
restrictions
defining for calculations  102
deleting  103
overview  101
using AND or OR groups  103
roles
adding  288
assigning security to input forms  82
assigning to input forms  82
assigning to users  330
copying  288
deleting  288
renaming  288
security overview  287, 289
segregation example  329
rules
adding  262
tasks  262
validation  83, 157, 196

Salesforce.com
changing web client theme for  343
enabling custom headers for  322
publishing calculations to  114
publishing tables to  54
selecting as data source  68
Salutation table  42
scenarios (continued)
changing the order of change sets  152
editing properties for overwrite changes sets  151
editing properties for transform changes sets  151
editing workspace properties  149
finding workspaces for  149
generating reports  152
overview  147
permission to add  310
permission to create workspaces  310
permission to promote  310
permission to view  310
previewing results  152
promoting  153
security overview  309
viewing workspaces for  149
Scheduler
adding data transformations  254
adding imports  251
adding period locking  255
adding processes  248
adding publications  253
adding purge history tasks  256
adding star schedule population  254
adding subfolders  248
adding table clearing  254
adding task generation  253
adding task run  253
adding workflow payees  256
adjusting timing  258
disabling web access  255
enabling web access  255
error notifications  259
finding items  257
managing saved publications  252
model optimization  255
overview  247
permission to edit  314
permission to view  314
properties  247
running items  258
scheduling external tools  251
scheduling items  257
scheduling publications  252
security overview  313
sending publications through email  253
setting up external tools  250
synchronizing tables in IBM Cognos Territory and Quota Management  251
tasks  249
time conflicts  258
unassigning idle inquiries  256
unscheduling items  258
viewing schedule history purges  257
Scheduler log
overview  272
viewing  259
schemas
See star schemas
security administration  317
approving web data edits  63
assigning to input forms  82
assigning users to input forms  82
Audit module  314
Calculate module  316
compensation plans  309

S

378 IBM Cognos Incentive Compensation Management Version 9.0.0: User Guide
security (continued)
  components 301
  Composer 300
  data imports 304
  data stores 307
  defining accessible information in tables 61
  editing table data through web client 63
  enabling direct table editing through web client 62
  input forms 305
  overview 287
  password expiration 324
  Payee Ledger 315
  Portal Access 312
  Presenter reports 311
  restricting visible rows in tables 62
  roles 287
  roles access 289
  Schedules 313
  tables 302
  Task Manager 314
  tools 319
  users 322, 323
  web forms 311
  web tabs 231
  web users 324
  Workflow Manager 315
Service Error log
  overview 271
sidebar
  viewing 24
sign offs
  colors 240
  ending 240
  forcing approvals 241
  sending emails to pending payees 241
  viewing status for group members 241
signature controls
  adding to Presenter reports 194
Signature log
  overview 272
sort calculations
  See calculations
star schemas
  adding 341
  connecting to a model 342
  importing 342
  importing with Microsoft Excel add-in 342
  overview 341
  permission to edit 321
  permission to view 321
  populating 254
Start nodes
  editing 219
statistic monitoring program 284
stored values
  adding 169
  examples 169
Structural table 44
Submit buttons
  adding to Presenter reports 195
Summary Ledger
  generating report 277
  overview 277
  results with caps and guarantees 277
swim lanes
  adding 218
swim lanes (continued)
  adding columns to 218
  deleting 218
  form initiators 217
  overview 217
  removing columns from 218
System tables 42
T tables
  Accounts 43
  adding 46
  adding data to 49
  adding data to records with effective dates 59
  adding Data type 47
  adding descriptions 51
  adding effective dates 23, 58
  adding end dates to records with effective dates 59
  adding global 55
  approving web data edits 63
  clearing contents of 56
  column types 45
  columns between components in 41
  connections between components 41
  copying 52
  copying text from Dependency Viewer 55
Currency 42
  custom 44
Data 44
  defining accessible information in 61
  defining pick list field types for 47
  deleting 51
  deleting multiple rows in 51
  deleting multiple versions of records in tables with effective dates 60
  disabling history collection for a specific table 61
  displaying description in pick list columns 50
  editing a View table 51
  editing data in 49, 50
  editing descriptions 51
  editing structure of 50
  editing table data through web client 63
  effective dates 57
  enabling direct editing through web client 62
  filtering data in 50
  finding 13
  finding data in 57
  Group Member 42
Hierarchy 42
history in 60
keys 46
migrating 347
migrating global 347
navigating between 56
overview 41
Payee 43
permission to add Views 303
permission to delete 303
permission to edit structure 303
permission to enable web data edit for 304
permission to purge change log history 303
permission to view structure 302
primary keys 46
publishing overview 52
publishing to Microsoft Dynamics CRM 53
publishing to Microsoft Excel 53
Index 379
tables (continued)
publishing to PDF 53
publishing to Salesforce.com 54
publishing to text file 54
purging calculation data in 22
purging history in 61
replacing connections with global 34
replacing data in 57
restricting visible rows in 62
Salutation 42
security overview 302
Structural 44
System 42
Time 44
Title 42
Turning off warning message when deleting rows in 343
types 41
View 44
viewing data in 49
viewing data in tables with effective dates 58
viewing dependencies 55
viewing structure of 50
Views 48
web data edit feature 61
tabs
Activity 79
changing order of for process lists 17
closing 8
moving 8
opening 8
overview 8
rearranging 9
taglines
defining 9
tailored report calculations
adding to process folders 250
tailored reports
adding calculations 140
copying 142
editing locked 141
enabling alerts 141
main steps to create 140
naming 140
overview 135
selecting payee groups 140
selecting reporting settings 140
viewing in Payee Ledger 142
task lists
generating 263
Task log
overview 272
Task Manager:
activating payee alerts 265
adding email notifications 264
adding groups 261
adding rules 262
administering tasks 264
alerts 265
cancelling deferrals 264
disabling payee alerts 265
generating task lists 263
overview 261
security overview 314
tasks
adding to process folders 249
adding to process lists 16
administering 264
tasks (continued)
changing the order of in process lists 17
deleting from process lists 17
deleting links from process lists 17
main steps to create 261
marking as complete in process lists 17
TerrAlign
See Microsoft Excel
text controls
adding to Presenter reports 192
text files
publishing calculations to 114
publishing tables to 54
selecting as data source 66
text values
adding to Presenter reports 183
themes
changing for web client 343
time shift calculations
See calculations
Time table 44
viewing as hierarchy 48
Title table 42
toolbars
hiding text in 12
showing text in 12
tools
overview 333
permission to edit calendars 320
permission to edit payee groups 321
permission to edit star schemas 321
permission to enable custom headers 322
permission to lock calendars 320
permission to optimize models 320
permission to perform a migration 321
permission to view calendars 320
permission to view payee groups 320
permission to view star schemas 321
security overview 319
transform change sets
adding 151
editing properties for 151
overview 150
transformations
overview 173
permission to delete 319
permission to edit 319
permission to view 319

U

URLs
setting the base URL for web client 326
user-defined calculations
See calculations
users
adding 322
assigning roles to 330
changing passwords for 322
concurrent 326
defining accessible table information for 61
disabling account 326
editing table data through web client 63
enabling direct table editing through web client 62
environment roles 329
forcing to change passwords 233
users (continued)

forcing web users to change passwords on first login 325

global action restrictions 328

publishing permissions report 326

restricting visible rows in tables for 62

security options on web 323

security overview 322

sending emails about inquiries to all members of group 243

sending emails about sign off process to all members of groups 241

setting email address for Request Assistance link on the web 325

V

validation

adding rules to input forms 83

View table overview 44

Viewer viewing data and results of tables or calculations 25

W

Watson Analytics

exporting data from data store to 134

web client adding payees to Port Access group for 233

adding web tabs for draw assignments and draw reports 123

approving web data edits in 63

assigning payees to draw templates 124

changing theme for 343

defining draw assignment web tab settings 122

defining draw report web tab settings 123

defining web access for draw assignments and draw reports 124

defining web access for draw assignments and draw reports 124

editing table data through 63

enabling direct table editing through 62

enabling password expiration per Portal Access group 234

exporting overview reports to PDF files 126

forcing users to change passwords on first login 325

hiding inactive payees 125

initiating workflows in 226

performing workflow actions in 227

scheduling web access 235

security for user login 324

setting email address for Request Assistance link 325

setting the base URL for 326

showing or hiding columns in Presenter reports 197

signing off in 240

submitting inquiries from 243

suppressing headers in data grids 200

tasks

disabled 255

enabled 255

unassigning payees 125

viewing adjustments in 146

viewing completed workflows in 227

viewing draw assignments for payees on fixed term draws 124

viewing draw assignments for payees on ongoing draws 125

web client (continued)

viewing draw reports 125

Workflow Manager 226

web data editing data through web client 63

enabling direct editing for 62

overview 61

restricting visible rows in tables for 62

web forms adding 155

adding admin forms to 159

adding JavaScript to 161

adding required flags to row forms 158

adding row forms to 158

adding saved filters to 158

adding sources to 157

adding validation rules to 157

adding web resources to 159

copying cells in 160

defining custom filters for 156

defining filters for 155

defining Portal Access filters for 156

defining simple filters for 156

finding 13

formatting 159

linking to other web forms 162

linking to Presenter reports 161, 206

linking to web pages 162

migrating 347

migrating filters for 348

overview 155

pasting cells in 160

permission to edit 311

publishing 162

security overview 311

setting cell spans in 160

setting field widths in 159

setting options in 160

setting preferences in 161

web pages linking to Presenter reports 206

linking to web forms 162

web tabs adding 230

adding groups to 231

deleting 231

editing 230

migrating 348

moving 230

overview 229

removing from groups 231

security 231

welcome message 11

Work Form IDs

overview 175

workflow dashboards adding to Presenter reports 194

Workflow Manager main steps to create 213

nodes 218

overview 213

permission to create workflows 315

permission to edit 316

permission to start workflows 316

permission to view Workflow Manager 315

permission to view workflows 316

security overview 315
Workflow Manager (continued)
swim lanes 217
viewing events in web client 224
workflows 213
workflow nodes
See nodes workflows
adding 214
adding payees for 256
adding payees to 216
clearing pending actions or history 226
copying 215
deleting 215
editing 215
errors 223
exporting errors, pending actions, or history 226
filtering errors, pending actions, or history 225
finding 217
initiating 226
migrating 349
organizing 216
overview 213
pending state 223
performing actions in 227
workflows (continued)
rerunning Process nodes 225
setting default parameters for starting 216
viewing completed 227
viewing errors 224
viewing events in Workflow Manager 224
viewing pending actions 225
viewing workflow events in Audit module 224
workspaces
adding for scenarios 148
editing properties for scenarios 149
finding for scenarios 149
viewing for scenarios 149
X
XML files
selecting as data source 69
Z
zooming in Composer 26